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Chapter 1. Release Notes

This document contains information about new features and enhancements for HCL OneTest™ Embedded and links

to useful information about the products.
Contents

« Description on page 5

« What's new in HCL OneTest Embedded 8.3.1 on page 5
« Installing the product on page 6

* Known issues on page 7

« Contacting HCL support on page 7

Description

HCL OneTest™ Embedded is a complete test and runtime analysis tool set for systems development created in any

cross-development environment.

HCL OneTest™ Embedded provides tools for automated component testing, code coverage, memory leak detection,

performance profiling, and UML sequence diagram tracing.

What's new in HCL OneTest™ Embedded 8.3.1

You can find information about the features introduced in this release of HCL OneTest™ Embedded.

The following sections list the new features, enhancements or other changes made in this release.

» Monitoring
» This feature targets cyclic-executive applications, that is applications that mainly rely on a cycle where
input data are read and output data are set at each cycle. These input/output data are implemented

with global variables.

See Application monitoring on page 245

> The complete application is instrumented to be able to access to the global variables in read/write
mode with various means (socket, files...). See Application monitoring on page 245.
> A new view in HCL OneTest™ Embedded for Eclipse IDE is available to interactively modify the input
data and display the output data. See Monitoring a cyclic executive application on page 248.
> Qutput data can be displayed as curves on a graphical view.
« Test Case Generation for C (preview):
> This is a preview feature of the new test case generation integrated in HCL OneTest™ Embedded for

Eclipse IDE only for now.
> When this feature is enabled, the source code is analyzed and the test cases can be generated from:
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= The call graph: A coverage objective can be provided to generate test cases.

= The coverage viewer: Clicking on a branch displays in a new view the precondition to satisfy
in input of the function under test, and a new test case can be generated to satisfy this
precondition.

Note: No customer support is ensured for this feature for now. If you have any queries or issues about
the Test Case Generation for C (preview) feature, you can request help from OneTest Embedded

forum.

« Import requirements with format ReqlF

In HCL OneTest™ Embedded for Eclipse IDE preferences, the user can now load a requirement file that
supports the format ReqlF. See https://www.omg.org/spec/ReqlF/About-ReqlF/ and Link Tests to
Requirements.

« Support C++17 and C++20 syntaxes

Almost all C+20 syntaxes are supported under Support for C17 and C+20 syntaxes.

« Multiple user-defined MISRA rules
o Multiple user-defined rules can be defined in MISRA 2004 and MISRA 2012.

> Each rule can have its own severity.

See Configuring code review rules on page 110 and Configuring code review rules on page 322.

« MISRA updater:
> When you update from an old version of HCL OneTest™ Embedded and you use MISRA in HCL
OneTest™ Embedded for Eclipse IDE 8.3.1 for the first time, you are requested to update the
configuration rule with the new rules added to the new version. By default, the unselected rules are
disabled, they must be selected to be enabled. See Configuring code review rules on page 110.
> In HCL OneTest™ Embedded Studio, the configuration file is automatically updated and the new rules

are disabled. See Running a code review on page 326.

« Support for Eclipse 2020-06 (4.12)

HCL OneTest™ Embedded is still delivered with Eclipse 4.7.2 but it can be also installed on Eclipse 2020-06
(4.12).

« TDP Visual 2019

A new Target Deployment Port dedicated to Microsoft Visual 2019 is delivered.

Installing the product

You can find information about the installation and upgrade instructions for HCL OneTest™ Embedded for Eclipse IDE.

For instructions about installing the software, see Installing on page 20.


https://support.hcltechsw.com/community?id=community_forum&sys_id=3941f1551bb85898c48197d58d4bcb17
https://support.hcltechsw.com/community?id=community_forum&sys_id=3941f1551bb85898c48197d58d4bcb17
https://www.omg.org/spec/ReqIF/About-ReqIF/
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You cannot upgrade HCL OneTest™ Embedded for Eclipse IDE from an earlier version of the product to version 8.3.1.

If you have an earlier version of the product, you must uninstall it before installing HCL OneTest™ Embedded 8.3.1.

Known issues

You can find information about the known issues identified in this release of HCL OneTest™ Embedded for Eclipse IDE

Table 1. Release documents - Fix list and known issues

Product Download document Knowledge Base

HCL OneTest™ Embedded Release document Knowledge articles

The knowledge base is continually updated as problems are discovered and resolved. By searching the knowledge
base, you can quickly find workarounds or solutions to problems.

Contacting HCL support

« For technical assistance, contact HCL Customer Support.

- Before you contact HCL support, you must gather the background information that you might need to describe
your problem. When you describe a problem to the HCL support specialist, be as specific as possible and
include all relevant background information so that the specialist can help you solve the problem efficiently.
To save time, know the answers to these questions:

> What software versions were you running when the problem occurred?
> Do you have logs, traces, or messages that are related to the problem?
> Can you reproduce the problem? If so, what steps do you take to reproduce it?

o |s there a workaround for the problem? If so, be prepared to describe the workaround.


https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0090846
https://support.hcltechsw.com/csm?id=kb_search
https://support.hcltechsw.com/csm

Chapter 2. System Requirements

This document includes information about hardware and software requirements for HCL® OneTest™ Embedded.
Contents

« Hardware on page 9

» Operating systems on page 9

 Prerequisites on page 10
o Eclipse Runtime Environment on page 10
o Installation on page 10
« Development environments on page 11
* Integration environments on page 12
o Compilers and languages on page 12
o Development Tools on page 13

o Quality_management on page 13
« Disclaimers on page 8

Disclaimers
This report is subject to the Terms of Use and the following disclaimers:

The information contained in this report is provided for informational purposes only. While efforts were made to
verify the completeness and accuracy of the information contained in this publication, it is provided AS IS without
warranty of any kind, express or implied, including but not limited to the implied warranties of merchantability, non-
infringement, and fitness for a particular purpose. In addition, this information is based on HCL's current product
plans and strategy, which are subject to change by HCL without notice. HCL shall not be responsible for any direct,
indirect, incidental, consequential, special or other damages arising out of the use of, or otherwise related to, this
report or any other materials. Nothing contained in this publication is intended to, nor shall have the effect of, creating
any warranties or representations from HCL or its suppliers or licensors, or altering the terms and conditions of the

applicable license agreement governing the use of HCL software.

References in this report to HCL products, programs, or services do not imply that they will be available in all
countries in which HCL operates. Product release dates and/or capabilities referenced in this presentation may
change at any time at HCL's sole discretion based on market opportunities or other factors, and are not intended to
be a commitment to future product or feature availability in any way. Discrepancies found between reports and other
HCL documentation sources may or may not be attributed to different publish and refresh cycles for this tool and
other sources. Nothing contained in this report is intended to, nor shall have the effect of, stating or implying that any
activities undertaken by you will result in any specific sales, revenue growth, savings or other results. You assume

sole responsibility for any results you obtain or decisions you make as a result of this report.
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Notwithstanding the Terms of Use users of this site are permitted to copy and save the reports generated from this

tool for such users own internal business purpose. No other use shall be permitted.

Hardware
You can find information about the hardware requirements for HCL® OneTest™ Embedded 8.3.1.
Hardware Deployment units Requirement
Desktop For Windows/Linux: 1.5GB
Disk space
Desktop Windows/Unix: 4 GB RAM
Memory
Desktop Windows/Unix: x64
Processor

Related information

System Requirements on page 8

Operating systems

You can find details about the supported operating systems.

Operating systems

Operating system Version Hardware
6.0
Red Hat Enterprise Linux (RHEL) Client x64
Red Hat Enterprise Linux (RHEL) Client 7
x64
8.0
Red Hat Enterprise x64

Linux (RHEL) Client

SUSE Linux Enterprise Server 12.0
x64

SUSE Linux Enterprise Server 15.0
x64
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Operating system Version Hardware
Ubuntu Desktop 16

x64
Ubuntu Desktop 18 18

x64
Ubuntu Desktop 20.04

x64
Windows 10 x64
Windows Server 2016 x64

Related information

System Requirements on page 8

Prerequisites

You can find the prerequisites that support the operating capabilities for HCL® OneTest™ Embedded 8.3.1.

Contents

Eclipse Runtime Environment on page 10

Installation on page 10

Eclipse Runtime Environment

Prerequisite Version
Version .
Minimum
Eclipse 47.3
412
Eclipse 2020-06 416

Installation

Version

Prerequisite Version
Minimum

IBM Installation Manager 1.8.6

10



Chapter 2. System Requirements

Related information

System Requirements on page 8

Development environments

HCL® OneTest™ Embedded supports multiple development environments thanks to its Target Deployment Port (TDP)
technology.

The following aspects of the development environments are considered:

« Compiler & linker used to compile the generated tests and link them with the code under test, or to compile
and link the instrumented code.
« Target used to execute the tests. These targets can be a laptop itself (case of TDP with native compilers), a

simulator, an emulator or an electronic board.

The multiple Target Deployment Ports that are provided in HCL® OneTest™ Embedded can be used as they are or
modified to adapt them to a new environment.

Non-exhaustive list of supported compilers/linkers:

« C/C++ languages:
> gcce (tested until version 11.2)
> Microsoft Visual Studio (tested with versions 2010 to 2019)
o Codewarrior
o gcc ARM
o Mirotec
o Keil
> DiabData
o Texas Instruments
> Microsoft eMbedded Visual
> HighTec TriCore
o GreenHills IAR

 Ada language:
e gnat

> Rational Apex

» Targets:
o winIDEA
o Hiwave simulator
> OpenODC
> jTag

11
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> gdb

> MPLAB

o Code Composer

> QNX

> Windows CE simulator
o Single Step

> IAR C-SPY

o Lauterbach Trace32

> Tornado (VxWorks)

Note: Some specific versions of compilers can include additional packages that might require a TDP
customization.

HCL® OneTest™ Embedded integrates the EDG parser for C and C++ version 6.1. The EDG parser supports
almost all the C++17 and C++20 features.

List of supported features until EDG 6.1:

« For C++17 features, refer to https://docs.google.com/spreadsheets/d/1ch1bA60V-
hkSGMykaGweU1HaQbscXGTy-dpLtCMd7W8/pubhtml.

- For C++20 features, refer to: https://docs.google.com/spreadsheets/d/1H-agjzVI2a-
XQKGtw0xaS0tyjDOFcoQP8ttJI9JZQTc/edit#gid=0.

Integration environments

The Prerequisites section specifies the capabilities that HCL® OneTest™ Embedded 8.3.1 requires, and the
prerequisite products that can be used to fulfill those capabilities. You can find details about the additional software
that are supported.

Contents
Compilers and Languages on page 12
Development Tools on page 13

Quality Management on page 13

Compilers and languages

Supported software Version

Microsoft Visual C++ 2005 and future fix packs

2008 and future fix packs

12


https://docs.google.com/spreadsheets/d/1cb1bA6OV-hkSGMykaGweU1HaQbscXGTy-dpLtCMd7W8/pubhtml
https://docs.google.com/spreadsheets/d/1cb1bA6OV-hkSGMykaGweU1HaQbscXGTy-dpLtCMd7W8/pubhtml
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Supported software

Version

Microsoft Visual C++ .NET

2003 and future fix packs

Development Tools

Supported software

Supported software Version
minimum
Microsoft Visual Studio 2005 and future fix packs
2005 and future fix packs

201x and future versions,

and fix packs

releases,

Rational Software architect 8.x

Rational Team Concert 5.0.x 4.x
Quality Management
Table 2.

Supported software
Supported software Version
minimum
Rational Quality Manager 6.0.6.0 6.0.6.0

Related information

System Requirements on page 8

13
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This guide provides an overview of HCL® OneTest™ Embedded. You can find the information to get you started with

HCL OneTest™ Embedded. This guide is intended for new users.

Before you can perform the various tasks described in the Getting Started Guide and the other guides, you must install
HCL OneTest™ Embedded. See Installing on page 20.

Overview

HCL® OneTest™ Embedded is a complete test and runtime analysis tool set for systems development created in any
cross-development environment. HCL OneTest™ Embedded provides tools for automated component testing, code
coverage, memory leak detection, performance profiling, and UML sequence diagram tracing.

Systems development includes (but is not limited to) embedded, real-time and/or technical systems development.
And this type of software is often performed in conjunction with the larger scope of a systems engineering activity.
HCL OneTest™ Embedded is a cross-platform solution designed specifically for developers creating software
applications for products of embedded (for example, mobile phone, medical device, handled global positioning
system, and so on), real-time (for example, aerospace, automotive or telecommunications control system), and
other technical systems applications for example, simulated research computation and advanced grid computing

systems).

Implementing a practical, effective and professional testing process within your organization has become essential
because of the increased risk that accompanies software complexity. The time and cost devoted to testing must
be measured and managed accurately. Very often, lack of testing causes schedule and budget overruns with no
guarantee of quality. Critical trends require software organizations to be structured and to automate their test
processes. These trends include:

« Ever increasing quality and time to market constraints.

- Growing complexity, size and number of software-based equipment.

« Lack of skilled resources despite need for productivity gains

« Increasing interconnections of critical and complex embedded systems.

- Proliferation of quality and certification standards throughout critical software markets, including the avionics,

medical, and telecommunications industries.

HCL OneTest™ Embedded provides a full range of answers to these challenges by enabling full automation of system

and software test processes.

HCL OneTest™ Embedded is a complete test and runtime analysis tool set for embedded, real-time and networked
systems created in any cross-development environment. Automated testing, code coverage, memory leak detection,

performance profiling, UML tracing, code review - with HCL OneTest™ Embeddedyou fix your code before it breaks.

HCL OneTest™ Embedded covers runtime analysis and software testing, all in a fully integrated testing environment.

14
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The latest release of HCL OneTest™ Embedded integrates with Rational Quality Manager to provide a more
collaborative approach to product software development and testing. HCL OneTest™ Embedded is the most complete
automated developer testing solution available on a wide range of host and target platforms. In addition, new
integrations with other popular development tool environments allow developers to work in the environment of their
choice. This enables the powerful testing capabilities of HCL OneTest™ Embedded to be used early in the product

software development lifecycle because it is part of the developers daily work environment.

Target deployment port technology

Target deployment port (TDP) technology is a versatile, low-overhead mechanism that enables target-independent
testing and runtime analysis with limitless target support. As a key component of HCL OneTest™ Embedded, TDP

technology allows your tests be run directly on your target embedded hardware.

Each TDP is customized to accommodate your compiler, linker, debugger, and target architecture. Tests are
independent of the TDP, so that the tests don't change when your environment changes. For example, you can run the
same tests and code on the embedded hardware or on your local computer by switching the TDP and rebuilding the

project.

Target deployment ports are designed to strongly reduce the data communication and runtime overhead that
can affect your embedded systems when tested, while being versatile enough to adapt to any cross-development
environment (RTOS, compiler, debugger, target communication) within a very short time.

DO0-178B/C Qualification Kit

All HCL OneTest™ Embedded customers have access to the HCL OneTest™ Embedded DO-178B/C Qualification

Kit, which can be submitted with your other project artifacts to meet DO-178B/C compliance requirements. The
Qualification Kit covers unit testing for C and Ada languages, coverage for C and Ada languages and code review for
C language (MISRA 2004).

For more information about DO-178bB/C support, contact the Products & Platforms Customer Support via this link:

https://www.hcltech.com/products-and-platforms/support.

Related information

Target deployment port overview on page 17

Source code instrumentation overview on page 16

Integrating HCL OneTest Embedded with other development tools on page 49
Analyzing static source code on page 251

Runtime analysis overview on page 336

15
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Source code instrumentation overview

Source code insertion (SCI) technology uses instrumentation techniques that automatically add specific code to the
source files under analysis. After compilation, execution of the code produces dump data for runtime analysis or

component testing.

HCL® OneTest™ Embedded makes extensive use of source code insertion technology to transparently produce test

and analysis reports on both native and embedded target platforms.

Instrumentation overhead

Instrumentation overhead is the increase in the binary size or the execution time of the instrumented application,
which is due to source code insertion (SCI) generated by the Runtime Analysis features. Source code insertion
technology is designed to reduce both types of overhead to a bare minimum. However, this overhead may still impact
your application. The following table provides a quick estimate of the overhead generated by the product.

- Code Coverage Overhead: Overhead generated by the Code Coverage feature depends largely on the coverage

types selected for analysis.

A 48-byte structure is declared at the beginning of the instrumented file. Depending on the information mode
selected, each covered branch is referenced by an array that uses

> 1 byte in Default mode

o 1 bit in Compact mode

o 4 bytes in Hit Count mode

The actual size of this array may be rounded up by the compiler, especially in Compact mode because of the
8-bit minimum integral type found in C . See Information Modes for more information. Other Specifics:
> Loops, switch and case statements: a 1-byte local variable is declared for each instance.
> Modified/multiple conditions: one n-byte local array is declared at the beginning of the enclosing
routine, where n is the number of conditions belonging to a decision in the routine 1/0 is either
performed at the end of the execution or when the end-user decides (please refer to Coverage

Snapshots in the documentation).

In summary, hit count mode and modified/multiple conditions produce the greatest data and execution time
overhead. In most cases you can select each coverage type independently and use pass mode by default in
order to reduce this overhead. The source code can also be partially instrumented.

- Memory and Performance Profiling and Runtime Tracing: Any source file containing an instrumented routine
receives a declaration for a 16 byte structure. Within each instrumented routine, a n byte structure is locally
declared, where n is 16 bytes +4 bytes for Runtime Tracing, +4 bytes for Memory Profiling, and +3*t bytes for

Performance Profiling, where t is the size of the type returned by the clock-retrieving function.

For example, if t is 4 bytes, each instrumented routine is increased of 20 bytes for Memory Profiling only, 20
bytes for Runtime Tracing only, 28 bytes for Performance Profiling only, or 36 bytes for all Runtime Analysis

features together

16
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- Memory Profiling Overhead: Any call to an allocation function is replaced by a call to the Memory Profiling
Library. These calls aim to track allocated blocks of memory. For each memory block, 16+12*n bytes are
allocated to contain a reference to it, as well as to contain link references and the call stack observed at
allocation time. n depends on the Call Stack Size Setting, which is 6 by default. If ABWL errors are to be
detected, the size of each tracked, allocated block is increased by 2*s bytes where s is the Red Zone Size
Setting (16 by default). If FFM or FMWL errors are to be detected, a Free Queue is created whose size depends
on the Free Queue Length and Free Queue Size Settings. Queue Length is the maximum number of tracked
memory blocks in the queue. Queue Size is the maximum number of bytes, which is the sum of the sizes of all

tracked blocks in the queue.

- Performance Profiling Overhead: For any source file containing at least one observed routine, a 24 byte
structure is declared at the beginning of the file. The size of the global data storing the profiling results of an

instrumented routine is 4+3*t bytes where t is the size of the type returned by the clock retrieving function.

 Runtime Tracing Overhead: Implicit default constructors, implicit copy constructors and implicit destructors
are explicitly declared in any instrumented classes that permits it. Where C++ rules forbid such explicit
declarations, a 4 byte class is declared as an attribute at the end of the class.

Instrumentation technology is designed to reduce both performance and memory overhead to a minimum.
Nevertheless, for certain cross-platform targets, it may need to be reduced still further. There are three ways to do
this.

- Limiting code coverage types: When using the Code Coverage feature, procedure input and simple and implicit
block code coverage are enabled by default. You can reduce instrumentation overhead by limiting the number

of coverage types.

Note: The Code Coverage report can only display coverage types among those selected for

instrumentation.

« Limiting instrumented calls: When calls are instrumented, any instruction that calls a C user function or library
function constitutes a branch and thus generates overhead. You can disable call instrumentation on a set of C
functions using the Selective Code Coverage Instrumentation Settings. For example, you can usually exclude
calls to standard C library functions such as printf or fopen.

 Optimizing the information mode: When using Code Coverage, you can specify the information mode, which

defines how much coverage data is produced and therefore stored in memory.

Target deployment port overview

Target deployment port (TDP) technology is a versatile, low-overhead technology enabling target-independent tests

and run-time analysis despite limitless target support.

As a key component of HCL® OneTest™ Embedded, TDP technology allows your test cases as well as test

execution analysis to be applied directly to your target embedded system. It is constructed to accommodate your

17
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compiler, linker, debugger, and target architecture. Tests are independent of the TDP, so tests don't change when the

environment does. Test script deployment, execution and reporting remain easy to use.

TDPs are designed to strongly reduce the data communication and runtime overhead that can affect your embedded
systems when tested, while being versatile enough to adapt to any cross-development environment (RTOS, compiler,

debugger, target communication) within a very short time.

TDP technology includes the following capabilities and benefits:

« Compiler dialect-aware and linker-aware, for transparent test building.

 Easy download of the test harness environment onto the target via the user's IDE, debugger, simulator or
emulator.

« Painless test and run-time analysis results download from the target environment using JTAG probes,
emulators or any available communication link, such as serial, Ethernet or file system.

» Powerful test execution monitoring to distribute, start, synchronize and stop test harness components, as well
as to implement communication and exception handling.

« Versatile communication protocol adaptation to send and receive test messages.

» XML-based Target Deployment Port Editor enabling simple, in-house TDP customization

Obtaining target deployment ports

TDP technology was designed to adapt to any embedded or native target platform. This means that you need a
particular TDP to deploy HCL® OneTest™ Embedded to your target. A wide array of TDPs has already been developed
to suit most target platforms. The following platforms are already supported:

« Native development platforms: Windows™ and Linux™, the development platforms that leading companies in
the devices/embedded systems and infrastructure industries are using.

« Cross-development environments: From 8- to 64-bit cross-development environments from WindRiver,
GreenHills, ARM, Sun, Montavista, TI, NEC, Hitachi, Nohau, and more.

If there is no existing TDP for your particular target platform, HCL Customer Support can provide the service of

creating a tailored TDP for you.

To obtain a copy of an existing TDP or to inquire about custom development, follow one of the methods:

« Contact your HCL sales representative.
« If you do not know your sales representative, contact HCL Customer Support or create an HCL Support case.

Creating new target deployment ports

You can choose to create, unassisted, a TDP tailored for your embedded environment. There are several requirements

to consider before choosing this option:
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- Perl language knowledge: The HCL OneTest™ Embedded compiler interface is written in perl
» Programming language and compiler knowledge: The HCL OneTest™ Embedded runtime library uses the

same language as the code under test (C, C++, Ada)
« Knowledge of HCL OneTest™ Embedded: Improve your experience with the product before considering your
first TDP. You will need to be familiar with the runtime analysis and component testing tools and how the TDP

is used with them.

Before creating a TDP for a new target platform, determine whether the target platform is capable of running
embedded tests. To create a TDP, see the documentation that is embedded in the Target Deployment Port Editor,

which provides an overview and detailed information on setting up a TDP, and using the Target Deployment Port

Editor.
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This guide describes how to install the HCL® OneTest™ Embedded software.

After you install the software, you can perform administration tasks such as license configuration, user management,
security, memory and disk usage management, back up and restore user data, and other tasks that a server

administrator can perform. This guide is intended for administrators.

Installing

This section provides the instructions for installing the product as well as installation verification. To install your
product, follow the procedures and information in these topics. Installing the product involves verifying requirements,

planning, managing licenses.

Installation requirements

This section details hardware, software, and user privilege requirements that must be met in order to successfully
install and run HCL OneTest™ Embedded.

Hardware and Software requirements

Before you install the product, verify that your system meets the hardware and software requirements.

For information about hardware and software compatibility, see System Requirements on page 8.

User privileges requirements

You must have a user ID that meets the following requirements before you can install HCL OneTest™ Embedded.

* Your user ID must not contain double-byte characters.

 You must install Installation Manager as an administrator on Windows if the version of your operating system
requires user privileges to install or update product offerings, or install license keys for your products.

- If you install Installation Manager as an administrator on Windows, all products installed from Installation
Manager must be run with the administrator privilege. In this case, you must run HCL OneTest™ Embedded as
an administrator.

« If you install Installation Manager as a non-administrator on Windows, HCL OneTest™ Embedded can be
installed with the same User account as the one used to install Installation Manager.

« You can enable users who are not the administrator so that they can work with HCL OneTest™ Embedded on
some versions of Windows. If you are in such a case:

> Do not install HCL OneTest™ Embedded into a package group (installation location) in the Program
Files directory (C:\Program Files\) and do not choose a shared resources directory in the Program
Files directory.

o If you are extending an existing Eclipse installation, then do not install Eclipse in the Program Files
directory (C:\Program Files\).

« On Linux, you must be able to log in as root (with sudo) to install and run HCL OneTest™ Embedded.
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» On Ubuntu, you must ensure that the environment variables that are set while installing the products are
retained when you open HCL OneTest™ Embedded and the application-under-test.

« HCL License Server must be installed on Windows™ at the same time or prior to HCL OneTest™ Embedded so
that the license information entered during HCL OneTest™ Embedded installation is valid. If you need to install
HCL License Server on Windows™ with a User account, right-click the | aunchpad. exe file, and click Run as

Administrator or install the HCL License Server separately with an Administrator account.

Installing software

Installing the product involves verifying requirements, planning, performing pre-installation tasks and managing

licenses.

Installation roadmap

The installation roadmap lists the high-level steps for installing your product.

Roadmap for installing HCL OneTest™ Embedded

Perform these tasks to install HCL OneTest™ Embedded:

1. Review the release notes on page 5.
2. Plan the installation.
a. Review hardware and software requirements on page 8.
b. Review user privilege requirements on page 20.
c. Plan for installation locations on page 30.
d. Plan for product coexistence on page 30.
e. Install with your instance of Eclipse on page 35.
3. Install the product with Installation Manager on page 31 or Installing stand-alone installer on page 25

4. Set up and manage product licenses on page 37.

Pre-installation Tasks

Before you install the product, you need to prepare or configure your computer.
Installing required libraries on Ubuntu

Before you install HCL OneTest™ Embedded on Ubuntu, you must install some libraries.
About this task

You must perform these procedures before installing HCL OneTest™ Embedded Studio or HCL OneTest™ Embedded
for Eclipse IDE.

Follow these procedures to download and install | i bXp. so. 6,1 i bssl.so. 6 and | i bcrypto. so. 6 libraries on
Ubuntu:
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1. Run the following commands to download the libraries:

wget -c
http://archive.ubuntu.com/ubuntu/pool/main/g/glibc/multiarch-support_2.27-3ubuntul.4_amd64.deb
wget -c  http://ftp.debian.org/debian/pool/main/Llibx/libxp/libxp6_1.0.2-2_amd64.deb

2. Run the following commands to install the | i bXp. so. 6 library:

sudo apt-get install ./multiarch-support_2.27-3ubuntul.4_amd64.deb ./libxp6_1.0.2-2_amd64.deb

3. Run the following commands to install | i bssl . so. 6 and | i bcrypt o. so. 6:

sudo apt-get install libssl-dev
sudo ln -s /1lib/x86_64-1linux-gnu/libcrypto.so0.1.0.0 /1lib/x86_64-linux-gnu/libcrypto.so.6
sudo 1n -s /1lib/x86_64-1inux-gnu/1libssl.s0.1.0.0 /1ib/x86_64-1inux-gnu/libssl.s0.6

Pre-installation tasks for Studio

Before you install your product, review the following information and ensure that all the pre-installation steps are

completed as required.

About this task
To help ensure a smooth installation process, complete these tasks before starting the installation tasks.

1. For HCL OneTest™ Embedded Studio support, you must first install Exuberant Ctags. See Installing Exuberant
Ctags on page 22 for more information.

2. Download and install Cygwin. See Installing Cygwin on page 23.

3. Ensure that your existing compilers and development environments are installed and run properly.

In particular, if you are using Microsoft™ Visual Studio, install and run it at least once before installing HCL
OneTest™ Embedded. See Support for Microsoft Visual Studio on page 23 for more information.

4. For UNIX™: If you want the product to be used by users other than root, then set the umask variable to 0022
before you install the product. To set this variable, log in as root user, start a terminal session, and type unesk
0022.

5. Install required libraries on Ubuntu. See Installing required libraries on Ubuntu on page 21.

Installing Exuberant Ctags

Before using HCL OneTest™ Embedded Studio on Windows™, you must ensure that Exuberant Ctags is installed on
your computer and that the directory containing Ctags binary files is set in the PATH environment variable.

To install Exuberant Ctags:

1. Go to the following website and download the latest package labeled Source and binary for Windows™: http://
ctags.sourceforge.net.
If the latest binary package is not available for download, go to the Download section and download the binary
package for the previous version of Ctags.

2. Extract thefileto C: \i nstal | ati on_di r ect or y\ HCL\ HCLOneTest \ Enbedded\ ct ags.

3. From the Start menu, select Parameters > Control Panel > System.
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4. Select the Advanced tab and click Environment variables.
5. Edit the PATH environment variable to add the C: \ i nstal | ati on_di r ect or y\ HCL\ HCLOneTest
\ Enbedded\ ct ags directory and click OK.

Installing Cygwin

Before using HCL OneTest™ Embedded Studio on Windows™, you must ensure that Cygwin is installed on your
computer and that the directory containing Cygwin binary files is set in the PATH environment variable.

To install Cygwin:

1. Go to the following website, on the Install Cygwin page and download the latest package for 32 or 64 bits
versions of Windows™: http://www.cygwin.com.

2. Run the setup program. Once the root install directory and local package are selected, select a download site.

3. Check MAKE box.

4. Then, select a packages to install. You must select gcc, gcc-core, gcc: GNU Compiler Collection (C) and (C++)
and GNU version of the make utility.
If you want to use the Cygwin gcc compiler, make sure that the Cygwin installation options include the

development tools category. If not, you can install a different gcc 3.2 compiler.
Update the PATH environment variable:

5. From the Start menu, select Parameters > Control Panel > System.

6. Select the Advanced tab and click Environment variables.

7. Edit the PATH environment variable to add the Cygwin installation directory, for example c: \ cygwi n\ bi n;
and click OK.

Support for Microsoft™ Visual Studio

If you plan to use HCL OneTest™ Embedded on Windows™ with Microsoft™ Visual Studio you must install Visual
Studio and execute it at least once before installing HCL OneTest™ Embedded in order to correctly initialize the

Windows™ registry database.
About this task

If you omitted to run Visual Studio before installing HCL OneTest™ Embedded, the installation produces an error
message. In this case, proceed with the installation and then execute the following steps.

To enable support of Microsoft™ Visual Studio after installation:

1. Run and close Visual Studio at least once.

2. Open a Windows™ Explorer and browse to the following directory:
C.\installation_directory\HCL\ HCLOneTest \ Enbedded\ t ar get s\ xm \

3. Double-click the cvi sual 6. xdp (for Visual 6.0) or cvi sual 7. xdp (for Visual .NET), or cvi sual 8. xdp (for
Visual 2005). This opens the Target Deployment Port (TDP) in the Target Deployment Port Editor.

4. Save the TDP to regenerate the TDP directory.
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Increasing the number of file handles on Linux™ workstations

For best product performance, increase the number of file handles above the default of 1024 handles.

About this task

! Important: Before you work with your product, increase the number of file handles. Most products use more
than the default limit of 1024 file handles per process. A system administrator might need to make this

change.

Exercise caution when using the following steps to increase your file descriptors on Linux™. If the instructions are not
followed correctly, the computer might not start correctly.

To increase your file descriptors:

1. Log in as root. If you do not have root access, you will need to obtain it before continuing.

2. Change to the / et ¢ directory

! Attention: If you decide to increase the number of file handles in the next step, do not leave an empty
initscript file on your computer. If you do so, your computer will not start up the next time that you turn

it on or restart.

3. Use the vi editor to edit the initscript file in the et ¢ directory. If this file does not exist, type vi initscript to
create it.
4. On thefirst line, type ulinit -n 4096. The point is that 4096 is significantly larger than 1024, the default on

most Linux™ computers.

! Important: Do not set the number of handles too high, because doing so can negatively impact

system-wide performance.

5. On the second line, type eval exec "$4".
6. Save and close the file after making sure you have completed steps 4 and 5.

Note: Ensure that you follow the steps correctly. If this procedure is not completed correctly, your
computer will not start.

7. Optional: Restrict the number of handles available to users or groups by modifying the limits.conf file in the
/ etc/ security directory. Both SUSE Linux™ Enterprise Server (SLES) Version 9 and Red Hat Enterprise
Linux™ Version 4.0 have this file by default. If you do not have this file, consider using a smaller number in step
4 in the previous procedure (for example, 2048). Do this so that most users have a reasonably low limit on
the number of open files that are allowed per process. If you use a relatively low number in step 4, it is less
important to do this. However, if you set a high number in step 4 earlier and you do not establish limits in the

limits.conf file, computer performance can be significantly reduced.
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The following sample limits.conf file restricts all users, and then sets different limits for others afterwards.

This sample assumes that you set handles to 8192 in step 4 earlier.

i soft nofile 1024
i hard nofile 2048
root soft nofile 4096
root hard nofile 8192

userl soft nofile 2048

userl hard nofile 2048

Note that the * in the preceding example sets the limits for all users first. These limits are lower than the limits
that follow. The root user has a higher number of allowable handles open, while number available to user1 is
between the two. Make sure that you read and understand the documentation contained in the limits.conf file
before making changes.

Installing stand-alone installer

About this task

The following pages explain how to install HCL OneTest Embedded by using InstallAnywhere installer on Windows

Installing the product on Windows

As an alternative to Installation Manager, you can install HCL OneTest™ Embedded on Windows with stand-alone
installer.

Before you begin

You must have performed these tasks:

« Uninstalled any older version of this product.
« Installed JRE from v8.0 to 11.0.

About this task

1. Download the installation file from the HCL License & Delivery portal HCL_OT_EMB_83_Install_IA_Win_64.zip
2. Righ-click the .exe file and select Run as Administrator.
Result
The installer is launched.
3. On the Introduction window, read through the details, and click Next.
4. Read the license agreement carefully, select the | accept check box and then click Next.

5. Browse the location or directory where you want to install the product and click Next.
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Note: You must select any other directory if the default directory is not empty.

6. Read through the installation details and click Install.
7. After the installation is complete, click Done.

Then, You must enter the license key when you launch the product.

Uninstalling the product on Windows

When you want to remove the product software on a Windows computer, use the uninstall option.

Before you begin
You must have completed the following tasks:

- Closed any open windows of the product.
« Closed any open web browsers.
« Closed all the other applications that are enabled by the product.

About this task

1. Open Windows explorer and goto <i nstal | ati on fol der>/ HCL/ Uni nstal | .
2. Launch Uni nst al | - HCL- OneTest - Enbedded. exe.
3. In the dialog box, follow the on-screen instructions.

Results

The product software is removed from your system.

Installing the product on Linux

As an alternative to Installation Manager, you can install HCL OneTest™ Embedded on Linux with InstallAnywhere

installer.

About this task

1. Download the product installer from the HCL License & Delivery portal :
HCL OneTest™ Embedded 8.3.1 (InstallAnywhere based) Install for Linux 64 bits:

HCL_OT_EMB 831_Install _I A LNX_64. zi p

. Log in as a root user and enter the unzip filename command to extract the .zip file.
. Execute the .bin file.
. On the Introduction screen, read through the details, and click Next.

. Read the license agreement carefully, select the 'l accept check' box and then click Next.

o g b~ WODN

. Browse the location or directory where you want to install the product and click Next.

The default installation directory is / opt / HCL.
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7. Read through the installation details and click Install.

8. When the installation is complete, click Done.

Results

You must enter the license key when you launch the product.

Uninstalling the product on Linux

When you want to remove the product software on Linux machine, use the uninstall option.

Before you begin
You must have completed the following tasks:

« Closed any open windows of the product.
* Closed any open web browsers.
« Closed all the other applications that are enabled by the product.

About this task

1. Log in as root user.

Note: If you are not a root user, uninstall the product by entering the following commands in the
terminal:
o <installation directory>/Uninstall
o sudo ./Uninstall-HCL-OneTest-Embedded

2. Click Applications > > Programming > Uninstall.
3. On the Uninstall screen, click Uninstall and follow the on-screen instructions.

Results

The product software is removed from your system.

Installing the product by using IBM® Installation Manager

In this section, you will learn how to install the product by using IBM® Installation Manager.

Planning the installation

After verifying hardware, software, and user privilege requirements, plan the features and software that you want to
install.

Planning features

You can customize your product by selecting which features to install.
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When you install the product package by using IBM® Installation Manager, the installation wizard displays the
features in the available product package. From the features list, you can select which to install. A default set of
features is selected for you (including any required features). Installation Manager automatically enforces any
dependencies between features and prevents you from clearing any required features.

0 Tip: After you finish installing the package, you can still add or remove features from your software product by
running the Modify Packages wizard in Installation Manager.

Planning compilers

During the installation process, the product scans your system for existing compilers. It is important that all
compilers and development environments that you plan to use with HCL OneTest™ Embedded are installed

beforehand.

Note: If you plan to use HCL OneTest™ Embedded on Windows™ with Microsoft™ Visual Studio, you must
install Visual Studio and run it at least once before installing HCL OneTest™ Embedded to correctly initialize

the Windows™ registry database. See Support for Microsoft Visual Studio on page 23

Installation conventions and terminology
Understanding these terms and conventions can help you take full advantage of the installation information and your
product.

The following conventions are used in this installation information:

The default installation directory is writtenas C: \ i nst al | ati on_di r ect or y\ HCL\ HCLOneTest \ Enbedded\ in
Windows andi nstal | ati on_di rect ory/ HCL/ HCLOneTest / Enbedded in UNIX.
These terms are used in the installation pages:
Installation directory
The location of product artifacts after the package is installed.
Package

An installable unit of a software product. Software product packages are separately installable units

that can operate independently from other packages of that software product.
Package group

A package group is a directory in which different product packages share resources with other
packages in the same group. When you install a package using Installation Manager, you can create a
new package group or install the packages into an existing package group. (Some packages cannot
share a package group, in which case the option to use an existing package group is unavailable.)
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Repository

A storage area where packages are available for download. A repository can be disc media, a folder on a
local hard disk, or a server or Web location.

Shared directory

In some instances, product packages can share resources. These resources are located in a directory
that the packages share.

UNIX™

Unless specified otherwise, in this document, the term UNIX™ refers to all UNIX-based operating

systems.

Installation Manager overview

IBM® Installation Manager is a program for installing, updating, and modifying packages. It helps you manage the
applications, or packages, that it installs on your computer. Installation Manager does more than install packages: It
helps you keep track of what you have installed, determine what is available for you to install, and organize installation
directories.

Installation Manager provides tools that help you keep packages up to date, modify packages, manage the licenses
for your packages, and uninstall packages.

Installation Manager includes six wizards that make it easy to maintain packages:

« The Install wizard walks you through the installation process. You can install a package by simply accepting
the defaults or you can modify the default settings to create a custom installation. Before you install, you get
a complete summary of your selections throughout the wizard. Using the wizard you can install one or more
packages at one time.

» The Update wizard searches for available updates to packages that you have installed. An update might be a
released fix, a new feature, or a new version of the product. Details of the contents of the update are provided
in the wizard. You can choose whether to apply an update.

« The Modify wizard helps you modify certain elements of a package that you have already installed. During
the first installation of the package, you select the features that you want to install. Later, if you require other
features, you can use the modify packages wizard to add them to your package. You can also remove features
and add or remove languages.

« The Roll Back wizard helps you to revert to a previous version of a package.

« The Uninstall wizard removes a package from your computer. You can uninstall more than one package at a
time.

Installation considerations

Part of planning entails making decisions about installation locations, working with other applications, extending

Eclipse, upgrading, migrating, and configuring help content.
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Installation locations

IBM® Installation Manager retrieves product packages from specified repositories and installs the products into

selected locations, referred to as package groups.
Package groups

During installation, you specify a package group into which to install a product.

« A package group represents a directory in which products share resources.

» When you install a product using the Installation Manager, you either create a package group or install the
product into an existing package group. A new package group is assigned a name automatically; however, you
choose the installation directory for the package group.

« After you create a package group you cannot change the installation directory. The installation directory
contains files and resources shared by the products installed into that package group.

- Product resources designed to be shared with other packages are installed in the shared resources directory.
Not all products can share a package group, in which case the option to use an existing package group will be
disabled.

» When you install multiple products at the same time, all products are installed into the same package group.

Note: When installing products from Windows™ operating system, if you create the package groups in the
Program Files directory (C: \ Pr ogr am Fi | es\ ), only users with Administrator privileges will be able to use
the product. If you do not want to require running your product as Administrator, complete one of these steps:

« For your product and any other programs that sharing the same installation location, select an
installation location that is not in the path c:\ Program Fi | es.

« For your product and all Software Delivery Platform product packages (regardless of their installation
location), select a shared resources directory and installation locations that are not in the path C:

\ Program Fi | es.

Shared resources directory

The shared resources directory is where product resources are installed so that they can be used by multiple product
package groups. You define the shared resources directory the first time that you install the first product package.
For best results, use your largest disk drive for shared resources directories. You cannot change the directory location
unless you uninstall all product packages.

Coexistence considerations

Some products are designed to coexist and share functions when they are installed in the same package group. A

package group is a location where you can install one or more software product packages.

When you install each product package, you select whether you want to install the product package into an existing

package group or whether you want to create a new package group. Installation Manager blocks products that are not
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designed to share or do not meet version compatibility and other requirements. If you want to install more than one

product at a time, the products must be able to share a package group.

Any number of eligible products can be installed to a package group. When a product is installed, the product
functions are shared with all of the other products in the package group. If you install a development product and a
testing product into one package group, when you start either of the products, you have both the development and
testing functions available to you in your user interface. If you add a product with modeling tools, all of the products in

the package group will have the development, testing, and modeling functionality available.

Installing multiple instances of the product
You can install multiple instances of HCL OneTest™ Embedded on a single system. However, you must be aware of

the following limitations:

« On Windows™, Start menu shortcuts will point to the last installed instance of the product. You can manually
create your own shortcuts to previously installed versions.

« The product requires that the environment variable TESTRTDIR is set to the product installation directory. This
will be set to the directory of the last installed instance of the product. Before running a different instance of

the product, you must change it manually to point to the directory of the version that you want to use.

Installing the product with Installation Manager

Use these instructions to install HCL OneTest™ Embedded.
About this task

To learn how to install the product from a command prompt in silent mode, see the Installing Silently section of the

Installation Manager Knowledge Center.

To install the new version of the product, you must first uninstall the previous version of the product and then install

the new one.

1. Review the Installation considerations on page 29, if you have not done so already.
2. Click a product package to highlight it.
Result
The description of the package is displayed in the Details pane at the bottom of the screen.

3. To search for updates to the product packages, click Check for Other Versions, Fixes, and Extensions. If
updates for a product package are found, then they are displayed in the Installation Packages list on the
Install Packages page below their corresponding products. Only recommended updates are displayed by
default.

Choose from:
- To view all updates that are found for the available packages, click Show all versions.
- To display a package description in the Details pane, click the package name. If additional information
about the package is available, such as a r eadne file or release notes, a More info link is included at
the end of the description text. Click the link to display the additional information in a browser. To fully

understand the package that you are installing, review all information.
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4. Select the product package and any updates to the package to install. Updates that have dependencies are

automatically selected and cleared together. Click Next to continue.

Note: If you install multiple packages at the same time, then all the packages are installed into the

same package group.

5. On the Licenses page, read the license agreement for the selected package. If you selected more than one
package to install, there might be a license agreement for each package. On the left side of the License page,
click each package version to display its license agreement. The package versions that you selected to install
(for example, the base package and an update) are listed under the package name.

a. If you agree to the terms of all of the license agreements, click | accept the terms of the license
agreements.
b. Click Next to continue.

6. On the Location page, type the path for the shared resources directory in the Shared Resources Directory field,

or accept the default path. The shared resources directory contains resources that can be shared by one or

more package groups. Click Next to continue.

The default path to use follows:
o IIITTTTM C: \ Pr ogr am Fi | es\ HCL\ HCLOneTest \ HCLI MShar ed
o / opt / HCL/ HCLOneTest / HCLI MShar ed

! Important: You can specify the shared resources directory only the first time that you install a
package. Use your largest disk for this to help ensure adequate space for the shared resources of

future packages. You cannot change the directory location unless you uninstall all packages.

7. On the Location page, create a package group to install the product package into or if this is an update, use
the existing package group. A package group represents a directory in which packages share resources with

other packages in the same group. To create a package group:
a. Click Create a new package group.

b. Type the path for the installation directory for the package group.

The name for the package group is created automatically.

The default path follows:
« IITTITEM C: \ Pr ogr am Fi | es\ HCL\ HCLOneTest
. / opt / HCL/ HCLOneTest

c. Click Next to continue.

8. On the Summary page, review your choices before installing the product package. To change the choices that
you made on previous pages, click Back, and make your changes. When you are satisfied with your installation
choices, click Install to install the package.

Result
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A progress indicator shows the percentage of the installation that is completed.
9. When the installation process is complete, a message confirms the completion of the process.
a. Click View log file to open the installation log file for the current session in a new window. You must
close the Installation Log window to continue.
b. In the Install Package wizard, select whether to start the product when you exit.
c. Click Finish to start installing the selected package.

10. License the product.

See the Setting up licensing on page 37 topic.

Updating software

You can search for product updates and install the updates for your product.

Before you begin
By default, Internet access is required unless your repository preferences points to a local update site.

Each installed package has the location embedded for its default update repository. For Installation Manager to
search the update repository locations for the installed packages, select the preference Search service repositories
during installation and updates on the Repositories preference page. This preference is selected by default. See the

Installation Manager help for more information.

See Migrating from previous versions on page 45 for information about updating your target deployment ports and

projects.

! Important:

» Close all programs that were installed using Installation Manager before updating.
« During the update process, Installation Manager might prompt you for the location of the repository
for the base version of the package. If you installed the product from CDs or other media, they must

be available when you use the update feature.

To find and install product package updates:

1. From the Start page of the Installation Manager, click Update.

2. If Installation Manager is not detected on your computer, continue with the installation of the latest release.
Follow the instructions in the wizard to complete the installation.

3. In the Update wizard, select the location of the package group where the product you want to update is
installed or select Update All, and then click Next.
Installation Manager searches for updates in its repositories and the predefined update sites for the product.

A progress indicator shows the search is taking place.
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4.

If updates for a package are found, then they are displayed in the Updates list on the Update Packages page
after the corresponding package. Only recommended updates are displayed by default. Click Show all to
display all updates found for the available packages.
a. To learn more about an update, click the update and review its description under Details.
b. If additional information about the update is available, a More info link is included at the end of the
description text. Click the link to display the information in a browser. Review this information before
installing the update.

. Select the updates that you want to install or click Select Recommended to restore the default selections.

Updates that have a dependency relationship are automatically selected and cleared together.

6. Click Next.

10.

11.
12.

. On the Licenses page, read the license agreements for the selected updates. On the left side of the License

page, the list of licenses for the updates you select is displayed

. Click each item to display the corresponding license agreement text.

a. If you agree to the terms of all the license agreements, click | accept the terms of the license
agreements.

b. Click Next to continue.

. On the Summary page, review your choices before installing the updates.

a. If you want to change the choices you made on previous pages, click Back, and make your changes.
b. When you are satisfied, click Update to download and install the updates. A progress indicator shows
the percentage of the installation completed.
Optional: When the update process is completed, a message that confirms the process is displayed near
the top of the page. Click View log file to open the log file for the current session in a new window. Close the
Installation Log window to continue.
Click Finish to close the wizard.
Optional: Only the features that you already have installed are updated using the Update wizard. If the update
contains new features that you want to install, run the Modify wizard, and select the new features to install
from the feature selection panel.

Uninstalling software

Use Installation Manager to uninstall your product. If no other products are installed, you can uninstall Installation

Manager also.

To uninstall your product from Windows™:

1. Start Installation Manager

2. Select the Uninstall wizard

3. Choose a package group and the package to uninstall, and follow the instructions on the wizard to complete

the uninstall process.
After uninstalling the product, some files are not removed, including any target deployment ports that you
might have modified after the installation. If you intend to reinstall the product later, you must delete the

Test Real Ti nme directory manually before reinstalling.
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To uninstall your product from Linux™ or UNIX™:

4. Open a terminal window, change directory to your installation directory (/ opt / HCL/
I nstal | ati onManager/ by default), and run /opt/HCL/InstallationManager/eclipse/HCLIM.

5. In Installation Manager, select the Uninstall wizard

6. Choose a package group and the package to uninstall, and follow the instructions on the wizard to complete
the uninstall process.

7. When the product is uninstalled, quit Installation Manager, change directory to / opt / HCL/ HCLOneTest /
Enbedded and run the following command to delete the remaining HCL/ HCLOneTest / Enbedded directory
cd/opt/HCL/HCLOneTest/Embedded && rm -rf.

Installing in Eclipse instance

The product package that you install using Installation Manager comes with a version of Eclipse, which is the base
platform of this product package. If you already have an Eclipse integrated development environment (IDE) installed
on your workstation, after installing the product, you can add your product package directly to that other Eclipse
installation and extend the functions of your Eclipse IDE by installing HCL OneTest™ Embedded from a local update

site.

Extending an Eclipse IDE adds the functions of the newly installed product, but maintains your IDE preferences and

settings. Previously installed plug-ins are also still available.

In most cases, your current Eclipse IDE must be the same version as the Eclipse that the product you are installing
uses. For more information about installing the product inside an existing Eclipse IDE, see the page 'Installing the

product from an update site'.

Installing the product from an update site

You can expand a third-party Eclipse-based IDE by installing HCL OneTest™ Embedded from an update site.

About this task
To integrate HCL OneTest™ Embedded for Eclipse IDE into a third-party Eclipse-based IDE such as Wind River
Workbench or Texas Instruments Code Composer Studio, you can install the plug-ins from a local Eclipse update site.

The update site is a folder installed with the product.

Note: Compatibility of HCL OneTest™ Embedded with third party workbench environments depends on the
availability of several extensions in those workbenches. Dependencies include Eclipse EMF, Eclipse GEF, and
Eclipse CDT.

To install the product from the local update site:

1. Proceed with a default Installation of the product in its own product group.
Result
A local update site is created alongside the product install.

2. Launch the third-party Eclipse workbench and click Help > Install New Software.
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3. Click Add, type a name for the update site, click Local and select the directory: <i nstal | ati on

di rect or y>\ HCL\ HCLOneTest \ Enbedded\ HCL One Test Enbedded Eclipse | DE update site\
4. Select all the features listed in the update site and click Next.
5. Approve the licensing agreement and click Next.

6. After installing the product, restart the workbench.

Verifying the installation

When the installation process is complete, a message confirms the success of the process. You can open the log file

to verify your installation of the product.

Before you begin
When the installation process is complete, a message confirms the success of the process.

To verify the installation:

1. Click View log file. The installation log file for the current session opens in a new window. To continue, close
the Installation Log window to continue.

2. In the Install Package wizard, select whether you want HCL OneTest™ Embedded to start when you exit.

3. Click Finish to launch the selected package. The Install Package wizard closes and you are returned to the

Start page of Installation Manager.

Starting HCL OneTest™ Embedded

You can start your product from the desktop environment or a command-line interface.
About this task

For Microsoft™ Windows™ operating systems:

* Click Start > Programs > > > to start HCL OneTest™ Embedded for Eclipse IDE.

« Click Start > Programs > > > to start HCL OneTest™ Embedded Studio for testing C, C++, Ada.

« To start HCL OneTest™ Embedded for Eclipse IDE from a command line, type this command:
<installation_directory>\eclipse.exe -product comibmrational.testrealtinme.product.ide.

* To start HCL OneTest™ Embedded Studio from a command line, type this command:

<installation_directory>\bin\intel\w n32\studio. exe

If the installation location or Shared Resources directory for your product is in a directory in the path C: \ Pr ogr am
Fi | es, you can run the product only as the administrator. To run as administrator, right-click the program shortcut,

and click Run as administrator.

Note: For Windows, the Pr ogr am Fi | es directory is usually virtualized in order to allow users who are not
running as the administrator to have write access to this protected directory. However, the virtualization

workaround is not compatible with your product. If you selected an installation location or shared resources
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Py directory in the path C: \ Progr am Fi | es\ and you do not want to require running your product as

Administrator, complete one of these steps:

« Reinstall your product and any other programs that sharing the same installation location, and select
an installation location that is not in the path C:\ Program Fi | es\ .

« Reinstall your product and all Software Delivery Platform product packages (regardless of their
installation location), and select a shared resources directory and installation locations that are not in

the path C: \ Program Fi | es\

For UNIX™ operating systems:

« To start HCL OneTest™ Embedded for Eclipse IDE from a sh or bash shell, type this command:
<installation_directory>/start_visualtest.sh
« To start HCL OneTest™ Embedded Studio from a sh or bash shell, type this command:

<installation_directory>/start_testrt.sh

Managing Licenses

Licensing for your HCL software is administered through HCL® License & Delivery portal. This portal is FlexNet-based

web application to manage software entitlements and licenses.

You must have ordered software. When a software order is placed and acknowledged, a software entitlement

is created. You can then create the devices and map the software entitlement with the devices. Every device is
associated to a server ID. This server ID is applied in the product. Multiple software entitlements can be created
based on your requirements. Follow the instructions in Software Order Acknowledgment document that you received

to activate your entitlement, create devices, and download the software from the Portal.

If you do not have access to the Internet, you can install and configure a local license server.
Setting up licensing

To start using a product, you must first set up licensing.

Before you begin

If you use a cloud license server, you must have:

- The ID of the server ID on cloud license server where your entitlements have been mapped.
« If the FlexNet cloud server https://hclsoftware.compliance.flexnetoperations.com is not the default one, you

need the URL of the cloud server you use

If you use a local license server, you need its URL.

About this task
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You must set up either a cloud license server or a local license server. It is done by setting some environment
variables according to the Operating System.

Set up a cloud license server:

Before starting the product, you must set up the following environment variable:

« HCL_LICENSING_ID: (mandatory): contains the server ID that was provided to you or copy the ID
from the HCL® License & Delivery portal.

« HCL_LICENSING_URL: (optional): contains the cloud server URL. If it is not set, it points to the
HCL cloud license.

When you launch the product, it connects to the HCL® License & Delivery portal to verify this server ID
and if there is a license available, it is checked out so that you can use the product. If the license is not

available, a message is displayed about it, in the console.

Note: If the license is not used for 15 minutes, the license is returned to the server for others to

consume it.

Set up a local license server

Sometimes, you might be working from a lab that does not have access to the Internet. In such cases,
you must install and set up a local license server behind your company's firewall. For more information
about installing and configuring the local license server, see the documentation of the local license
server on the same page from where you downloaded the product bits. As part of configuration, the

local license server must already have mapped your entitlements and therefore can serve your requests.

Before starting the product, you must be set the following environment variable:

« HCL_LICENSING_URL: (mandatory) must be set up to point to your local server.

Example: HCL_LI CENSI NG_URL=htt p://nyServer: portNunber.

HCL_LICENSING_ID environment variable must be undefined. If you enter a value, the local server will be
used as a cloud server, and the licenses do not apply.

Notes:

+ HCL OneTest™ Embedded (all versions) supports only the http protocol for local servers.

If you use the default local configuration file to setup a local server, configure your
environment variable with the 7070 port as follows:
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HCL_LICENSING_URL=http://myServer:7070

» The HCL® Local License Server is supported on 32 and 64-bit Windows, and Linux
platforms. You must install the server on a physical computer and not on a Virtual

Machine.

Setting environment variables

See “Set up cloud license server" or “Set up local license server" above to find the required variables and

values.

* Procedure on Windows:
> Open the System Properties window. Select the Advanced tab then click Environment variables.

> Under System variables, click New to add one of these environment variables:
» Procedure on Linux:

On some occasions, your computer might not be connected to the open Internet. For such cases, you can set up a

local proxy server that can be on cloud or local.

What to do next
You can now work with the product.

Configuring

Use these topics to configure the product.

Target Deployment Port Editor overview

The TDP Editor provides a user interface designed to help you customize and create Target Deployment Ports (TDP)

for any platform on which you want to run tests or programs.

The Target Deployment Port Editor user interface is made up of 4 main sections:

» Navigation: Use the navigation explorer view to select customization points.

« Help: This area provides direct reference information for the selected customization point.

« Edit: Use this area to edit the customization point. The form of the Edit window depends on the nature of the
customization point.

- Comment: Use this area to store comments or descriptions for each customization point.

In the Navigation view, you can click on any customization point to obtained detailed reference information for that

parameter in the Help area. Use this information to customize the TDP to suit your requirements.
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Target Deployment Port Editor overview

The TDP Editor provides a user interface designed to help you customize and create Target Deployment Ports (TDP)

for any platform on which you want to run tests or programs.

The Target Deployment Port Editor user interface is made up of 4 main sections:

« Navigation: Use the navigation explorer view to select customization points.

« Help: This area provides direct reference information for the selected customization point.

« Edit: Use this area to edit the customization point. The form of the Edit window depends on the nature of the
customization point.

- Comment: Use this area to store comments or descriptions for each customization point.

In the Navigation view, you can click on any customization point to obtained detailed reference information for that

parameter in the Help area. Use this information to customize the TDP to suit your requirements.

Opening the Target Deployment Port Editor

Target Deployment Ports (TDP) are stored as XDP files, which can be viewed and edited with the Target Deployment
Port Editor.

To open a TDP in the Target Deployment Port Editor:

1. From the Start menu, click > Target Deployment Port Editor, or from a shell or command window, type the
command: t dpedi t or .
2. Click File > Open
3. Inthet ar get s directory, select an XDP file and click Open.
4. Save your changes and reload the TDP in HCL OneTest™ Embedded:
Choose from:
> In HCL OneTest™ Embedded for Eclipse IDE, right-click the project and click Properties > C/C++ Build >
Settings > TDP Build, select another TDP and select the updated TDP again. Click OK.
o In HCL OneTest™ Embedded Studio, restart HCL OneTest™ Embedded Studio, click Project >
Configuration, select the TDP, click Remove. Click New, select the updated TDP again and click OK.

To open a TDP from HCL OneTest™ Embedded:

5. First you must have the Target Deployment Port view displayed in HCL OneTest™ Embedded. To open this
view, in the toolbar associated with the HCL OneTest™ Embedded perspective, click Window, and select Show
View > Other > HCL OneTest™ Embedded Target Deployment Port.

6. The Target Deployment Port view opens and displays the list of all the Target Deployment Ports that are

installed in HCL OneTest™ Embedded. Select a Target Deployment Port and click the 7 button to edit the
selected Target Deployment port.

From this view, you can also open the preferences panel and configure the Target Deployment Port search
path.
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Creating a TDP

This topic provides a typical example workflow for creating a new target deployment port (TDP) for a C compiler.

About

Creati

this task

ng a new TDP requires advanced familiarity with:

« HCL® OneTest™ Embedded and its underlying TDP technology.
« The target platform hardware and software architecture.

« The target development environment.

. In the Target Deployment Port Editor, at the top of the Navigation area, right-click the TDP name and type a

new name.

2. Specify all the Basic settings. Create intermediate keys to help with future changes and save the TDP.

w

N o o b

. In HCL OneTest™ Embedded Studio, open the add. r t p project which is located in exanpl es/ TDP/
tutorial . Thisis a simple project that can be used for debugging target deployment ports.

. Click Edit > Preferences > Project and select Verbose.

. Click Project > Configuration to create a new configuration, and select the new TDP. Click OK.

. Select the new configuration based on the new TDP.

. Click Settings > Build > Build Options > ... and remove all instrumentation. At this point any modifications
of the DEFAULT _xxxx in the Target Deployment Port Editor will be ignored in the project. Therefore, you must
duplicate or copy any changes in the Build > Build > Compiler/Link configuration settings.

8. In the project browser, right click add. ¢ and select Compile. Check that the object file is generated in the

correct directory. If any problems occurred, open the Target Deployment Port Editor and correct the problems
in Build Settings > Compilation function. Repeat this step until add. c is properly generated.

9. In the Build > Build options > ... settings, enable coverage instrumentation only and remove all files located in

the exanpl es/ TDP/ t ut ori al / xdp nane directory.

10. In the project browser, right click add. ¢ and select Compile. The instrumentation occurs after the

11.

preprocessing and before compilation. Check the . i file is generated properly in the correct directory and that
it contains #line xx "fileName" or # xx "fileNane". If any problems occurred, open the Target Deployment
Port Editor and correct the problems in Build Settings > Preprocessing function. Repeat this step until the . i
file is properly generated.

Check that add. o or add. obj is generated in the correct directory and not a file named add_aug. o or
add_aug. obj . If any problems occurred, open the Target Deployment Port Editor and correct the problems in

Build Settings > Compilation function. Repeat from step 9 until add. o or add. obj are properly generated.

12. In the project browser, right click TP.c and select Compile. Check that TP. o or TP. obj are generated in the

correct directory. If any problems occurred, open the Target Deployment Port Editor and correct the problems
in Library Settings. Repeat this step until TP. o or TP. obj are properly generated.
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13. Check that Test.exe is generated in the correct directory. If any problems occurred, open the Target
Deployment Port Editor and correct the problems in Build Settings > Link function. Repeat this step until

Test.exe is properly generated.

Note: Any files added in the TDP Editor Build settings are located in STARGETDIR/cmd by default.

Using the TDP Editor

The TDP Editor provides a user interface designed to help you customize and create unified Target Deployment Ports.
The TDP Editor is made up of 4 main sections:

- A Navigation Tree: Use the navigation tree on the left to select customization points.

« A Help Window: Provides direct reference information for the selected customization point.

« An Edit Window: The format of the Edit Window depends on the nature of the customization point.

« A Comment Window: Lets you to enter a personal comment for each customization point.

In the Navigation Tree, you can click on any customization point to obtained detailed reference information for that
parameter in the Help Window. Use this information to customize the TDP to suit your requirements.

Note The TDP Editor is not included with the trial version of the product.

To learn about See

Making changes to the TDP Editing customization points in a TDP on
page 42

Launching the TDP Editor Opening the Target Deployment Port Editor on
page 40

Creating a new TDP Creating a TDP on page 41

Applying changes made to a TDP Updating a Target Deployment Port on page 43

Changing the way a TDP is generated Using a Post-generation Script on page 44

Importing old TDPs from ATTOL Testware prod- Migrating from Pre-v2002 Target Deployment
ucts Ports on page 45

Editing customization points in a TDP

Use the Target Deployment Port Editor to adapt an existing Target Deployment Port (TDP) to a specific target

platform or development environment.

About this task
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Target Deployment Ports can be subdivided into four primary sections:

- Basic Settings: This section specifies default file extensions, default compilation and link flags, environment
variables and custom variables required for your target environment. This section allows you to set all the
common settings and variables used by HCL OneTest™ Embedded and the different sections of the TDP. For
example, the name and location of the cross compiler for your target is stored in a Basic Settings variable,
which is used throughout the compilation, preprocessing and link functions. If the compiler changes, you only
need to update this variable in the Basic Settings section.

Build Settings: This section configures the functions required by the HCL OneTest™ Embedded build process.
It defines compilation, link and execution Perl scripts, plus any user-defined scripts when needed. This section
is the core of the TDP, as it drives all the actions needed to compile and execute a piece of code on the target.
All files related to the Build settings are stored in the cnd subdirectory of the TDP folder.

Library Settings: This section describes a set of source code files and a dedicated customization file

(cust om h), which adapt the TDP to target platform requirements. This section is the most complex and
usually only requires customization for specialized platforms (unknown RTOS, no RTOS, unknown simulator,
emulator, etc.). These files are stored in the | i b subdirectory of the TDP folder.

Parser Settings: This section modifies the behavior of the parser in order to address non-standard compiler
extensions (for example: non-ANSI extensions). This section allows HCL OneTest™ Embedded to properly
parse your source code, either for instrumentation or code generation purposes. The resulting files are stored
in the ana subdirectory of the TDP folder.

1. In the Navigation view of the Target Deployment Port Editor, select the customization point that you want to
edit.
2. In the Help window, read the reference information pertaining to the selected customization point. Use this
information fill out the Edit window.
3. Type any remarks or comments in the Comments window.
4. Save your changes and reload the TDP in HCL OneTest™ Embedded:
Choose from:
> In HCL OneTest™ Embedded for Eclipse IDE, right-click the project and click Properties > C/C++ Build >
Settings > TDP Build, select another TDP and select the updated TDP again. Click OK.
o In HCL OneTest™ Embedded Studio, restart HCL OneTest™ Embedded Studio, click Project >
Configuration, select the TDP, click Remove. Click New, select the updated TDP again and click OK.

Updating a Target Deployment Port
Target Deployment Technology

The Target Deployment Port (TDP) settings are read or loaded when a HCL OneTest™ Embedded project is opened, or

when a new Configuration is used.

If you make any changes to the Basic Settings of a TDP with the TDP Editor, any project settings that are read from

the TDP will not be taken into account until the TDP has been reloaded in the project.

To reload the TDP in HCL OneTest™ Embedded:
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1. From the Project menu, select Configurations.
2. Select the TDP and click Remove.
3. Click New, select the TDP and click OK.

Related Topics

Editing customization points in a TDP on page 42 | Creating a TDP on page 41

Using a Post-generation Script
Target Deployment Technology

In some cases, it can be necessary to complete the generation of the TDP in the target directory by adding an

additional phase at the end of the generation.

To do this, the TDP editor runs a post-generation Perl script called postGen.pl, which can be launched automatically

at the end of the TDP directory generation process.

To use the postGen script:

1. In the TDP editor, right click on the Build Settings node and select Add child and Ascii File.

2. Name the new node postGen.pl.

3. Write a perl function performing the actions that you want to perform after the TDP directory is written by the
TDP Editor.

Example

Here is a possible template for the postGen.pl script file:

sub postGen

{

Sd=shift;

# the only parameter passed to this function is the path to the target directory
# here any action to be taken can be added

}

1

The parameter $d contains <tdp_dir>/<tdp_name>, where <tdp_dir> is a chosen location for the TDP directory (by
default, the targets subdirectory of the product installation directory), and <tdp_name> is the name of the current TDP

directory

Related Topics
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Creating a TDP on page 41

Migrating from v2001A Target Deployment Ports
Target Deployment Technology

This section describes the conversion of TDPs built for older versions (before v2002) of HCL OneTest™ Embedded to
the current, unified format.

This section applies to TDPs and ATTOL Target Packages created for:

« ATTOL Coverage, UniTest and SystemTest

* HCL OneTest™ Embedded v2001A

TDPs created for later versions of HCL OneTest™ Embedded or HCL OneTest™ Embedded are compatible with the

current version.

To migrate your old TDP to the current format:

1. In the TDP Editor, create a new Target Deployment Port based on the appropriate new template:
> use templatec.xdp for C and C++ TDPs

> use templatea.xdp for Ada TDPs

2. Item by item, recode or copy-paste information from your old TDP to the corresponding customization points

in the TDP Editor, using the information in this section of the Target Deployment Guide to direct you.

Related Topics

Updating a Target Deployment Port on page 43 | Migrating from previous versions on page 45

Migrating from previous versions

Test scripts and projects from previous versions of HCL OneTest™ Embedded continue to work with the HCL
OneTest™ Embedded Studio user interface and the command line tools. The current version of HCL OneTest™
Embedded Studio can open and run all assets that you created with previous versions of the product.

There is currently no direct migration path from HCL OneTest™ Embedded Studio projects and test scripts to the HCL
OneTest™ Embedded for Eclipse IDE.

See HCL OneTest™ Embedded Studio overview on page 257 for information about HCL OneTest™ Embedded.

Upgrading from a previous version

HCL OneTest™ Embedded uses Installation Manager for installing, updating, and uninstalling the product. If you are
upgrading from a version of the product prior to V8.3.1, you must first remove any previous version of the product.

See the uninstall instructions provided with the previous version.
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Target Deployment Ports

Target deployment ports must be updated to the latest version of the product. To do this, simply load them in the

Target Deployment Port Editor and save them again.

See Target Deployment Port Editor overview on page 39.

Integrating

Read these topics to learn how the product works when integrated with other products.

IBM® Rational® Quality Manager integration

IBM® Rational® Quality Manager is a business-driven software quality environment for people seeking a collaborative
and customizable solution for test planning, workflow control, tracking and metrics reporting capable of quantifying

how project decisions and deliverables impact and align with business objectives.

Rational® Quality Manager allows you to:

- Create Rational® Quality Manager test environments that are linked to HCL OneTest™ Embedded target
deployment ports

« Create Rational® Quality Manager test scripts that are linked to HCL OneTest™ Embedded test assets.

« Deploy and run HCL OneTest™ Embedded tests for the Rational® Quality Manager interface.

« View HTML reports in the Rational® Quality Manager interface.

Rational® Quality Manager uses the term test script to describe it's basic test assets. Rational® Quality Manager
test scripts are mapped to HCL OneTest™ Embedded test suites. A test suite contains multiple test harnesses that

are run sequentially to provide global results for a project.

To use Rational® Quality Manager with a computer that uses HCL OneTest™ Embedded for Eclipse IDE, the HCL
OneTest™ Embedded adapter service must be running on the computer.

With the adapter running, you can import test suites as Rational® Quality Manager test scripts, construct a new
Rational® Quality Manager test case based on those test suites, and run the tests from Rational® Quality Manager.
You can also view the results of the tests in Rational® Quality Manager as HTML reports.

Related information

Initializing the Rational Quality Manager adapter on page 46

Importing test suites into Rational Quality Manager on page 48

Initializing the Rational® Quality Manager adapter

To use Rational® Quality Manager with a computer that uses HCL OneTest™ Embedded for Eclipse IDE, the HCL
OneTest™ Embedded adapter service must be properly running and configured on the computer.
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Before you begin

You need administrator privilege to run Rational® Quality Manager adapter service on Windows and Linux.

As an RQM user, you must have write access to a valid RQM Public URL and project and the appropriate RQM CALs.
From HCL OneTest™ Embedded for Eclipse IDE V8.2.0, Rational® Quality Manager V6.0.5 is required.

To start the HCL OneTest™ Embedded for Eclipse IDE and Rational® Quality Manager adapter, follow these steps:

1. Run command prompt as an administrator user on Windows. On Linux open the command shell and enter
sudo to have root rights.

2. Start the Rational® Quality Manager adapter service with the following command, located in the
\ RQVAdapt er\ Test RTadapt er folder of the product installation directory:
Choose from:

> On Windows™, enter the following command: st art Test RTAdapt er . bat

C:\Program Files\HCL\HCLOneTest\Embedded\RQMAdapter\TestRTAdapter\"startTestRTAdapter.bat"

o On UNIX™, enter st art Test RTAdapt er . sh

sudo startTestRTadapter.sh

Note: The adapter requires access to a writable temporary directory. The %¥TEMP% variable is
used to access to the default directory. If the adapter encounters permission problems with
the default settings, add the following option to the command to specify a writable directory:

-tenpDir=tenp_directory. For example: start Test RTAdapt er. bat -tenpDir=C:\tenp.

3. If this is the first time you run the adapter, you must configure the adapter by typing the following information,

when prompted, in the command window:

a. Type the base URL of the Rational® Quality Manager server.
Example

For example: https://host nane: 9443/ j azz
b. Type your login and password for the Rational® Quality Manager account.
c. Type the Rational® Quality Manager project area name.

d. Type a name for the adapter, or press Return to use the default name.

Note: This step is not mandatory. If you don't enter any name, the default adapter name is

taken into account.

The adapter only asks these questions the first time it is run. If you need to change the server URL or login

information, run the adapter with the - reconfi gure option as follows:
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> On Windows, enter:

C:\Program Files\HCL\HCLOneTest\Embedded\RQMAdapter\TestRTAdapter\"startTestRTAdapter.bat"
-reconfigure

o On Linux, enter:

sudo startTestRTadapter.sh -reconfigure

Results
The Rational® Quality Manager adapter service starts.

Related information

IBM Rational Quality Manager integration on page 46

Importing test suites into Rational Quality Manager on page 48

Importing test suites into Rational® Quality Manager

The Rational® Quality Manager adapter for HCL OneTest™ Embedded enables you to import HCL OneTest™
Embedded test suites as Rational® Quality Manager test scripts.

To import a HCL OneTest™ Embeddedtest suite into Rational® Quality Manager:

. Login to Rational® Quality Manager and click Construction > Import test scripts.
. In Script type, select .
. Select Use test resources that are local to a test machine and click Select Adapter.

. Select the HCL OneTest™ Embedded adapter that you want to use and click Next.
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. In Project Path, specify the path to the workspace project where the HCL OneTest™ Embedded test suite is
located, and select Go.
The adapter parses all the subdirectories under the selected directory, therefore, if you specify a workspace
path, it will find all the test suites in that workspace.

6. Select one or several test suites to import, click Finish and Import.

What to do next

Once the test scripts are imported, construct a new test case in Rational® Quality Manager with the HCL OneTest™
Embedded test suites. After running the Rational® Quality Manager test case, click Close and Show results. You can
click the links in the Result Details section of Rational® Quality Manager to view the HTML reports.

Related information

IBM Rational Quality Manager integration on page 46

Initializing the Rational Quality Manager adapter on page 46
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Configuring the Jenkins environment for running test suites

HCL OneTest™ Embedded for Eclipse IDE has command line interface that facilitates the integration of Jenkins in
HCL OneTest™ Embedded.
About this task

First create a test suite in your project and add all the test harness that you want to execute.

To configure Jenkins:

1. On the Jenkins dashboard, click Configure.

2. Under Build, click Add build step where you want to insert your test execution.

3. Select Execute Windows batch command for Windows, or Execute shell for UNIX.

4. Setup your command as described here to execute your test suite: rtrteclipse -WORKSPACE= <your
workspace> <your test suite>.

For more details, see Running test suites from the command line on page 234.

Integrating HCL OneTest™ Embedded with other development tools

HCL OneTest™ Embedded Studio is a versatile tool that is designed to integrate with your existing development

environment.

To learn about See

Rational ClearCase integration Working with Rational ClearCase on
page 50

Rational ClearQuest integration Working with Rational ClearQuest on
page 51

Microsoft Visual Studio integration Configuring Microsoft Visual Studio on
page 55

Using third party configuration management soft- Working with Configuration Manage-

ware ment on page 49

Integrating Studio with configuration management

The GUI provides an interface that allows you to control your project files through a configuration management (CM)

system such as Rational® ClearCase® and submit software defect report to a Rational® ClearCase® system.

Note Before using any configuration management tool, you must first configure the CMS Preferences dialog box. See

Customizing Configuration Management.

You can also set up the GUI to use a CM system of your choice.
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To learn about See

Configuration management with Rational ClearCase Working with Rational ClearCase
on page 50

Reporting defects with Rational ClearQuest Working with Rational Clear-

Quest on page 51

Setting up the GUI to use a third-party configuration management Customizing source control tools
tool. on page 52

Related Topics

CMS Preferences on page 1046 | ClearQuest Preferences on page 1047 | Working with Other Development Tools on
page 49

Integrating Studio with IBM Rational ClearCase

Rational® ClearCase® is a configuration management system (CMS) tool providing version control, workspace
management, configuration process, and build management. With Rational® ClearCase®, your development team
gets a scalable, best-practices-based development process that simplifies change management - shortening your
development cycles, ensuring the accuracy of your releases, and delivering reliable builds and patches for your
previously shipped products.

By default, HCL OneTest™ Embedded offers configuration management support for Rational® ClearCase®. You can
however customize the product to support different configuration management software. When using Rational®

ClearCase®, you can instantly control your files from the product Tools menu.

Note: Before using ClearCase commands, select Rational® ClearCase® as your CMS tool in the CMS
Preferences. on page 1046
Source Control Commands.

For any file in the HCL OneTest™ Embedded project, Rational® ClearCase®, or any other CMS tool, can be accessed

through a set of source control commands.

Source control can be applied to all files and nodes in the Project Browser or Asset Browser. When a source control

command is applied to a project, group, application, test or results node, it affects all the files contained in that node.

The following source control commands are included to be used with Rational® ClearCase®:

» Add to Source Control
» Check Out

» Check In
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« Undo Check Out
» Compare to Previous Version
« Show History

« Show Properties

Refer to the documentation provided with Rational® ClearCase® for more information about these commands.
Source control commands are fully configurable from the Tools menu.

To control files from the Tools menu:

1. Select one or several files in the Project Explorer window.
2. From the Tools menu, select Rational® ClearCase® and the source control command that you want to apply.

To control files from the Source Control popup menu:

1. Right-click one or several files in the Project Explorer window.
2. From the popup menu, select Source Control and the source control command that you want to apply.

Related Topics

Working with Rational ClearQuest on page 51 | CMS Preferences on page 1046 | About the Tools Menu on

page 744 | Customizing source control tools on page 52

Integrating Studio with IBM Rational ClearQuest

IBM® Rational® ClearQuest® is a defect and change tracking tool designed to operate in a client/server environment.
It allows you to easily track defects and change requests, target your most important problems or enhancements to
your product. Rational® ClearQuest® helps you determine the quality of your application or component during each

phase of the development cycle and helps you track the release in which a feature, enhancement or bug fix appears.

By default, the product offers defect tracking support for Rational® ClearQuest®. When using ClearQuest with HCL

OneTest™ Embedded Studio you can directly submit a report from a test or runtime analysis report.

To submit a ClearQuest report from HCL OneTest™ Embedded Studio:

1. In the Report Explorer, right-click a test.

2. From the pop-up menu, select Submit ClearQuest Report.

3. This opens the ClearQuest Submit Defect window, with information about the Failed test.
4. Enter any other necessary useful information, and click OK.

For more information, see the Rational® ClearQuest® documentation.

Related Topics
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ClearQuest Preferences on page 1047

Customizing source control tools

Out of the box, the product offers configuration management support for Rational ClearCase on page 50, but the
product can be configured to use most other Configuration Management Software (CMS) that uses a vault and local
repository architecture and that offers a command line interface.

To configure the product to work with your version control software:

1. Add a new CMS tool to the Toolbox with the command lines for checking files into and out of the configuration
management software. This activates the Check In and Check Out commands in the Project Explorer on
page 1056 and the ClearCase Toolbar.

2. Set up version control repository in CMS Preferences.

Related Topics

Working with Rational ClearCase on page 50 | CMS Preferences on page 1046 | About the Tools Menu on
page 744

Working with IBM Rational Quality Manager

Integrating Studio with IBM Rational Quality Manager

Rational® Quality Manager is a business-driven software quality environment for people seeking a collaborative and
customizable solution for test planning, workflow control, tracking and metrics reporting capable of quantifying how

project decisions and deliverable impact and align with business objectives.

HCL OneTest™ Embedded Studio integration with Rational Quality Manager enables you to:

« Create Rational Quality Manager test environments that are linked to HCL OneTest™ Embedded target

deployment ports

« Create Rational Quality Manager test scripts that are linked to HCL OneTest™ Embedded Studio projects and
tests or application nodes

« Deploy and run HCL OneTest™ Embedded Studio tests for the Rational Quality Manager interface

» View HTML reports in the Rational Quality Manager interface

To learn about See

Enabling a computer with HCL OneTest™ Embedded to be used by Running the Rational Quality Manager
Rational Quality Manager for running tests adapter on page 53
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Creating Rational Quelity Manager test scripts with HCL OneTest™ Importing a HCL OneTest™ Embedded
Embedded projects project on page 54

Running tests with different Target Deployment Ports. Using Target Deployment Ports with Rational
Quality Manager on page 54

Running the Rational Quality Manager adapter
To use Rational Quality Manager with a computer that uses HCL OneTest™ Embedded Studio, the HCL OneTest™
Embedded adapter must be running on the computer.

Before running the adapter, ensure that both the PATH and JAVA_HOME environment variables are properly set to the

correct location of a Java Runtime Environment (JRE) version 1.5 or later.
When you run the adapter for the first time, you are asked to type configuration information in the console window.

To run the HCL OneTest™ Embedded adapter for Rational Quality Manager:

1. Open a command line window and navigate to the run the adapter command line:
<installation directory>\RQMAdapter\TestRTadapter\

2. Run the adapter command:

> On Windows, type startTestRTAdapter.bat, or from the Start menu, select > Tools > Start > Adapter
for Rational Quality Manager.

> On UNIX, enter the following command:
startTestRTAdapter.sh

3. If you run the adapter for the first time, enter the following information in the command window:
- Server URL: Enter the URL of the Rational® Quality Manager server.
> Login: Enter the login used to connect to Rational® Quality Manager.
> Password: Enter your password.
- Project Area (Optional): Enter the name of project area, if necessary.

- Enter adapter name: Enter the name of the HCL OneTest™ Embedded adapter on the current computer
as it will appear in Rational® Quality Manager. By default the name is TestRT on <hostname> .

The adapter only asks these questions the first time it is run. If you need to change this server URL and login

information, run the adapter with the -reconfigure option.

startTestRTAdapter.bat -reconfigure
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Related Topics

Importing a HCL OneTest™ Embedded project on page 54 | Associating Target Deployment Ports with test

environments on page 54

Importing a HCL OneTest™ Embedded project into Rational Quality Manager
IBM Rational Quality Manager integration

Rational Quality Manager uses the term test script to describe it's basic test assets. TheHCL OneTest™ Embedded
adapter for Rational Quality Manager enables you to import HCL OneTest™ Embedded projects as Rational Quality
Manager test scripts.

When you select the HCL OneTest™ Embedded adapter, theHCL OneTest™ Embedded project will be run with the
default Target Deployment Port selected in the project.

To import a HCL OneTest™ Embedded project into Rational Quality Manager:

. Log in to Rational Quality Manager, clickConstruction > Import test script.

. InScript type, select HCL OneTest™ Embedded.

. Select Use test resources that are local to a test machine and click click Select Adapter.
. Select the HCL OneTest™ Embedded adapter that you want to use.
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. In Project Path, specify the directory where the HCL OneTest™ Embedded .rtp project file is located, and select
Go. The adapter will parse all the sub-directories under the selected directory.

6. Select one or several .rtp project files, click OK, and then click Import.

Once the test scripts are imported, construct a new test case with the HCL OneTest™ Embedded test scripts. After

execution, click Close and show results. You can click the links in the Result Details section to view the HTML reports.
Related Topics

Running the Rational Quality Manager adapter on page 53 | Associating Target Deployment Ports with test

environments on page 54

Associating Target Deployment Ports with test environments
IBM Rational Quality Manager integration

When you select the HCL OneTest™ Embedded adapter in Rational Quality Manager, by default, the HCL OneTest™
Embedded project will be run with the Target Deployment Port (TDP) that is selected in the project. To run the same
project with different TDPs, you can create different test environments in Rational Quality Manager.

To create a test execution record with a specific TDP:
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1. Log in to Rational Quality Manager, clickLab Management > Create Test Environment.

2. Type a name for the test environment that applies to the name of the HCL OneTest™ Embedded configuration.
The name must be exactly the same as the Configuration name in HCL OneTest™ Embedded, for example: C
Win32 - GNU.

. Click Save.

. Click Construction > Create Test Execution Record and enter a name for the new test execution record.

. Select the Test Case and the Default Test Script.

. In Available Test Environments, select the test environment with the name of the TDP that you want to use.

. ClickSave.

N o o AW

Related Topics

Running the Rational Quality Manager adapter on page 53 | Associating Target Deployment Ports with test

environments on page 54

Integrating Studio with Microsoft Visual Studio

HCL OneTest™ Embedded provides a special setup tool to configure runtime analysis tools with Microsoft Visual
Studio 6.0.

Note Integration with Microsoft Visual Studio is only available with the Windows version of HCL OneTest™ Embedded
Studio.

Installation
Both HCL OneTest™ Embedded and Microsoft Visual Studio must be installed on the same machine.

To install the Microsoft Visual Studio 6.0 plug-in:

1. From the Windows Start menu, select Programs HCL® Software > HCL OneTest™ Embedded Software HCL
OneTest™ Embedded, Tools and HCL OneTest™ EmbeddedPlug-in for Microsoft Visual Studio Install to add the

new menu items to Microsoft Visual Studio
To uninstall the plug-in:

1. From the Windows Start menu, select Programs > HCL OneTest™ Embedded Software > HCL OneTest™
Embedded Software, HCL OneTest™ Embedded, Tools andHCL OneTest™ Embedded Plug-in for Microsoft

Visual Studio Uninstall to remove the plug-in from Microsoft Visual Studio.
To install the Microsoft Visual Studio .NET plug-in:

1. From the Windows Start menu, select All Programs > HCL OneTest™ Embedded Software > HCL OneTest™
Embedded > Tools > TDP Editor.

2. In the TDP Editor, select File > Open and open cvisual7.xdp located in the <install_directory>/ targets/xml

directory.
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3. Under Basic Settings > For All, set the INSTALL_PLUGIN key to TRUE.

4. Save cvisual7.xdp and close the TDP Editor.
To uninstall the plug-in:

1. From the Windows Start menu, select All Programs > HCL OneTest™ Embedded Software > HCL OneTest™
Embedded > Tools > TDP Editor.

2. In the TDP Editor, select File > Open and open cvisual7.xdp located in the <install_directory>/ targets/xml

directory.
3. Under Basic Settings > For All, set the INSTALL_PLUGIN key to FALSE.

4. Save cvisual7.xdp and close the TDP Editor.

Configuration

The HCL OneTest™ Embedded setup for Microsoft Visual Studio tool allows you to set up and activate coverage types
and instrumentation options for HCL OneTest™ Embedded Studio runtime analysis features, without leaving Microsoft
Visual Studio.

To run the product Setup for Microsoft Visual Studio:

In Microsoft Visual Studio, two new items are added to the Tools menu:

« HCL OneTest™ Embedded Viewer:this launches the Studio user interface, providing access to reports

generated by HCL OneTest™ Embedded runtime analysis and test features.
* HCL OneTest™ Embedded Options:this launches the Setup for Microsoft Visual Studio tool.
The following commands are available:

« Apply:Applies the changes made
» OK:Apply the choices made and leave the window
 Enable or Disable: Enable or Disable the runtime analysis tools

» Cancel:Cancels modifications

Code Coverage Instrumentation Options

See About Code Coverage on page 72 and the sections about coverage types.
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« Function instrumentation:
. > SelectNoneto disable instrumentation of function inputs, outputs and termination instructions.
> SelectFunctionsto instrument function inputs only.

> SelectExitsto instrument function inputs, outputs and termination instructions.

« Function calls instrumentation (C only):
. o SelectNoneto disable function call instrumentation.

o SelectCallsto enable function call instrumentation.

* Block instrumentation
. o SelectNoneto disable block instrumentation.
o SelectStatement Blocksto instrument simple blocks only.
o Selectlmplicit Blocksto instrument simple and implicit blocks.

> SelectLoopsto instrument implicit blocks and loops.

- Condition instrumentation (C only)

. o SelectNoneto disable condition instrumentation
- SelectBasicto instrument basic conditions
- SelectModified/Multipleto instrument multiple

> SelectForcedto instrument forced multiple conditions

» No Ternaries Code Coverage:when this option is selected, simple blocks corresponding for the ternary
expression true and false branches are not instrumented

« Instrumentation Mode:see Information Modes on page 339 for more information.
. - Pass mode:allows you to distinguish covered branches from those not covered.

> Count mode:The number of times each branch is executed is displayed in addition to the pass mode

information in the coverage report.

- Compact mode:The compact mode is similar to the Pass mode. But each branch is stored in one bit

instead of one byte to reduce overhead.
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Other Options

« Dump:this specifies the dump mode:
. > SelectNoneto dump on exit of the application
> SelectCallingto dump on call of the specified function
o Selectincomingto dump when entering the specified function
> SelectReturningto dump when exiting from the specified function
- Static Files Directory:allows you to specify where the.fdcand.tsffiles are to be generated
 Runtime Tracing:this option activates the Runtime Tracing runtime analysis feature
« Memory Profiling:this option activates the Memory Profiling runtime analysis feature
- Performance Profiling:this option activates the Performance Profiling runtime analysis feature

- Other:allows you to specify additional command-line options that are not available using the buttons. See the

Reference help for a complete list of Instrumentor options.

Related Topics

Using Runtime Analysis Features on page 336 | Importing Files from a Microsoft Visual Studio Project file on

page 721 | |Working with Rational ClearQuest on page 51 | Working with Rational ClearCase on page 50

Integrating HCL OneTest™ Embedded Studio with Microsoft Visual Studio

Integration with Microsoft Visual Studio is only available for the Windows versions of HCL OneTest™ Embedded
Studio.

HCL OneTest™ Embedded Studio and Microsoft Visual Studio 6.0 must be installed on the same machine.

« To enable the integration with Visual Studio, from the Windows Start menu, select Programs > HCL OneTest™
Embedded, Tools > HCL OneTest™ Embedded Plug-in for Microsoft Visual Studio 6.0 Install to add the new

menu items to Microsoft Visual Studio.

« To disable the integration with Visual Studio, from the Windows Start menu, select Programs >HCL OneTest™
Embedded, Tools > HCL OneTest™ Embedded Plug-in for Microsoft Visual Studio 6.0 Uninstall to add the
new menu items to Microsoft Visual Studio.

Related Topics

Configuring Microsoft Visual Studio Integration on page 55 | Importing Files from a Microsoft Visual Studio Project

file on page 721
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Integrating Studio with Microsoft Visual Studio

HCL OneTest™ Embedded provides a special setup tool to configure runtime analysis tools with Microsoft Visual
Studio 6.0.

Note Integration with Microsoft Visual Studio is only available with the Windows version of HCL OneTest™ Embedded
Studio.

Installation
Both HCL OneTest™ Embedded and Microsoft Visual Studio must be installed on the same machine.

To install the Microsoft Visual Studio 6.0 plug-in:

1. From the Windows Start menu, select Programs HCL® Software > HCL OneTest™ Embedded Software HCL
OneTest™ Embedded, Tools and HCL OneTest™ EmbeddedPlug-in for Microsoft Visual Studio Install to add the

new menu items to Microsoft Visual Studio
To uninstall the plug-in:

1. From the Windows Start menu, select Programs > HCL OneTest™ Embedded Software > HCL OneTest™
Embedded Software, HCL OneTest™ Embedded, Tools andHCL OneTest™ Embedded Plug-in for Microsoft

Visual Studio Uninstall to remove the plug-in from Microsoft Visual Studio.
To install the Microsoft Visual Studio .NET plug-in:

1. From the Windows Start menu, select All Programs > HCL OneTest™ Embedded Software > HCL OneTest™
Embedded > Tools > TDP Editor.

2. In the TDP Editor, select File > Open and open cvisual7.xdp located in the <install_directory>/ targets/xml

directory.
3. Under Basic Settings > For All, set the INSTALL_PLUGIN key to TRUE.

4. Save cvisual7.xdp and close the TDP Editor.
To uninstall the plug-in:

1. From the Windows Start menu, select All Programs > HCL OneTest™ Embedded Software > HCL OneTest™
Embedded > Tools > TDP Editor.

2. In the TDP Editor, select File > Open and open cvisual7.xdp located in the <install_directory>/ targets/xml

directory.
3. Under Basic Settings > For All, set the INSTALL_PLUGIN key to FALSE.

4. Save cvisual7.xdp and close the TDP Editor.
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Configuration

The HCL OneTest™ Embedded setup for Microsoft Visual Studio tool allows you to set up and activate coverage types
and instrumentation options for HCL OneTest™ Embedded Studio runtime analysis features, without leaving Microsoft
Visual Studio.

To run the product Setup for Microsoft Visual Studio:

In Microsoft Visual Studio, two new items are added to the Tools menu:

» HCL OneTest™ Embedded Viewer:this launches the Studio user interface, providing access to reports

generated by HCL OneTest™ Embedded runtime analysis and test features.

« HCL OneTest™ Embedded Options:this launches the Setup for Microsoft Visual Studio tool.
The following commands are available:

« Apply:Applies the changes made
» OK:Apply the choices made and leave the window
- Enable or Disable: Enable or Disable the runtime analysis tools

» Cancel:Cancels modifications

Code Coverage Instrumentation Options

See About Code Coverage on page 72 and the sections about coverage types.

* Function instrumentation:
. > SelectNoneto disable instrumentation of function inputs, outputs and termination instructions.
- SelectFunctionsto instrument function inputs only.

> SelectExitsto instrument function inputs, outputs and termination instructions.

« Function calls instrumentation (C only):
. > SelectNoneto disable function call instrumentation.

o SelectCallsto enable function call instrumentation.

 Block instrumentation
. > SelectNoneto disable block instrumentation.

o SelectStatement Blocksto instrument simple blocks only.
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o Selectlmplicit Blocksto instrument simple and implicit blocks.

> SelectLoopsto instrument implicit blocks and loops.

- Condition instrumentation (C only)

. > SelectNoneto disable condition instrumentation
- SelectBasicto instrument basic conditions
o SelectModified/Multipleto instrument multiple

> SelectForcedto instrument forced multiple conditions

- No Ternaries Code Coverage:when this option is selected, simple blocks corresponding for the ternary

expression true and false branches are not instrumented
« Instrumentation Mode:see Information Modes on page 339 for more information.
. - Pass mode:allows you to distinguish covered branches from those not covered.

- Count mode:The number of times each branch is executed is displayed in addition to the pass mode

information in the coverage report.

o Compact mode:The compact mode is similar to the Pass mode. But each branch is stored in one bit

instead of one byte to reduce overhead.
Other Options

« Dump:this specifies the dump mode:
. o SelectNoneto dump on exit of the application
> SelectCallingto dump on call of the specified function
> Selectincomingto dump when entering the specified function
- SelectReturningto dump when exiting from the specified function
- Static Files Directory:allows you to specify where the.fdcand.tsffiles are to be generated
- Runtime Tracing:this option activates the Runtime Tracing runtime analysis feature
- Memory Profiling:this option activates the Memory Profiling runtime analysis feature
- Performance Profiling:this option activates the Performance Profiling runtime analysis feature

« Other:allows you to specify additional command-line options that are not available using the buttons. See the

Reference help for a complete list of Instrumentor options.
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Related Topics

Using Runtime Analysis Features on page 336 | Importing Files from a Microsoft Visual Studio Project file on

page 721 | |[Working with Rational ClearQuest on page 51 | Working with Rational ClearCase on page 50
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This guide describes tasks that you can perform to test application code in HCL OneTest™ Embedded for Eclipse IDE.
This guide is intended for testers or test execution specialists.

Testing with HCL OneTest™ Embedded for Eclipse IDE

Read these topics to learn how to use the product.

Getting started with HCL OneTest™ Embedded for Eclipse IDE

HCL OneTest™ Embedded for Eclipse IDE is designed to integrate into your existing Eclipse-based tool chain. Use this

section as a guide to a typical workflow for testing and evaluating your C source code in the Eclipse CDT environment.
Before you begin

These guidelines assume that you have some familiarity with the following concepts and tools:

* The Eclipse CDT development environment.
« The features and tools provided by HCL OneTest™ Embedded.
« The target platform on which you plan to run the tests.

About this task

It is important to understand the concepts and assets used by the product.

To start using HCL OneTest™ Embedded:

1. Familiarize yourself with the features and tools provided by the product. See Overview on page 14 and Test
assets overview on page 210.
2. Choose whether you are going to create a new project or import an existing CDT project.
Choose from:
- If you already have an Eclipse CDT project, import the project into HCL OneTest™ Embedded for
Eclipse IDE and convert it into a HCL OneTest™ Embedded project. See Importing C projects on
page 64.
- If you are starting a new C project or if want to import an unmanaged C project into Eclipse, create
anew HCL OneTest™ Embedded project and import the source files. See Creating test projects on
page 212.

Note: There is currently no migration path from HCL OneTest™ Embedded Studio test scripts and
command line tools into the HCL OneTest™ Embedded for Eclipse IDE environment.

3. Verify that the C source files build and run correctly.
Resolve any compilation errors if necessary.
4. Open the call graph to view the structure of your source code and create a new test harness. See Creating test

harnesses from the call graph on page 226.
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The generated test harness contains a test case, and optionally a stub behavior.

5. Open the test case and edit the initial and expected expressions for the each variable check. See Editing test
cases on page 216.

6. Run the test harness and compare the obtained values with the expected values for each variable in the test
case editor. See Running a test harness on page 232.
If necessary, repeat from step 4 to ensure that you obtain a passed test result.

7. Generate a test report from the results. See Generating test reports on page 957.

8. Deploy and run your test on the target platform by changing the test configuration and running the test again.

See Switching test configurations on page 231.

What to do next
Once your test harness is running correctly, you can use more of the features of the product:

- Measure code coverage, memory profiling, performance profiling, and static metrics with the runtime analysis
tools. See Runtime analysis overview on page 65.

« Include test data sets from data pools and create data dictionary to reuse data sets. See Creating data pools
on page 223 and Data dictionary overview on page 222.

« Create more test harnesses or add test cases and stubs to existing test harnesses.

« Create test suites to run multiple test harnesses and compare their results. See Creating test suites on
page 228.

« Integrate test suites into IBM® Rational® Quality Manager. See IBM Rational Quality Manager integration on
page 46.

Importing C projects

You can either create a new C project with the Eclipse CDT tools or you can import your existing C source files or
Eclipse projects into your HCL OneTest™ Embedded workspace.

About this task
HCL OneTest™ Embedded can only work with its own CDT managed build toolchain. Therefore, imported projects

must be converted to HCL OneTest™ Embedded projects.

To import an existing C project:

. Click File > Import > General > Existing projects into workspace.

. Follow the wizard to import the project into the workspace.

. After importing, right-click the project and select Convert to HCL OneTest™ Embedded Project.
. Select the default target deployment port (TDP) for the project and click Finish.
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. If you have not already enabled CDT indexing, click Window > Preferences > C/C++ > Indexer, select Index
unused headers and click OK.

Results
After conversion, the toolchain of the project is configured to use HCL OneTest™ Embedded instead of the default
toolchain. If necessary, you can temporarily switch to the original toolchain in the project properties. However, you
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must switch back to the HCL OneTest™ Embedded toolchain to use HCL OneTest™ Embedded runtime analysis and

component testing tools.

0 Tip: You can edit the CDT managed build toolchain to use environment variables with the UNIX notation $$.

This can be useful when you are sharing projects with other users.

Related information

Importing HCL OneTest Embedded examples on page 65
Creating test projects on page 212

Target deployment port overview on page 17

Importing HCL OneTest™ Embedded examples
HCL OneTest™ Embedded is provided with several sample projects to help you get started.

To import the sample projects:

1. In the C/C++ perspective, click File > Import > General > Existing projects into workspace and click Next.

2. Click Select root directory, Browse, and choose a project folder in the following directory: <pr oduct
installation directory>/exanpl eskcli pse/.

3. Click Select All and select Copy projects into workspace.

4. Click Finish.

Related information
Importing C projects on page 64
Creating test projects on page 212

Target deployment port overview on page 17

Analyzing source code

Runtime analysis overview

The runtime analysis tools are designed to closely monitor the behavior of your application for debugging and
validation purposes. These features use source code insertion to instrument the source code providing dynamic
analysis of the application while it is running, either on a native or embedded target platform.

The following tools are available:

« Code coverage performs code coverage analysis.

- Memory profiling analyzes memory usage and detects memory leaks.
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- Performance profiling provides metrics on execution time for each procedure/function/method of the
application. For C language, it also provides an estimation of WCET.

« Control Coupling provides coverage information on Control Coupling that represent the interactions between
modules (C language only).

- Data Coupling provides coverage information on def/use pairs identified in the application (C language only).

 Worst Stack Size computes an estimation of the maximum of the application stack size (C language only).

 Runtime tracing draws a real-time UML sequence diagram of your application.

Each of these runtime analysis tools can be used alone or together with the component testing features. When the
source code is run with any of the runtime analysis tools engaged, either alone or in a component test, the source
code is instrumented. The resulting instrumented code is then executed and the result is dynamically displayed in the
corresponding reports.

Note: Instrumentation of the source code generates a certain amount of overhead, which can impact
application size and performance.

Runtime analysis tools can analyze source code that complies with ANSI 89, ANSI 99, C99, and K&R C specifications.

Code coverage

Source code coverage consists of identifying which portions of a program are executed or not during a given test
case. Source code coverage is recognized as one of the most effective ways of assessing the efficiency of the test
cases applied to a software application.

The code coverage tool can provide the coverage information for the following source code elements:

« Statement blocks, decisions, and loops.

« Function or procedure calls.

« Basic conditions, modified conditions/decisions (MC/DC), multiple condition, and forced condition.
« Procedure entries and exits.

» Terminal or potentially terminal statements

« Statements that can't be covered in C.
For more information, see Code review overview on page 109.

Memory profiling

Runtime memory errors and leaks are among the most difficult errors to locate and the most important to correct.
The symptoms of incorrect memory use are unpredictable and typically appear far from the cause of the error. The
errors often remain undetected until triggered by a random event, so that a program can seem to work correctly when

in fact it's only working by accident. Memory profiling helps you detect HEAP memory allocation problems and leaks.
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After execution of an instrumented application, the Memory Profiling report provides a summary diagram and a
detailed report for both byte and HEAP memory block usage. The summary diagrams give you a quick overview of
HEAP memory usage in blocks and bytes, including:

« The total HEAP memory allocated during the execution of the application.
- The HEAP memory that remains allocated after the application was terminated.

« The maximum HEAP memory usage encountered during execution

The detailed section of the report lists memory usage events identified as errors or warnings.

For more information, see Memory profiling overview on page 87.

® Restriction: With HCL OneTest™ Embedded for Eclipse IDE, static and stack memory are not checked, only
dynamically allocated memory is checked.

Performance profiling

The performance profiling tool provides performance data for each software component so that you can locate the
performance bottlenecks. With this information, you can concentrate your optimization efforts on those portions of

code, which can lead to significant improvements in performance.

The Performance Profiling report provides function profiling data for your program and its components so that you
can see exactly where your program spends most of its time. A Top Functions graph provides a high level view of the
largest time consuming functions in your application. The Performance Summary section of the report indicates, for
each instrumented function, procedure, or method (collectively referred to as functions), the number of calls and the
time spent in the function and in its descendants. And for C language, it provides the Worst Case Estimation Time.

For more information, see Performance Profiling Results on page 96.

Runtime tracing

Runtime Tracing is a tool for monitoring real-time dynamic interaction analysis of your source code by generating
trace data, which is dynamically turned into a UML sequence diagram. The diagram displays a lifeline of the

interactions of the source code components. For more information, see Runtime tracing overview on page 102.

Control Coupling

HCL OneTest™ Embedded introduces a new coverage level called “Control Coupling” for C language that consists in
verifying that all the interactions between modules have been covered by at least one test. This new coverage level is

implemented in HCL OneTest™ Embedded as follows:

« Modules on C language and compilation units (example: C files that are independently compiled).
« Interactions are calls between 2 functions that are in 2 different compilation units.
- Control Coupling is not a simple interaction. It is a control flow in the calling module that ends with an

interaction with another module.
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For more information, see Control Coupling overview on page 182.

Data Coupling

HCL OneTest™ Embedded introduces a new coverage level called “Data Coupling" for C language that consists to
verify that all the global variables of the application under test has been consumed in read (also called use) and write
(also called def) during the tests, as following:

- For each global variable, HCL OneTest™ Embedded identifies the def and use. Then it considers all the
possible def/use pair as a data coupling.
« To cover a Data Coupling, i.e. a def/use pair, it should exist at least one test that has executed this def and this

use.
For more information, see Data Coupling on page 192.

Worst Stack Size
Static analysis and Dynamic analysis are used to provide an estimation of the worst stack size.

For more information, see Worst Stack Size overview on page 199.

Enable runtime analysis tools

When the source code is run with any of the runtime analysis tools enabled, either alone or in a component test, the

source code is instrumented and the results are displayed in a report.

Before you begin
Before running a test with any of the runtime analysis tools enabled, ensure that the correct Target Deployment Port
(TDP) is selected.

To enable runtime analysis tools on your source code:

1. In the project explorer, right-click the project on which you want to enable the runtime analysis tools and click
Properties.
2. Click C/C++ Build > Settings and select the Build TDP page to check that the correct TDP is selected.
If necessary, click the Target Deployment Port value to change the TDP.
3. Select the Build Instrument page and select Settings > General > Selective instrumentation.
4. Select the Build Options line and click Edit.
5. In the Build Options window, select the runtime analysis tools that you want to enable.
- Memory Profiling detects memory leaks and allocation problems.
- Performance Profiling locates performance issues and bottlenecks.
- Code Coverage provides coverage information of the source code as it is run.
> Runtime Tracing displays a dynamic UML sequence diagram of the run.
- Static Metrics evaluates the complexity of the source code.
- Code Review assesses compliance to coding rules.
> Debug enables the workbench debug mode.
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6. Click OK, Apply the changes and close the Properties window.

7. Click Project > Clean > Clean all projects.
Result
If the project is successfully built, in the project explorer, the Binaries folder contains the compiled binary
executable for the project. If the project did not build successfully, see the Troubleshooting section for help on

resolving compilation issues.

Related information

Runtime analysis overview on page 65

Running instrumented applications

To run a program with runtime analysis tools enabled, you must run it as an instrumented application.

About this task
If you run the program with a standard C/C++ run configuration, the program is not instrumented and the runtime
analysis tools are not used.

To run an instrumented application:

1. Click Project > Clean > Clean all projects.
Result
If the project is successfully built, in the project explorer, the Binaries folder contains the compiled
instrumented program for the project.

2. Right-click the instrumented program and click Run As > Run Instrumented Application.

Results

After running the instrumented application, in the Project Explorer, the Application Result folder contains the
compiled binary executable for the project. To view the results of the run, see Opening runtime analysis reports on
page 959.

Estimating Instrumentation Overhead

Instrumentation overhead is the increase in the binary size or the execution time of the instrumented application,
which is due to source code insertion (SCI) generated by the Runtime Analysis features.

Source code insertion technology is designed to reduce both types of overhead to a bare minimum. However, this
overhead may still impact your application.

The following table provides a quick estimate of the overhead generated by the product.
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Code Coverage Overhead

Overhead generated by the Code Coverage feature depends largely on the coverage types on page 340 selected for

analysis.
A 48-byte structure is declared at the beginning of the instrumented file.

Depending on the information mode selected, each covered branch is referenced by an array that uses

* 1 byte in Default mode
« 1 bit in Compact mode

« 4 bytes in Hit Count mode

The actual size of this array may be rounded up by the compiler, especially in Compact mode because of the 8-bit

minimum integral type found in C and C++.
See Information Modes on page 339 for more information.

Other Specifics:

* Loops, switch and case statements: a 1-byte local variable is declared for each instance

- Modified/multiple conditions: one n-byte local array is declared at the beginning of the enclosing routine,

where n is the number of conditions belonging to a decision in the routine

I/0 is either performed at the end of the execution or when the end-user decides (please refer to Coverage Snapshots

in the documentation).

As a summary, Hit Count mode and modified/multiple conditions produce the greatest data and execution time
overhead. In most cases you can select each coverage type independently and use Pass mode by default in order to
reduce this overhead. The source code can also be partially instrumented.

Memory and Performance Profiling and Runtime Tracing
Any source file containing an instrumented routine receives a declaration for a 16 byte structure.

Within each instrumented routine, a n byte structure is locally declared, where n is:

* 16 bytes
* +4 bytes for Runtime Tracing
« +4 bytes for Memory Profiling

- +3*t bytes for Performance Profiling, where t is the size of the type returned by the clock-retrieving function

For example, if t is 4 bytes, each instrumented routine is increased of:
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« 20 bytes for Memory Profiling only
« 20 bytes for Runtime Tracing only
« 28 bytes for Performance Profiling only

- 36 bytes for all Runtime Analysis features together

Memory Profiling Overhead
This applies to Memory Profiling for C and C++. Memory Profiling for Java does not use source code insertion.

Any call to an allocation function is replaced by a call to the Memory Profiling Library. See the Target Deployment

Guide for more information.

These calls aim to track allocated blocks of memory. For each memory block, 16+12*n bytes are allocated to contain
a reference to it, as well as to contain link references and the call stack observed at allocation time. n depends on the
Call Stack Size Setting, which is 6 by default.

If ABWL on page 397 errors are to be detected, the size of each tracked, allocated block is increased by 2*s bytes
where s is the Red Zone Size Setting (16 by default).

If FFM on page 396 or FMWL on page 398 errors are to be detected, a Free Queue is created whose size depends
on the Free Queue Length and Free Queue Size Settings. Queue Length is the maximum number of tracked memory
blocks in the queue. Queue Size is the maximum number of bytes, which is the sum of the sizes of all tracked blocks

in the queue.

Performance Profiling Overhead
For any source file containing at least one observed routine, a 24 byte structure is declared at the beginning of the file.

The size of the global data storing the profiling results of an instrumented routine is 4+3*t bytes where t is the size of

the type returned by the clock retrieving function. See the Target Deployment Guide for more information.

Runtime Tracing Overhead

Implicit default constructors, implicit copy constructors and implicit destructors are explicitly declared in any
instrumented classes that permits it. Where C++ rules forbid such explicit declarations, a 4 byte class is declared as
an attribute at the end of the class.

Related Topics

Reducing Instrumentation Overhead on page 72 | Source code instrumentation overview on page 16
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Reducing Instrumentation Overhead

HCL OneTest™ Embedded Source Code Insertion (SCI) technology is designed to reduce both performance and
memory overhead to a minimum. Nevertheless, for certain cross-platform targets, it may need to be reduced still

further. There are three ways to do this.

Limiting Code Coverage Types

When using the Code Coverage feature, procedure input and simple and implicit block code coverage are enabled by
default. You can reduce instrumentation overhead by limiting the number of coverage types.

Note The Code Coverage report can only display coverage types among those selected for instrumentation.

Instrumenting Calls (C Language)

When calls are instrumented, any instruction that calls a C user function or library function constitutes a branch
and thus generates overhead. You can disable call instrumentation on a set of C functions using the Selective Code

Coverage Instrumentation Settings.

For example, you can usually exclude calls to standard C library functions such as printf or fopen.

Optimizing the Information Mode

When using Code Coverage, you can specify the Information Mode which defines how much coverage data is

produced, and therefore stored in memory.
Related Topics

Estimating Instrumentation Overhead on page 69 | Selecting Coverage Types on page 340 | Information Modes

on page 339
Code coverage

Code coverage overview

Source code coverage consists of identifying which portions of a program are executed or not during a given test
case. Source code coverage is recognized as one of the most effective ways of assessing the efficiency of the test

cases applied to a software application.

The code coverage tool can provide the coverage information for the following source code elements:

« Statement blocks, decisions, and loops.

« Function or procedure calls.

- Basic conditions, modified conditions/decisions (MC/DC), multiple condition, and forced condition.
* Procedure entries and exits.

» Terminal or potentially terminal statements

« Statements that are considered non-coverable in C.
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See Coverage levels on page 73 for more details about each coverage level.

Information modes

The information mode is the method used to code the trace output. This has a direct impact of the size of the trace
file as well as on CPU overhead. You can change the information mode in the coverage type settings. See Changing

code coverage settings on page 81.

There are three information modes:

« Default mode: Each branch generates one byte of memory. This offers the best compromise between code
size and speed overhead.

- Compact mode: This is functionally equivalent to Pass mode, except that each branch needs only one bit of
storage instead of one byte. This implies a smaller requirement for data storage in memory, but produces a
noticeable increase in code size (shift/bits masks) and execution time.

- Hit Count mode: In this mode, instead of storing a Boolean value indicating coverage of the branch, a specific
count is maintained of the number of times each branch is executed. This information is displayed in the code
coverage report.

Count totals are given for each branch, for all trace files transferred to the report generator as parameters. In the code
coverage report, branches that have never been executed are highlighted with an asterisk "*'. The maximum count in
the report generator depends on the amount of memory available on the computer running the tests. If this maximum
count is reached, the report signals it with a Maximum reached message.

Note: The last bracket (}) in a function after a return statement is always displayed in red in the coverage
report, even if the function reports 100% coverage.

On-the-fly display

By default, code coverage generates a report when the execution ends. The on-the-fly mode generates code coverage
results dynamically during the execution. This is useful for applications that never exit or to interact with the
execution during the analysis, for example if you want to stop the code coverage when you reach a specified coverage
rate threshold.

Coverage levels
The product provides coverage information for various levels of statements, decisions, loops, calls, conditions.
Block coverage

When running the code coverage feature on C source code, the following coverage types are analyzed.

« Statement blocks (simple blocks): Simple blocks are the main blocks of the C function, introduced by decision
statements:
o THENand ELSE FOR | F statements
° FOR, WH LEand DO ... WHI LE blocks
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> Non-empty blocks introduced by switch case or default statements.
> True and false outcomes of ternary expressions (<expr ession> ? <expression> : <expressi on>).

» Blocks following a potentially terminal statement.

Each simple block is a branch. Every C function contains at least one simple block corresponding to its main
body.

« Decisions (implicit blocks): Implicit blocks are introduced by an | F statement without an ELSE or a sw TcH
statement without a bEFAULT. Each simple block is a branch. Every C function contains at least one simple
block corresponding to its main body.

« Loops (logical blocks): Logical blocks are defined by loop statements FOR, W4l LE,and DO ... WHI LE.

A typical ForR or wHi LE loop can reach three different conditions:
> The statement block contained within the loop is executed zero times. The output condition is True
from the start
> The statement block is executed exactly once. The output condition is False, then True the next time
o The statement block is executed at least twice. The output condition is False at least twice, and
becomes True at the end.

In apo .. w4 LE loop, because the output condition is tested after the block has been executed, two further
branches are created:
> The statement block is executed exactly once. The output is condition True the first time.
o The statement block is executed at least twice. The output condition is False at least once, then True
at the end.

Call coverage

Code coverage provides coverage of function or procedure calls by counting as many branches as it encounters
function calls while running the program. This type of coverage ensures that all the call interfaces can be shown to

have been exercised for each C function, which may be a pass or failure criterion in software integration test phases.

You can exclude specific C functions whose calls you do not want to measure coverage in the configuration settings
of the project. This can be useful for C library functions for example.

Condition coverage

For conditions, the following coverage types are analyzed:

- Basic condition coverage: Conditions are operands of either | | or && operators wherever they appear in
the body of a C function, | F statements and ternary expressions, and tests for FOR, WHI LE,and DO ... WHI LE

statements even if these expressions do not contain || or && operators.

Two branches are involved in each condition, causing the sub-condition to be true or false. In a switch

statement, one basic condition is associated with every case and DEFAULT, whether implicit or not.
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Two branches are enumerated for each condition, and one per CASE or DEFAULT.

 Modified condition/decision coverage (MC/DC): A modified condition (MC) is defined for each basic condition
enclosed in a composition of | | or && operators, proving that the condition affects the result of the enclosing
composition. For example, in a subset of values affected by the other conditions, if the value of this condition
changes, the result of the entire expression changes. Because compound conditions list all possible cases,
you must find the two cases that can result in changes to the entire expression. The modified condition is

covered only if the two compound conditions are covered.

You can associate a modified condition with more than one case. Code Coverage calculates matching cases
for each modified condition. The number of modified conditions matches the number of Boolean basic

conditions in a composition of | | and && operators.

Multiple condition coverage: A multiple (or compound) condition is one of all the available cases for the | |
and && logical operator compositions, whenever it appears in a C function. It is defined by the simultaneous
values of the enclosed Boolean basic conditions. Remember that the right operand of a || or && operator is
not evaluated if the evaluation of the left operand determines the result of the entire expression.

Code Coverage calculates every available case for each composition. The number of enumerated branches is
the number of distinct available cases for each composition of the | | or && operators.

.

Forced condition coverage: Forced conditions are multiple conditions in which the instrumentation replaces
any occurrence of the | | or && logical operators in the code, with | and & binary operators. You can use this
coverage type, after evaluating all modified conditions, to make sure that every basic condition has been
evaluated. With this forced condition coverage, you can ensure that only the basic condition has changed
between two tests.

Function coverage

When analyzing C source code, HCL® OneTest™ Embedded can provide the following function coverage:

- Procedure entries: Inputs identify the C functions that are executed. One branch is defined per C function.
« Procedure exits: These include the standard output (if coverable), and all return instructions, exits, and other
terminal instructions that are instrumented, as well as the input. At least two branches are defined per C

function.

The input is always enumerated, as is the output if it can be covered. If it cannot, it is preceded by a terminal
instruction involving returns or an exit. In addition to the terminal instructions provided in the standard definition file,

you can define other terminal instructions using the pragma attol exit_instr.

Additional statements

Some statements are identified as terminal, potentially terminal, or non-coverable.
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A C statement is terminal if it transfers program control out of sequence (RETURN, GOTQ, BREAK, CONTI NUE), or if it stops
the execution (Exi T). By extension, a decision statement (I F or sw TcH) is terminal if all branches are terminal; that is
if the non-empty THEN ... ELSE, casE, and DEFAULT blocks all contain terminal statements. An | F statement without an
ELSE and a sw TcH statement without a DEFAULT are never terminal, because their empty blocks necessarily continue

the program sequence.

The following decision statements are potentially terminal if they contain at least one statement that transfers

program control out of their sequence (RETURN, GOTQ, BREAK, CONTI NUE), or that stops the execution (Exi T):

« | F without an ELSE
* SW TCH
* FOR

*WH LEOrDo ... WHLE

Some C statements are considered non-coverable if they follow either a terminal instruction, a CONTI NUE, or a BREAK,
and are not a corolabel. Code coverage detects non-coverable statements during instrumentation and produces a

warning message that specifies the source file and line location of each non-coverable statement.

Note: User functions whose purpose is to terminate execution unconditionally are not evaluated. Furthermore,
code coverage does not statically analyze exit conditions for loops to check whether they are infinite. As a
result, FOR ... WH LEand DO ... W LE loops are always assumed to be non-terminal, able to resume program

control in sequence.

Justification of non-covered lines of code

You can enter justification statements in uncovered branches of a program so that they are considered as exceptions
to the coverage rules. Thus, you identify in the source code the branches that are not covered and explain why they
are not covered. The justification text must be declared in the attol cov_justify pragma line of the uncovered branch

with one or multiple attributes.
Note: This feature applies to C and C++ programming languages only.

SYNTAX:

The justification pragma syntax is the following one:

#pragma attol cov_justify (<lineOffset>, <type>, <what>, <justification text> ) [ (..) [ (w.) w..1]
#pragma attol cov_justify is the pragma, and <lineOffset>, <type>, <what>, and <justification text> are the attributes.
Multiple statements can be specified in the same pragma line, with four attributes for each.

Each justification statement in a pragma line can cover only one branch of the code starting from a specified line of

the source code.
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Double-quotes can be added if the attribute includes commas.

The attributes are the following ones:

« <type> attribute:

This attribute is mandatory. It is used to determine what kind of code must be covered and how it must be

covered.

You can use the following <type>values:

> proc: to justify that a function or a method is not covered.

o return: to justify that a return statement is not covered.

> branch or block: to justify that a block of code is not covered.

o implicit: to justify that an implicit else statement is not covered.

> logical, or for, or while: to justify that a loop is not covered (the loop number is given in the <what>
attribute).

o case: to justify that a case statement in a switch is not covered.

o call: to justify that a function call or method call is not covered.

- cond: to justify that a simple condition is not covered (the value true or false of the condition is given
in the <what> attribute).

- medc: to justify that a MC/DC is not covered (the description of the MD/DC is given in the <what>
attribute).

- <lineOffset> attribute:
This attribute is optional.

<lineOffset> attribute represents the number of lines between the pragma and the branch that must be
justified. The value can be '+ if the branch is located after the pragma, or -' if the branch is located before the

pragma.

If the <lineOffset> attribute is omitted <lineOffset> is considered as "0". It means that the justification applies
1o the closest type of branch (attribute <type>) from the pragma. If there are multiple branches at a same

distance of the pragma, <lineOffset> helps distinguish between branches which branch should be justified.

The <lineOffset> attribute specifies the line where the branch or condition to justify starts, it is relative to the

pragma line (+/-), allowing to write this pragma line anywhere in the source file.
Note: For the <block> value, the target block of lines is the block where the pragma is declared.

» <what> attribute:

The <what> values are used to help specify some of the branches to be justified. It depends on the attribute
<type> values being used:
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> For block or branch <type>: The value is a string that describes the logical position of the block in the
function, like ‘/then/else/seq’.

o For logical, for and while <type>: The value is a list of ‘0’ (the loop is not executed), ‘1’ (the loop is
executed only once) or 2+ (the loop is executed more that once) separated by ‘;, each of them could
be prefixed with the block description string.

- For cond <type>: The value is <expression>:<value>, <value> is true or false and <expression>.

> For medc <type>: The value is a list of impossible combinations of the conditions separated by *;,
each value of the conditions are set with ‘T’ for true, ‘F’ for false, or ‘X" if the condition is not evaluated.
For example, if the MC/DC consists of 3 conditions, the <what> value could be the following one:
“TEX;EXX".

- <justification text> is the reason why this part of code can't be covered by a test.

<justification> is mandatory. It is presented as a free text in the coverage report that justifies a uncovered
branch. It explains why it is not covered.

Example:

#pragma attol cov_justify (call, ”my justification”) (block, ”myjustification”) (cond, ”:true”,
”my justification”) (for, ”0;1” ,”my justification”)

The following table lists the parameters that can be entered in the “<lineOffset>" and <what> attributes depending on
the parameters indicated in the <type> attribute.

<type> attribute <lineOffset> attribute <what> attribute

proc For the <type>=proc, the pragma line
declared above or inside the body, or
just after the end of the body justifies
the function/procedure entry.

return For <type>=return, the pragma line,
must be just before or just after the

return line.

branch/block For <type>=branch or block. It starts

The “branch to cover" attribute is
on the first { of that block or on the

. . used for a branch=<type> The branch
line of the unique statement.

string format is a list of :
/then/ el se/ seq OF /

It is used to indicate which branch

to cover when there are multiple

branches on the same line.
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<type> attribute

<lineOffset> attribute

<what> attribute

It can be empty is there are no ambi-

guity with the line number.

implicit

For <type>=implicit, the pragma line
must be just before the decision, or
at the else place.

The “branch to cover" attribute is

used for <type>= <branch>.

The branch string format is a list of: /

then/ el se/ seq Or/

It is used to indicate which branch
to cover when there are multiple

branches on the same line.

It can be empty is there are no ambi-

guity with the line number.

logical/for/do/while

For <type>=logical/for/while, the
pragma line must be just before the
‘for' or ‘while’, or ‘do’ keyword.

This attribute is used for <type>=log-
ical, the branch string format looks
like ‘branch depth/instruction type/

value’ with :
instruction type is:
/for Or/while Or/do

The valueis /o0 or /1 or/2+to specify
which part must be covered and jus-
tified. It is mandatory and can speci-
fy multiple parts if separated by ; e.g.
“/0; /1"

Branch depth is a suite of strings like
/then /else /for /while etc. clari-
fying the code depth of the branch

where the loop has been found.

e.g. “I el se/then/for/whilel/ 1" or

”

“I'while/1” or “/1

case

For <type>=case, the pragma line
must be just before or just after the

case line.

Used for <type>=case, the string de-
tails the case expression (between
‘case’ and the ") to cover into the

switch block.

79



HCL® OneTest™ Embedded

<type> attribute <lineOffset> attribute <what> attribute
A case is both a block and a condi- It can be empty is there are no ambi-
tion. If you enter a justification for a | guity with the line number.
case <type>, it is the condition that is
justified. You need to declare another
pragma to justify the corresponding
block.
call For <type>=call, the pragma line
. . Used for type=call, the string details
must be just before or just after the yp g
. the called method name to cover.
call line,
It can be empty is there are no ambi-
guity with the line number.
cond For <type>=cond, the pragma line
. . “condition expression:value” is used
must be just before or just after the
s for “<type>"=cond.The string indi-
condition line.
cates the condition expression to
cover into the decision with the value
to cover, true or false. The “condition
expression” can be empty if there is
no ambiguity with the line number
but the value must always be spec-
ified after a colon at the end of the
string.
Example: “var>5: fal se” or “: true”.
Multiple values can be justified, sepa-
rated by ;" such as “:true ; :false”
mcdc For <type>=mcdc, the pragma line
. “combinations” is used for type=
must be just before or after the first vP
e . mcdec. It is a series of patterns sepa-
condition line, or just before or after
o rated by a semi-colon ";". It cannot be
the last condition line.
empty.

Once the source code is built, you can see the results of the non-coverage justification statements in the Code

Coverage report, on the Source page.

For more information about the code coverage reports, see About coverage reports on page 961.
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Changing code coverage settings

You can edit the configuration settings for code coverage to explicitly include or exclude files, change the information

mode, coverage level, and other settings.

To change the code coverage settings:

1. In the project explorer, right-click the project on which you want to change the settings and click Properties.
2. Click C/C++ Build > Settings and select Build Settings.
3. Expand Code coverage to access the settings and set the required coverage level for functions, calls, blocks

and conditions, as well as any other required settings.
Instrumentation control

You can use the coverage type settings to declare various types of coverage. See Coverage

levels on page 73 for more information about these settings.
Coverage level functions
Select between function Entries, With exits, or None.
Coverage level calls
Select Yes or No to toggle call code coverage.
Coverage level blocks

Select the desired block code coverage type. You can combine, enable, or disable
any of these coverage types before running the application node. All coverage
types selected for instrumentation can be filtered out in the coverage viewer.

Exclude for loops

Select Yes to exclude for loops from instrumentation. Only while and do loops are

instrumented.
Coverage level conditions

Selects the condition level of code coverage to be included in the report:

> None: The coverage report ignores conditions.

- Basic: Only basic conditions are included in the coverage report.

- Modified (MC/DC): Only modified conditions are included in the coverage
section of the test report.

- Modified and Multiple: Both modified and multiple conditions are included
in the coverage report.

- Forced Modified (MC/DC): The report includes modified conditions where
all operators are replaced with bitwise operators.

- Forced Modified and Multiple: The report includes modified and multiple
conditions where all operators are replaced with bitwise operators.
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Condition in expressions

Select Yes to consider relational operators in an expression (for example: y =
(a>0)) as conditions.

Bitwise as logical

Select Yes to instrument bitwise operators as logical when both operands are

booleans.
Ternary coverage

When this option is selected, code coverage reports ternary expressions as

statement blocks.
Information mode

This setting specifies the information modes to be used by code coverage.
- Default (Optimized for Code Size and Speed): This setting uses one byte
per branch to indicate branch coverage.
- Compact (Optimized for Memory): This setting uses one bit per branch.
This method saves target memory but uses more CPU time.
> Report Hit Count: This adds information about the number of times each
branch was executed. This method uses one integer per branch.

Excluded function calls

Specifies a list of functions to be excluded from the call coverage instrumentation
type, such as printf or fopen. Use the Add, Remove buttons specify the functions to

be excluded.
Not returning functions

Type the identifiers (not signatures) of the functions that do not return (functions

that execute a longjmp or exit).
Advanced options
Trace file name (.tio)

this allows you to specify a path and filename for the . t i o dynamic coverage

trace file.
Key ignore source file path

Identifies source files based only on the filename instead of the complete path.
Use this option to consolidate test results when a same file can be located in
different paths. This can be useful in some multi-user environments that use
source control. If you use this option, make sure that the source file names used by

your application are unique.
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User comment

This adds a comment to the code coverage report. This can be useful for
identifying reports produced under different configurations. To view the comment,
click the a magnifying glass symbol that is displayed at the top of your source

code in the coverage viewer.
Report summary

Select Yes to add the coverage summary to the summary text file of the selected

node.
On-the-fly frequency dump

Specify the function call number after which the coverage results are updated
dynamically during execution. 0 means no update during execution.

4. Click OK, Apply the changes and close the Properties window.

Related information

Coverage levels on page 73

Engaging runtime analysis tools on page 68

Code coverage for assembler source files

With HCL OneTest™ Embedded for Eclipse IDE, you can collect coverage metrics for assembler source files. Coverage

information is displayed in the coverage report.

Note:

This feature supports only ARM in 32 bits mode. It is an extension of the C language mode.

You must have configured HCL OneTest™ Embedded for Eclipse IDE to recognize the .asm file extension used

for assembler files.
Coverage Assembler language for ARM processor is fully compatible with C/C++ and Ada code coverage.

Assembler source files are taken into account in the build as C/C++ source files. Optionally, C/C++ source

files could be instrumented at the assembler level instead of at the C/C++ level.

The supported coverage levels are:

 Functions

» Functions and exits
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o « Statement blocks
« Calls
CONFIGURATION

Code coverage for assembler source files requires the use of an appropriate TDP. You can use the
cl i nCr ossRaspi Renot e. xdp and cwi nCr ossRaspi Renot e. xdp that are delivered, for example.

There two use case scenarios:

« For a project that uses both C and assembler source files, you only have to add the assembler .asm source
files to the list of sources to be compiled. The .asm files are then instrumented, built, and linked with the other
C sources to produce an executable file.

« For C code source files that are instrumented in assembler mode, the C source files are converted into
assembler files by using the gcc -S command. Then, they are instrumented in assembler mode, they are

converted into assembly language, and linked.
To implement this use case scenario, you must set the INSTR_C_AS_ASM=1 environment variable.

To add this environment variable in Studio, proceed as follows:
o Right-click on your project in the Project Explorer, and select Properties.
> Select C/C++ Build > Environment.
> Click Add, give a name to the variable, and enter INSTR_C_AS_ASM=1 in Value.
> Apply and close the window.
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See the following example:

| a Environment v v w

» Resource
Bullders Configuration: | build [ Active ] ~ || Manage Configurations...
v C/C++ Build

Build Variables

m Environment variables to set Add...

Value

Logaing ‘ | i . . - Select...
Settings CWD /home/pierre/testasm: BUILD SYSTEM
Tool Chain Editor INSTR-C_AS_ASM 1 USER: CONFIG
b C/IC++ General PWD /home/pierre/testasm: BUILD SYSTEM
Project Facets
Project References
Run/Debug Settings
Server ) Append variables to native environment
Service Policies Replace native environment with specified one
Task Tags
» Validation Restore Defaults Apply
'f?/' Cancel Apply and Close

Note: In some case, when the assembler code increased due to the code coverage level, it might be
necessary to re-organize the assembler code (Example: you can move data pools), or to decrease the level of
code coverage (Example: you can delete code coverage for some functions calls in libraries).

Using the Code Coverage Viewer to view reports
Code Coverage for Ada, C and C++

The Code Coverage Viewer allows you to view code coverage reports generated by the Code Coverage feature. Select

a tab at the top of the Code Coverage Viewer window to select the type of report:

« A Source report that displays the source code under analysis, highlighted with the actual coverage

information.

- Arates report that provides detailed coverage rates for each activated coverage type.

You can use the Report Explorer to navigate through the report. Click a source code component in the Report Explorer

to go to the corresponding line in the Report Viewer.

You can jump directly to the next or previous Failed test in the report by using the Next Failed Test or Previous Failed

Test buttons from the Code Coverage toolbar.
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You can jump directly to the next or previous Uncovered line in the Source report by using the Next Uncovered Line or

Previous Uncovered Line buttons in the Code Coverage feature bar.

When viewing a Source coverage report, the Code Coverage Viewer provides several additional viewing features for

refined code coverage analysis.
To open a Code Coverage report:

1. Right-click a previously executed test or application node.
2. If a Code Coverage report was generated during execution of the node, select View Report and then Code
Coverage.

Coverage types

Depending on the language selected, the Code Coverage feature offers the following choices:

- Function or Method code coverage: select between function Entries, Entries and exits, or None.
- Call code coverage: select Yes or No to toggle call coverage for Ada and C.
- Block code coverage: select the block coverage method you need.

- Condition code coverage: select condition coverage for Ada and C.

Any of the Code Coverage types selected for instrumentation can be filtered out in the Code Coverage report stage if

necessary.

To filter coverage types from the report, proceed as follows:

1. From the Code Coverage menu, select Code Coverage Type.

2. Toggle each coverage type in the menu.

For example, to filter out multiple conditions (MC) from the report, select Code Coverage > > Code Coverage

Type, and clear Multiple conditions.

3. Alternatively, you can filter out coverage types from the Code Coverage toolbar by toggling the Code Coverage
type filter buttons.

Test by test analysis mode

The test by test analysis mode allows you to refine the coverage analysis by individually selecting the various tests
that were generated during executions of the test or application node. In Test-by-Test mode, a Tests node is available
in the Report Explorer.

When test by test analysis is disabled, the Code Coverage Viewer displays all traces as one global test.

To toggle test by test mode, proceed as follows:
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1. In the Code Coverage Viewer window, select the Source tab.

2. From the Code Coverage menu, select Test-by-Test.
To select the Tests to display in Test-by-Test mode, follow these steps:

1. Expand the Tests node at the top of the Report Explorer.
2. Select one or several tests. The Coverage Viewer provides code coverage information for the selected tests.

Opening the HTML report
You can open the code coverage report in an HTML format if it is available.
To open the HTML report, select Open HTML report in the Coverage Viewer menu.

The HTML coverage report has been generated in the build folder with the extension .cov.html. The root name of the

report is the name of the application, or the name of the test harness, or the name of the test suite result.

Note: The HTML report is created from a template file: covr eport . t enpl at e located in the folder
<installation folder>/1ib/report. Youcan modify this template. This is the default template that

can be used as a string point for a new template.

To select a new template file, select Code coverage > Advanced options in the build settings. Then, click Coverage

Report Template to select the new template file.

Memory profiling

Memory profiling overview

Memory profiling helps you detect memory allocation problems and leaks.

Runtime memory errors and leaks are among the most difficult errors to locate and the most important to correct.
The symptoms of incorrect memory use are unpredictable and typically appear far from the cause of the error. The
errors often remain undetected until triggered by a random event, so that a program can seem to work correctly when

in fact it's only working by accident.

After execution of an instrumented application, the memory profiling report provides a summary diagram and a
detailed report for both byte and memory block usage. The summary diagrams give you a quick overview of memory

usage in blocks and bytes, including:

« The total memory allocated during the execution of the application.
- The memory that remains allocated after the application was terminated.

» The maximum memory usage encountered during execution

The detailed section of the report lists memory usage events identified as errors or warnings.
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Related reference

Memory profiling warnings on page 993

Memory profiling errors on page 991

Checking for ABWL and FMWL errors

You can insert pragma macros into your source code to check for Late Detect Array Bounds Write (ABWL) and Late
Detect Free Memory Write (FMWL)

About this task

By default, memory profiling checks for ABWL and FMWL errors whenever the routines are called or whenever the free
queue is actually flushed. In some cases, you might want to manually specify when to check for ABWL and FMWL
errors, and on which functions. You can use the ABWL and FMWL check frequency setting to perform a check at the

following times:

« Each time the memory is dumped (by default).
» Each time a manual check macro is encountered in the code.
« Each function return.

The checks can be performed either on all memory blocks or only a selection of memory blocks.

1. To indicate where you want an ABWL or FMWL check to occur in your source code, insert an _ATP_CHECK( )

macro at the corresponding location.

Use the following syntax for the pragma macro:

#pragma attol insert _ATP_CHECK(@RELFLINE)

Each time this macro is encountered during execution, memory profiling checks for ABWL and FMWL errors
on the specified blocks. The @RELFLINE parameter allows navigation from the memory profiling viewer to the

corresponding line in the source code.
2. To create a selection of blocks that you explicitly want to verify, create a list in your source code using the

_ATP_TRACK() macro variable. The syntax for this macro is:

Use the following syntax for the pragma macro:

#pragma attol insert _ATP_TRACK(<pointer>)
Related reference

Memory profiling warnings on page 993

Memory profiling errors on page 991
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Related information

Memory profiling overview on page 87

Engaging runtime analysis tools on page 68

Memory profiling user heap

Memory profiling can use heap management routines on target hardware platforms where there are no or only partial

provisions for memory management instructions.

When using Memory profiling on some embedded or real-time target platforms, you might encounter one of the

following situations:

« Situation 1: There are no provisions for malloc, calloc, realloc or free functions on the target platform. The
program uses custom heap management routines that may use a user API. Such routines could, for example,
be based on a static buffer that performs memory allocation and free functions. In this case, you need to
customize the memory heap parameters RTRT_DO_MALLOC and RTRT_DO_FREE in the target deployment port
(TDP) to use the custom malloc and free functions. In this case, you can access the custom API functions.

- Situation 2: There are partial implementations of malloc, calloc, realloc or free functions on the target platform,
but other functions provide methods of allocating or freeing heap memory. In this case, you do not have
access to any custom API. This requires customization of the TDP. Refer to the documentation provided in the

target deployment port editor for customization options.

In both of the above situations, memory profiling can use the heap management routines to detect memory leaks,

array bounds and other memory-related defects.

Note: Application pointers and block sizes can be modified by memory profiling in order to detect Late
Detect Array Bounds Write (ABWL) errors. Actual-pointer and actual size refer to the memory data handled by
memory profiling, whereas user pointer and user size refer to the memory handled natively by the application-
under-analysis. This distinction is important for the memory profiling ABWL and red zone settings.

Target deployment port API

The TDP library provides the following API for memory profiling:

void * _PurifyLTHeapAction ( _PurifyLT_API_ACTION, void %, RTRT_U_INT32, RTRT_U_INTS );

In the function _puri f yLTHeapAct i on, the first parameter is the type of action that will be or has been performed on the

memory block pointed by the second parameter. The following actions can be used:

typedef enum {
_PurifyLT_API_ALLOC,
_PurifyLT_API_BEFORE_REALLOC,
_PurifyLT_API_FREE

} _PurifyLT_API_ACTION;

The third parameter is the size of the block. The fourth parameter is either of the following constants:

89



HCL® OneTest™ Embedded

#define _PurifyLT_NO_DELAYED_FREE 0
#define _PurifyLT_DELAYED_FREE 1

If an allocation or free instruction has a size of 0, this fourth parameter indicates a delayed free in order to detect Late
Detect Free Memory Write (FWML ) and Freeing Freed Memory (FFM) errors. See the Build configuration settings on
page 980 section for the memory profiling settings.

A freed delay can only be performed if the block can be freed with RTRT_bo_FREeE (for the situation 1 described
previously) or ANSI C free (for situation 2). For example, if a function requires more parameters than the pointer
to deallocate, then the FMWL and FFM error detection cannot be supported and FFM errors will be indicated by a

Freeing Unallocated Memory (FUM) error instead.

The following function returns the size of an allocated block, or 0 if the block was not declared to Memory Profiling.

This allows you to implement a library function similar to the msize from Microsoft™ Visual 6.0.
RTRT_SIZE_T _PurifyLTHeapPtrSize ( void * );

The following function returns the actual-size of a memory block, depending on the size requested. Call this function
before the actual allocation to find out the quantity of memory that is available for the block and the contiguous red
zones that are to be monitored by memory profiling.

RTRT_SIZE_T _PurifyLTHeapActualSize ( RTRT_SIZE_T );

Exemple

Example

In the following examples, my_nal | oc, ny_real | oc, ny_free and ny_nsi ze demonstrate the four supported memory heap
behaviors. The following routine declares an allocation:

void *my_malloc ( int partId, size_t size )
{
void *ret;
size_t actual_size = _PurifyLTHeapActualSize(size);
/* Here 1is any user code making ret a pointer to a heap or
simulated heap memory block of actual_size bytes x/

/* Then comes the memory profiling action %/
return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0 );
/* The user-pointer 1is returned */

In situation 2, where you have access to a custom memory heap AP, replace the "..." with the actual malloc API

function.

For a my_calloc(size_t nelem, size_t elsize), pass on nelem*elsize as the third parameter of the _PurifyLTHeapAction
function. In this case, you might need to replace this operation with a function that takes into account the alignments

of elements.

To declare a reallocation, two operations are required:

void *my_realloc ( int partId, void * ptr, size_t size )

{
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void *ret;

size_t actual_size = _PurifyLTHeapActualSize(size);

/* Before comes first Memory Profiling action x/

ret = _PurifyLTHeapAction ( _PurifyLT_API_BEFORE_REALLOC, ptr, size, 0 );

/* ret now contains the actual-pointer x/

/* Here is any user code making ret a reallocated pointer to a heap or
simulated heap memory block of actual_size bytes x/

/* After comes second Memory Profiling action x/
return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0 );
/* The user-pointer 1is returned */

To free memory without using the delay:

void my_free ( int partId, void * ptr )

{
/* Memory Profiling action comes first */
void xret = _PurifyLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, 0 );
/* Any code insuring actual deallocation of ret */

To free memory using a delay:

void my_free ( int partId, void * ptr )

{
/* Memory Profiling action comes first */
void *ret = _PurifyLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, 1 );
/* Nothing to do here x/

To obtain the user size of a block:

size_t my_msize ( int partId, void x ptr )
{
return _PurifyLTHeapPtrSize ( ptr );

Use the following macros to save customization time when dealing with functions that have the same prototypes as
the standard ANSI functions:

#define _PurifyLT_MALLOC_LIKE(func) \
void *RTRT_CONCAT_MACRO(usr_,func) ( RTRT_SIZE_T size ) \
{\
void *ret; \
ret = func ( _PurifylLTHeapActualSize ( size ) ); \
return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0 ); \
}
#define _PurifyLT_CALLOC_LIKE(func) \
void *RTRT_CONCAT_MACRO(usr_,func) ( RTRT_SIZE_T nelem, RTRT_SIZE_T elsize ) \
{\
void *ret; \
ret = func ( _PurifylLTHeapActualSize ( nelem * elsize ) ); \
return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, nelem * elsize, 0 ); \
}
#define _PurifyLT_REALLOC_LIKE(func,delayed_free) \
void *RTRT_CONCAT_MACRO(usr_,func) ( void xptr, RTRT_SIZE_T size ) \
{\
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void *ret; \
ret = func ( _PurifyLTHeapAction ( _PurifyLT_API_BEFORE_REALLOC, \
ptr, size, delayed_free ), \
_PurifyLTHeapActualSize ( size ) ); \

return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0 ); \
}
#define _PurifyLT_FREE_LIKE(func,delayed_free) \
void RTRT_CONCAT_MACRO(usr_,func) ( void *ptr ) \

{\
if ( delayed_free ) \

{\
_PurifyLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, delayed_free ); \

I

else \

{\
func ( _PurifyLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, delayed_free ) ); \

A\
}
Changing memory profiling settings

You can edit the configuration settings for memory profiling to specify the errors and warnings that you want to

detect and to set other advanced options.

To change the memory profiling settings:

1. In the project explorer, right-click the project on which you want to change the settings and click Properties.
2. Click C/C++ Build > Settings and select Build Settings.
3. Expand Memory profiling to access the settings and set the error and warning detection options as well as
any other required options.
The following settings are available:

Instrumentation control

You can specify the type of memory errors and warnings that you want to detect. See Memory
profiling errors on page 991 and Memory profiling warnings on page 993 for more
information about these settings.

Detect File in Use (FIU)
When the application exits, this option reports any files left open.
Detect Memory in use (MIU)

When the application exits, this option reports allocated memory that is still

referenced.
Free Invalid Memory (FIM)

This option activates the detection of invalid free memory instructions.
Detect Signal (SIG)

This option indicates the signal number received by the application forcing it to

exit.
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Detect Freeing Freed Memory (FFM) and Detect Free Memory Write (FMWL)
Select Yes to activate detection of these errors.
Free queue length (blocks)
Specifies the number of memory blocks that are kept free.
Free queue size (bytes)
Specifies the total buffer size for free queue blocks.
Largest free queue block size (bytes)
Specifies the size of the largest block to be kept in the free queue.
Detect Array Bounds Write (ABWL)
Select Yes to activate detection of ABWL errors.
Red zone length (bytes)

Specifies the number of bytes added by Memory Profiling around the memory
range for bounds detection.

Number of functions in call stack

Specifies the maximum number of functions reported from the end of the CPU call
stack. The default value is 6.

Only show memory leaks with call stack

Select this option to only record memory leaks that are associated with a call
stack. Memory allocations that occurred before the application started do not have
a call stack and are not included in the Memory Profiling report.

Line number link

Select Statement to link the line number in the report to the corresponding
allocation or free statement in the function. Select Function to link only to the

function entry and to improve performance.
Only show new memory leaks in each dump

In multi-dump report, Memory leaks (MLK) and potential leaks (MPK) are only
reported once.

Advanced options

Trace File Name (.tpf)
This setting allows you to specify a filename for the generated . t pf trace file.
Exclude block tracking before init

Disables memory profiling for any memory blocks allocated before the first
execution of instrumented code. Use this option to prevent crashes when the
system uses memory allocations that cannot be tracked.
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Excluded global variables

Specifies a list of global variables that are not to be inspected for memory leaks.
This option can be useful to save time and instrumentation overhead on trusted

code. Use the Add and Remove buttons to add and remove global variables.
Exclude variables from directories

Specifies a list of directories from which any variables found in files are not to be

inspected for memory leaks.
Break on error

Use this option to break the execution when an error is encountered. The break
point must be set to priv_check_failed in debug mode.

ABWL and FMWL check frequency

Use this to check for ABWL and FMWL errors:

> Each time the memory is dumped (by default).

> Each time a manual check macro is encountered in the code.

- Each function return.
These checks can be performed either on all memory blocks or only a selection of
memory blocks. See Checking for ABWL and FMWL errors on page 88 for more

information.
Preserve block content

Set this setting to Yes to preserve the content of memory blocks freed by the
application. Use this setting to avoid application crashes when memory profiling
is engaged. When this setting is enable, reads to freed blocks of memory are no
longer detected.

4. Click OK, Apply the changes and close the Properties window.

Related reference

Memory profiling errors on page 991

Memory profiling warnings on page 993
Related information

Memory profiling overview on page 87
Memory profiling user heap on page 89

Enable runtime analysis tools on page 68
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Performance profiling

Performance profiling overview

The performance profiling tool provides performance data for each software component so that you can locate the

performance bottlenecks.

With performance profiling, you can concentrate your optimization efforts on those portions of code, which can lead

to significant improvements in performance.

The performance profiling report provides function profiling data for your program and its components so that you
can see exactly where your program spends most of its time. A Top Functions graph provides a high level view of the
largest time consuming functions in your application. The Performance Summary section of the report indicates, for
each instrumented function, procedure, or method (collectively referred to as functions), the number of calls and the
time spent in the function and in its descendants. For C language, it also provide an estimation of WCET. Optionally, it

includes the WCET calculation (Worst Case Execution Time) results.

Related information

About performance profiling reports on page 968

Performance profiling settings

You can configure the performance profiling settings before running your application in HCL OneTest™ Embedded for
Eclipse IDE.

Build settings

All the following options must be set from the Build settings tab in the Properties window. To open this tab:

« In the Project Explorer, right-click on the project and click Properties.
« In the Properties window, click C C++ Build > Settings.

Enable the Performance Profiling

- In the Build Settings tab, click Settings > General > Selective instrumentation.

« In the right pane, click the Value field in Build options and click ... to open the Build options
window.

« In the Build options list, click Performance Profiling to enable the feature.

Generate a trace file

« In the Build Settings tab, click Settings > Performance profiling.
- In Trace file name (.tqgf), click ... to open the editor window and specify a filename for the

generated .tqf trace file for performance profiling.
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To get an evaluation of the Worst Case Execution Time in the report, you must set the WCET option.

Select the Worst Case Execution Time and/or the maximum execution time for each function and descendants:

« In the Build Settings tab, click Settings > Performance profiling.
« In the right pane, click Compute F max and F+D max time and select a value depending on the
execution time that you want to be calculated for your project:
> No: Does not calculate the maximum execution time for each function and descendants.
o Yes: Calculate the maximum execution time for each function and its descendants.
> Yes + WCET: Calculate the maximum execution time for each function and descendants,
and the Worst Case Execution Time. With this option selected, the report indicates the
number of time a function is called.

To get the performance profiling per entry point, you must enter the list of entry point threads of your application.
Entry points

To get the performance profiling per entry point, you must enter the list of entry points for each thread of

your application.

« In the Build Settings tab, click General > Multi-thread options.
* Click ... to open the editor and enter the list of entry points for each thread of your application .

Use commas to separate the thread names.

Then, run the application and see the Performance report.

Performance Profiling Results

The Performance Profiling report provides function profiling data for your program and its components so that you
can see exactly where your program spends most of its time. When the configuration settings are set and the test
application is run, you can see the Performance Profiling report.

The default Performance report is in HTML format. It is generated from a template named wcetreport.template
provided as text file that you can modify to customize the report. It uses four online JavaScript libraries:

» Bootstrap,

» JQuery,

» Font Awesome,
* VisJS.

These libraries are not provided. You need an internet connectivity when you open the report. If not, download the
libraries (.css and .js files), copy them in the same folder than your report, and modify the template file as follows:

Replace the following lines:

<link rel="stylesheet" href="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/css/bootstrap.min.css"
integrity="sha384-MCw98/SFNGE8fJIT3GXWEONgsV7Zt27NXFoaoApmYm81iuXoPkFOJwJI8ERdknLPMO"
crossorigin="anonymous">
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<link rel="stylesheet" href="https://use.fontawesome.com/releases/v5.5.0/css/all.css"
integrity="sha384-B4dIYHKNBt8Bc1l2p+WXckhzcICoOwtJAoU8YZTY5qEOId1GSseTk6S+L3B1XeVIU"
crossorigin="anonymous">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.min.css">

<script src="https://code.jquery.com/jquery-3.3.1.slim.min.js"
integrity="sha384-q87/X+965Dz00rT7abK41JStQIAqVgRVzpbzo5smXKp4YfRvH+8abtTE1Pi6jizo"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/popper.js/1.14.3/umd/popper.min.js"
integrity="sha384-ZMP7rVo3mIykV+2+9J3UJ46jBkOWLaUAdn689aCwoqbBJIiSnjAK/18WVCWPIPmM49"
crossorigin="anonymous"></script>

<script src="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/js/bootstrap.min.js"
integrity="sha384-ChfqqxuZUCnJISK3+MXmPNIYE6ZbWh2IMqE241rYiqIxyMiZ60W/ImZQ5stwEULTY"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.js"></script>

With the following ones:

<link rel="stylesheet" href="./bootstrap.min.css>
<link rel="stylesheet" href="./all.css">
<link rel="stylesheet" href="./vis.min.css">

<script src="./jquery-3.3.1.slim.min.js"></script>
<script src="./popper.min.js"></script>

<script src="./bootstrap.min.js"></script>

<script src="./vis.js"></script

The Performance profiling report is made of Summary, Functions and the Call Graph parts.

SUMMARY
Summary table

The Summary table displays the total number of functions and the number of functions that have

never been executed and for which we have no data. If the instrumentation has been done with the
WCET option (Worst Case Execution Time), then the table contains the list of the entry points with an
evaluation of the WCET for each of them. This information can be empty (and the cell is red) if the
WCET could not be computed. This can occur when one of the called functions in the call graph starting

with this entry point has never been executed.

The WCET is given for each entry point if you have entered the list of entry point of your application in

the Settings. For more details, see Performance profiling settings on page 95.
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Summary

# Functions and Entry Points

# Functions

29
# Never called Functions _

main

ompute uationOflme I main obliquityCorrected main recherche_elevation Max [l recherche elevation X

\

% Function Time Average Function Time

L

Function time graphs

The Summary is followed by two graphs that provide a high level view of the largest time consumers

detected by Performance Profiling in your application.

* % Function Time: It gives the five top functions with the greatest percentage of Function Time.
- Average Function Time: It gives the five top functions with the greatest Average Function Time.

FUNCTIONS

The Functions section of the report displays a table with the instrumented functions, procedures or methods

(collectively referred to as functions) found in the application with the following information:

« Functions: Name of the function (in red if the function has never been executed).

If you have selected the WCET option, the chevron in front of the name allows the user to see how many times
this function calls other functions. This can help to understand how the WCET is calculated.

« EP: Indicate if this function is an entry point or not. You can provide the list of the entry points, or, if not, they
are deduced from the call graph (all the functions that are never called).

« # Calls: Number of times the function is called. If this value is 0, there is no more information for this function
in the table because it has never been executed.

- Function Time: Total time spent for executing the function, excluding its descendants.

- Function + Descendants Time: Total time spent for executing the function, including its descendants.

« % Function Time: Percentage of time spent in this function against the total execution time.

» % Function + Descendants Time: Percentage of time spent for executing the function and its descendants
against the total execution time.

- Average Function Time: Average time spent for executing this function, excluding its descendants.

» Max Function Time: Only if you set the option Compute F max and F + D max. Indicates the maximum time
spent in a call while executing this function, excluding its descendants.
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» Max Function + Descendants Time: Only if you set the option Compute F max and F + D max time, see
Performance profiling settings on page 95. This is the maximum time spent in a call while executing this
function, including its descendants.

« WCET: Only if you set the option WCET, see Performance profiling settings on page 95. It gives an
evaluation of the Worst Case Execution Time. This information can be empty if the WCET could not be

calculated during the execution. It is the case when one of the function and its descendants has never been

executed. Click the chevron icon to deploy the list of functions that are not called.

Functions
% Max
Function % Function  Average Max Function
Function  + Desc. Function  + Desc. Function  Function  + Desc.
Functions Time Time Time Time Time Time “ Time
> main v o 13310us 153967us  8.64% 100% 13310us 13310us 153967us
write_st_elevation_time 1 445us 445us 0.29% 0.29% 445us 445us 445us 445us
Call Graph

The Call Graph part displays all the functions in an interactive call graph that can be moved from left to right or from
top to bottom. If the option WCET has been set, a tooltip on each function (node of the graph) gives the WCET. For

more information, see Performance profiling settings on page 95.
Customize the Performance Report
You can customize a Performance report.

The Performance report is based on a template called wcetreport.template that you can find in the following folder:

* In Windows:

<installation_directory>\HCL\ HCLOneTest \ Enbedded\ | i b\reports

« In Unix:

<installation_directory>/ HCL/ HCLOneTest / Enbedded/ | i b/ reports

Raw data

This template is made of three sections:

» The HTML section that is the common part of all reports,
- A JavaScript section that sets the tables and call graph depending of 2 variables dynamically initialized while
the report is creating:

var data = {{json}}; // the raw data

var d = new Date({{date}}) // the date of the generation
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Raw data is composed of three sections at the top level:

« The list of the modules, each of them has the following information:
> Name is the short name of the C file,
> Fullname is the name and path of the C file,
- uuid is a unique identifier of the module,
- unknown is set to true is the module is not part of the information you provided (there is only one
unknown module that gathers all the function calls that are not in the known modules),

o functions is the list of the unique identifiers of functions of the module.

Modules are listed as hashmap with the uuid, as follows:

"modules”; {
"f5b557%edeaca82df478a6780c0c4c92™: {
"name": "USAGE.C",
“fullname™ "..."
"yuid": "f5b5579%edeacab2df476a6780c0c4ca2”,
"unknown":
"functions™ [

"ba9eb05ad703046fed306b4271b7ead 7"

]
b

]

« The list of functions including following information:
> name is the name of the C function,
o line is the first line of the function in the module,
o id is the number used in .tsf file to identify this function,
- stacksize is the stack size computed during the execution if this option has been set (otherwise -1),
> uuid is a unique identifier of the function,
- module is a unique identifier of the module in which the function is declared,
o calls is the list of the calls in this function. Each of them have the following information:
= calling_uuid is the unique identifier of the calling function,
= called_uuid is the unique identifier of the called function,
= line is the line number of the call in the module,
= col is the column number of the call in the module,
= same_module is set to true id the called function is in the same module that the calling
function.
- level is a number that represent the level of the function in the call graph, starting to 0.
- calledby is the list of unique identifiers of functions that call this one.
> maxLocal is the maximum time spent in the function, excluding its descendants.
- maxTotal is the maximum time spent in the function, including its descendants.
- sumLocal is the time spent in the function, excluding its descendants.
- sumTotal is the time spent in the function, excluding its descendants.
- wcet is the Worst Case Execution Time of the function (this value is negative if it has not been

calculated).
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- Functions are listed as hashmap with the uuid, as following:

"functions™ {
"bafebl5ad703046fed 3060427 1bTead ™ {

"name"; “wiile_ usage”,
“line™; 9,

"id™ 1,

“slacksize’ -1,

"yt “hafeb(Jad703046fed 3060427 1b7eadT”,
"module”. Fabad 7 Sedeacad2di4/8aG7 80c0c4cHz",
“calls™ [

"caling_uuid™. "bafeb05ad703046fed 3060427 1b7ead?",
“called_uuid": “Tbhecd643b5b44e 1005 10f30f627 20eba”,
“hne”: 10,
“col™ 2,

}"thﬁ?ﬂhl[ﬁ"-

"Imnl::l"' 1,

calledby”™ |
"3b6b20659cIbTOfc6d01baTd7abae 1

8
"maxlogal™ 27,

“maxlajal”. 28,
“suml.ecal”: 3190,
“sumlolal: 3853,
“ayeragel.ocal™- 0,
“weel™ 60

b

- The final section contains the following information:
- entrypoints is the list of entry points of the application; each of them contains:
= name is the name of the entry points.
= module is the uuid of the module where is the entry point.
= wcet is the Worst Case Execution Time of the entry points (this value is negative if it has not
been calculated).
- timeunit is the unit of time used in the report (us is for micro-second, ms for millisecond, s for
second).
- level is the setting for performance (0 when there is no "compute F max + D max time", 1 when this
option is not set to yes, 2 when it is set to yes + WCET).

An example of this section:

"SnyRQIn” |
"name"; "main”,
"module™: "57f1afe89e0a74b786aab75cd448db9b",
"weet’: -10

}

]:l

"] it": "us",

"level": 2
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Runtime tracing

Runtime tracing overview
Runtime Tracing is a feature for monitoring realtime interaction of your code in a dynamic UML sequence diagram.

Runtime tracing uses source code instrumentation to generate trace data, which produces a UML sequence diagram.

UML sequence diagrams

The lifeline of an object is represented in the trace viewer as shown below. The instance creation box displays
the name of the instance. For more information about UML sequence diagrams, see the UML sequence diagram

reference on page 991.
Step-by-step mode
When tracing large applications, it may be useful to slow down the display of the UML sequence diagram. You can do

this by enabling the step-by-step mode in the trace viewer.

Triggers

Sequence diagram triggers allow you to predefine automatic start and stop parameters for the trace viewer. The
trigger capability is useful if you only want to trace a specific portion of an instrumented application. Triggers can be
inactive, time-dependent, or event-dependent.

Notes®

You can manually add your own notes inside your source code to make them display in the UML sequence diagram
when runtime tracing is enabled. To do this, you must insert the following instrumentation pragma macro, into the C

source code of the program:

#pragma attol att_insert_ATT_USER_NOTE("Text")

Advanced runtime tracing

On some platforms or for some specific applications, these settings might be useful.

Multithreaded programs

™

Runtime tracing can be configured for use in a multithreaded environment such as Posix, Solaris and Windows™.
Multithread mode protects target deployment port global variables against concurrent access. This causes a

significant increase in target deployment port size as well as an impact on performance.

To enable multithreaded mode, change the Maximum number of threads and Record and display thread info
configuration settings. See Changing runtime tracing settings on page 104 for more information about these

settings.
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Partial trace flush

When using this mode, the target deployment port only sends messages related to instance creation and destruction,
or user notes. All other events are ignored. This can be useful to reduce the volume of the trace dump file. When
partial trace flush mode is enabled, message dump can be toggled on and off during trace execution. The partial
trace flush settings are located in the runtime tracing settings.

To do this manually, use the runtime tracing pragma user directives:

+ ATT_START_DUWP
o ATT STCP DUMP

* ATT TOGGLE_DUMP
+ _ATT_DUMP_STACK

For example, add the following line to the source code to toggle the trace dump on or off:

#pragma attol insert _ATT_TOGGLE_DUMP

Trace item buffer

Buffering allows you to reduce formatting and processing at time-critical steps by instructing the target deployment
port to only output trace information when its buffer is full or at explicitly specified points in the program. This can

prove useful when using runtime tracing on embedded platforms with limited resources.

A smaller buffer optimizes memory usage on the target platform, whereas a larger buffer improves performance of

the real-time trace. The default value is 64.

It can be useful to flush the buffer before entering a time-critical part of the application-under-trace. You can do this

by adding the _ATT_FLUSH_ | TEMS user directive to the source-under-trace. For example:

#pragma attol insert _ATT_FLUSH_ITEMS

Splitting trace files

During execution, runtime tracing generates a dynamic trace file (. t df ). When a large application is instrumented, the

size of the trace file can impact the display of the sequence diagram.

Splitting trace files allows you to produce multiple smaller files, resulting in better performance of the sequence
diagram viewer and lower memory usage. However, split trace files cannot be used simultaneously with the on-the-fly

tracing mode.

When displaying split trace files, synchronization elements are added to the UML sequence diagram to ensure that all

instance lifelines are synchronized.
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Note: The total size of split trace files is slightly larger than the size of a single trace file because each file

contains additional context information.

Related reference
UML sequence diagram reference on page 991
Related information

Runtime tracing overview on page 102

Changing runtime tracing settings
You can edit the configuration settings for runtime tracing to specify how the trace dumps are performed and how the

UML sequence diagram is drawn during or after the execution of the program.

To change the runtime tracing settings:

1. In the project explorer, right-click the project on which you want to change the settings and click Properties.
2. Click C/C++ Build > Settings and select Build Settings.
3. Expand Runtime tracing to access the runtime tracing settings and set the required options for dumping trace

data and drawing UML sequence diagrams.
Instrumentation control
Runtime Tracing file name (.tdf)
This allows you to force a filename and path for the dynamic . t df file. By default,
the . t df carries the name of the application node.
Show data classes
When this option is disabled, structures or classes that do not contain methods
are excluded from instrumentation. Disable this option to reduce instrumentation
overhead.
Trace control
Split trace file
When you use several runtime analysis tools together, the executable produces a
multiplexed trace file, containing the output data for each tool. Use this option to
split the generated at | out . spt output trace file into multiple files.
Maximum size (Kbytes)

This specifies the maximum size for a split . t df file. When this size is reached, a

new split . t df file is created.
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File name prefix:

By default, split files are named as at t _<nunber >. t df , where <number> is a 4-
digit sequence number. This setting allows you to replace the at t _ prefix with the

prefix of your choice.
Automatic loop detection

Loop detection simplifies UML sequence diagrams by summarizing repeating
traces into a loop symbol. Loops are an extension to the UML sequence diagram
standard and are not supported by UML.

Additional options

This setting allows you to add command line options. Normally, this line should be
left blank.

Display maximum call level

When selected, the target deployment port records the highest level attained by
the call stack during the trace. This information is displayed at the end of the
UML sequence diagram in the runtime tracing viewer as Maximum calling level
reached.

Runtime options
Disable on-the-fly mode

When selected, this setting stops on-the-fly updating of the dynamic . t df file. This
option is primarily for target deployment ports that use printf output.

Runtime tracing buffer and Partial Runtime Tracing flush

See Advanced runtime tracing on page 102 for more information about these
settings.

Maximum buffer size (events)
The maximum number of events recorded in the buffer before it is flushed.
User signal action

Specify an action to be performed when a user signal is detected:
> No action: nothing.
- Flush call stack: the call stack is flushed to the trace file.

> Runtime tracing on/off: toggles the runtime tracing feature on or off.
Record and display time stamp

This setting adds timestamp information to each element in the UML sequence
diagram generated by runtime tracing.
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Record and display heap size

This setting enables the heap size bar in the UML sequence diagram generated by

runtime tracing.
Record and display thread info

This setting enables the Thread Bar in the UML sequence diagram generated by

runtime tracing.

4. Click OK, Apply the changes and close the Properties window.

Related reference
Build configuration settings on page 980
Related information

Runtime tracing overview on page 102

Advanced runtime tracing on page 102

Installing the Recommended GNU Compiler on Windows

Since the Tutorial requires access to both a C and C++ compiler, if you are working on a Windows operating system
and you do not have Windows Visual C++ 6.0 installed, you are advised to install the following, recommended GNU C

and C++ compiler. It is free to use and simple to install.

Name: MinGW

Home Page: MinGW - Minimalist GNU for Windows

1. Locate and download the latest distribution archive to your machine.
2. Install the distribution as described in the MinGW documentation.
3. To verify a successful installation, open a DOS window, type gcc -v, then press the Enter key. You should see

output close to the following:

Reading specs from c:/mingw/bin/../lib/gcc-lib/mingw32/2.95.3-5/specs

Note that your base installation directory may differ.

The Target Deployment Port for the MinGW compiler needs to properly reference the location of certain MinGW
folders. To do this, you will open the TDP template for the MinGW compiler, make the proper path modifications,
and then create the actual TDP for use on your machine. For more information about the Target Deployment Port

technology, see Host-based Testing vs Target-based Testing.

1. Using the Start menu on your computer, select:
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Programs > OneTest Enbedded > Target Deployment Port Editor
. Maximize the TDP Editor window.
. Select the menu item File-> Open.
. Open the TDP template gccmingw_template.xdp

a A WODN

. The fields you need to modify - in order to reflect the MinGW installation location on your machine - are
highlighted in a large text box in the lower-right of the Editor, entitled Comment for the root node. If you can
not see this edit box, left-click any node in the tree browser to the left other than the topmost node - named
Gnu 2.95.3-5 (mingw) - and then click the topmost node. (This topmost tree node contains the name you will
see in the Test RealTime interface.)

6. Make the corrections specified in the edit box entitled Comment for the root node. Every use of the text C:

\Gcc must be replaced by the path to the top level folder of your machine's MinGW installation.

7. Select the menu item File-> Save As...

8. In the File Name edit box, type the name cwinmingw, and then click the Save button.

You just created a Target Deployment Port customized for your machine's MinGW installation - the files for this TDP
were saved in the targets folder (which contains the TDP templates folder) in a folder named cwinmingw. Proceed
with the tutorial.

Static metrics

Static metrics overview

Statistical measurement of source code properties is an extremely important matter when you are planning your test
work for a software project. HCL® OneTest™ Embedded provides a static metrics report, which displays complexity
data and statistics for your source code.

Halstead metrics

Halstead complexity measurement was developed to measure a program module's complexity directly from source
code, with emphasis on computational complexity. The measures were developed by the late Maurice Halstead as a
means of determining a quantitative measure of complexity directly from the operators and operands in the module.

Halstead provides various indicators of the module's complexity

Halstead metrics allow you to evaluate the testing time of any C/C++ source code. These only make sense at the

source file level and vary with the following parameters:

Table 3.

Para-

meter Meaning
nq Number of distinct operators
ny Number of distinct operands

107



HCL® OneTest™ Embedded

Table 3. (continued)

Para-
meter Meaning
N4 Number of operator in-
stances
N, Number of operand instances

When a source file is selected in the metrics report, the following results are displayed:

Table 4.

Metric Meaning Formula

n Vocabulary nq+n,

N Size N7+ Ny

\ Volume N *log2 n

D Difficulty n1/2 * Np/ny
E Effort V*D

B Errors V /3000

T Testing E/k
time

In the above formulaeg, k is the stroud number, which has an arbitrary default value of 18. With experience, you can
adjust the stroud number to adapt the calculation of the estimated testing time (T) to your own testing conditions:

team background, criticity level, and so on.

When the project is selected, the metrics viewer displays the total testing time for the entire project.

V(g) or cyclomatic number

The V(g) or cyclomatic number is a measure of the complexity of a source code function that is correlated with
difficulty in testing. The standard value is between 1 and 10. A value of 1 means the code has no branching. A

function's cyclomatic complexity should not exceed 10.

The static metrics report displays the V(g) of a function in the Metrics tab when a source file or function is selected.
When the type of the selected node is a source file, the sum of the V(g) of the contained function, the mean, the

maximum and the standard deviation are calculated.

At the project level, the same statistical treatment is provided for every function in any source file.

Changing static metric settings

You can edit the configuration settings for static metrics to specify how the source code statistics are generated.
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To change the static metric settings:

1. In the project explorer, right-click the project on which you want to change the settings and click Properties.
2. Click C/C++ Build > Settings and select Build Settings.
3. Expand Static metrics to access the runtime tracing settings and set the required options for dumping trace

data and drawing UML sequence diagrams.
One level metrics

By default, . met static metric files are produced for source files as well as all dependency files
that are found when parsing the source code. Set to Yes to restrict the calculation of static
metrics only to the source files displayed in the navigator.

Analyzed directories

This setting allows you to restrict the generation of . met metric files only to files which are

located in the specified directories.
Generate metrics in source directories

By default, all . net files are generated in the project directory, and use the same name as the
source file. Select Yes on this setting to compute metrics for source files that have the same
name but are located in different directories. In this case, each . net is generated in the source

directory of each file.
Additional options
Use this setting to specify extra command line options. In most cases, this should be empty.

4. Click OK, Apply the changes and close the Properties window.

Related information

Static metrics overview on page 107

Code review

Code review overview

Automated source code review is a method of analyzing code against a set of predefined rules to ensure that the
source adheres to guidelines and standards that are part of any efficient quality control strategy. HCL® OneTest™
Embedded provides an automated code review tool, which reports adherence to guidelines for your C source code.

HCL® OneTest™ Embedded code review tool implements rules from the MISRA-C: 2004 and MISRA C-: 2012
standards, which are guidelines for the use of the C language in critical systems.

Code review is part of the runtime analysis tools and can be enabled during a test run or in the project configuration

settings.
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When an application or test node is built, the source code is analyzed by the code review tool. Code review can be
performed each time a node is built, but can also be calculated without executing the application. The tool checks the
source file against the predefined rules and produces an HTML report and a .crc report.

Report

When the build is complete, the code review report lists the following elements:

- The Outline window displays a list of rules that were not compliant for each source file and function. You can
use the elements in this view to navigate through the report.

- A summary provides information about the general configuration, the date and the number of analyzed files. It
also lists the number of errors and warnings that were encountered.

« The code review report lists the rules for which errors or warnings were detected. It also provides information
about the location of the error. You can click the title to go directly to the corresponding line in the source
code.

Related reference
Code review MISRA 2004 rules on page 114
Related information

Enable runtime analysis tools on page 68

Configuring code review rules

The code review tool uses a set of predefined rules. You can select the default rule configuration file for the code
review tool. MISRA 2004 and MISRA 2012 from HCL OneTest™ Embedded V8.2.0 are the default installed rule
configuration files. You can disable or set the severity level to Warning. You can also configure the entry-point option if

your application is multi-threaded.

About this task

By default all rules are enabled and produce either an error or a warning in the code review report. You can

save multiple customized rule policies. The default rule policy files MISRA 2004 and MISRA 2012 are located

in:<i nstal |l ati on directory>/plugins/ Common/|ib/confrul e.xm . Do not modify the default rule
configuration files. The only change that can be done in the default rule configuration files is to change or disable the

severity level of the rule.

Note: For all new projects, you must select the configuration file that must be used. When you make any
changes to the rule policy file, you can save the new policy file in the project.
To select the configuration file and disable or set the severity level of code review rules:

1. In the project explorer, right-click the project on which you want to change the settings and click Properties.
2. Expand C/C++ Build in the left panel, select Settings.
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3. In the right panel, in the Build tab, expand Settings and select Code Review.
4. Expand Code review to access the code review settings.

(D Properties for myProject O *
type filter text sﬂtings =g - v
» Resource
~
Builders
« C/C++ Build Configuration: build [ Active ] ~ | Manage Configurations...

Build Variables

Environment - .
Build Artifact [} Binary Parsers @ Error Parsers Build TDP Build Settings 4 | *

Logging
Settings Enable HCL OneTest Embedded instrumentation.
Tool Chain Editor cetti ;
» CfC++ General = Gmgs | Name Value
Project Facets ener Rule configuration | confrule| . |_| X

+ Code coverage
» Memary Profiling
Application Profiling

Additional includ...
Review included .. Mo

Project References
Run/Debug Settings

Task Tags Include files
) g Performance Profiling . . I
» Validation . Display Errors/W... All
Coupling ) S
 Runtime tracing MNaming script file
Static rretrics Report Template
Code Review
et
:? Apply and Close Cancel

5. Click in the value on the Rule configuration row and click ... to select a rule configuration file.

Note: If your configuration file is an out-of-date version, you are prompted to update it. Click ok to
select the rules that are missing in your configuration file. The selected rules are added with their
default severity levels to your configuration file. Unselected rules are added to your configuration file

as disabled rules.

6. Select the default MISRA 2004 or MISRA 2012 rule configuration file that are installed with the product.
Alternatively, click + to select a new rule configuration in your browser.

7. Click OK.
Result
The path to the selected rule configuration is displayed in the value column on the Rule Configuration line.

8. On the Rule configuration row, click the to open the Rule Configuration window.
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B | Rule configuration X

DATESTRT\New folder\myProject\confrule_2012.xml

~ MISRA C:2012 ~ | MName
« 1- A standard C environment
Rule M1.1 (Errar)
Rule M1.1W (Error)

Rule M1.2 (Warning)
Rule E1.1 (Error) Functions should have less than S6param:’

Rule E1.2 (Error) parameters (current value : S%enamesc).

Rule E1.12

Description:

Rule E1.3 (Error) Severity

Rule E1.4 (Error) () Disable () Waming (@ Error
Rule E1.5 (Error) Parameter:

Rule E1.6 (Error)

Rule E1.7 (Error) Function number of parameters
Rule E1.8 (Error) I 5

Rule E1.9 (Error)

Rule E1.10 (Error)

Rule E1.11 (Error)

Rule E1.12 (Error)
~ 2- Unused code

] Only show the first occurrence for each file

Find next

Save & Close Cancel Save As..

9. In the Rule configuration window, select the rule that you want to configure.
Rules are grouped into categories. You can filter the rules by labels from the Find field. Search is not case
sensitive.
When a rule is selected, its description is displayed on the right panel with the parameter description and value
if any parameter is available for the selected rule.
10. On the right panel, select the severity level:

a. Disabled: The selected rule is ignored and is not displayed in the code review report.

b. Warning: When the rule condition is found, a warning is displayed in the code review report.
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c. Error: When the rule condition is found, an error is displayed in the code review report.

Note: Multiple user-custom rules (from Rule U99.1 to Rule U99.10) can be defined for MISRA
2004 and MISRA 2012 with their own severity level.

11. Select Show only the first occurrence to only show the first occurrence of a rule condition in a file. Any
subsequent occurrences of the condition are not reported.

Note: If your application is multi-threaded, you can provide the list of entry points to avoid that the
rules about 'non-used functions' are raised.

To configure the Multi_thread option, follow these steps:

12. In the Project Explorer, right-click the project on which you want to change the settings and click Properties.
13. Click C/C++ Build > Settings and select Build Settings.

14. In the right panel, click SettingsGeneral > Multi-Thread option.

15. Click ... in the value field of the Entry points option to open the editor.

16. In the editor, enter the list of entry points for each thread and click OK.

17. Click OK, Apply the changes and close the Properties window.

Note: The Entry point option applies to rule E16.50 (MISRA_2004) and M2.2.2 (MISRA 2012).

Related reference
Code review MISRA 2004 rules on page 114
Related information

Code review overview on page 109

Using a customized Naming script file

In HCL OneTest™ Embedded for Eclipse IDE, you can edit and customize a Perl Naming script file to check your own
naming rules (code custom naming rules U99.1). You must set the path to this customized naming script file in the

code review settings to check your naming rules.
To set the path to a customized Naming script file:

1. From the Project Explorer view, select the project node.

2. Right-click and select Properties.

3. In the window that opens, select Settings in the left panel.
4. In the right panel, click Settings > Code Review.

5. Click in Value cell of the Naming script file option and click ....
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6. Select the sample file that you installed: Example “NamingRules1.pl".
7. Click Apply.

Code review deviations

In some cases, it can be useful to temporarily ignore a rule non-compliance on a short portion of source code, while

documenting the reason why you are allowing this deviation.

About this task

You can justify why you are allowing the deviation in a text. The text is added to the non-compliance in the
source code. You can declare a deviation in the source code, for a specified number of lines and for the first or all
occurrences of the error, by adding pragma lines to your source code.

1. Open the source file in the Text editor and find the lines of code that you want the rule to ignore.
2. Before the section of code for which compliance to the rule should be ignored, add one of the following lines:

> To justify non-compliance of a rule to the following pragma statement in the first occurrence:
#pragma attol crc_justify (<rule>[,<lines>],"<text>")
» To justify non-compliance of a rule to the following pragma statement in all occurrences:
#pragma attol crc_justify_all (<rule>,<lines>,"<text>")
> To justify the first occurrence of non-compliance of a rule in all the files of the current project,
including in traps located before the pragma statement:

#pragma attol crc_justify_everywhere (<rule>,"<text>")

For all the pragma statements: <rule>
o <rul e> is the name of the code review rule (for example: 'Rule M8.5").
° <lines> is the number of lines.

o <t ext > is the reason why the rule is ignored.

The recommended usage for crc_j usti fy_everywhere is to create a specific source file containing only the list
of pragma statements and add this file to the project.

Code review MISRA 2004 rules

The code review tool covers rules from the lists the rules that produced and error or a warning. Each rule can be
individually disabled or assigned a Warning or Error severity by using the Rule configuration window. Some rules also
have parameters that can be changed. Among other guidelines, the code review tool implements most rules from the
MISRA-C:2004 standard, "Guidelines for the use of the C language in critical systems". These rules are referenced
with an M prefix. In addition to the industry standard rules, HCL OneTest™ Embedded provides some additional coding

guidelines, which are referenced with an E prefix.
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Code review MISRA-C: . L
Code review message Description
reference 2004 reference
Code compli-
ance
M1.1 Rule 1.1 ANSI C error: <error> All code shall conform to ISO 9899:1990
Required
M1.1w Rule 1.1 ANSI C warning: <warning>
Required
Language exten-
. Required
sions
M2.2 Rule 2.2 Source code shall only use /* ... | Source code shall only use /* ... */ style
*/ style comments comments
Required
M2.3 Rule 2.3 The character sequence /* shall | The character sequence /* shall not be
not be used within a comment used within a comment
Required
E2.3.1 The character sequence // should not be
used within a 'C-style' comment
Advisory
E2.3.2 Line-splicing shall not be used in // com-
ments
Advisory
E2.6 A function should not contain unused label
declarations
Advisory
E2.7 There should be no unused para- | Advisory
meters in functions
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Table 5. MISRA 2004 rules
(continued)

Code review MISRA-C: . L.
reference 2004 reference Code review message Description
E2.8 Macro %name% is never used
Advisory
E2.9 Type %name% is never used
Advisory
E2.10 Tag %name% is never used
Advisory
E2.50 Functions should have less than )
'100' lines. Note The number of Advisory
lines can be specified.
E2.51 Functions should have less than )
"15' V(g) complexity. Note: The Advisory
complexity limit of lines can be
specified.
E2.52 Functions should have less than
'‘%param%' lines, outside empty
lines (current value: %name%).
E2.53 Functions should have less than
‘%param%' lines, outside empty
lines or comment lines (current
value : %name%).
E2.54 Functions should have less than |Lines are not counted in the following cas-
‘%param%' lines, outside empty | es:
lines, comment lines or bracket
lines (current value : %name%). « If they contain spaces (including \t,
\r, \n),

« If they contain only brackets (there
might be several brackets on same
line),

« If they contain comments only, or
if they contain brackets and com-
ments only.
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(continued)
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Code review MISRA-C: . L.
Code review message Description
reference 2004 reference
E2.55 Compilation units should define
Optional
have less than '%param%' func- P
tions (current value : %name%). | Compilation unit max number of functions.
Default parameter value: 10.
E2.56 Optional
Compilation units should have
) o' :
less than ‘%param% functions Compilation unit max number of variables.
(current value: %name%).
Default parameter value: 10.
E2.57 Compilation unit should have
. o1 Optional
less than '%param% lines (cur-
rent value: %name%). Compilation unit max number of lines.
Default parameter value : 200.
E2.58 Compilation unit should have
. . Optional
less than '%param%' lines, not
counting empty lines (current val- | Compilation unit max number of lines.
ue : %name%).
Default parameter value : 200.
E2.59 Compilation unit should have
. o s Optional
less than '%param%' lines, not
Counting empty lines or com- Compilation unit max number of lines.
ments (current value: %name%).
Empty lines or comments (current value:
%name%) are not counted.
Default parameter value : 200.
E2.60 Compilation units should have
o ot 1 Optional
less than '%param%' lines, not
counting empty lines, com- Compilation unit max number of lines.
ments or brackets (current value:
%name%) are not counted. Empty lines, comments or brackets (current
value : %name%) are not counted.
Default parameter value : 200.
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Table 5. MISRA 2004 rules

(continued)
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Code review MISRA-C:
Code review message Description
reference 2004 reference
E2.61 Functions should have less than
'‘%param%' parameters (current
value: %name%).
Documentation
M3.4 Rule 3.4 All uses of the #pragma direc-
Required
tive shall be documented and ex- equire
plained.
Character sets
M4.1.1 Rule 4.1 Only escape sequences that are | Only escape sequences that are defined in
defined in the ISO C standard the ISO C standard shall be used
shall be used
Required
M4.1.2 Rule 4.1 Only ISO C escape sequences are | Only ISO C escape sequences are al-
allowed(\v) lowed(\v)
Required
M4.2 Rule 4.2 Trigraphs shall not be used Trigraphs shall not be used
Required
Identifiers
M5.1 Rule 5.1 Identifiers %name% and %name | Identifiers (internal and external) shall not
% are identical in the first <value> | rely on the significance of more than 31
characters. The number of char- | characters
acters can be specified.
Required
ES5.1.1 Identifiers %name% and %name%
. Advisory
are ambiguous because of pos-
sible character confusion. Note
that you can change parameters
for ambiguous characters.
E5.1.2 Possible typing mistakes be-
. Advisory
tween the variables %name% or




Table 5. MISRA 2004 rules

(continued)

Chapter 5. Test Execution Specialist Guide

Code review MISRA-C: . L.
Code review message Description
reference 2004 reference
%name% because of repeating
character.
E5.1.3 Identifiers %name% and %name%
. L Advisor
are identical in the first %param% y
characters ignoring case
E5.1.4 Macros %name% and %name%
. s Advisor
are identical in the first %param% y
characters
E5.1.5 Macro %name% and identifier
. L Advisor
%name% are identical in the first y
%param% characters
E5.1.6 Macros %name% and %name%
. L Advisor
are identical in the first %param% y
characters ignoring case
ES5.1.7 Macro %name% and identifier
. L Advisor
%name% are identical in the first y
%param% characters ignoring
case
M5.2 Rule 5.2 Identifier %name% in an inner Identifiers in an inner scope shall not use
scope hides the same identifier |the same name as an identifier in an outer
in an outer scope : %location% scope, and therefore hide that identifier
Required
ES5.3 The tag name %name% should
Advisor
not be reused. Name already y
found in %location%
M5.3.1 Rule 5.3 The typedef name %name% should not be

reused except for its tag. Name already

found in %location%

Required
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Table 5. MISRA 2004 rules

(continued)

Code review MISRA-C:
Code review message Description
reference 2004 reference
M5.3.2 Rule 5.3 The typedef name '‘%name%' should not be
reused even for its tag. Name already found
in %location%
Required
M5.4 Rule 5.4 A struct and union cannot use A tag name shall be a unique identifier
the same tag name
Required
M5.5 Rule 5.5 The static object or function No object or function identifier with static
%name% should not be reused. | storage duration should be reused
Static object or function already
. . Advisory
found in %location%.
M5.6 Rule 5.6 No identifier in one name space should
Avoid using the same identifier . . e
have the same spelling as an identifier in
%name% in two different name . .
another name space, with the exception of
spaces. Identifier already found .
structure and union member names
in %location%
Advisory
M5.7 Rule 5.7 The identifier %name% should
. Advisor
not be reused. Identifier already y
found in %location%.
Types
M6.1.1 Rule 6.1 The C language plain char type | The C language plain char type should only
should only be used for character | be used for character values.
values.
Required
M6.1.2 Rule 6.1 Case char value is applicable on-
. . . | Required
ly if the switch statement value is
plain character variable
M6.1.3 Rule 6.1 Avoid using comparison opera- | Required
tors on plain char.
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Code review MISRA-C:
Code review message Description
reference 2004 reference
M6.2 Rule 6.2 The C language signed char or The C language signed char or unsigned
unsigned char types should only | char types should only be used for numeric
be used for numeric values. values.
Required
M6.3 Rule 6.3 The C language numeric type typedefs that indicate size and signedness
%name% should not be used di- | should be used in place of the basic types
rectly but instead used to define
Advisory
typedef.
E6.3 The implicit 'int' type should not | Required
be used.
M6.4.1 Rule 6.4 Bit fields should only be of type | Required
‘unsigned int' or 'signed int'.
M6.4.2 Rule 6.4 Bit fields should not be of type Required
‘'enum'
M6.4.3 Rule 6.4 Bit fields should only be of explic- | Required
itly signed or unsigned type
M6.4.4 Rule 6.4 Bit fields should not be of type Required
'bool' under c99
M6.4.5 Rule 6.4 Bit fields should not be of type Required
'boolean’ outside c99
M6.5 Rule 6.5 Bit fields of type 'signed int' must | Required
be at least 2 bits long.
Constants
M7.1 Rule 7.1 Octal constants and escape se- | Octal constants (other than zero) and octal
guences should not be used. escape sequences shall not be used
Required
E7.1 Octal and hexadecimal escape
. Required
sequences shall be terminated
E7.2 The lowercase character 'I' shall
. . ) Required
not be used in a literal suffix
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Table 5. MISRA 2004 rules

(continued)

Code review MISRA-C:
Code review message Description
reference 2004 reference
E7.3 A string literal shall not be as-
. . Required
signed to an object unless the
object's type is pointer to a con-
st-qualified char
Declarations
and definitions
M8.1.1 Rule 8.1 A prototype for the function Functions shall have prototype declarations
%name% should be declared be- | and the prototype shall be visible at both
fore defining the function. the function definition and call
Required
E8.1.1 A prototype for the global object |Required
%name% should be declared be-
fore defining the object
M8.1.2 Rule 8.1 A prototype for the function Functions shall have prototype declarations
%name% should be declared be- |and the prototype shall be visible at both
fore calling the function. the function definition and call
Required
M8.1.3 Rule 8.1 A prototype for the function
Required
%name% should be declared be- equire
fore calling the function
M8.2.1 Rule 8.2 The type of %name% should be [ Whenever an object or function is declared
explicitly stated. or defined, its type shall be explicitly stated
Required
M8.2.2 Rule 8.2 The type of parameter %name%
Required
should be explicitly stated equire
M8.3 Rule 8.3 Parameters and return types For each function parameter the type giv-
should use the same type names | en in the declaration and definition shall be
in the declaration and in the defi- |identical, and the return types shall also be
nition, even if basic types are the |identical
same.
Required
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Code review MISRA-C:
Code review message Description
reference 2004 reference

E8.3 Parameters and return types Required
should use compatible type in
the declaration and in the defini-
tion

M8.4 Rule 8.4 If objects or functions are de- Required
clared multiple times their types
should be compatible.

M8.5.1 Rule 8.5 The body of function %name% Required
should not be located in a header
file.

E.8.50 Use the const qualification for Required
variable %name% which is point-
er and which is not used to
change the pointed object

E.8.51 The object %name% is never ref- | Required
erenced

M8.5.2 Rule 8.5 The memory storage (definition) | Objects shall be defined at block scope if
for the variable %name% should [they are only accessed from within a single
not be in a header file. function.

Required

M8.6 Rule 8.6 Functions should not be declared

Required
at block scope.

M8.7 Rule 8.7 Global objects should not be de- | Objects shall be defined at block scope if
clared if they are only used from | they are only accessed from within a single
within a single function. function

Required

M8.8.2 Rule 8.8 Static function %name% should o
only be declared in a single file. Require
Redundant declaration found at:

%location%
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Table 5. MISRA 2004 rules

(continued)
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Code review MISRA-C: . L.
reference 2004 reference Code review message Description

M8.8.3 Rule 8.8 Static object %name% should on- )
ly be declared in a single file. Re- Required
dundant declaration found at:

%location%

M8.8.4 Rule 8.8 Identifiers %name% that declare
objects or functions with external Required
linkage shall be declared once in
one and only one file

M8.8.5 Rule 8.8 Identifiers %name% that declare
objects or functions with external Required
linkage shall be unique

M8.9.1 Rule 8.9 The global object or function An identifier with external linkage shall
%name% should have exactly one | have exactly one external definition
external definition. Redundant
definition found in %location%

M8.9.2 Rule 8.9 The global object or function Required
%name% should have exactly one
external definition. No definition
found.

M8.10.1 Rule 8.10 Global object %name% that are | All declarations and definitions of objects
only used within the same file or functions at file scope shall have internal
should be declared using the sta- | linkage unless external linkage is required.
tic storage-class specifier.

Required

M8.10.2 Rule 8.10 Global function %name% that are | All declarations and definitions of objects
only used within the same file or functions at file scope shall have internal
should be declared using the sta- | linkage unless external linkage is required
tic storage-class specifier.

Required

M8.11 Rule 8.11 Global objects or functions that | The static storage class specifier shall be
are only used within the same file | used in definitions and declarations of ob-
should be declared with using jects and functions that have internal link-
the static storage-class specifier. | age
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Code review MISRA-C:
Code review message Description
reference 2004 reference
Required
M8.12 Rule 8.12 When a global array variable can | Required
be used from multiple files, its
size should be defined at initial-
ization time.
E.8.14 Inline function %name% should | Required
be static
Initialization The restrict type qualifier shall Required
not be used
M9.1 Rule 9.1 Variables with automatic storage | Required
duration should be initialized be-
fore being used.
M9.2 Rule 9.2 Nested braces should be used to | Required
initialize nested multi-dimension
arrays and nested structures.
E9.2 Arrays shall not be partially ini- Required
tialized
M9.3 Rule 9.3 Either all members or only the In an enumerator list, the “=" construct shall
first member of an enumerator not be used to explicitly initialize members
list should be initialized. other than the first, unless all items are ex-
plicitly initialized
Required
M9.3 Rule 9.3 Either all members or only the Required
first member of an enumerator
list should be initialized
E9.3 Rule E9.3 Enumeration member %name% | Required
have a not unique implicitly spec-
ified value
E9.4 The global variable %name% is Required
not initialized
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Table 5. MISRA 2004 rules

(continued)

conversions

Code review MISRA-C:
Code review message Description
reference 2004 reference
Arithmetic type

expression is not allowed. Only
constant expressions can be im-
plicitly converted and only to a
wider floating type of the same

signedness.

E10.1 Constraint violation : can't use Required
floating type as operand of '[], %,
<<, >3 ~ & N

M10.1.1 Rule 10.1 Implicit conversion of a complex | The value of an expression of integer type
integer expression to a smaller shall not be implicitly converted to a differ-
sized integer is not allowed. ent underlying type if:

+ a) itis not a conversion to a wider
integer type of the same signed-
ness, or

« b) the expression is complex, or

« ¢) the expression is not constant
and is a function argument, or

« d) the expression is not constant
and is a return expression.

Required
M10.1.2 Rule 10.1 Implicit conversion of an integer | Required
expression to a different signed-
ness is not allowed.
M10.2 Rule 10.2 Conversion of a complex floating | The value of an expression of floating type

shall not be implicitly converted to a differ-

ent type if:

« a) it is not a conversion to a wider
floating type, or

« b) the expression is complex, or

« c) the expression is a function argu-
ment, or

« d) the expression is a return expres-

sion.

Required
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Code review MISRA-C:
Code review message Description
reference 2004 reference
E10.2 Operand should be boolean. Required
M10.3 Rule 10.3 Type cast of complex integer The value of a complex expression of inte-
expressions is only allowed in- ger type may only be cast to a type that is
to a narrower type of the same narrower and of the same signedness as
signedness. the underlying type of the expression
Required
E10.3 Can't use a boolean as a numeric | Required
value
M10.4 Rule 10.4 Type cast of complex floating The value of a complex expression of float-
expressions is only allowed in- ing type may only be cast to a narrower
to a narrower type of the same floating type
signedness.
Required
E10.4 Can't use a char as a numeric val- | Required
ue
M10.5 Rule 10.5 When using operator '~' or '<<' on | Required
‘unsigned char' or 'unsigned int',
you should always cast returned
value
E10.5 Rule E10.5 Can't use a not anonymous enum | Required
as a numeric value
M10.6 Rule 10.6 Definitions of unsigned type con- | A “U" suffix shall be applied to all constants
stants should use the 'U' suffix. | of unsigned type
Required
E10.6 Shift and bitwise operations Required
should be performed on un-
signed value
E10.7 Right hand operand of shift oper- | Required
ation should be an unsigned val-
ue
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Table 5. MISRA 2004 rules

(continued)

Code review

reference

MISRA-C:

2004 reference

Code review message

Description

E10.8

Unary minus operation should
not be performed on unsigned

value

Required

E10.9

Expressions of essentially char-
acter type shall not be used inap-
propriately in addition and sub-
traction operations

Required

E10.10

The value of an expression shall
not be assigned to an object with

a narrower essential type

Required

E10.11

The value of an expression shall
not be assigned to an object with

a different essential type catego-

ry

Required

E10.12

Both operands of an operator in
which the usual arithmetic con-
versions are performed shall
have the same essential type cat-
egory

Required

E10.13

The value of an expression
should not be cast to an inappro-

priate essential type

Required

E10.14

The value of a composite expres-
sion shall not be assigned to an

object with wider essential type

Required

E10.15

If a composite expression is
used as one operand of an opera-
tion in which the usual arithmetic
conversions are performed then
the other operand shall not have

wider essential type

Required

E10.16

The value of a composite expres-
sion shall not be cast to a differ-

Required
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Code review

reference

MISRA-C:

2004 reference

Code review message

Description

ent essential type category or a

wider essential type

Pointer type

conversions

between pointer to object and a

non-integer arithmetic type

M11.1 Rule 11.1 A function pointer should not Conversions shall not be performed be-
be converted to another type of | tween a pointer to a function and any type
pointer. other than an integral type

Required

E11.1 Conversions shall not be per- Required
formed between a pointer to an
incomplete type and any other
type

M11.2 Rule 11.2 An object pointer should not be [ Conversions shall not be performed be-
converted to another type of tween a pointer to object and any type oth-
pointer. er than an integral type, another pointer to

object type or a pointer to void
Required

E11.2 A conversion should not be per- | Required
formed from pointer to void into
pointer to object

M11.3 Rule 11.3 Casting a pointer type to an inte- | A cast should not be performed between a
ger type should not occur. pointer type and an integral type

Advisory

E11.3 E11.3 A cast shall not be performed Required
between pointer to void and an
arithmetic type

E11.4 A cast shall not be performed Required
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Table 5. MISRA 2004 rules

(continued)

side effect should not be used in
the right-hand operand of a logi-
cal && or || operator.

130

Code review MISRA-C:
Code review message Description
reference 2004 reference

M11.4.1 Rule 11.4 Casting an object pointer type A cast should not be performed between a
to a different object pointer type | pointer to object type and a different point-
should not occur. er to object type

Advisory

M11.4.2 Rule 11.4 Casting an object pointer type Advisory
to a different object pointer type
should not occur, especially
when object sizes are not the
same.

M11.5 Rule 11.5 Casting of pointers to a type that | A cast shall not be performed that removes
removes any const or volatile any const or volatile qualification from the
qualification on the pointed ob- | type addressed by a pointer.
ject should not occur.

Required

Expressions

M12.1 Rule 12.1 Implicit operator precedence Limited dependence should be placed on
may cause ambiguity. Use paren- | C's operator precedence rules in expres-
thesis to clarify this expression. |sions

Advisory

E12.11 Implicit bitwise operator prece- | Advisory
dence may cause ambiguity. Use
parenthesis to clarify this expres-
sion.

M12.3 Rule 12.3 The sizeof operator should not Required
be used on expressions that con-
tain side effects.

M12.4.1 Rule 12.4 An expression that contains a The right-hand operand of a logical && or ||

operator shall not contain side effects

Required
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Code review MISRA-C:
Code review message Description
reference 2004 reference
M12.4.2 Rule 12.4 The function in the right-hand
operand of a logical && or || oper-
ator might cause side effects.
M12.5 Rule 12.5 Parenthesis should be used Required
around expressions that are
operands of a logical && or [|.
E12.51 Ternary expression ?: should not | Advisory
be used.
E12.54 Expressions should not cause a | Advisory
side effect assignment.
M12.6 Rule 12.6 Only Boolean operands should be | The operands of logical operators (&8, ||
used with logical operators ( &&, |and!) should be effectively Boolean. Ex-
[l and !). pressions that are effectively Boolean
should not be used as operands to opera-
tors other than (&&, || and !)
Advisory
E12.61 The operator on a Boolean ex- Advisory
pression should be a logical op-
erator ( &amp;&amp;, || or !).
M12.7 Rule 12.7 Bitwise operators should only Bitwise operators shall not be applied to
use unsigned operands. operands whose underlying type is signed
Required
M12.8 Rule 12.8 The right-hand operand of a shift | The right-hand operand of a shift operator
operator should not be too big or | shall lie between zero and one less than the
negative. width in bits of the underlying type of the
left-hand operand
Required
M12.9 Rule 12.9 Only use unary minus operators | The unary minus operator shall not be ap-
with signed expressions. plied to an expression whose underlying
type is unsigned
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Table 5. MISRA 2004 rules

(continued)

tor should not be used in float-

ing-point expressions.

Code review MISRA-C:
Code review message Description
reference 2004 reference
Required
M12.10 Rule 12.10 Do not use the comma operator | Required
M12.12 Rule12.12
Advisory
Parenthesis should be used around expres-
sion that is operand of 'sizeof' operator.
M12.13 Rule 12.13 The increment (++) or the decre- | Advisory
ment () operators should not be
used with other operators in an
expression.
Control state-
ment expres-
sions
E13.1 The result of an assignment op- | Required
erator should not be used in an
expression
M13.1.1 Rule 13.1 Boolean expressions should not [ Assignment operators shall not be used in
contain assignment operators. expressions that yield a Boolean value
Required
M13.1.2 Rule 13.1 Boolean expressions should not | Required
contain side effect operators.
M13.2 Rule 13.2 Non-Boolean values that are test- | Tests of a value against zero should be
ed against zero should have an | made explicit, unless the operand is effec-
explicit test tively Boolean
Advisory
M13.3 Rule 13.3 The equal or not equal opera- Floating-point expressions shall not be test-

ed for equality or inequality

Required
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Code review MISRA-C:
Code review message Description
reference 2004 reference

M13.4 Rule 13.4 Floating-point variables should Required
not be used to control a for state-
ment.

M13.5.1 Rule 13.5 Only loop counter should be ini-

. o The three expressions of a statement shall
tialized in a loop initialization
be concerned with loop control only.
part.
Required

M13.5.2 Rule 13.5 Required
In the 'update part' of a 'for state-
ment', only 'loop counter' should
be updated

M13.5.3 Rule 13.5 There should be one and only Required
one loop counter for loop state-
ment.

M13.6 Rule 13.6 Loop counter of a 'for statement' | Required
should not be modified within the
body of the loop.

M13.7 Rule 13.7 Invariant Boolean expressions Boolean operations whose results are in-
should not be used. variant shall not be permitted

Required

Control flow

M14.1 Rule 14.1 Unreachable code. Required

M14.2 Rule 14.2 A non-null statement should ei- | Required
ther have a side effect or change
the control flow.

M14.3 Rule 14.3 A null statement in original Before preprocessing, a null statement
source code should be on a sep- | shall only occur on a line by itself; it may be
arate line and the semicolon followed by a comment provided that the
should be followed by at least first character following the null statement
one white space and then a com- | is a white-space character
ment.

Required
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Table 5. MISRA 2004 rules

(continued)

Code review MISRA-C:
Code review message Description
reference 2004 reference

M14.4 Rule 14.4 Do not use the goto statement. Required

E14.4.1 The goto statement shall jump to | Required
a label declared later in the same
function

E14.4.2 Any label referenced by a goto Required
statement shall be declared in
the same block, or in any block
enclosing the goto statement

E14.4.3 There should be no more than Required
one break or goto statement
used to terminate any iteration
statement

M14.5 Rule 14.5 Do not use the continue state- Required
ment.

M14.6 Rule 14.6 Only one break statement should | For any iteration statement there shall be
be used within a loop. at most one break statement used for loop

termination
Required

M14.7.1 Rule 14.7 Only one exit point should be de- | A function shall have a single point of exit

fined in a function. at the end of the function
Required

M14.7.2 Rule 14.7 The return keyword should not be | Required
used in a conditional block.

M14.8.1 Rule 14.8 The switch statement should be | The statement forming the body of a
followed by a compound state- switch, while, do ... while or for statement
ment {}. shall be a compound statement

M14.8.2 Rule 14.8 The while statement should be | Required
followed by a compound state-
ment {}.
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not have side effects.

Code review MISRA-C:
Code review message Description
reference 2004 reference

M14.8.3 Rule 14.8 The do..while statement should
contain a compound statement
{.

M14.8.4 Rule 14.8 The for statement should be fol-
lowed by a compound statement
{.

M14.9.1 Rule 14.9 The if (expression) construct An if (expression) construct shall be fol-
should be followed by a com- lowed by a compound statement. The else
pound statement {}. keyword shall be followed by either a com-

her if

M14.9.2 Rule 14.9 The else keyword should be fol- pound statement, or another if statement
lowed by either a compound Required
statement or another if state-
ment.

M14.9.3 Rule 14.9 The else keyword should be fol-
lowed by a compound statement

M14.10 Rule 14.10 Allif ... else if sequences should | Allif ... else if constructs shall be terminat-
have an else block. ed with an else clause

Required

Switch state-

ments

M15.0 Rule 15.0 A switch block should start with | The MISRA C switch syntax shall be used
acase.

Required

M15.1 Rule 15.1 A case or default statements A switch label shall only be used when the
should only be used directly most closely-enclosing compound state-
within the compound block of a [ ment is the body of a switch statement
switch statement.

Required

E15.10 The switch expression should Required
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Table 5. MISRA 2004 rules

(continued)

Code review MISRA-C:
Code review message Description
reference 2004 reference
M15.2 Rule 15.2 The break statement should only | An unconditional break statement shall ter-
be used to terminate every non- | minate every non-empty switch clause
empty switch block.
Required
M15.3.1 Rule 15.3 The switch statement should Required
have a default clause.
M15.3.2 Rule 15.3 The default clause should be the
last clause of the switch state-
ment.
M15.4.1 Rule 15.4 A Boolean should not be used as | A switch expression shall not represent a
a switch expression. value that is effectively Boolean
Required
M15.4.2 Rule 15.4 A constant should not be used as | Required
a switch expression.
M15.5 Rule 15.5 At least one case should be de- [ Every switch statement shall have at least
fined in the switch. one case clause
Required
Functions
M16.1 Rule 16.1 The function %name% should not | Functions shall not be defined with a vari-
have a variable number of argu- | able number of arguments
ments.
Required
Rule M16.1.2 Rule 16.1 The library functions 'va_list, va_- | Required
arg, va_start, va_end, va_copy'
should not be used
M16.2.1 Rule 16.2 Recursive functions are not al- Functions shall not call themselves, either
lowed. The function %name% is | directly or indirectly Functions shall not call
directly recursive. themselves, either directly or indirectly
M16.2.2 Rule 16.2 Recursive functions are not al- Required
lowed. The function %name% is
recursive when calling %name% .
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Code review MISRA-C:
Code review message Description
reference 2004 reference

M16.3 Rule 16.3 The function prototype should Identifiers shall be given for all of the para-
name all its parameters. meters in a function prototype declaration

Required

M16.4 Rule 16.4 The identifiers used in the proto- | Required
type and definition should be the
same.

M16.5 Rule 16.5 Functions with no parameters Required
should use the void type.

E16.50 The function %name% is never Required
referenced.

M16.6 Rule 16.6 The number of arguments used | Required
in the call does not match the
number declared in the proto-
type.

M16.7 Rule 16.7 Use the const qualification for A pointer parameter in a function prototype
parameter %name% which is should be declared as pointer to const if
pointer and which is not used to | the pointer is not used to modify the ad-
change the pointed object. dressed object

Required

M16.8 Rule 16.8 The return should always be de- | All exit paths from a function with non-
fined with an expression for non- | void return type shall have an explicit return
void functions. statement with an expression

Required

M16.9 Rule 16.9 Function identifiers should al- A function identifier shall only be used with
ways use a parenthesis or a pre- | either a preceding &, or with a parenthe-
ceding &. sized parameter list, which may be empty

Required

M16.10 Rule 16.10 When a function returns a value, [ If a function returns error information, then

this value should be used. that error information shall be tested
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Table 5. MISRA 2004 rules

(continued)

Code review

reference

MISRA-C:
2004 reference

Code review message

Description

Required

Pointers and ar-

comments may occur before the

#include statements.

rays
M17.4 Rule 17.4 Pointer arithmetic except array | Array indexing shall be the only allowed
indexing should not be used. form of pointer arithmetic
Required
M17.5 Rule 17.5 A declaration should not use Advisory
more than two levels of pointer
indirection.
Structures and
unions
M18.1 Rule 18.1 Structure or union types should | Required
be finalized before the end of the
compilation units.
E18.1 Flexible arrays members shall Required
not be declared
18.2 Variable-length array types shall | Required
not be used
E18.3 The declaration of an array para- | Required
meter shall not contain the static
keyword between the [|
M18.4 Rule 18.4 Do not use unions. Required
Preprocessing
directives
M19.1 Rule 19.1 Only preprocessor directives or | #include statements in a file should only be

preceded by other preprocessor directives

or comments

Advisory
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Code review MISRA-C:
Code review message Description
reference 2004 reference
M19.2 Rule 19.2 Do not use non-standard charac- | Advisory
ters in included file names.
M19.3 Rule 19.3 Filenames with the #include di- | Required
rective should always use the
<filename> or "filename" syntax.
M19.4 Rule 19.4 A C macro should only be ex- Required
panded to a constant, a braced
initializer, a parenthesised ex-
pression, a storage class key-
word, a type qualifier, or a do-
while-zero block.
M19.5 Rule 19.5 Macro definitions or #undef Required
should not be located within a
block.
M19.6 Rule 19.6 Do not use the #undef directive. | Required
M19.7 Rule 19.7 Function should be used instead | Advisory
of macros when possible.
M19.8 Rule 19.8 Missing argument when calling [ A function-like macro shall not be invoked
the macro. without all of its arguments.
Required
M19.9 Rule 19.9 The preprocessing directive Arguments to a function-like macro shall
%name% should not be used as | not contain tokens that look like prepro-
argument to the macro. cessing directives
Required
M19.10 Rule 19.10 The parameter %name% in the In the definition of a function-like macro
macro should be enclosed in each instance of a parameter shall be en-
parentheses except when it is closed in parentheses unless it is used as
used as the operand of # or ##. |the operand of # or ##
Required
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(continued)

Code review MISRA-C:
Code review message Description
reference 2004 reference

M19.11 Rule 19.11 Undefined macro identifier in the | All macro identifiers in preprocessor direc-
preprocessor directive. tives shall be defined before use, except in

#ifdef and #ifndef preprocessor directives
and the defined() operator
Required

M19.12 Rule 19.12 The # or ## preprocessor opera- | There shall be at most one occurrence of
tor should not be used more than | the # or # preprocessor operators in a sin-
once. gle macro definition

Required

M19.13 Rule 19.13 The # and ## preprocessor oper- | Advisory
ator should be avoided.

M19.14 Rule 19.14 Only use the 'defined’ preproces- | The defined preprocessor operator shall
sor operator with a single identifi- | only be used in one of the two standard
er. forms

Required

M19.15 Rule 19.15 Header file contents should be Precautions shall be taken in order to pre-
protected against multiple inclu- | vent the contents of a header file being in-
sions cluded twice

Required

M19.16 Rule 19.16 Possible bad syntax in prepro- Preprocessing directives shall be syntac-

cessing directive. tically meaningful even when excluded by
the preprocessor
Required

M19.17 Rule 19.17 A #if, #ifdef, #else, #elif or #endif | All #else, #elif and #endif preprocessor di-
preprocessor directive has been | rectives shall reside in the same file as the
found without its matching direc- | #if or #ifdef directive to which they are re-
tive in the same file. lated

Required
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Code review

reference

MISRA-C:

2004 reference

Code review message

Description

E19.18

The controlling expression of a
#if or #elif preprocessing direc-

tive shall evaluateto 0 or 1

Required

E19.19

A macro parameter immediately
following a # operator shall not
immediately be followed by a ##
operator

Required

E19.20

Macro parameter %name% used
as an operand to the # and ##
operators shall not be used else-

where in this macro

Required

Standard li-

braries

M20.1

Rule 20.1

%name% should not be defined,
redefined or undefined.

Reserved identifiers, macros and functions

in the standard library, shall not be defined,

redefined or undefined

Required

E20.1

A macro shall not be defined with
the same name as a keyword:

%name%

Required

M20.2.1

#define and #undef shall not be
used on a reserved identifier or
reserved macro name: Identifier
%name% already found in %name
%

Required

M20.2.2

Rule 20.2

#define and #undef shall not be
used on identifier beginning with
an underscore or on 'defined’ key-

word: %name%

Required

M20.2.3

Rule 20.2

Declared identifier should not be

a reserved identifier or reserved

Required
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Code review MISRA-C:
Code review message Description
reference 2004 reference
macro name: Identifier %name%
already found in %name%
M20.2.4 Rule 20.2 Declared identifier should not be- | Required
gin with an underscore or be 'de-
fined' keyword: %name%
M20.4 Rule 20.4 This precludes the use of the functions cal-
Dynamic heap memory allocation
y ! P y ! loc, malloc, realloc free and strdup. There
shall not be used. . . )
is a whole range of unspecified, undefined
and implementation-defined behaviour as-
sociated with dynamic memory allocation,
as well as a number of other potential pit-
falls. Dynamic heap memory allocation may
lead to memory leaks, data inconsistency,
memory exhaustion, non-deterministic.
Note that some implementations may use
dynamic heap memory allocation to imple-
ment other functions (for example func-
tions in the library string.h). If this is the
case then these functions shall also be
avoided.
Required
M20.5 Rule 20.5

The error indicator errno shall not

be used.

errno is a facility of C, which in theory
should be useful, but which in practice is
poorly defined by the standard. A non zero
value may or may not indicate that a prob-
lem has occurred; as a result it shall not be
used. Even for those functions for which
the behaviour of errno is well defined, it is
preferable to check the values of inputs be-
fore calling the function rather than rely on

using errno to trap errors (see Rule 16.10).

Required
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Code review MISRA-C:
Code review message Description
reference 2004 reference
M20.6 Rule 20.6 The macro offsetof, in library
Use of this macro can lead to undefined be-
<stddef.h>, shall not be used.
haviour when the types of the operands are
incompatible or when bit fields are used.
Required
M20.7 Rule 20.7 The setjmp macro and the
. . etjmp and longjmp allow the normal func-
longjmp function shall not be
used tion call mechanisms to be bypassed, and
' shall not be used.
Remark : sigsetjmp and siglongjmp (Gnu Li-
brary) are also detected
Required
E20.7 The standard header file <setjm- | Required
p.h> shall not be used
M20.8 Rule 20.8
The signal handling facilities of [ Signal handling contains implementa-
<signal.h> shall not be used. tion-defined and undefined behavior.
Required
M20.9 Rule 20.9
The input/output library <stdio.h> [ This includes file and 1/0 functions fgetpos,
shall not be used in production fopen, ftell, gets, perror, remove, rename,
code. and ungetc.
Streams and file I/0 have a large number
of unspecified, undefined and implemen-
tation-defined behaviours associated with
them. It is assumed within this document
that they will not normally be needed in pro-
duction code in embedded systems.
If any of the features of stdio.h need to be
used in production code, then the issues
associated with the feature need to be un-
derstood.
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Code review MISRA-C:
Code review message Description
reference 2004 reference
Required
M20.10 Rule 20.10
The library functions atof, atoi These functions have undefined behavior
and atol from library <stdlib.h> associated with them when the string can-
shall not be used. not be converted.
Required
M20.11 Rule 20.11
The library functions abort, exit, | These functions will not normally be re-
getenv and system from library | quired in an embedded system, which does
<stdlib.h> shall not be used. not normally need to communicate with an
environment
Then, it is essential to check on the imple-
mentation-defined behavior of the function
in the environment.
Required
E20.11 The library macro or function Required
'bsearch, gsort' should not be
used
M20.12 Rule 20.12
The time handling functions of li- [ Includes time, strftime. This library is asso-
brary <time.h> shall not be used. | ciated with clock times. Various aspects
are implementation dependent or unspeci-
fied, such as the format of times. If any of
the facilities of time.h are used, then the ex-
act implementation for the compiler being
used must be determined, and a deviation
being raised.
Required
E20.12 The input/output library Required
<wchar.h> shall not be used in
production code
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Code review MISRA-C:
Code review message Description
reference 2004 reference

E20.13 The standard header file <tg- Required
math.h> shall not be used

E20.14 The library macro or function Required
‘feclearexcept, fegetexceptflag,
feraiseexcept, fesetexceptflag,
fetestexcept, FE_LINEXACT, FE_-
DIVBYZERO, FE_UNDERFLOW,
FE_OVERFLOW, FE_INVALID, FE_-
ALL_EXCEPT' should not be used

Rule U99.1 Warning You can customize this rule in the confrule

Rule U99.2 Error file

Rule U99.3 Warning

Rule U99.4 Error

Rule U99.5 Warning

Rule U99.6 Error

Rule U99.7 Warning

Rule U99.8 Error

Rule U99.9 Warning

Rule U99.10 Error

Note: Applies to HCL OneTest™ Embedded Studio only:

The code review references in bold in this table are disabled when they are run from the code review link

checker in test mode. To verify these rules, you must run the code review from the application node in HCL

OneTest™ Embedded Studio. For more information, see Running complete verification of MISRA rules from an

application node on page 328.

Code review MISRA 2012 rules

The code review tool covers rules from the lists the rules that produced and error or a warning. Each rule can be

individually disabled or assigned a Warning or Error severity by using the Rule configuration window. Some rules also

have parameters that can be changed. Among other guidelines, the code review tool implements most rules from the
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MISRA-C:2012 standard, "Guidelines for the use of the C language in critical systems". These rules are referenced
with an M prefix. In addition to the industry standard rules, HCL OneTest™ Embedded provides some additional coding
guidelines, which are referenced with an E prefix.

Code Review - MISRA 2012 rules

D is set for Decidable, U for Undecidable.

Code review o
Type D/U Description Level
reference

M1.1 Error D ANSI C error: %name Required
%

M1.1W Error D ANSI C warning: Required

%name%

M1.2 Error U Use of #pragma Advisory
%name% should al-
ways be encapsulat-

ed and documented

E1.1 Error D Function max number Required

of line
E1.2 Error D Function max V(g) Required

E1.3 Functions should
have less than
‘%param%' lines, out-
side empty lines (cur-

rent value: %name%).

E1.4 Functions should
have less than
‘%param%' lines, out-
side empty lines or
comment lines (cur-

rent value : %name%).

E1.5 Functions should
have less than
‘%param%' lines, out-
side empty lines,
comment lines or
bracket lines (current

value : %name%).
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E1.6

E1.7

Code review o
reference Type D/U Description
Lines are not counted
in the following cas-
es:

- If they contain
spaces (in-
cluding \t, \r,
\n),

- If they contain
only brackets
(there might
be several
brackets on
same line),

« If they contain
comments on-
ly, or if they
contain brack-
ets and com-
ments only.

Optional

Compilation units
should define less
than '%param%' func-
tions (current value:
%name%).

Default parameter
value: 10.

Optional

Compilation units
should define less
than '%param%' vari-
ables (current value:

%name%).

Level
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Code review

reference

E1.8

E1.9

E1.10

Type

D/U

Description

Default parameter
value: 10.

Optional

Compilation units
should have less than
'‘%param%' lines (cur-

rent value: %name%).

Default parameter
value : 200.

Optional

Compilation unit
should have less
than '%param%' lines,
not counting empty
lines (current value :

%name%).

Empty lines (current
value : %name%) are

not counted.

Default parameter
value : 200.

Optional

Compilation unit
should have less than
‘%param%' lines not
counting empty lines
or comments (current

value : %name%).

Empty lines or com-
ments (current val-
ue : %name%) are not

counted.

Level
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Code review o
Type D/U Description Level
reference

Default parameter
value : 200.

E1.11
Optional

Compilation unit
should have less than
‘%param%' lines not
counting empty lines,
comments or brack-
ets (current value:

%name%).

Empty lines, com-
ments or brack-
ets (current value :
%name%) are not

counted.

Default parameter
value : 200.

E1.12 Functions should
have less than
‘%param%' parame-
ters (current value :

%name%).

M2.1 Error U a project shall not Required
contain unreachable

code

M2.2.1 Error U A non-null statement Required
should either have a
side effect or change

the control flow

M2.2.2 Error u The function %name  Required

% is never referenced

M2.2.3 Error D The object %name%  Required

is never referenced
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Code review

reference

M2.3

M2.4

M2.5

M2.6

M2.7

M3.1.1

M3.1.2

M3.2

E3.1

M4.1

150

Type

Warning

Warning

Warning

Warning

Warning

Error

Error

Error

Error

Error

D/U

Description

Type %name% is nev-

er used

Tag %name% is never

used

Macro %name% is

never used

A function should not
contain unused label
declarations

There should be no
unused parameters in

functions

The character se-
quence /* should not
be used within a com-

ment

The character se-
quence // should not
be used within a 'C-

style' comment

Line-splicing shall not
be used in // com-

ments

A null statement in
original source code
should be on a sep-
arate line and the
semicolon should be
followed by at least
one white space and

then a comment

Octal and hexadec-
imal escape se-
quences shall be ter-

minated

Level

Advisory

Advisory

Advisory

Advisory

Advisory

Required

Required

Required

Required

Required
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Code review

reference

M4.2

E4.1

E4.2

M5.1.1

M5.1.2

M5.2

M5.3

M5.4.1

Type

Warning

Error

Error

Error

Error

Error

Error

Error

D/U

Description

Trigraphs should not
be used

Only ISO C escape se-
quences are allowed

Only ISO C escape
sequences are al-
lowed(\v)

External identifiers
shall be distinct in the

first 31 characters

External identifiers
shall be distinct in the
first 6 characters ig-

noring case

Identifiers %name

% declared in the
same scope and
name space shall

be distinct. Identifier
identical in the first
%param% characters
already found in %lo-

cation%

Identifier %name%
declared in an inner
scope shall not hide
an identifier declared
in an outer scope.
Identifier identical

in the first %param

% characters already

found in %location%

Macros %name% and
%name% are identical
in the first %param%

characters

Level

Advisory

Advisory

Advisory

Required

Required

Required

Required

Required
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Code review
Type D/U
reference
M5.4.2 Error D
M5.5.1 Error D
M5.5.2 Error D
M5.6 Error D
M5.7.1 Error D
M5.7.2 Error D
M5.8 Error D

152

Description Level

Macros %name% and Required
%name% are identical

in the first %param%

characters ignoring

case.

Macro %name% and  Required
identifier %name%

are identical in the

first %param% char-

acters.

Macro %name% and  Required
identifier %name%

are identical in the

first %param% char-

acters ignoring case.

Macro %name% and  Required
identifier %name%

are identical in the

first %name% %param

% characters ignor-

ing case. The type-

def name %name%

should not be reused

except for its tag.

Name already found

in %location%

The tag name %name Required
% should not be

reused

A struct and union Required
cannot use the same

tag name

Identifiers that define Required
objects or functions
with external linkage

shall be unique
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Code review

reference

M5.9

ES.1

E5.2

E5.3

ES.4

ES.5

M6.1.1

M6.1.2

M6.1.3

Error

Error

Error

Warning

Error

Error

Error

Error

Error

Type

D/U

Description

Identifiers that define
objects or functions
with internal linkage

should be unique

External identifiers
shall not be ambigu-
ous because of pos-
sible character confu-

sion.

External identifiers
shall not be ambigu-
ous because of char-

acter repetition

The identifier<name>
should not be reused.
Identifier already
found in %location%

Identifier %name% in
an inner scope hides
the same identifier in
an outer scope : %lo-

cation%

The typedef name
%name% should not
be reused even for
its tag. Name already

found in %location%

Bit fields should only
be of type 'unsigned

int' or 'signed int'

Bit fields should not

be of type 'enum’

Bit fields should only
be of explicitly signed
or unsigned type

Level

Advisory

Advisory

Advisory

Advisory

Advisory

Advisory

Required

Required

Required
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Code review o
Type D/U Description Level
reference

M6.1.4 Error D Bit fields should not  Required
be of type 'bool' under
c99

M6.1.5 Error D Bit fields should not  Required
be of type 'boolean’
outside c99

M6.2 Error D Single-bit fields shall  Required
not be of a signed

type

E6.1 Warning D The C language nu-  Required
meric type %name%
should not be used
directly but instead
used to define type-
def

E6.2 Warning D The implicit 'int' type  Required

should not be used

M7.1 Error D Octal constans shall  Required

not be used

M7.2 Error D A"u" or "U" suffix Required
shall be applied to all
integer constants that
are represented in an

unsigned type"

M7.3 Error D The lowercase char-  Required
acted |" shall not be

used in a literal suffix"

M7.4 Error D A string litteral shall  Required
not be assigned to an
object unless the ob-
ject's type is pointer
to a const-qualified

char

M8.1 Error D Types shall be explic- Required

itly specified
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Code review

reference

M8.2.1

M8.2.2

M8.2.3

M8.3.1

M8.3.2

M8.4.1

M8.4.2

M8.4.3

M8.5

Error

Error

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description

The function proto-
type should name all

its parameters

Functions with no pa-
rameters should use
the void type

The type of parame-
ter %name% should

be explicitly stated

Parameters and re-
turn types should use
compatible type in
the declaration and in

the definition

The identifiers used
in the prototype and
definition should be

the same

A prototype for

the global function
%name% should be
declared before defin-

ing the function

A prototype for the
global object %name
% should be declared
before defining the

object

If objects or functions
are declared multi-
ple times their types

should be compatible

Identifiers %name%
that declare objects
or functions with ex-

ternal linkage shall be

Level

Required

Required

Required

Required

Required

Required

Required

Required

Required
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Code review
Type D/U
reference
M8.6 Error D
M8.7.1 Warning D
M8.7.12 Warning D
M8.8 Error D
M8.9 Warning D
M8.10 Error D
M8.11 Warning D

Description

declared once in one
and only one file

Identifiers %name%
that declare objects
or functions with ex-
ternal linkage shall be

unique

Global object %name
% that are only used
within the same file
should be declared
using the static stor-

age-class specifier.

Global function
%name% that are on-
ly used within the
same file should be
declared using the
static storage-class
specifier.

The static storage
class specifier shall
be used in all declara-
tions of objects and
functions that have
internal linkage

An object should

be defined at block
scope if its identifier
only appears in a sin-

gle function

Inline function
%name% should be
static

When an array with
external linkage is de-

Level

Required

Advisory

Advisory

Required

Advisory

Required

Advisory
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Code review

reference

M8.14

E.8.1

E.8.2

E.8.3

E.8.4

E.8.5

E.8.6

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description

clared, its size should
be explicitly specified

The restrict type qual-
ifier shall not be used

Parameters and re-

turn types should use
exactly the same type
names in the declara-
tion and in the defini-

tion

A prototype for

the static function
%name% should be
declared before defin-

ing the function

Static function
%name% should only
be declared in a sin-
gle file. Redundant
declaration found at:

%name%

Static object %name
% should only be de-
clared in a single file.
Redundant declara-

tion found at: %loca-

tion%

Either all members or
only the first member
of an enumerator list

should be initialized

The body of function
%name% should not
be located in a header
file

Level

Required

Required

Required

Required

Required

Required

Required
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Code review

reference

E.8.7

E.8.8

E.8.9

E.8.10

E.8.11

M9.2

M9.3

E9.1

Type

Error

Error

Error

Error

Error

Error

Error

D/U

Description

The memory stor-
age (definition) for
the variable %name
% should not be in a

header file

Functions should not
be declared at block

scope

The global object or
function '%name%'
should have exactly
one external defini-
tion. Redundant defi-
nition found in %loca-

tion%

The global object or
function %name%
%name% should have
exactly one external
definition. No defini-
tion found

Use the const quali-
fication for variable
%name% which is
pointer and which is
not used to change
the pointed object

The initializer for an
aggregate or union
shall be enclosed in

braces

Arrays shall not be

partially initialized

Variables with au-

tomatic storage du-

Level

Required

Required

Required

Required

Required

Required

Exception not cov-

ered

Required

Exception not cov-

ered

Required
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Code review o
Type D/U Description Level
reference

ration should be ini-
tialized before being

used

E9.2 Error D The global variable Required
%name% is not initial-

ized

M10.1.1 Error D Constraint violation:  Required
can't use floating type
as operand of "[], %,
&lt&lt;, >>, ~, &amp;, |,

AN

M10.1.2 Error D Operand should be Required

boolean

M10.1.3 Error D Can'tuse aboolean  Required

as a numeric value

M10.1.4 Error D Can'tuseacharasa Required

numeric value

M10.1.5 Error D Can't use a not anony- Required
mous enum as a nu-

meric value

M10.1.6 Error D Shift and bitwise op-  Required
erations should be
performed on un-
signed value

M10.1.7 Error D Right hand operand  Required
of shift operation
should be performed

on unsigned value

M10.1.8 Error D Unary minus oper- Required
ation should not be
performed on un-
signed value

M10.2 Error D Expressions of essen- Required
tially character type
shall not be used in-

appropriately in addi-
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Code review o
Type D/U Description Level
reference

tion and subtraction
operations

M10.3.1 Error D The value of an ex- Required
pression shall not be
assigned to an object
with a narrower es-

sential type

M10.3.2 Error D The value of an ex- Required
pression shall not be
assigned to an object
with a different es-

sential type category

M10.4 Error D Both operands of an  Required
operator in which
the usual arithmetic
conversions are per-
formed shall have the
same essential type

category

M10.5 Warning D The value of an ex- Advisory
pression should not
be cast to an inappro-

priate essential type

M10.6 Error D The value of acom-  Required
posite expression
shall not be assigned
to an object with
wider essential type

M10.7 Error D If a composite ex- Required
pression is used as
one operand of an
operation in which
the usual arithmetic
conversions are per-
formed then the oth-

er operand shall not
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Code review

reference

M10.8

E10.1

M11.1

M11.2

M11.3.1

M11.3.2

M11.3.3

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description Level

have wider essential
type

The value of acom-  Required
posite expression

shall not be cast to

a different essential

type category or a

wider essential type

When using operator Required
'~' or '&amp;lt;&am-

p;lt;' on 'unsigned

char' or 'unsigned int',

you should always

cast returned value

A function pointer Required
should not be con-
verted to another type

of pointer

Conversions shall Required
not be performed be-

tween a pointer to an
incomplete type and

any other type

Casting an object Required
pointer type to a dif-
ferent object pointer

type should not occur

Casting an object Required
pointer type to a dif-

ferent object pointer

type should not oc-

cur, especially when

object sizes are not

the same

An object pointer Required
should not be con-
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Code review

reference

M11.4

M11.5

M11.6

M11.7

M11.8

M12.1.1

M12.1.2

Type D/U

Warning

Warning

Error

Error

Error

warning

warning

Description

verted to another type
of pointer

Casting a pointer type
to an integer type
should not occur

A conversion should
not be performed
from pointer to void

into pointer to object

A cast shall not be
performed between
pointer to void and
and an arithmetic

type

A cast shall not be
performed between
pointer to object and
a non-integer arith-

metic type

Casting of pointers to
a type that removes
any const or volatile
qualification on the
pointed object should

not occur

Implicit operator
precedence may
cause ambiguity. Use
parenthesis to clarify
this expression

Implicit bitwise oper-
ator precedence may
cause ambiguity. Use
parenthesis to clarify

this expression

Level

Advisory

Advisory

Required

Required

Required

Advisory

Advisory
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Code review

reference

M12.1.3

M12.1.4

M12.3

E12.1

E12.2

E12.3

E12.4

M13.3

warning

warning

warning

warning

warning

error

error

Warning

Type

D/U

Description

Parenthesis should
be used around ex-
pressions that are
operands of a logi-
cal &amp;amp;&am-

p;amp; or ||

Parenthesis should
be used around
expression that is
operand of 'sizeof' op-

erator.

The comma operator

should not be used.

The operator on a
Boolean expression
should be a logical
operator ( &amp;&am-
p. Il or!)

Ternary expression '?:'

should not be used

Expressions should
not cause a side ef-

fect assignment

The equal or not
equal operator should
not be used in float-

ing-point expressions

a full expression con-
taining an increment
(++) or decrement
(-) operator should
have no other poten-
tial side effects oth-
er than that caused
by the increment or

decrement operator

Level

Advisory

Advisory

Advisory

Advisory

Advisory

Advisory

Advisory

Advisory

163



HCL® OneTest™ Embedded

Code review
Type D/U
reference
M13.4.1 Warning
M13.4.2 Warning
M13.6 Error
E13.1 Error
E13.2 Error
E13.3 Error
M14.1.1 Error
M14.2.1 Error

164

Description

Boolean expressions
should not contain
assignment opera-

tors.

The result of an as-
signment operator
should not be used in

an expression

The operand of the
sizeof operator shall
not contain any ex-
pression which has

potential side effects

Boolean expressions
should not contain

side effect operators

An expression that
contains a side ef-
fect should not be
used in the right-hand
operand of a logical
&amp;&amp; or || op-

erator

The function in the

right-hand operand of
a logical && or || oper-
ator might cause side

effects

Floating-point vari-
ables should not be
used to control a for

statement

Only loop counter
should be initialized
in a for loop initializa-

tion part

Level

Advisory

Advisory

Required

Required

Required

Required

Required

Required
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Code review

reference

M14.2.2

M14.2.3

M14.2.4

M14.3.1

M14.4

M15.1

M15.2

M15.3

M15.4

Error

Error

Error

Error

Error

Warning

Error

Error

Warning

Type

D/U

Description

In the 'update part' of
a 'for statement’, only
'loop counter' should
be updated

There should be one
and only one loop
counter for loop

statement

Loop counter of a 'for
statement' should not
be modified within
the body of the loop

Invariant Boolean ex-
pressions should not

be used

Non-Boolean val-
ues that are tested
against zero should
have an explicit test

The goto statement
should not be used

The goto statement
shall jump to a label
declared later in the

same function

Any label referenced
by a goto statement
shall be declared in
the same block, or in
any block enclosing

the goto statement

There should be no
more than one break
or goto statement
used to terminate any

iteration statement

Level

Required

Required

Required

Required

Required

Advisory

Required

Required

Advisory
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Code review

reference

M15.5

M15.6.1

M15.6.1

M15.6.2

M15.6.3

M15.6.4

M15.6.5

M15.6.6

M15.7

Type

Warning

Error

Error

Error

Error

Error

Error

Error

Error

D/U

Description

A function should
have a single point of
exit at the end

The switch statement
should be followed
by a compound state-

ment

The switch statement
should be followed
by a compound state-

ment

The while statement
should be followed
by a compound state-

ment

The do..while state-
ment should contain
a compound state-

ment

The for statement
should be followed
by a compound state-

ment

The if (expression)
construct should be
followed by a com-
pound statement

The else keyword
should be followed
by either a compound
statement or another

'if' statement.

All if ... else con-
structs shall be ter-
minated with an else

statement

Level

Advisory

Required

Required

Required

Required

Required

Required

Required

Required
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Code review

reference

E15.1

E15.2

E15.3

E15.4

M16.1

M16.2

M16.3

M16.4

M16.5

M16.6

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description

Level

Do not use the contin- Required

ue statement

Only one break state-
ment should be used
within a loop

The return keyword
should not be used in

a conditional block

The else keyword
should be followed
by a compound state-

ment.

All switch state-
ment should be well
formed

A switch label shall
only be used when
the most closely-en-
closing copound
statement is the body
of a switch statement

An unconditional
break statement
shall terminate every

switch-clause

Every switch state-
ment shall have a de-
fault label

A default label appear
as either the first or
the last switch label

of a switch statement

Every switch state-
ment shall have at
least two switch-

clauses

Required

Required

Required

Required

Required

Required

Required

Required

Required
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Code review

reference

M16.7

E16.1

E16.2

E16.3

M17.1.1

M17.1.2

M17.2.1

M17.2.2

M17.3

M17.4

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description

A switch expression
shall not have essen-
tially Boolean type

Case char value is
applicable only if the
switch statement val-
ue is plain character

variable

A constant should not
be used as a switch

expression

The switch expres-
sion should not have

side effects

The function '%name
%' should not have a
variable number of ar-

guments

The va_list, va_arg,
va_start, va_end and
va_copy functions of
&lt;stdarg.h> shall not

be used

Recursive functions
are not allowed. The
function '%name%' is

directly recursive

Recursive functions
are not allowed. The
function '%name%' is
recursive when call-

ing '%name%'

A function shall not

be declared implicitly

All exit paths from
a function with non-

Level

Required

Required

Required

Required

Required

Required

Required

Required

Required

Required
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Code review

reference

M17.6

M17.7

E17.1

E17.2

E17.3

M18.4

M18.5

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description

void return type shall
have an explicit return
statement with an ex-

pression

The declaration of an
array parameter shall
not contain the static
keyword between the

I

The value returned by
function having non-
void return type shall

be used

The number of argu-
ments used in the call
does not match the
number declared in

the prototype

Use the const quali-
fication for parame-
ter '%name%' which
is pointer and which
is not used to change

the pointed object

Function identifiers
should always use a
parenthesis or a pre-
ceding &amp;

The +, -, += and -= op-
erators should not be
applied to an expres-

sion of pointer type

Declarations should
contain no more than
two levels of pointer

nesting

Level

Advisory

Required

Advisory

Advisory

Advisory

Advisory

Advisory
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Code review

reference

M18.7

M18.8

M19.2

E19.1

M20.1

M20.2

M20.3

M20.4

M20.5

M20.6

Type D/U

Error

Error

Warning

Error

Warning

Error

Error

Error

Warning

Error

Description

Flexible arrays mem-
bers shall not be de-
clared

Variable-length ar-
ray types shall not be
used

The union keyword

should not be used

Structure or union
types '%name%'
should be finalized
before the end of the

compilation units

#include directive
should only preceded
by preprocessor di-

rectives or comments

The', or \ character
and the /* or // char-
acter sequences shall
not occur in a header

file name"

The #include direc-
tive shall be followed
by either a &lt;file-
name> or a filename"
sequence”

A macro shall not
be defined with the
same name as a key-

word %name%

#undef should not be

used

Token that look like a
preprocessing direc-

tive should not occur

Level

Required

Required

Advisory

Advisory

Advisory

Required

Required

Required

Advisory

Required
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Code review

reference

M20.7

M20.8

M20.9

M20.10

M20.11

M20.12

M20.13

Error

Error

Error

Warning

Error

Error

Error

Type

D/U

Description Level

withing a macro argu-

ment

Expressions resulting Required
from the expansion

of macro parameters

shall be enclosed in

parenthesis

The controlling ex- Required
pression of a #if or

#elif preprocessing

directive shall evalu-

atetoOor1

All identifiers used Required
in the controlling ex-

pression of #if or

#elif preprocessing

directives shall be

#define'd before eval-

uation

The # and ## pre- Advisory
processor operators
should not be used

A macro parameter Required
immediately following

a # operator shall not
immediately be fol-

lowed by a ## opera-

tor

A macro parameter Required
used as an operand

to the # and ## op-

erators shall only be

used as an operand

to these operators

A line whose first to-  Required
ken is # shall be a
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Code review
reference
M20.14 Error
E20.1 Error
E20.2 Error
E20.3 Error
E20.4 Error
E20.5 Error
E20.6 Error

Type

Error

D/U

Description Level
valid preprocessing
directive

All #else, #elif and
#endif preprocessor

Required

directives shall reside
in the same file as

the #if, #ifdef or #ifn-
def directive to which

they are related

Header file contents  Required
should be protected
against multiple inclu-

sions

The # or ## pre-
processor operator

Required

should not be used

more than once

Missing argument Required
when calling the

macro

Only use the 'defined’ Required
preprocessor opera-
tor with a single iden-
tifier

Macro definitions or
'#undef' should not

Required

be located within a
block

A C macro should on- Required
ly be expanded to a

constant, a braced

initialiser, a paren-

thesised expression,

a storage class key-

word, a type qualifi-

er, or a do-while-zero

block
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Code review

reference

M21.1.1

M21.1.2

M21.2.1

M21.2.2

M21.3

M21.4

M21.5

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description Level

#define and #undef = Required
shall not be used

on areserved iden-

tifier or reserved

macro name: Iden-

tifier %name% al-

ready found in &lt;

%libname%>

#define and #undef = Required
shall not be used on

identifier beginning

with an underscore or

on 'defined' keyword

%name%

Declared identifier Required
should not be a re-

served identifier or re-

served macro name:

Identifier %name% al-

ready found in <%lib-

name%>

Declared identifier Required
should not begin with

an underscore or be

‘defined' keyword

%name%

The memory allo- Required
cation and deallo-

cation functions of

&lt;stdlib.h> shall not

be used

The standard header Required
file &lt;setjmp.h> shall

not be used

The standard header Required
file &lt;signal.h> shall

not be used
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Code review

reference

M21.6.1

M21.6.2

M21.7

M21.8

M21.9

M21.10

M21.11

M21.12

174

Type

Error

Error

Error

Error

Error

Error

Error

Warning

D/U

Description

The input/output li-
brary &lt;stdio.h>
shall not be used in

production code

The input/output li-
brary &lt;wchar.h>
shall not be used in

production code

The library macro
or functions atof,
atoi, atol and atoll of
&lt;stdlib.h> shall not

be used

The library macro or
functions abort, exit,
getenv and system of
&lt;stdlib.h> shall not

be used

The library macro or
functions bsearch
and gsort of
&lt;stdlib.h> shall not
be used

The standard library
time and date func-
tions shall not be

used

The standard head-
er file &lt;tgmath.h>
shall not be used

The library macro or
function 'feclearex-
cept, fegetexceptflag,
feraiseexcept, fese-
texceptflag, fetestex-
cept, FE_INEXACT,
FE_DIVBYZERO, FE_-

Level

Required

Required

Required

Required

Required

Required

Required

Advisory
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Code review
Type D/U
reference
E21.1 Error
E21.2 Error
E21.3 Error
Rule U99.1 Warning
Rule U99.2 Error
Rule U99.3 Warning
Rule U99.4 Error
Rule U99.5 Warning
Rule U99.6 Error
Rule U99.7 Warning
Rule U99.8 Error
Rule U99.9 Warning
Rule U99.10 Error

Description

UNDERFLOW, FE_-
OVERFLOW, FE_IN-
VALID or FE_ALL_EX-
CEPT' should not be
used.

The variable 'errno’

should not be used

The macro 'offsetof’

should not be used

The library macro

or function 'setjm-
p,longjmp,sigsetjm-
p,siglongjmp' should

not be used

You can customize
this rule in the con-

frule file

Level

Required

Required

Required

Executing the code review

You can use the code review tool on any test, application node, or a single source file. The code review tool is run on

the source code whenever you build the file.

Before you begin

For all new projects, you must have selected the rule configuration file. You can configure the code review rules if

necessary. See Configuring code review rules on page 110.

About this task
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To perform a code review without compiling and executing the application:

1. In the Project Explorer, select the node that you want to check.

-
2. Click the Code Review icon = to enable code review in the build and click the Launch icon @ .
3. If your rule configuration file is an out-of-date version, you are prompted to update it. Click ok and select the

rules that are missing.

Note: The selected rules are added with their default severity levels to your configuration file.

Unselected rules are added as disabled rules.

4. In the Project Explorer view, right-click on the result file under the Test Result node, select Open with > HTML
Reports > Code Review to see the report.

Customizing the code review report

The default code review report is generated in an HTML format from a template named misrareport.template as that
you can modify to customize the code review reports.

The code review HTML reports are generated from a template named misrareport.template that you can find in the
following folder as a text file:

* On Windows: <instal l ati on_directory>\lib\reports

«OnUnix:<installation_directory>/lib/reports
The template file uses the following JavaScript libraries:

» Bootstrap

» JQuery

» Font Awesome
* VisdS

* Chart

These libraries are not provided. An internet connection is required to open the report. If you don't have any internet
connection, download the libraries (.css and .js files), copy them in the folder in which the report is saved, and modify

the template file as follows:

Replace the following block of lines:

<link rel="stylesheet" href="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/css/bootstrap.min.css"
integrity="sha384-MCw98/SFNGE8fJIT3GXwWEONgsV7Zt27NXFoaoApmYm81iuXoPkFOJwI8ERdknLPMO"
crossorigin="anonymous">

<link rel="stylesheet" href="https://use.fontawesome.com/releases/v5.5.0/css/all.css"
integrity="sha384-B4dIYHKNBt8Bc1l2p+WXckhzcICoOwtJAoU8YZTY5qEOId1GSseTk6S+L3B1XeVIU"
crossorigin="anonymous">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.min.css">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/Chart.js/2.8.0/Chart.min.css">
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<script src="https://code.jquery.com/jquery-3.3.1.slim.min.js"
integrity="sha384-q8i/X+965Dz00rT7abK41IStQIAqVgRVzpbzo5smXKp4YfRvH+8abtTE1Pi6jizo"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/popper.js/1.14.3/umd/popper.min.js"
integrity="sha384-ZMP7rVo3mIykV+2+9J3UJ46jBkOWLaUAdn689aCwoqbBJiSnjAK/18WvCWPIPmM49"
crossorigin="anonymous"></script>

<script src="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/js/bootstrap.min.js"
integrity="sha384-ChfqqxuZUCnISK3+MXmPNIYE6ZbWh2IMqE241rYiqIxyMiZ60W/ImZQ5stwEULTY"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.js"></script>
<script src="https://cdnjs.cloudflare.com/ajax/libs/Chart.js/2.8.0/Chart.min.js"></script>

With the following one:

<link rel="stylesheet" href="./bootstrap.min.css>
<link rel="stylesheet" href="./all.css">

<link rel="stylesheet" href="./vis.min.css">
<link rel="stylesheet" href="./Chart.min.css">

<script src="./jquery-3.3.1.slim.min.js"></script>
<script src="./popper.min.js"></script>

<script src="./bootstrap.min.js"></script>

<script src="./vis.js"></script>

<script src="./Chart.min.js"></script>

The following sections give the list of elements that you can use in the raw data and the JavaScript functions to

customize your report file.

Data format

The misrareport.template template consists of two sections:

» The HTML section that is common to all reports,
- A JavaScript section that sets tables depending on two variables that are initialized dynamically when the
report is created:

var data = {{json}}; // the raw data, in json format
var d = new Date({{date}}) // the generation date

Raw data contains the following information at the top level:

- output is the name of the json file that contains the raw data

« title is the nternal title of the report (displayed in the “crc” file format)

- configurationTitle is the title of the used configuration file

- systemLevel is the C level norm used. The possible values are "C90", "C90 and Normative Addentum 1", "C99
or"C11"

configuration is the configuration file used to generate this report

date is the generation date of raw data

.

nbAnalyzedFiles is the number of analyzed files

nbFileskO is the number of files containing errors

nbFilesOK is the number of files without errors
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- nbError is the total number of all errors in all analyzed files

- nbWarning is the total number of all warnings in all analyzed files

- files is the array of file element (each one represents a physical file) or array of deactivated element
- statistics is the array of rule statistics element

Example:
{

"output": "../build/fullreport_1l.crc.json",

"title": "HCL OneTest (TM) Embedded MISRA C:2012 Report using C90",
"configurationTitle": "MISRA C:2012",

"systemLevel": "C90",

"configuration": "C:\\Program
Files\\HCL\\HCLOneTest\\Embedded/plugins/Common/1lib/confrule_2012.xml",
"date": "Mon Oct 19 15:52:07 2020",

"nbAnalyzedFiles": 5,

"nbFilesk0": 4,

"nbFilesOK": 1,

"nbError": 49,

"nbWarning": 68,

"files": [

]J

"statistics": [

]

}

Each file elementfile element represents an analyzed source file. It contains the following information at the top level:

- source is the physical location of source file

- fileDate is the date of last editing of this source

- nbErrorOrWarning is the total of error or warning in this file

- content is an array of rule element (if the rule is directly raised at file level) or function element. It is always
available but it can be empty (file with no function and with no error or warning)

Each function element represents a function. It contains the following information at the top level:
> function is the name of the function
o kind is the analysis result of this function. The possible values are 'Failed' or 'Passed'

- content is an array of rule element (rules that are raised inside this function). It is always available

but it can be empty (function with no error or no warning)

Examples:

file element

{

"source": "C:\\workspace\\project\\src\\core.h",
"fileDate": "Mon Sep 07 10:31:50 2020",
"nbErrorOrWarning": 25,

"content": [
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:
/7 3
function element:

{

"function": "win",
"kind": "Failed",
"content": [

]

}

Each rule element represents a triggered rule, justified or not. It contains the following information at the top level:

« rule is the name of the rule, corresponding to its label defined in the configuration file

- group is the family of this rule, it corresponds to the label of the rule’s group that is defined in the configuration
file

« kind is the severity of the rule. The possible values are ‘error', 'warning' or 'info, depending on the error level in
the configuration file and on the possible justification (the justified rules have an 'info' type value)

« line is the line of the current file where the rule was triggered

« column is the column of the current file where the rule was triggered

- text is the rule description. It is related to the rule text in configuration file

« justification is the justification text for the rule. This field is optional, and is present only if the rule is justified

Example:
{

"rule": "M21.6.1",

"group": "21- Standard libraries",

"kind": "info",

"line": 21,

"column": 10,

"text": "The 1input/output library <stdio.h> shall not be used in production code.",
"justification": "This rule does not apply to the following line"

}

Each deactivated element represents a group of rules that is deactivated for a specific reason. It contains the
following information at the top level:

- deactivated_rules_by_user is used for all the rules that are deactivated when it is used in the configuration file
with the error set to level 0. This field is optional, it can be empty, or you can enter an array of deactivated rule

element

Example:
{

"deactivated_rules_by_user": [

179



180

HCL® OneTest™ Embedded

]
4

- deactivated_rules_by_test_option is used for all the rules that are deactivated by using the “test” option. This

field is optional, it can be empty, or you can enter an array of deactivated rule element

Example:
{

"deactivated_rules_test_option": [
]
}

Each deactivated rule element represents a deactivated rule for any reason. It contains the following information at

the top level:

« rule is the name of the rule, it corresponds to the rule label that is defined in the configuration file
- text is the rule description, it corresponds to the rule text in configuration file

Example:
{

"rule": "E15.3",
"text": "The return keyword should not be used in a conditional block."

}

Each rule statistics element represents global statistics for the rule raised during test. It contains the following

information at the top level:

- ruleStatistics is the array of the statistic rule element

Example:
{

"rulesStatistics": [
]
}

Each statistic rule element contains a rule that was raised one or several times. It contains the following information

at the top level:

« rule is the name of the rule. It corresponds to the rule label that is defined in the configuration file
« kind is the severity of the rule. The possible values are 'error' or 'warning' that correspond to the error level in
the configuration file

» occurences is the number of times that the rule was raised
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Example:
{

"rule": "M17.7",
"kind": "error",
"text": "When a function returns a value, this value should be used.",
"occurences": 4

3

Javascript functions
You can find in the misrareport.template template a set of JavaScript functions.

Some of the helper functions simplify access to “raw data”:

- isFct(element) checks whether an element is a function or not

- isFile(element) checks whether an element is a file or not

« isFilelnError(element) checks whether an element is a file that contains an error or a warning
« isFctPassed(element) checks whether an element is a passed function or not

- isFctFailed(element) checks whether an element is a failed function or not

- isRuleError(element) checks whether a rule level is error or not

« isRuleWarning(element) checks whether a rule level is warning or not

« isRulelnfo(element) checks whether a rule level is an information or not

- isRuleJustified(element) checks whether a rule is justified or not
Other functions are used to display each section of the report:

» emptyLine() displays an empty line (helper function)

- startFile(element) is called at start of a file element.

- endFile() is called at end of a file element.

- startFileRules() is called at the beginning of a group of rules that is relative to a file. Used to display array
headers

- endFileRules() is called at end of a group of rules relative to a file.

« startFileFunctions() is called at the beginning of a function

« rule(element) is called to display details of a raised rule.
The last section is a set of functions that is used to display summaries:

- displayDeactivatedbytest(elem) displays all deactivated rules by using the "-test' option
- displayDeactivatedbyuser(elem) displays all deactivated rules that are used in the configuration file

- displayrulesstatistics(elem) displays statistics for all rules that are raised during the test

The main algorithm dispatches the function calls by parsing the raw data.
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Coupling Analysis

Coupling Analysis consists of Control Coupling and Data Coupling.

Control Coupling

Control Coupling is defined as “the manner or degree by which one software component influences the execution
of another software component" in the Clarification of Structural Coverage Analyzes of Data Coupling and Control
Coupling document edited by the Certification Authorities Software Team (CAST). The purpose is 'to provide a
measurement and assurance of the correctness of these modules/components’ interactions and dependencies'.
Control Coupling is used to verify that all the interactions between modules have been covered by at least one test.

HCL OneTest™ Embedded introduces a new coverage level called “Control Coupling” for C language that consists in
verifying that all the interactions between modules have been covered by at least one test. This new coverage level is

implemented in HCL OneTest™ Embedded in two ways:

« Modules are compilation units, in this case:
> Control Couplings are calls between two functions that are in two different compilation units.
> Control Coupling is not a simple interaction. It is a control flow in the calling module that ends with an
interaction with another module.
> Groups of compilation units can be defined as a single module. This will increase the number of calls
between modules but also increase the number of control flows in the calling modules.
> The report contains a button to display:
= All the Control Couplings (default option).
= Only the shortest Control Couplings (only the last calls between modules are taken into
account)
= Only the longest Control Couplings (the sub-control flows are ignored)
» Modules are Functions, in this case:
= Control Couplings are considered as all the calls between two functions, in the same compilation unit
or not.
> Each Control Coupling is only a call, and not a control flow as previously defined.

So, to identify the Control Couplings, HCL OneTest™ Embedded analyzes all the external calls between modules
(definition of the modules could be different depending on the option) and statically identifies all the possible paths in
the calling module that end with each external call, excluding the one that starts with a static function (ex: a function

that can't be called from another module). This constitutes the set of Control Coupling of the application.

For each of them, HCL OneTest™ Embedded provides the following information:

* The calling modules.
 The complete control flow (example: the set of successive calls, the last one is the external call). If the option
"module as function" is set, each control flow has two functions only.

« In case of option module as "compilation unit":
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> |s it the longest one that leads to this external call (it is not the longest when there is another Control
Coupling that includes the current one).
o |s it the shortest one that leads to this external call (it is not the shortest when there is another Control
Coupling that is included by the current one).
* It is covered or not.
- The list of test cases that each Control Coupling covered.
« The list of requirements that are related to the test cases.

How Control Coupling Works

When an application node or a test is executed, the source code is instrumented by the Instrumentor (attolcc4 for
C language) that produces a static file with the extension .tsf containing information on the Control Couplings. The
resulting source code is then compiled, linked and executed and the Control Coupling feature outputs a dynamic file

with the extension .tgf.

These 2 types of files are the input of the report generator that produces a report in HTML format (and optionally
the raw data can be generated in a Json file). A template is provided for this generator. You can provide your own

template to modify the report.

If the Control Coupling feature is used with unit testing feature, the report generator can take the .tdc files as input
files. This allows to have also in the report the test cases that covered each Control Coupling and the associated
requirements declared in the .ptu file. If not, the test cases are identified by their execution date, and there is no

requirement.

Note:

To visualize your report in HCL OneTest™ Embedded for Eclipse IDE, if you are using the default browser
option, be sure that JavaScript is enabled. Otherwise, you can choose another browser that is compatible with
your version of JavaScript by changing it in Window > Preferences > General > Web Browser .

Set Control Coupling options

You can set options for Control Coupling to build your project in HCL OneTest™ Embedded for Eclipse IDE. Control

Coupling feature must be enabled to be selected in the build settings before running the build.

Enable Control Coupling

« In the Project Explorer, right-click on the project and click Properties.

« In the Properties window, click C C++ Build > Settings.

« In the Build Settings tab, click Settings > General > Selective instrumentation.

« In the right pane, click the Value field in Build options and click ... to open the Build options
window.

- In the Build options list, click Performance Profiling to enable the feature.
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Control Coupling

In the Project Explorer, right-click on the project and click Properties, then click C C++ Build > Settings. In the Build

Settings tab, under the Coupling menu, select Control Coupling.

From this setting page, you can change the following choices:

« Trace file name (.tgf): Sets the name of the trace file dedicated to control coupling, click the edit button to
change the name. By default, this name is the base name of the test with the extension .tgf.
+ Exclude libraries: Include (No) or exclude (Yes) the control couplings must be included or excluded. that end
with a call to a function that is not part of the application .
- Report Template: changes the template of the report generator. By default, this template is ccreport.template.
» Modaule as: Select the choice that corresponds the best to your definition of a module. A module can be
defined as a function or a compilation unit. HCL OneTest™ Embedded offers two ways to interpret Control
Coupling, depending on how the "module” in CAST-19 is interpreted:
- Module as function: Each call between each function is considered as Control Coupling.
> Module as compilation unit: Only the calls between two functions in two different compilation units
are considered as Control Coupling. Moreover, the different called stacks in the calling module are
also considered as different Control Couplings. With the previous option set, the user can group two
or more compilation units in a single module (called component) in order to ignore the calls between
these compilation units.
« Components List: Select a file that contains a list of components. This option is used only when the option
"module as compilation unit" is selected. This file is in a JSON format and contains a list of components with

their associated compilation units as follows:

{

"component_name" : [ “filel", “file2",..],

Set Control Coupling Options

You can set the options for Control Coupling to build your project in HCL OneTest™ Embedded Studio.
Execute a build with Control Coupling

« In HCL OneTest™ Embedded Studio, open the Settings of the project and click the Configuration Properties >
Build > Build options menu.

« In the right panel, click on the Build options and edit the options by clicking on the ... button.

« In the dialog window that shows up on the right, you can select the different tools that can be used for the

build. Select Ctrl Coupling analysis to enable the control coupling feature.

Control Coupling options

Options for Control Coupling can be updated in the following menu of the settings: Configuration Properties >

Runtime analysis > Control coupling
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From this setting page, you can change the following choices:

- Trace file name (.tgf): sets the name of the trace file dedicated to control coupling. By default, this name is
the base name of the test with the extension .tgf.

« Exclude libraries: Include or exclude the control couplings that end with a call to a function that is not part of
the application (sets the -noccext option of the report generator if it is set to yes).

- Report Template: changes the template of the report generator. By default, this template is ccreport.template.

« Module as: Select the choice that corresponds the best to your definition of a module. A module can be
defined as a function or a compilation unit. HCL OneTest™ Embedded offers two ways to interpret Control
Coupling, depending on how the "module" in CAST-19 is interpreted:

- Module as function: Each call between each function is considered as Control Coupling.

- Module as compilation unit: Only the calls between two functions in two different compilation units
are considered as Control Coupling. Moreover, the different called stacks in the calling module are
also considered as different Control Couplings. With the previous option set, the user can group two
or more compilation units in a single module (called component) in order to ignore the calls between

these compilation units.

Control Coupling Report

After you build a project with HCL OneTest™ Embedded, you can get a Control Coupling report with compilation unit
module or a Control Coupling report with function module, depending on the build settings.

The default Control Coupling report is in HTML format. It is generated from a template named ccreport.template (for
the module as compilation unit option ), or ccfreport.template (for the module as function option). The templates are

provided as text files that you can modify to customize the report. It uses four online JavaScript libraries:

» Bootstrap,

« JQuery,

» Font Awesome,
« VisJS.

These libraries are not provided. You must have an internet connection when you open the report. If not, download the
libraries (.css and .js files), copy them in the same folder than your report, and modify the template file as follows:

Replace the following lines with the lines from the second text block:

<link rel="stylesheet" href="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/css/bootstrap.min.css"
integrity="sha384-MCw98/SFNGE8fJIT3GXWEONgsV7Zt27NXFoaoApmYm81iuXoPkFOJwJI8ERdKknLPMO"
crossorigin="anonymous">

<link rel="stylesheet" href="https://use.fontawesome.com/releases/v5.5.0/css/all.css"
integrity="sha384-B4dIYHKNBt8Bc12p+WXckhzcICoOwtJAoU8YZTY5qEOId1GSseTk6S+L3B1XeVIU"
crossorigin="anonymous">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.min.css">

<script src="https://code.jquery.com/jquery-3.3.1.slim.min.js"
integrity="sha384-q8i/X+965Dz00rT7abK41IStQIAqVgRVzpbzo5smXKp4YfRvH+8abtTE1Pi6jizo"
crossorigin="anonymous"></script>
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<script src="https://cdnjs.cloudflare.com/ajax/libs/popper.js/1.14.3/umd/popper.min.js"
integrity="sha384-ZMP7rVo3mIykV+2+9J3UJ46jBkOWLaUAdn689aCwoqbBJIiSnjAK/18WvCWPIPmM49"
crossorigin="anonymous"></script>

<script src="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/js/bootstrap.min.js"
integrity="sha384-ChfqqxuZUCnJISK3+MXmPNIyE6ZbWh2IMqE241rYiqIxyMiZ60W/ImZQ5stwEULTY"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.js"></script>

Replacement lines:

<link rel="stylesheet" href="./bootstrap.min.css>
<link rel="stylesheet" href="./all.css">
<link rel="stylesheet" href="./vis.min.css">

<script src="./jquery-3.3.1.slim.min.js"></script>
<script src="./popper.min.js"></script>

<script src="./bootstrap.min.js"></script>

<script src="./vis.js"></script

If you set a module as a compilation unit in the control coupling properties, you get a control coupling report with
compilation units in output of your project build. If you set a module as a function, you get a control coupling report
with function in output. For more details about the control coupling settings, see Set Control Coupling options on
page 183 for HCL OneTest™ Embedded for Eclipse IDE. In a report with function as module, the report shows all the

function calls (internal and external).
The Control Coupling report includes three parts.

Summary

In the Summary section, you find the number of Control Couplings for your application that are covered, given the

information that you provided and the percentage of Control Couplings that are covered.
A graph displays the total percentage of covered and non covered control couplings for the entire application.

The Summary table displays the following information:

- The percentage of Control Couplings of your application by module pairs that have not been covered,
depending on the information that you provided.
« The percentage of Control Couplings that are covered by module pairs.
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Filter Modules l m Show Hide Graphs Show Hide Requirements

Summary
# Control Coupling 98 (filtered W)
% Control Coupling covered 33%
Control Coupling covered
Details

The Details table lists all the Control Couplings and displays the following information for each of them:

« The calling compilation unit.

 The control flow, for example: the successive calls in the module that end with the external call in the called
module. Note that the called module is mentioned in the last function of the control flow. In case of option
"module as function®, this control flow contains only two functions.

- A check mark if it is a longest Control Flow but only if the "module as compilation unit" option is set.

- A check mark if it is a shortest Control Flow but only if the "module as compilation unit" option is set.

« The list of test cases that covered this control flow. If the Control Coupling feature is set with the unit testing
feature, the test cases are the one in the . pt u files named as <service>/<test>.

- The associated requirements. If the Control Coupling feature has been set with the unit testing feature, the
requirements are those that have been described in the . pt u files with the keyword REQUIREMENT for each
test cases that covered this Control Coupling.

« A check mark if the control coupling has been covered.

Call Graph

For each compilation unit, a partial call graph displays all the functions in an interactive call graph from left to right or

from top to bottom, depending on the selector button position on the top of the call graph.

You can select a control coupling in the table to highlight it in the call graph.
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At the end of the report, a complete call graph displays all the functions calls.

Filters

You can apply filters in the report by selecting different options at the top:

- If the option “module as compilation unit" option is set, you can choose first to display all Control Couplings,
the longest (only the Control Couplings that have the longest control flow in the calling module) or the
shortest (only the Control Couplings that have the shortest control flow in the calling module). The summary
tables and the details table are updated accordingly to your selection. This option applies to reports with
compilation unit as module only.

« You can select the calling modules and the called modules. It filters the Control Couplings depending on
their calling and called modules. The summary tables and the details table are updated accordingly to your
selection.

* You can choose to display all graphs or hide them in the report.

« You can show or hide the Requirements.

Customize Control Coupling Report

The Control Coupling report is created from a template called ccreport.template (if option “module as compilation
unit" is set), or ccfreport.template (if option “module as function” is set) that you can find in the folder <install>/lib/

reports.

This template is made of 2 parts:

e The HTML part that is the common part of all reports,
A JavaScript part that sets the tables and call graph depending of 2 variables initialized dynamically when the

report is creating:
var data = {{json}}; // the raw data

var d = new Date({{date}}) // the date of the generation
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Raw data

Raw data is composed of 4 sections at the top level:

« A summary of the Control Coupling metrics:
> nbecc is the number of Control Coupling found in the application,
> nbcovered is the number of Control Coupling found in the application that have been covered by at
least one test,
> nbccShortest and nbcoveredShortest are the same for the shortest Control Coupling,
- nbccLongest and nbcoveredLongest are the same for the longest Control Coupling,
- filtered is set to true if the report has been generated with a filter (shortest or longest),
- filtered_longest is set to true if the report has been generated with a filter longest (set only if filter is

true).

"filtered": ,
"filtered longest™: ,
"nbcc": 112,

"nbcovered”: 48,
"nbccshortest™: 32,
"nbcoveredshortest™: 25,

"nbcclongest™: 58,
"nbcoveredLongest": 23

« The list of the modules, each of them has the following information:
> Name is the short name of the C file,
> Fullname is the name and path of the C file,
o uuid is a unique identifier of the module,
- unknown is set to true is the module is not part of the information you provided (there is only one
unknown module that gathers all the call to functions that are not in the known modules),

- functions is the list of the unique identifiers of functions of the module.
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Modules are listed as hashmap with the uuid, as follows:

"modules": {
"f5bb57% deacald2dfd78a6780c0cdc92m: |
"name": "USAGE.C",
"uuid": "fOb5579%edeacal82df478a6780c0c4c92",
"unknown": ;

"functions": [
"ba9eb05ad703046fed306b4271b7cad/"

]
by

« The list of functions including following information:
> name is the name of the C function,
- line is the first line of the function in the module,
o id is the number used in .tsf file to identify this function,
- stacksize is the stack size computed during the execution if this option has been set (otherwise -1),
- uuid is a unique identifier of the function,
- module is a unique identifier of the module in which the function is declared,
o calls is the list of the calls in this function. Each of them have the following information:
= calling_uuid is the unique identifier of the calling function,
= called_uuid is the unique identifier of the called function,
= line is the line number of the call in the module,
= col is the column number of the call in the module,
= same_module is set to true id the called function is in the same module that the calling
function.
- level is a number that represent the level of the function in the call graph, starting to 0.
- calledby is the list of unique identifiers of functions that call this one.
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- Functions are listed as hashmap with the uuid, as following:

"functions": |
"bateb05ad703046fed206b4271b7ead": |

"name": "write usage",

"line™: 9,

Tlid'rl . l_,

"gtacksize": L,

"ouid": "bal9ehb05ad703046fed306b4271b72ad?",
"module": "fibELTVOedeacalfidlrd78ae780c0cdcB2",
"calls™: [

i
"calling uuid": "ba9eb05ad703046fed306b4271b7ead7",
"called uuid": "7bécdbd3bbbddelebl0f3056272%ba™,
"line™: 10,
"col": 2,
"same module":

}

1,

"level™: 1,

"calledby": [
"Ifh6bZ206509c8bT0fchd01ba797abacl "
1

bro

- The list of the Control Couplings, each of them have the following information:
o calls is the list of successive calls that composed this control coupling, each of them have the
following information:
= calling_uuid is the unique identifier of the calling function.
= called_uuid is the unique identifier of the called function.
= isShortest is set to true if the control coupling is a shortest one.
= isLongest is set to true if the control coupling is a longest one
= line is the line number of the call in the module.
= col is the column number of the call in the module.
= same_module is set to true if the called function is in the same module that the calling
function.
- testcases is the list of test cases that covered the control coupling, each of them have the following
information:
= name is the name of the test case.
= requirements is the list of requirements that is covered by this test case.
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Control couplings are listed as an array, as follows:

"controlcouplings": [
1
"isLongest": '
"calls™: [

{
"calling uuid": "3fb6b20659c9b70fcéd01ba797abaclf",

"called uuid": "0ddedlfbch09e237ch0600£451d27d59",
"line™: 100,

"col™: 19,

"zame module":

}
1,

"teskcases": [

i
"name": "fct &8/1",
"requirements™: [

{
"name": "REQ PTU 123"

Data Coupling

Data Coupling is defined as “the manner or degree by which one software component influences the execution of
another software component” in the Clarification of Structural Coverage Analyzes of Data Coupling and Control
Coupling document edited by the Certification Authorities Software Team (CAST). The purpose is 'to provide a
measurement and assurance of the correctness of these modules/components’ interactions and dependencies'. Data
Coupling is used to verify that all the global variables of the application under test have been consumed in read (also

called use) and write (also called def) during the tests.

HCL OneTest™ Embedded introduces a new coverage level call “data coupling” for C language that consists to verify
that all the global variables of the application under test has been consumed in read (also called use) and write (also

called def) during the tests, as following:

« For each global variable, HCL OneTest™ Embedded identifies the def and use. Then it considers all the
possible def/use pair as a data coupling.

- To cover a Data Coupling, i.e. a def/use pair, this def and this use must be executed from at least one test.

HCL OneTest™ Embedded provides a new interactive HTML-based report for Data Coupling.
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To identify Data Coupling instances, HCL OneTest™ Embedded analyzes all the global variables of the application,
where they are read and written. For one global variable, each pair of write and read constitutes an instance of Data
Coupling.

For each data coupling, HCL OneTest™ Embedded provides the following information:

« The name of the global variable.

« The def position (file name, line, and column).

* The use position (file name, line, and column).

« The list of test cases that covered the Data Coupling.

« The list of requirements that are relative to these test cases.

How Data Coupling works

HCL OneTest™ Embedded identifies the position if the def/use using coverage information. When you select the Data

Coupling option, some coverage options are set automatically: blocks, calls and conditions.

Coverage files (.fdc and .tio) are the input of the report generator that produces a report in HTML format (and
optionally the raw data can be generated in a Json file). A template is provided for this generator. You can provide

your own template to modify the report.

If the Data Coupling feature is used with unit testing feature, the report generator could take as input the .tdc
files. This allows to have also in the report the test cases that covered each Control Coupling and the associated
requirements declared in the .ptu file. If not, the test cases are identified by its execution date, and there is no

requirement.
Set Data Coupling Options
You can set the options for Data Coupling to build your project in HCL OneTest™ Embedded for Eclipse IDE.

In the Project Explorer, right-click on the project and click Properties, then click C C++ Build > Settings. In the Build
Settings tab, under the Coupling menu, select Data Coupling.

From this setting page, you can change the following choice:

» Report Template: You can change the template of the report generator. By default, this template is

ccreport.template.

Data Coupling report

From HCL OneTest™ Embedded V8.2.0, you can get a HTML interactive Data Coupling report as a result to your
project build.

The default Data Coupling report is in HTML format. It is generated from a template named dcreport.template

provided as a text file that you can modify to customize the report. It uses four online JavaScript libraries:
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» Bootstrap,

» JQuery,

* Font Awesome,
* VisJS.

These libraries are not provided. You need an Internet connection when you open the report. Otherwise, download the

libraries (.css and .js files), copy them in the same folder as your report's, and modify the template file as follows:

Replace:

<link rel="stylesheet" href="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/css/bootstrap.min.css"
integrity="sha384-MCw98/SFNGE8fJIT3GXWEONgsV7Zt27NXFoaoApmYm81iuXoPkFOJwJI8ERdknLPMO"
crossorigin="anonymous">

<link rel="stylesheet" href="https://use.fontawesome.com/releases/v5.5.0/css/all.css"
integrity="sha384-B4dIYHKNBt8Bc12p+WXckhzcICo®wtJAoU8YZTY5qEOId1GSseTk6S+L3B1XeVIU"
crossorigin="anonymous">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.min.css">

<script src="https://code.jquery.com/jquery-3.3.1.slim.min.js"
integrity="sha384-q81i/X+965Dz00rT7abK41JIStQIAqVgRVzpbzo5smXKp4YfRvH+8abtTE1Pi6jizo"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/popper.js/1.14.3/umd/popper.min.js"
integrity="sha384-ZMP7rVo3mIykV+2+9J3UJ46jBkOWLaUAdn689aCwoqbBJIiSnjAK/18WvCWPIPmM49"
crossorigin="anonymous"></script>

<script src="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/js/bootstrap.min.js"
integrity="sha384-ChfqqxuzZUCnJISK3+MXmPNIyE6ZbWh2IMqE241rYiqIxyMiZ60W/ImZQ5stwEULTY"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.js"></script>

with

<link rel="stylesheet" href="./bootstrap.min.css>
<link rel="stylesheet" href="./all.css">
<link rel="stylesheet" href="./vis.min.css">

<script src="./jquery-3.3.1.slim.min.js"></script>
<script src="./popper.min.js"></script>

<script src="./bootstrap.min.js"></script>

<script src="./vis.js"></script

The Report is made of three parts.
Summary

In the summary section, a table displays the following information:

» The number of global variables in your application.

» The number of Data Couplings in your application.

 The number and the list of global variables without Data Coupling. If you get this information,
it means that HCL OneTest™ Embedded has identified global variables that are read but never
written, or written but never read. This could be due to the fact that only a part of the application

is analyzed.
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Two charts display the following information:

- The percentage of Data Coupling in a pie graph.
« A two-colored horizontal graph that provides a number of covered and uncovered Data

Couplings for each global variable.

Not covered Covered I Not covered Covered

currentDate

updated

% Data Coupling covered 0 05 10 15 20 25 30

Details

A table lists all the Data Couplings and displays the following information for each of them:

« Variable: The name of the global variable.

« Def: The Def position of the column: file name [line] and (column).

» Use: The Use position of the column: file name [line] and (column).

» Test Cases: The list of cases that covered the Data Coupling.
 Requirements: The list of requirements relative to these test cases.

« Covered: This option is checked if the Data Coupling has been covered.

They are grouped by global variables.

Details

Variable Def Use =T Requirements

Global Vanable "‘currentDate’

currentDate main [MAIN.C] (32:2) main [MAIN.C] (118:T) = g name &1 [Thu Moy 14 14:06:14 2019)
currentDate  main [MAIN.C] (33:2) main [MAIMN.C] (123:2) = Ia r};irrru' #7 [Thu Nov 14 140614 2019)
currentDate DiffDays [DIFFDATES.C) (74:28) main [MAIN.C] (118:7)
currentDate  DiffDays [DIFFDATES.C] (74:28)  main [MAIN.C] (123:2)

Global Variable ‘updated’

This variable ‘updated’ is written but never read within the selected compilation units

Covered
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Call graph

The call graph displays all the global variables with their interactions with one or more functions of the

application that read or/and write them.

« Incoming arrows are 'Def' (write).

« Outcoming arrows are 'Use' (read).

The arrows between them represent a 'Def’ or a 'Use' (depending of the sense of the arrow). It is green
if the corresponding 'Def' or 'Use’ has been covered. These arrows are not representing Data Coupling.
A Data Coupling instance is a couple of incoming and outcoming arrows that reach the same global

variables.

Filters

Buttons can be used to filter different sections of the report.

- Show/Hide Graph: It is used to show or hide the call graph at the end of the report.
- Show/Hide Requirements: It is used to show or hide the Requirements column in the Details

section of the report.
Customize Data Coupling Report

The Data Coupling report is based on a template called ccreport.template that you can find in the following folder:

Raw data

This template is made of 2 parts:

« The HTML part that is the common part of all reports,
« A JavaScript part that sets the tables and call graph depending of 2 variables initialized dynamically when the

report is creating:
var data = {{json}}; // the raw data

var d = new Date({{date}}) // the date of the generation
Raw data is composed of 4 sections at the top level:

« A summary of the Data Coupling metrics:
- nbGlobalVariables is the number of global variables found in the application.
> nbDefUses is the number of Def/Use pairs found in the application.
- nbDefUsesCovered Def/Use pairs found in the application that have been covered by at least one test.
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- nbVariablesWithoutDefUse is the number of global variables that have no Def/Use pairs in the
application.
- variablesWithoutDefUse is the list of global variables that have no Def/Use pairs in the application.

"‘nbGlobalVariables™ 2,

"nbDefUses™ 4,

"nbDefUsesCovered'™: 2,

‘nbVariablesWithoutDefUse™ 1,

“varablesWithoutDefUse™ [
"updated"

]

« The list of the modules, each of them has the following information:
- Name is the short name of the C file,
> Fullname is the name and path of the C file,
- uuid is a unique identifier of the module,
- unknown is set to true is the module is not part of the information you provided (there is only one
unknown module that gathers all the call to functions that are not in the known modules),

- functions is the list of the unique identifiers of functions of the module.

Modules are listed as hashmap with the uuid, as follows:

"modules”; {
"f5b5579%edeaca82df478a6780c0c4c92™: {
"name": "USAGE.C",

“fullname™ "..."
"yuid": "f5b5579%edeacal2df478a6780c0c4c92",
"unknown"; \

"functions™ [

"ba9eb05ad703046fed306b4271b7ead7"”

]
..

« The list of functions including following information:

- name is the name of the C function,

o line is the first line of the function in the module,

o id is the number used in .tsf file to identify this function,

- stacksize is the stack size computed during the execution if this option has been set (otherwise -1),

- uuid is a unique identifier of the function,

> module is a unique identifier of the module in which the function is declared,

o calls is the list of the calls in this function. Each of them have the following information:
= calling_uuid is the unique identifier of the calling function,
= called_uuid is the unique identifier of the called function,
= line is the line number of the call in the module,
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= col is the column number of the call in the module,
= same_module is set to true id the called function is in the same module that the calling

function.
o level is a number that represent the level of the function in the call graph, starting to 0.

- calledby is the list of unique identifiers of functions that call this one.
- Functions are listed as hashmap with the uuid, as following:
"funchions®: {

"bafeb05ad703046fed306b427 1bTead 7™ {
“name”: “wiile_usage”,

“line®: 9,

Nid™ 1,

“slacksize”. -1,

“yuid™ "badeb05ad703046fed306b427 1h7eadT",
"module™. Fob55T7edeacal2df478a6780c0c4c92”,

"calls™; [

{
“calling_uuid": “bafebliad703046fed306b427 1hfead?™,
“called_uuid™ "7hécd6d3bHbdde 1051 MINBE2T7 20aba”,
“lina™; 10,
“col™; 2,
}"WLL‘?#'EAH‘J%"-
]I

“leval™; 1,
"calledby: [
"IhEL20659cb FOfcBdD1bal 9 abae 11

|
Lo

- The list of the control flows, each of them have the following information:
- stacksize is the size computed for this control flow. This value is -1 if the tool was unable to compute.
o calls is the list of successive calls that composed this Control Flow, each of them have the following
information:
= calling_uuid is the unique identifier of the calling function.
= called_uuid is the unique identifier of the called function.
= line is the line number of the call in the module.
= col is the column number of the call in the module.
= same_module is set to true if the called function is in the same module that the calling

function.
= alternates is a list of line and column if the function is called several times in this function

- isRecursive is set to true if a recursive call has been found in this control flow.

= name is the name of the test case.
= missingFunctions is the list of functions (name and unique identifier) in the control flow for

which there is no stack size.
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Control couplings are listed as an array, as follows:
“vanables": |

{ ‘name” "curentDalte”,
“line™ 7,
"moduleuuid™: "e60218b872e86c7d154afde306e9160a",
*iﬂs [

“linglocal™ -1,
"line”. 33,
"col™: 2
"function™: "main"”,
"modulewud™ "4306a1i82e1b1400a35d13acBe2efcei™,
"isdef” true,
"where™. "bloc”,
"varaibletype™ "global”,
"covered. true

| 3

l.

"uses” |

{
“vanablename": “cumeniDate”,
"linelocal™ -1,
"line”: 118,
"eol™ T,
"function”. "man”,
"meduleyusd™ "4306a1182e1b1400a35d1 Jacte2efca™,
"tedef” false,
“where". "cond!!
“yaraibletype™ "global”,
"covered™: true

N

“nbDefllses” 4,

“testcases” |

[
[

{
"name”. Yot 81",
"requirements”: |

"name”; "REQ_PTLI 123"

Application Profiling

Application Profiling is gathering the main features that provide profiling information at the application level: the
Worst Stack Size feature and the Worst performance (coming soon) feature.

Worst Stack Size

HCL OneTest™ Embedded introduces the Worst Stack Size feature to compute an estimation of the maximum stack
size of the application under test.

Overview
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To implement this feature, HCL OneTest™ Embedded uses two mixed technologies:

- Static analysis that computes the call graph of the application (Example: all the calls between functions are
analyzed and computed as a graph),

« Dynamic analysis that provides the stack size of each functions when executing them.

This information is used to provide an estimation of the worst stack size. This estimation is accurate under the
following conditions:

« All the functions of the application should have been executed at least once in order to have the stack size for
each of them.

« Your application should not have recursive calls, because the number of loops in the recursive calls being
unpredictable, it is impossible to compute the stack size.

« If your application used libraries (Example: call functions for which we have not the source code), you should
provide an additional file that gives an estimation of the stack size for each of them. These estimations do not
need to be precise, but should be an upper bound of the exact stack size.

« If your compiler optimizes the Stack Size, you might have different Stack Sizes for the same function. In this
case, the Worst Stack Size is computed with the maximum value found in the different runs.

- If your application is multi-threaded, you can provide the list of entry points so that HCL OneTest™ Embedded
can calculate the worst total stack size and compare it to the maximum memory stack available on your
target to produce a pass/failed verdict.

For the Worst Stack, HCL OneTest™ Embedded provides a brand-new interactive HTML-based report. This report
identifies if one or more of these conditions are not met.

How Worst Stack Size Works

When an application node is executed, the source code is instrumented by the Instrumentor (attolcc4
for C language) that produces a static file with the .tsf extension that contains information on the
functions (this file is common with Control Coupling feature). The resulting source code is then
compiled, linked and executed and the Control Coupling feature outputs a dynamic file with the

extension .tzf.

These 2 types of files are used in input of the report generator that produces a report in HTML format
(and optionally the raw data can be generated in a Json file). A template is provided for this generator.
You can provide your own template to modify the report. An addition file could be provided to this report
generator in order to specify the stack size of the external functions.

Note:

To visualize your report in Eclipse, if you are using the default browser option, be sure that JavaScript is enabled.
Otherwise, you can choose another browser that is compatible with your version of JavaScript by changing it in
Window> Preferences> General > Web Browser.
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Set Worst Stack Size Options

Enable Worst Stack Size

« In HCL OneTest™ Embedded Studio, open the settings of the project and click Configuration Properties >
Build > Build options.

- Then, in the right panel, click on the value field of the Build options line and click the ... button to open the
Build options editor.

« Then, a dialog window shows you on the right the different tools that you can select during the build. Select
Application profiling to enable the Worst Stack Size feature.

Multi-thread option

The Multi-thread option for the Worst Stack Size feature can be configured in the following menu of the settings:

« Click Configuration Properties > Runtime analysis > Multi-Threads.
« In the right pane, click the ... in the value field of the Entry points option to open the Entry points editor.
« In the Entry points editor, enter the list of entry points for each thread and click OK.

Stack Size options

Options for the Worst Stack Size feature can be updated in the following menu of the settings: Configuration

Properties > Runtime analysis > Application Profiling > Stack size.

In the setting page, you can change the following options:

« Trace file name (.tzf): set the name of the trace file dedicated to worst stack size. By default this name is the
base name of the test with the extension .tzf.

- Report Template: change the template of the report generator. By default this template is wssreport.template.

« External functions stack size: this is a file that contains the stack size of the external functions (generally
functions that are in libraries and used by your application). The format of this file should be in Json, with the

extension .tzfe, as follows:

[

{"name":"printf", "stacksize":4},
{"name":"sin", "stacksize":4},
{"name":"cos", "stacksize":4},
{"name":"tan", "stacksize":4}

]

» Maximum Size: Enter the maximum stack size in bytes that the application should not exceed.

- Security: Enter a percentage of available Stack Size for security.

If you provide the maximum Stack Size allowed and a percentage of available Stack Size for security, the

report displays the total Stack Size and verify if this size does not go over the available Stack Size.

Set Worst Stack Size Options
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Enable Worst Stack Size

- In the Project Explorer, right-click on the project and click Properties.

« In the Properties window, click C C++ Build > Settings.

« In the Build Settings tab, click Settings > General > Selective instrumentation.

- In the right pane, click the Value field in Build options and click ... to open the Build options
window.

« In the Build options list, click Application Profiling to enable the Worst Stack Size feature.
Multi-thread option

« In the Project Explorer, right-click on the project and click Properties.

« In the Properties window, click C C++ Build > Settings.

« In the Build Settings tab, click Settings > General > Multi-thread options.

- In the right pane, click the ... in the value field of the Entry points option to open the Entry points editor.
« In the Entry points editor, enter the list of entry points for each thread and click OK.

Worst Stack Size options

In the Project Explorer, right-click on the project and click Properties, then click C C++ Build > Settings. In the Build
Settings tab, under the Application Profiling menu, select Stack Size.

In the setting page, you can change the following options:

- Trace file name (.tzf): set the name of the trace file dedicated to worst stack size. By default this name is the
base name of the test with the extension .tzf.

- Report Template: change the template of the report generator. By default this template is wssreport.template.

- External functions stack size: this is a file that contains the stack size of the external functions (generally
functions that are in libraries and used by your application). The format of this file should be in Json, with the

extension .tzfe, as follows:

L

{"name":"printf", "stacksize":4},
{"name":"sin", "stacksize":4},
{"name":"cos", "stacksize":4},
{"name":"tan", "stacksize":4}

]

« Maximum Stack Size (byte): Enter the maximum stack size in bytes that the application should not exceed.

- Percentage of available Stack Size for security: Enter a percentage of available Stack Size for security.

If you provide the maximum Stack Size allowed and a percentage of available Stack Size for security, the

report displays the total Stack Size and verify if this size does not go over the available Stack Size.

Worst Stack Size Report
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The default Worst Stack Size report is in HTML format. It is generated from a template named wssreport.template

provided as a text file that you can modify to customize the report. It uses four online JavaScript libraries:

» Bootstrap,

» JQuery,

* Font Awesome,
* VisJS.

These libraries are not provided. You need an Internet connection when you open the report. Otherwise, you need to
download the libraries (.css and .js files), copy them in the same folder as your report's, and modify the template file

as follows:

Replace:

<link rel="stylesheet" href="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/css/bootstrap.min.css"
integrity="sha384-MCw98/SFnNGE8fJIT3GXWEONgsV7Zt27NXFoaoApmYm81iuXoPkFOJwI8ERdAknLPMO"
crossorigin="anonymous">

<link rel="stylesheet" href="https://use.fontawesome.com/releases/v5.5.0/css/all.css"
integrity="sha384-B4dIYHKNBt8Bc12p+WXckhzcICoOwtJAoU8YZTY5qEOId1GSseTk6S+L3B1XeVIU"
crossorigin="anonymous">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.min.css">

<script src="https://code.jquery.com/jquery-3.3.1.slim.min.js"
integrity="sha384-q81i/X+965Dz00rT7abK41JIStQIAqVgRVzpbzo5smXKp4YfRvH+8abtTE1Pi6jizo"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/popper.js/1.14.3/umd/popper.min.js"
integrity="sha384-ZMP7rVo3mIykV+2+9J3UJ46jBkOWLaUAdn689aCwoqbBJIiSnjAK/18WvCWPIPmM49"
crossorigin="anonymous"></script>

<script src="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/js/bootstrap.min.js"
integrity="sha384-ChfqqxuZUCnJISK3+MXmPNIyE6ZbWh2IMqE241rYiqJIxyMiZ60W/ImZQ5stwEULTY"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.js"></script>

with

<link rel="stylesheet" href="./bootstrap.min.css>
<link rel="stylesheet" href="./all.css">
<link rel="stylesheet" href="./vis.min.css">

<script src="./jquery-3.3.1.slim.min.js"></script>
<script src="./popper.min.js"></script>

<script src="./bootstrap.min.js"></script>

<script src="./vis.js"></script

The Worst Stack Size report is made of three parts.
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Summary

204

Worst Stack Size per Entry Point table

Summary

Worst Stack Size per Entry Point 1616 bytes

# Control Flows 165 2

# Control Flows without Stack Size E
# Recursive Computed Control Flows 0 0

# Functions 37 3

The Summary section displays a table with the Worst Stack Size calculated by the tools, given the

information you provided in the build settings. This number is provided in bytes.

The Worst Stack Size is given per entry point and per thread if you have entered the list of entry point
threads of your application in the Build Settings. You can set the list of entry point threads of your
application in the Build Settings.

The table displays the following information:

» The number of control flows found in your application. A control flow is a set of successive calls
starting from an entry point (each function that is never called by another one is considered as

an entry point) to a function with no call or to an external function.

The number of control flows for which we have no estimation of the stack size. This happens
when one of the functions in this control flow has not been executed or if it is an external

function for which no estimation of the stack size is provided.

If this number if greater than 0, it is highlighted in red because there is no way to be sure that the

worst stack size is really the worst regarding the missing information.

The number of recursive control flows found in the application. If this number if greater than 0,
it is highlighted in red because there is no way to be sure that the worst stack size is really the

worst.

The number of functions in your application.
The number of functions without stack size estimation. These are the functions that have not

been executed or the external functions for which we have not provided an estimation of the
stack size. If this number if greater than 0, it is highlighted in red because we can't be sure that

the worst stack size is really the worst.
The information is given for each entry thread.

If you don't provide the list of entry points in the build settings, the information is displayed only

for the control flow and gives the Worst Stack Size.
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Total Stack Size vs. Maximum Stack Size graph

Total Stack Size vs. Maximum Stack Size

Total Worst Stack Size 1616 bytes
Maximum Stack Size 3000 bytes
% Stack Size for Security 30 %

Maximum Stack Size Allowed 2100 bytes

If you provide in the Settings the list of entry points, optionally you can provide the maximum Stack Size
allowed and a percentage of available Stack Size for security. In such case, the report displays the total

Stack Size and verifies if this size does not go over the available Stack Size.

The Maximum Stack Size and Percentage of available Stack Size for security options can be set in the
Build Settings.

In the report, you can compare the Stack Size or the sum of Stack Size with the maximum of Stack
Size allowed and the percentage of available Stack Size for security if both options are provided in the
settings.

In the toolbar that is under the graph, you can select the information to display or hide (all entry points, or for only one
thread) and the number of control flows in the table. You can also show or hide the graph in the report from a button.

Details

The Details table lists by default the 10 first control flows with the biggest Stack Size and displays for each of them

the following information:

« The control flow, for example, the successive functions starting from an entry point (any function that is never
called by another one is considered as an entry point) to a function with no call, or to an external function.
Each function is identified by its name, its module (example: C file) between brackets, and by the line and
column where this call to the next function calls appear in the code in parenthesis.

« The estimation of the Stack Size. The information is blank if the tool has not been able to calculate the Stack
Size for this control flow. In this case, the functions in the control flow that prevent us from computing the
Stack Size are highlighted in red.

A drop down menu at the top of the table allows you to choose 10, 20, 30, 50, 100 or all the control flows to display.

Functions

The Functions table lists all the functions of your application, including external functions. The following information
is provided for each function:
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» The module name (i.e. the C file) where the function is saved.,

» The function name. This name is in red if there is no stack information for this function,
« The number of functions called in the current one.

 The Stack Size of the function in bytes.

Call Graph

The Call Graph part displays all the functions as an interactive call graph from left to right or from the top to the

bottom, depending on the selector button position on the top of the call graph.

You can select a control flow in the table to highlight it in the call graph.
Customize the Worst Stack Size Report

The Worst Stack Size report is based on a template called wssreport.template that you can find in the folder

<install>/lib/reports.

This template is made of 2 parts:

« The HTML part that is the common to all reports,
A JavaScript part that sets the tables and call graph depending on 2 variables dynamically initialized when the

report is created:
o var data = {{json}}; // the raw data

o var d = new Date({{date}}); // the date of the generation

Raw data

Raw data is made of four sections at the top level:

« A summary of the Worst Stack Size metrics:

- worstStackSize is the worst stack size computed by the tools, depending on the information you
provided. This number is provided in bytes.

> nbFlows is the number of control flows found in your application. A control flow is a set of successive
calls starting from an entry point (each function that is never called by another one is considered as an
entry point) to a function without calls or to an external function.

> nbFlowsWithoutStack is the number of control flows for which there is no estimation of the stack
size. This happens when one of the functions in this control flow has not been executed, or if it is an
external function for which we have not provided an estimation of the stack size.

- nbRecursiveFlows is the number of recursive control flows found in the application.
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- nbFunctions is the number of functions in your application.

- nbFunctionsNoValue is the number of functions without stack size estimation. These are the

functions that have not been executed, or the external functions for which there is no estimation of the

stack size provided.

"worstStackSize™: 2139,
“nbFlows’: 167,
"neFlowsWithoutStack™ 70,
‘nbRecursiveFlows™ 0,
‘nbFunctions:” 40,
"nbEunctionsNoValue™ 10

The list of the modules, each of them has the following information:

* name is the short name of the C file,

« fullname is the name and path of the C file,

- uuid is a unique identifier of the module,

« unknown is set to true if the module is not part of the information you provided (there is only one unknown
module that gathers all the function calls that are not in the known modules),

« functions is the list of the unique identifiers of functions of the module.

Modules are listed as Hashmap with the uuid, as following:

"modules™: {
"f5b5579edeacaB82df478a6780c0c4c92"; {
"name”: "USAGE.C",

"fullname” "...",
"uyid": "fob5579edeaca82df478a6780c0c4c92",
"unknown": ,

“functions™: [
"ba9eb05ad703046fed306b4271b7ead7"

]
..

The list of functions, each of them have the following information:

» name is the name of the C function.

« line is the first line of the function in the module.

« id is the number used in .tsf file to identify this function.

- stacksize is the stack size computed during the execution if this option has been set (otherwise -1).
« uuid is a unique identifier of the function.

» module is a unique identifier of the module in which the function is declared.

- calls is the list of the calls in this function. Each of them have the following information:
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- calling_uuid is the unique identifier of the calling function.

- called_uuid is the unique identifier of the called function.

o line is the line number of the call in the module.

o col is the column number of the call in the module.

- same_module is set to true if the called function is in the same module that the calling function.
- level is a number that represents the level of the function in the call graph, starting from 0.

- calledby is the list of unique identifiers of functions that call the function.

Functions are listed as hashmap with the uuid, as following:

"functions”; {
"ba9eb05ad703046fed306b4271b7ead 7" {
"name”: "write. usage”,
"ling™ 9,
"id™ 1, _
“slacksize™ -1,
"yuid™: "bafeb05ad03046fed306b427 1b7eadi",
"module”; "f3bi57%edeacal2df478a6780c0c4c92”,
“calls™ |
{
“calling_uuid™ "ba%eb05ad703046fed306b427 1b7ead7",
"called, uuid”™: “7Th6cd643b5b44e1e0510f30f6272%eba”,
"line™; 10,
"E.Dl": ?I
"same.module”™
}
]?
“level™ 1,
“calledby™ |
"3b6b20659cb70fc6d(1bar97fabae 1"

]
he..

The list of the Control Flows, each of them have the following information:

- stacksize is the size of the stack computed for the control flow. This value is -1 if the tool was unable to
compute it.
« calls is the list of successive calls that composed this control flow, each of them is including the following
information:
- calling_uuid is the unique identifier of the calling function.
- called_uuid is the unique identifier of the called function.
o line is the line number of the call in the module.
o col is the column number of the call in the module.
- same_module is set to true id. The called function is in the same module that the calling function.
- alternates is a list of line & column in case of the calling function is called several times in this
function.
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« isRecursive is set to true if a recursive call has been found in this control flow.

- missingFunctions is the list of functions (name and unique identifier) in the control flow for which we have not

the stack size.

Control flows are listed as an array, as follows:

"controlflows™ [
{
"isRecursiye” false,
"stacksize™ 2139,
"calls™ [
{
"calling_uyid™ "3fb6b20659cab70fc6d01ba797abaalf,

"called  uuid": "0dd641fbc509e237cb0600f451d27d59",
"line™: 97

"col™: 19,

"same.module” false,

".a{JLermte;": [

"line™: 100,
"col™ 19
}
]
L.
.
"missingfunctions™ [1.

Testing software components

Component testing overview

Component testing provides a unique, fully automated, and proven solution for applications written in C/C ++,
dramatically increasing test productivity.

Component testing in HCL OneTest™ Embedded supports C ++ ANSI C89 and C99.

A test case contains code blocks which call the methods under test and check blocks for variable checks, which
verify that the values of a variable are within a specified set of requirements during the run. The test harness is the
execution unit producing the executable. It contains the test cases, the source code under test and any files required
to run the application, including libraries, stubs, and the runtime of the Target Deployment Port (TDP), which allows
the test to run on a target platform. When you run the test harness, the code is compiled and tested. If any runtime

analysis tools are engaged on the test harness, then the source code is also instrumented.

During the run, the test cases interact with the source code, producing test results, and if engaged, coverage and

runtime analysis results.

After the run, you can open the test results in the test editor to check which test cases passed or failed, and to view

the actual values obtained for each variable during the run.
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A test suite is a list of test harnesses to run automatically. It generates an additional test suite report and a merged
coverage report. The test suite can be executed in batch mode or interactively. Each test suite allows you to select
one or two different configurations. When the two different configurations are selected, the tool generates the result
report in comparison mode so that you can have the obtained values in both configurations.

Test assets overview

HCL OneTest™ Embedded several types of assets, which each describe different levels of the test environment.

These test assets include the following items:

« Test cases contain the verification actions for source code functions.

« Stubs are dummy components that allow you isolate the components under test or to replace components
that do not exist.

« Test harnesses contain test cases and the associated source files and stubs required to run the test.

« Test suites contain multiple test harnesses that are run sequentially.

Test cases

A test case applies to a function and describes the checks that are performed against the variables contained in the

component under test.

For each variable, array, or struct, you can specify an initialization value and an expected value. These values can be
finite values, sets, or ranges, with multiple comparison types. When the test case is run, each check compares the

expected value to the actual value and generates a Passed or Failed verdict.

The data used to specify initialization and expected values can be provided by native code, function calls, data

pools or linked to a data dictionary. A data pool is a table, typically imported from a spreadsheet, containing multiple
associated data sets. A data dictionary is a list of initialization and expected values for each variable type that can be
reused by multiple test cases in the project.

You create a test case by selecting a function in the project explorer or the call graph. The test case is generated with
the variables that are visible from outside the function. For each variable, a default check is added to the test case.

You can use the test case editor to specify the initialization and expected values of each variable check.

Stubs

A stub is a dummy software component designed to replace a component that the component under test relies

on, but cannot use in the test because it is not practical or available. A stub simulates the response of the stubbed
component. Stubs can also be used to isolate the behavior of the component under test to provide more reliable test
results or to simulate specific input values that cannot be practically simulated with the actual component. Stubs can

be used in the following roles:

« Retrieving and storing input values to stubbed functions from a function under test.
« Assigning output values from the stubbed functions to a function under test.
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Stubs generate passed or failed results based on the number of times that they are called.

You create a stub by selecting a function in the project explorer or the call graph. The stub is generated with the same

interface as the stubbed function.

You can use the stub editor to specify the behavior of the stubbed function. You can also add additional blocks of

code and conditions to structure the behavior of the test case.

Test configurations

The test configuration is an instance of a target deployment port (TDP) and its associated configuration settings.

Configuration settings are the particular properties assigned to each test harness for a given test configuration.

For example, you can create a test configuration for each compiler involved in your project. If you are developing
for an embedded platform, you can have one test configuration for native development on your Unix or Windows™
development platform and another test configuration for running and testing the same code on the target platform.

You can set up several test configurations based on the same TDP, but with different libraries, compilers or settings.
The configuration settings allow you to customize test and runtime analysis options for each test asset in the project.
You can reach the configuration settings for each test asset by right-clicking any node in the project explorer window

and selecting Properties > C/C++ Build > Settings and Build TDP or Build Instru.

Test harnesses

The test harness contains all the test assets that are required to compile and run the test. These test assets include:

« Test cases
« Stubs
- Required source files, including:

- Tested files: These are source files under test. The functions of these components are instrumented
and integrated into the test harness.

o Additional sources: These are dependency files that are added to test harness, but are not tested or
instrumented. For example: resource files can be compiled inside a test harness by specifying them as
additional files.

o Linked files: These are source files that are linked with the test harness but are not tested or
instrumented.

o Libraries: These are libraries that are required for the link. For example: math libraries.

The test harness can also contain header code and global declarations that are required to run the test and
instantiates the parameters of the test case.

You can use the test harness editor to add and remove test assets from the test harness and to graphically arrange
the order in which the test cases are run. You can also add additional blocks of code and conditions to structure the

behavior of the test harness.
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To run a test harness, it must be associated with a test configuration. You can do this in a run configuration or in a

test suite.

Test suites
A test suite contains multiple test harnesses that are run sequentially to provide global results for a project.

In the test suite, each test harness is associated with a test configuration (a TDP with associated configuration
settings) and can be run a second time with another test configuration to provide comparison results. For example,
this can be useful for certification purposes.

Creating test projects

In HCL® OneTest™ Embedded, projects are similar to C/C++ projects, but contain extra folders and a specific
toolchain for component testing and runtime analysis.

About this task
HCL OneTest™ Embedded can only work with its own managed build toolchain. You can also import and convert
existing Eclipse CDT projects to work with HCL OneTest™ Embedded.

To create a new project:

1. In the C/C++ perspective, click File > New > C Project/C ++ Project . Or you can work in Test RealTime
perspective, and click File > New > Project, and in the New project window, click C/C++, then C Project or C ++
Project.

2. In the C Project or C ++ Project wizard, type a Project name.

3. In Project type, select Executable > Empty project and in Toolchains, select . Click Next.

4. On the Select Configurations page, ensure that the correct configuration is selected and click Next.

You can select multiple configurations for the project.

5. On the Target Deployment Port, select a TDP that you want to use as the native target platform for your
project.

6. Click Finish.

What to do next
After creating a project, you can import an existing C/C++ project into the product or use the Eclipse CDT tools to

create a new project.

Related information
Importing C projects on page 64
Creating test harnesses from the call graph on page 226

Creating a test case from the project explorer on page 216

212



Chapter 5. Test Execution Specialist Guide

Test cases

Test case structure

The main objective of a test case is to define the variable checks that will compare the values obtained during the run

with the expected values defined in the test case.

During the run, the test case performs a call to the C function using a set of initialization expressions and compares

the return values with expected value expression. Each variable check is defined by:

» The name of the variable in the function.

« An initial expression: this is the expression of a value, or a set of values, that is submitted to the function
during the test. You can express multiple initialization values, which causes multiple iterations of calls to the
function under test.

« An expected expression: this is the expression of a value, or a set of values, that is compared to the actual
value obtained during the test. Compliance with the expected expression produces either a failed or passed

verdict for the test.

Activity diagram

The Activity diagram displays a flow chart describing the blocks that are required in the test case. If necessary,
you can add and remove blocks, conditions and arrow lines to edit the activity diagram. The test case criteria are
contained in one or several Check blocks.

The graphical flow chart allows you to add decision blocks and native C code to the test. For example, you can use
decision blocks to run specific checks when a variable matches a specific value, or you can write a code block to
define a counter and associate it with a decision block to create a loop.

Initialization and stubs
The Init & Stubs block summarizes the initialization values from all the check blocks and stub behaviors in the test

case.

Code
By default, the Code block contains code that performs the call to the function under test.

The code block enables you to add native code to a test. This can be useful to run a specific portion of code in the
middle of a test case. For example, you can change a hardware configuration before running a test or between two

check blocks that verify the same function.
You can also write a code block to define a counter and associate it with a decision block to create a loop.

Variable checks

The main objective of editing a test case is to define the variable and structure checks. This is done in the Checks

block by using the Variable checks table.
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Variable initial expressions

The initial expressions are used to assign an initial value to a variable under test. The initial expression for each

variable check is displayed in the test case.

Initial expressions can be among any of the following types:

» Numeric (integer or floating-point), character, or character string literal values, expressed using standard C
syntax.

« Native constants, which can be numeric, characters, or character strings.

« Series of values, with a From and To value, and a Step.

« Global variables that are declared by the program under test.

« A null pointer.

« Arrays and structures, any of the above-mentioned expressions between braces ('{}').

- C functions or expressions with one or more of the above elements combined using any operators and
casting, with all required levels of parentheses.

« Multiple arbitrary values, which can be specified in the test case editor, randomly picked between a given
range, or extracted from a datapool (read from a linked CSV file).

- No Change, which indicates that the test case does not set the value for the test.

- No Dump indicates that the variable initial value is not taken into account in the report, it is the same as
‘unchanged’. This option is used so that the variable is not read during the initialization phase of the test case

execution.

The data type of the variable defines what is a valid initial expression.

Initial expressions can be synchronized, which means that a list of multiple values for one variable will be
synchronized with a matching number of values for another variable. See Synchronizing multiple values on

page 219 for more information.

Additional notes
The number of values inside an initialization expression is limited to 100 elements in a single variable.

If variables are used in the initialization expression, the test evaluates the initialization value with variable values from
after the execution.

Related information

Variable expected value expressions on page 214

Editing test cases on page 216

Variable expected value expressions

The expected expressions are used to specify a test criteria by comparison with the value of a variable. The test

receives a passed verdict when the actual obtained value matches the expected value expression.
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The expected expressions can be among any of the following values:

» Numeric (integer or floating-point), character, or character string literal values. Strings can be delimited by
single or double quotes.

« Native constants, which can be numeric, characters, or character strings.

» Ranges with lower and upper values and inclusive or exclusive bounds.

« Global variables that are declared by the program under test.

« A null pointer or a non-null pointer.

« Arrays and structures, any of the above-mentioned expressions between braces ('{}').

- C functions or expressions with one or more of the above elements combined using any operators and
casting, with all required levels of parentheses. The + operator allows to concatenate character string
variables.

» No Check, which specifies that no check is performed on that variable.

« Same As Init, which specifies that the expected variable equals the initialization expression.

- Data sets that are synchronized with a multiple initialization expression.

The data type of the variable defines the acceptable values for the expected value.
Numeric values can be associated with a comparison operator in the test case editor.

Expected expressions can be synchronized, which means that a list of multiple values for one variable will be
synchronized with a matching number of values for another variable. See Synchronizing multiple values on

page 219 for more information.

Additional notes

Any integers contained in an expression must be written either in accordance with native lexical rules, or under the

form:

« hex_integerH for hexadecimal values. In this case, the integer must be preceded by 0 if it begins with a letter.
« binary_integerB for hexadecimal values.

Ranges are not allowed for pointers.
The number of values inside an expected expression is limited to 100 elements in a single variable.

If variables are used in the expected expression, the test evaluates the initialization value with variable values from

after the execution.

Euclidean divisions performed by the test case round to the inferior integer. Therefore, writing -a/b returns a different

result than -(a/b), as in the following examples:

* -(9/2) returns -4
* -9/2 returns -5

215



HCL® OneTest™ Embedded

Related information

Variable initial expressions on page 214

Editing test cases on page 216

Creating a test case from the project explorer

You can create a test case from the project by simply selecting a source file or a function. Each test case focuses on

a particular function.

To create a test case from the project explorer:

1. In the project explorer, right-click the project, source file, or a function, and click New > Test Case.
If you select a function, skip to step 3.
Result
The Create Test Case wizard opens.
2. On the Select Test Assets page, select the function or variable that you want to test and click Next.
You can choose to only display Only functions, Only variables, or you can filter the list by typing characters in
Filter. Click Clear to clear the filter list.
3. On the Test Documentation page, you can edit the description of the test, and click Next.
The Published description contains information that you want to display in the test report. Use the Internal
notes to add personal notes and comments that can be viewed and edited in the test editor.
4. On the Test Case Location page, select a folder and a type a file name for the test case and click Finish.
5. Choose whether you want to create a new test harness or use an existing one.
A test harness contains one or several test cases and is necessary to run the test.
Choose from:
o If you want to add the test case to an existing test harness, in the click No. You must edit the test
harness to add the new test case.
o If not, click Yes and create a test harness with the Create Test Harness wizard.

Results
The test case and test harness are generated in the project explorer and the test case editor opens. Editing test cases

on page 216 for information about the test case editor.
Using the test case editor

Editing test cases

The test case editor enables you to visually design test cases associated with your source code and to create variable

checks.
About this task

The test case editor is made of two panes:

216



Chapter 5. Test Execution Specialist Guide

- The Activity diagram displays a flow chart describing the blocks that are required in the test case. If
necessary, you can add and remove blocks, conditions and arrow lines to edit the activity diagram. The test
case criteria are contained in one or several Check blocks.

« The Details pane contains information about the selected block. For example, click the Inits & Stubs block to

edit the initialization parameters, headers, and stubs required to run the test case.

0 Tip: You can find where the edited file is located by clicking on the title of editor or on the header and
selecting Navigate > Show In > Project Explorer . The explorer selects the current test case and expands
automatically all parent nodes.

The main objective of editing a test case is to define the variable and structure checks in the Check block.

1. In the project explorer, open a test case.
2. In the Activity diagram, create the necessary blocks for the test case and connect them with connector lines.
The default flow chart contains an Init. & Stubs block, followed by a Code block, followed by a Check block.

a. Click Create Code Block & or Create Check Block &# buttons to create new blocks.
Code blocks can be used to run portions of C code inside the test case. Check blocks contain the test

criteria for the variables under test.

b. Click Create Decision Block & to make the execution of other blocks conditional.
You can combine code blocks and decision blocks to create loops.

c. Click Create Connector “» to connect new blocks in the diagram.
Ensure that all blocks are properly connected.

3. On the Requirements page, document requirements that are specific to your program or quality process. You
can enter the name, a comment, and if a web page exists in your requirement management tools, enter the
link to the web page that displays the requirement. You can also add requirements that come from a .cvs file.

a. To add a requirement, click € and enter a name for the requirement. You can modify the name. The
table is editable, you can modify the name of the requirement, add a comment and add a link to a web

page that is used as requirement in the table.
b. Click % to duplicate a requirement in the table.
c. Click & to view the requirement in a browser.

d. Click ¥ to add a requirement from a list. This button is available only if you previously set the
preferences to retrieve the requirements from a .cvs, .xml, or .reqif file. For more information, see Link
Tests to Requirements. The requirements are filtered by name and comment. In the test reports, you
can find the list of tests associated with the list of requirements.
4. In the Activity diagram, select a check block.
The Checked Variables table displays the variables and structures contained in the function under test.
5. For each variable or structure, specify an initial value and an expected value.

These values can be simple values, multiple values (ranges, series) or C structures.
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a. In the Checked Variables table, select a variable Initial Expression cell that you want to set and click
the menu button (=) to specify a single Value, Multiple values, a Series, whether to Use Structure
Fields, or to apply No Change to the initial value. You can also choose constructor in the list, which
means that you choose a constructor other than the default one. A constructor is a set of methods
that has the same name as the class it belongs to. It is used to initialize the current instance and it is
available only for a variable which is an instance of C ++ class.

See Variable initial expressions on page 214 for more information.

b. To edit single values, multiple values, or series, type the values in the quick edition area line above
the table. To specify structure values, edit the individual fields of the structure. To select a new
constructor, click the menu button (=) and select a value in the drop-down list.

The quick editor area adapts to the selected data type or entry mode.

c. In the Checked Variables table, select a variable Expected Expression cell that you want to set and
click the menu button = to specify an expected value or range.

See Variable expected value expressions on page 214 for more information.

Note: By default, the Obtained Value column displays the actual value for the variable obtained during
the last run. Use the Available Runs list, located at the top of the test case editor, to display the actual

values obtained during a specific run.

6. When you have finished editing the test case, click Save and close the test case.

Defining series value sets in initialization values

When a series is defined as the initial expression, the variable check generates one call to the function under test (or

iteration) for each step in the series.

To create a series value set.

1. In the test editor, select a Check block to edit the variable checks.
2. In the Initial Expression column of one variable, click the menu button (=) and select Series.

The quick edition area switches to series edition mode.

|i E] From To By Step

3. In the quick edition area, type the starting and end values of the series and the step.

The number of iterations is evaluated and displayed on the Iterations line of the test editor.

4. Press ENTER or click - to apply the changes.

Specifying multiple value sets in initialization values

When a multiple initialization value is defined, the test generates one call to the function under test (or iteration) for
each element in the set.
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To create a multiple value set.

1. In the test editor, select a Check block to edit the variable checks.

2. In the Initial Expression column of one variable, click the menu button (=) and select Multiple.

3. In the Multiple Initial Expression window, specify the number of values in the set, and click OK.

5.

The number of iterations is evaluated and displayed at the top of the test editor and the quick edition area
switches to multiple edition mode.
Enter initial and expected values for checked variables

a3 oo 700 SOREmE]N

. In the quick edition area, type a value for each element in the set.

> Press TAB to move to the next value in the set.
> Click the Previous % and Next * buttons to scroll through the elements of the set.
> You can increase and decrease the number of elements in the set.

o Click the ... button to open the advanced editor window

Press ENTER or click " to apply the changes.

Synchronizing multiple values

In a variable check, when multiple values have been defined for a variable, you can create a synchronized set of

values, with the same number of elements, which can be synchronized.

Before you begin

Synchronizing values requires that at least two sets of values (series, multiple, datapool) have been defined in the test

case. Both value sets must have the same number of elements.

About this task

Without synchronization, each combination of all the values from all sets generates one call to the function under

test, or iteration. The number of iterations is displayed in the test case editor. Using multiple sets can rapidly generate

a large number of iterations, which can cause tests to run for long periods. For example, for the values in the

following table, the test generates 5 x 5 x 2 = 50 iterations.

Vari-
able

b

c

Initialization value = Number of elements
[0.0,1.0,2.0,3.0,40] 5
[0.0,0.1,5.0,10.0,10.1] 5

[0, 1] 2

When two or more sets are synchronized, elements of each set are run together. In the previous example, if the

initialization values for a and b are synchronized, a=0 is called with b=0.0, a=2 is called with 0.1, and so on. The test

generates 5 x 2 = 10 iterations.
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Synchronizing variables enables you to run two or more sets of values in parallel, such as linked curves or sets of

coordinates.

To create a synchronized multiple value set.

1. In the test editor, select a check block to edit the variable checks.

2. In the Initial Expression column of one variable, click the Menu button and select Multiple.

3. In the Multiple Initial Expression window, select Synchronized with and select the variable which is initialized
with another multiple set.
The number of iterations is evaluated and displayed on the Iterations line of the test editor and the quick
edition area switches to multiple edition mode.
Enter initial and expected values for checked variables
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4. In the quick edition area, type a value for each element in the set.
> Press TAB to move to the next element in the set.
- Click the Previous % and Next * buttons to scroll through the elements of the set.
o Click the ... button to open the advanced editor window. The advanced editor provides an expanded

table view of the values.

5. Press ENTER or click % to apply the changes.

Defining ranges in expected values
When a range expected expression is defined, the test checks that the obtained value is within the bounds of the
range.

To create a range expected expression.

1. In the test editor, select a check block to edit the variable checks.

2. In the Expected Expression column of one variable, click the menu button (=) button and select Range >
Native Expression.
The quick edition area switches to range edition mode.

1l
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3. In the quick edition area, type the lower and upper bound values for the range and click the [ and ] buttons to

set each bound as inclusive or exclusive.

4. Press ENTER or click ** to apply the changes.

Defining a synchronized expected value

When a multiple initialization value is defined, you can specify a synchronized set of expected values. The test checks
that for each initialization value element in the multiple set, the obtained result matches the corresponding element in

the synchronized expected value set.
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To create a multiple value set.

1. In the test editor, select a Check block to edit the variable checks.

2. In the Expected Value column of one variable, click the menu button (=) and select Synchronized.

3. In the Multiple Initialization Expression window, specify the number of values in the set, and click OK.
The quick edition area switches to multiple edition mode.
Enter initial and expected values for checked variables

)] s 200 pE:s B

4. In the quick edition area, type an expected value for each element in the set.
The number of synchronized expected values matches the number of multiple initialization values.
> Press TAB to move to the next value in the set.
o Click the Previous % and Next * buttons to scroll through the elements of the set.
= You can increase and decrease the number of elements in the set.

o Click the ... button to open the advanced editor window

5. Press ENTER or click ~* to apply the changes.

Using values from a data pool

Data pools contain a series of values, or data patterns, that can be used as initialization or expected values for use in

a test case or the data dictionary.

Before you begin
The values contained in the data pool must match the type of the variable that you want to initialize.

About this task
Data pools do not import the data contained in a CSV file. When a CSV file is updated externally, any tests that refer to

the data pool will use the data contained in the updated CSV file.

To use values from a data pool:

1. In the test editor, select a Check block to edit the variable checks.

2. In the Initial Expression column of one variable, click the menu button (=) and select Data pool.

3. In Data pool, select a data pool that is in the project.
Values number indicates the number of rows contained in the CSV table.

4. In Column, select the column number of the data set that you want to use to initialize the variables and click
OK.

Results
The number of iterations displayed in the test case editor is updated to incorporate the number of values of the data

pool (or rows in the CSV file).
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Related information

Creating data pools on page 223

Generating 2D and 3D chart data on page 957

Using the data dictionary

Data dictionary overview

The data dictionary contains data sets, which are user-defined sets of values, multiples, ranges, series, or structures

that can be applied to initialization and expected values.

The data dictionary enables you to create, modify and reuse data sets in variable checks of the same type throughout

your project. You can also export data dictionaries, import them into other projects, or share them with a team.

For example, if your application frequently uses values representing the speed of a vehicle, you can predefine a data
set speed in the data dictionary, which will use a range from 0 to 200 kilometers per hour with a step of 20. You can
then apply this data set to any variable check in your project that represents speed.

The data dictionary maintains links between the data set and the variables that are linked to it. Variables that are
linked to a data set in the data dictionary are highlighted in green in the test editor.

When you modify an initial or expected value that is linked to the data dictionary, the changes automatically affect the
data set stored in the data dictionary and any other variables that are also linked to the data set.

The Data Dictionary view

The Data Dictionary view lists the data sets that you have created. Each data set has a name, a type and a set of initial

and expected values.

You can edit data sets in the data dictionary. Any changes to the initial or expected values affect the variable checks

in the same project that are linked to the data set.

If you delete a data set from the data dictionary, all variable checks that are linked to the data set retain the last

known values, but the links are removed.

Adding data sets to the data dictionary

Data sets are user-defined values that can be used as initial values or expected values in variable checks.

About this task
Data sets in the data dictionary can be linked to variables or structures in the test case editor. Once a data set is
created, it can be linked to a variable or structure. When you update the data set of a variable check that is linked to

the data dictionary, all other variable checks linked to the same data set are updated.

To add and edit data sets:
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1. In the variable check table of the test case editor, select a variable or a structure and specify its initial value
and expected value.
For a structure, specify the initial values and expected values of its components.
2. Right-click the variable or structure and select Add Initial Expression to Dictionary or Add Expected
Expression to Dictionary.
Alternatively, you can drag and drop the variable or structure into the Data Dictionary view. You can also
choose to only add the initial value or the expected value.
3. Type a name for the data set and click OK.
By default, the name of the variable or structure is used.
4. The variable or structure is listed in the Data Dictionary view and the value that is linked to a data set is
highlighted in green in the test case editor.
Choose from:
- To dissociate a highlighted value in the test case editor from its data set in the data dictionary, right-
click the value and select Remove Link from Data Dictionary.
> To associate a data set to an existing variable of the corresponding type, drag and drop the data set
from the data dictionary on to the variable check in the test case editor.
> To delete a data set, right-click the data set in the data dictionary and select Delete. All variable checks

that are linked to the data set retain the last values, but the links are removed.

Creating data pools

Data pools are links to a CSV file that is either in the file system or in the workspace.
About this task

The data pool contains series of values, or data patterns, that can be used as initialization or expected values for
use in a test case or the data dictionary. The data pattern can also be used to produce a 2D or 3D chart with the test

results.

Data pools do not import the data contained in a CSV file. When a CSV file is updated externally, any tests that refer to
the data pool will use the data contained in the updated CSV file.

To create a datapool link to a CSV file:

1. Click File > New > Other > > Data Pool.
2. In the Create Data Pool wizard, click Browse to locate the CSV file, click Open, and click Next.
3. Select a folder in the workspace, type a name for the new data pool, and click Finish.
Result
The data pool editor opens.
4. In the data pool editor, select the Import parameters and Separator options.
Ensure that the selected language matches the locale settings used to generate the CSV file.

5. When the Preview area displays the correct data, save the data pool and close the editor.
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Related reference
Data pool editor reference on page 990
Related information

Using values from a data pool on page 221

Generating 2D and 3D chart data on page 957

Test harnesses

Test harness structure

Test harnesses contains all the information required to compile and run a test. This includes, test cases, source files
under test, stubs, and Target Deployment Port (TDP) configuration settings.

These test assets include:

 Test cases
* Stubs
« Required source files, including:

> Tested files: These are source files under test. The functions of these components are instrumented
and integrated into the test harness.

- Additional sources: These are dependency files that are added to test harness, but are not tested or
instrumented. For example: resource files can be compiled inside a test harness by specifying them as
additional files.

- Linked files: These are source files that are linked with the test harness but are not tested or
instrumented.

o Libraries: These are libraries that are required for the link. For example: math libraries.

To run a test harness, you must associate it with a test configuration from a run configuration for a standalone run
or from a test suite if you want to run multiple test harnesses in a step. For more information, see Running a test

harness on page 232 and Running a test suite on page 233.

You can use the test harness editor to add and remove test assets from the test harness and to graphically arrange
the order in which the test cases are run. You can also add additional blocks of code and conditions to structure the
behavior of the test harness.

Activity flow chart

The Activity area is located on the left of the test harness editor and contains a flow chart, which describes the

behavior of the test harness. You can use this flow chart to define the order in which each test case is run.

The Activity flow chart can contain blocks of native code, which can be run before or between test cases. This can be

useful for setting parameters or changing hardware to a specific configuration before running the test case.



Chapter 5. Test Execution Specialist Guide

You can also add decision blocks, making the execution of paths in the flow chart conditional.

The calls of test cases in a test harness are all taken into account by default when a test harness is run but you can

deactivate a test case from the activity flow chart so that it is not taken into account in the generation.

Test harness details

In addition to the behavior of the test, the test harness includes information that is required to run the test. The

Details section contains the following pages:

« Context Definitions: This page lists the source code assets that are required to run the test.

- Tested files: These are source files under test. The functions of these components are instrumented
and integrated into the test harness.

- Additional sources: These are dependency files that are added to test harness, but are not tested or
instrumented. For example: resource files can be compiled inside a test harness by specifying them as
additional files.

- Linked files: These are source files that are linked with the test harness but are not tested or
instrumented.

o Libraries: These are libraries that are required for the link. For example: math libraries.

- Build Instrumentation: This page contains the configuration settings that are used to build the test. These
settings override the default configuration settings of the project.

« Stubs: This page specifies any stub files that simulate functions that are required by the functions under test.
Stubs can be used to replace functions that are under development or not practical to use for testing. They
can also be used to inject specific values or conditions into the test.

» Requirements: This page allows you document the requirements for the test case.

« Header Code: This page contains code that is run before the test cases are executed.

« Declarations: This page specifies global and local variables that must be declared in the test harness.

Creating test harnesses

Use the New Test Harness wizard to create new test harnesses. A test harness contains one or several test cases
and is required to run the test, it also includes source files under test, stubs, and Target Deployment Port (TDP)

configuration settings.

To create a test harness from the project explorer:

1. In the project explorer, right-click the project and click New > Test Harness.
If you select a function, skip to step 3.
Result
The Create Test Case wizard opens.
2. In the Create Test Harness wizard, select one or several test cases that you want to run together and click
Next.
If no test cases exist, you can click New Test Case to create a new one.
3. On the Test Harness Location page, select the folder and name for the test harness and click Finish.
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Results
The test harness is created in the specified folder and opens in the test harness editor.

Creating test harnesses from the call graph

The call graph provides a visual diagram that helps you select the functions that require testing in your project. You
can use this diagram to create a test harness that contains a test case, stubs, and other test assets required to run
the test.

1. In the project explorer, right-click the project, source file, or a function, and click Open Call Graph.
Result

The call graph displays a diagram representing the function calls in the selected component.

2. In the call graph toolbar, click Create Test Harness '
Result
This opens the Test Creation Activity view, which details the steps to create the test harness.
3. Under Test Asset Selection, select a function to test and click Next.
You can take advantage of the call graph display to locate the functions that are critical to your application.
4. If some functions require stubbing, under Stub Selection, select a function to simulate, and click Next. If the
test does not require stubs, click Next.
See Stubbing overview on page 241 for more information about stubs.
5. Under Test Case Creation, select a folder or create a new one, type a file name for the test case, and click
Next.
6. Under Test Harness Creation, select a folder or create a new one, type a file name for the test harness, and
click Finish.

The test harness contains one or several test cases and is necessary to run the test.

Results
The test cases, stubs, and test harness are generated in the project explorer and the test harness editor opens.

Editing test harnesses on page 226 for information about the test harness editor.

Editing test harnesses

Use the test harness editor to edit test harnesses.
About this task

The test harness editor is made of two panes:

« The Activity diagram displays a flow chart describing the blocks that are required in the test harness. If
necessary, you can add and remove blocks, conditions and arrow lines to edit the activity diagram. The test

case criteria are contained in one or several Check blocks. You can also activate or deactivate a test case call

in a test harness. Click a test case block in the Activity diagram, and click the <" icon in the test case block to

deactivate a test case call, or click the Pf icon to activate a test case call.

226



Chapter 5. Test Execution Specialist Guide

- The Details pane contains information about the selected block. For example, click a code block to edit the
C/C++ source code that you want to insert into the test harness or click the black initialization circle to define
the properties of the test harness. If you click a test case block in the Activity diagram, the pane displays all
functions/methods and variables used by the test harness.

0 Tip: You can find where the edited file is located by clicking on the title of editor or on the header and
selecting Navigate > Show In > Project Explorer . The explorer selects the current test harness and expands
automatically all parent nodes.

To edit a test harness:

1. In the project explorer, open a test harness.
2. In the Activity diagram, create the necessary blocks for the test harness and connect them with connector
lines.

The default flow chart contains a test case.
a. Click Insert Test Case " to add an existing test case into the test harness.

b. Click the Create Code Block & to add a block containing native C code that can be run between test

cases.

c. Click Create Decision Block a9 to make the execution of other blocks conditional.
You can combine code blocks and decision blocks to create loops.

d. Click Create Connector “ to connect new blocks in the diagram.
Ensure that all blocks are properly connected.

3. On the Context Definition page, ensure that all the source files and libraries required to compile and run the
test harness are properly defined.

> Tested files: These are source files under test. The functions of these components are instrumented
and integrated into the test harness.

- Additional sources: These are dependency files that are added to test harness, but are not tested or
instrumented. For example: resource files can be compiled inside a test harness by specifying them as
additional files.

- Linked files: These are source files that are linked with the test harness but are not tested or
instrumented.

o Libraries: These are libraries that are required for the link. For example: math libraries.

4. On the Build Settings page, you can override the project the build settings.
See Build configuration settings on page 980 for information about each of these settings.
5. On the Stubs page, specify any stub behaviors that you want to replace a function with.

See Stubbing overview on page 241 for information about stub simulation.
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6. On the Requirements page, document requirements that are specific to your program or quality process. You
can enter the name, a comment, and if a web page exists in your requirement management tools, enter the
link to the web page that displays the requirement. You can also add requirements that come from a .cvs file.

a. To add a requirement, click & and enter a name for the requirement. You can modify the name. Table
is editable, you can modify the name of the requirement, add a comment and add a link to a web page
that is used as requirement directly in the table.

b. Click "% to duplicate a requirement in the table.
c. Click & to view the requirement in a browser.

d. Click ¥ to add a requirement from a list. This button is available only if you previously set the
preferences to retrieve the requirements from a .cvs, .xml or .reqif file. For more information, see Link
Tests to Requirements. The requirements are filtered by name and comment. In the test reports, you
can find the list of tests associated with the list of requirements.

7. On the Header Code page, add native C source code that might be required run as a header for the test
harness. For example, you could add code to initialize or set the hardware to a specific state before running
the test cases.

8. On the Declarations page, add any global or local variables that need to be set before running the test

harness.

a. Click Add application variable (&) to initialize a variable in the test harness.

Select one of the variables that are declared in the application.

b. Click Add application variable to simulate (%) to simulate a variable in the test harness.
Select one of the variables that are declared in the application.

c. Click Add local variable (&) to create a local variable for the test harness.
Specify a name and a type for the new variable.

9. In the Details pane, select the icon corresponding to the feature that you want to add to the settings of your
project: Code coverage, Memory profiling, Performance profiling, Application profiling, Control coupling, Data
coupling, Runtime tracing, Static metrics, and Code review.

10. When you have finished editing, save the test harness.

Note: You can run the test harness from the editor. For details, see Running a test harness on

page 232.

Test suites

Creating test suites

A test suite contains multiple test harnesses that are run sequentially to provide global results for a project. When you
create a test suite, you select the test harnesses that will be used in the test suite run. You can also select test scripts

that can be run from a test suite.
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About this task

In the test suite, each test harness is associated with a test configuration (a TDP with associated configuration
settings). In the test suite editor, you select the main test configuration, that is an instance of a target deployment
port (TDP) and its associated configuration settings and usually carries the name of the TDP. A test harness can
optionally be run a second time with another test configuration to provide comparison results. This can be useful for

certification purposes or to compare the results of a test on two different hardware platforms.

The Test Suite Content wizard automatically displays all the files that are available in your project and that can be run
with the selected test harnesses: main test configuration files for test harnesses, .ptu files for PTU test scripts, .otd
files for OTD test scripts, .bat files for Windows scripts, .pl files for Perl scripts, .py files for Python scripts (.py files),
or .shell for Linux scripts.

To create a test suite:

1. In the project explorer, right-click the project and select New > Test Suite.
2. In the Create Test Suite wizard, select the test harnesses that you want to run together and the test scripts

located in your project. Then, click Next.
B ! New Test Suite O X

Test Suite Content :

Select the test harnesses that you want to add to the test suite.

Filter: (enter at least a char to get the list filled in)

Test harnesses:

- E]ﬁ maze New Test Harness
w . sSIc
[ ]9 checkTypesptu
[v] @ mainbat
[ | mainpl
E F] main.py
[ ] th_main

? : Next > nist Cancel

3. Select the main test configuration files for the test harnesses that are compatible with your test suite.
4. If you want to compare the test results with another test configuration, select Compare with and choose a

secondary test configuration.
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This will run the test suite twice, using both the main configuration and the secondary configuration. You can
use this option to run the same test suite on a native platform and an embedded platform, to ensure that
results are consistent.

5. Click Next.

6. Specify a location and file name for the test suite, and click Finish.

Results
The test suite is created in the selected location in the project, under the test suite folder in the Project Explorer.

Related information

Running a test suite on page 233

Configuring the Jenkins environment for running test suites

HCL OneTest™ Embedded for Eclipse IDE has command line interface that facilitates the integration of Jenkins in
HCL OneTest™ Embedded.

About this task
First create a test suite in your project and add all the test harness that you want to execute.

To configure Jenkins:

1. On the Jenkins dashboard, click Configure.

2. Under Build, click Add build step where you want to insert your test execution.

3. Select Execute Windows batch command for Windows, or Execute shell for UNIX.

4. Setup your command as described here to execute your test suite: rtrteclipse -WORKSPACE= <your
workspace> <your test suite>.

For more details, see Running test suites from the command line on page 234.
Test configurations

Creating test configurations

Test configurations contain the settings required to apply a target deployment port (TDP) to your compiler, linker,

debugger, and target deployment.

About this task
A test configuration can be understood as the base target deployment port settings, augmented with the various build
and settings for the project.

To create a new test configuration:

1. In the project explorer, right-click the project and click Properties.
2. Expand C/C++ Build, select Settings, and click Manage Configurations.
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Result
The Manage Configurations window for the project opens.
3. Click New.
4. Type a Name and Description for the new configuration.
Example
For example, use the name of the compiler or target platform.
5. Specify the source settings to use to create the new configuration.
Choose from:
- Select Existing configuration to base this configuration on one of the previously created
configurations for this project.
- Select Default configuration to base the configuration on the default configurations for the project.
> Select Import from projects to copy the configuration from another project in the workspace.
- Select Import predefined to copy the configuration from one of the predefined configurations provided
with the product.
6. Click OK. If you want to use the new configuration, click Set Active.
7. Click OK to close the Manage Configurations window.

What to do next
To make any changes to the test configuration, edit the Build TDP and Build Settings pages of the Properties window.

See the Configuration Settings reference for more information.

Note: It is possible to rename test configurations. However, when the configuration is renamed, the previous
directory of the configuration is not renamed and a new one is created. To build the new makefiles for the
renamed configuration, you must edit the managed build to point to the source files that are in the new

configuration directory.

Related information

Switching test configurations on page 231

Switching test configurations

Although a project can use multiple configurations, as well as multiple TDPs, there must always be at least one active
configuration. You can switch from one configuration to another at any time, except during build activity.

About this task

The active configuration affects compiler and deployment options for each resource in the project.

Note: You can also run a test harness with two different test configurations by creating a test suite. See

Creating test suites on page 228.

To change the active test configuration:
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1. In the project explorer, right-click the project and click Properties.
2. Expand C/C++ Build, select Settings, and click Manage Configurations.
Result
The Manage Configurations window for the project opens.
3. Select the configuration that you want to use to build and run the test and click Set Active.

4. Click OK to close the Manage Configurations window.

Related information

Creating test configurations on page 230

Running a test

Running a test harness

The test harness contains everything required to run the test.
About this task

The test harness associates the test cases with the source code and other required components to a test
configuration. The test configuration is an instance of a target deployment port (TDP) with its association

configuration settings.

To run a test harness:

1. In the project explorer, in the Test Harness folder, right-click the test harness and click Run As > Run Test
Harness.
2. Alternatively, you can run a test harness from the test harness editor.

Note: In some environments, if you have installed the product in an existing Eclipse, the test result
timestamps and verdicts are not properly displayed in the package explorer. To correct this, in the
project explorer, click View Menu > Customize View > Content and ensure that only Working Sets,

Elements, CDT Elements, and Resources are selected.

Note: To run multiple test harnesses in a step, you must create a test suite, select the test harnesses
that will be run from the test suite and then run the test suite. For more information, see Creating test

suites on page 228 and Running a test suite on page 233.

Results
The Test Result folder in the Project Explorer contains the test harness result file. To open the reports, right-click the

Test result, select Open with > HTML reports and select the appropriate report.
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Running a test suite

Test suites enable you to run multiple test harnesses or test scripts in a single step. You can update the list of test

harnesses and test scripts to be run, and the build configuration from the Test Editor before running a test suite.
About this task

In the test suite, each test harness is associated with a test configuration (a TDP with associated configuration
settings) and can be run a second time with another test configuration to provide comparison results. This can be

useful for validation purposes.

To run a test suite:

1. In the project explorer, open the Test Suite folder and double-click the test suite to open the Test Suite editor.
2. In the Test harness section of the test editor window, to update the test harness list, you can:

a. Select or deselect test harnesses and test scripts (examples: .ptuy, .otd,.py, .pl, .bat) that are available in

your project

b. Add to the test suite other resources that are not displayed in the list by using one of the following
procedures:
= You can drag the test script files from the Project Explorer and drop them in the test harness
list in the Test harness section of the test suite editor.
= Click the Add test harness icon to select resources compatible with your project: supported

scripts and test harnesses.

x|t d|E]0

c. Click the Delete icon to remove a test harness or a test script file from the test suite.

d. Click the 'Up arrow' and 'Down arrow' icons to modify the order of resources in the list. The test

harnesses and test scripts will be run in the order they are listed.

3. Save and click Run.
Result
After running the test suite, you can see the run result details in the Run results for selected test harnesses

with the run status (success, failed, inconclusive) in the test suite editor.

The Test Result folder in the Project Explorer contains the test results for each test harness and for the
generated test scripts contained in the test suite. You can produce a common, merged result file, containing

the results of all the test harnesses of the test, see details in the Merging test suite results page.

4. To open reports, right-click a Test result, select Open with > HTML reports and select the appropriate report.
5. To order the test results, select Sort result files by ascending date in Window > Preferences > HCL®
OneTest™ EmbeddedNavigator
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Note: In some environments, if you have installed the product in an existing Eclipse, the test result
timestamps and verdicts are not properly displayed in the package explorer. To fix this issue, in the
project explorer, click View Menu > Customize View > Content and ensure that only Working Sets,
HCL® OneTest™ Embedded Elements, CDT Elements, and Resources are selected.

Running test suites from the command line

You can integrate test suites created with HCL OneTest™ Embedded for Eclipse IDE into your command line tool

chain.
About this task

To run the test suite in command line mode, a Perl launcher script launches the Eclipse workbench silently. In this

mode, the Eclipse workbench is not started and there is no user interaction. All information is output to the console.

The launcher script is located in the bin folder of the HCL OneTest™ Embedded installation directory. This folder
directory is added to the PATH environment variable when the product is installed.

To run a test suite from the command line:

1. Close HCL OneTest™ Embedded for Eclipse IDE.
The Eclipse workspace must not be in use when you run the command line.

2. Type the following command line:

rtrteclipse [-WORKSPACE={wor kspace directory}] [testsuite_pathname [{testsuite_pathnanme}]]
[-BU LD PROIECT={project_name | all}][-BIND R={directory}][-TDPDl R={directory}]

[ - REPORTDI R={di rectory}]

o <workspace> is the path to the workspace that contains the test suite. For example "C:\ tenp
\ wor kspace" .

o <test suite_pathname> is the path and filename of the test suite in the workspace. You can run multiple
test suites in the same workspace.

o <bin directory> optionally indicates the location of ecl i pse. exe. By default, the product uses:

"C:\ Program Fi | es\ HCL\ HCLOneTest \ Enbedded"

o <tdp directory> optionally indicates the location of the target deployment port directory. By default, the

product uses:

"C:\ Program Fi | es\ HCL\ HCLOneTest \ Enbedded\t ar get s"

o <reportdir directory> indicates the location where all the .xml report files are copied.
Example

For example:
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ortrteclipse - WORKSPACE={wor kspace} {testsuitePathFromtrkspace} [{testsuite}] [options]
ortrteclipse {testsuiteWthAbsol utePath} [{testsuite}] [options] #. Inthis case, the workspace
and the directory where are located the test suites, are deducted from the first test suite path.
3. When the test is finished, start HCL OneTest™ Embedded for Eclipse IDE to view the results or open the

directory reports with a web browser.

Test scripts files

Testing with PTU test scripts

You can add and configure PTU test scripts and execute them in a standalone mode or from a test suite in HCL
OneTest™ Embedded for Eclipse IDE.

About this task

You must import a PTU file in a project to be able to execute the test script.

1. To import a PTU file, select File > Import and choose General > File System to select the file. You can import
the file in any folder at any file structure level.

2. To configure a PTU test script file, see Configuring .ptu or .otd test scripts on page 236.

3. To execute PTU file, use one of the following method:

a. To execute one PTU test script, right-click on a PTU file and choose Run as > Script test file.

b. Alternatively, select Run Configurations and Test Script file in the dialog box that opens. Right-click
and select New to create a new launch configuration. Then proceed as follows:
= Set a name to your launch configuration.
= In the Testing Script tab, select your PTU file in Select Application panel.

= Select your configuration in the Configurations panel and click Run.

c. To execute multiple PTU test scripts, create a test suite and select the PTU test scripts before running
the test suite. For more details, see Creating test suites on page 228 and Running a test suite on
page 233.
Result
A test report and runtime analysis reports are generated. The test result and the test script results are
displayed in the Test Result folder. From these files, you can open the appropriate HTML reports.

4. To open the reports, select the report file corresponding to your last execution, right-click and select Open
With > Test Report.

Testing with .otd test scripts

You can add, configure and execute .otd test scripts in a standalone mode or from a test suite in HCL OneTest™
Embedded for Eclipse IDE.

About this task
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You must import the .otd file in a project and configure the test script to be able to execute it and see the results.

1. Select File > Import and choose General > File System and select the files that you want to import.
Note: You can import these files in any folder at any file structure level.

2. Follow the instructions that are described in the Configuring .ptu or .otd test scripts on page 236 page to
configure .otd test scripts.
3. To execute .otd files, use one of the following methods:
o Right-click the .otd file and choose Run as > Test script file.
o Alternatively, proceed as follows:
a. Select Run Configurations.
b. Select the .otd file under Test Script file, in the dialog that opens.
c. Right-click and select New to create a new launch configuration.
d. Set a name to your launch configuration.
e. Select your .otd file in Select Application panel, in the Testing Script tab.
f. Select your configuration in the Configurations panel and click Run. The reports are available
into the Test Result folder.
> To execute multiple .otd test scripts from a Test Suite, see Running a test suite on page 233.
Result
A test report and runtime analysis reports are generated. The reports are available into the Test Result folder.
From these files, you can open the appropriate HTML reports.
4. To open the reports, select the report file corresponding to your last execution, right-click and select Open
With > Test Report.

Configuring .ptu or .otd test scripts

You can add additional options in a .ptu or .otd test script before executing.
About this task

A .ptu or an .otd file test script might need additional files and additional options before running that must be

specified into the .ptu or the .otd file itself, as follows:

1. Enter instructions with specific lines starting with --%f and --%o located on top of the file, before the HEADER
keyword setting.
2. In the line starting with %0, enter build options. Options format must follow the one used for attolcc.
3. In the line starting with %f, enter the list of additional source files that must be taken into account into the
build.
4. Set relative paths to specify the test scripts location.
5. Set the PATH environment variable as follows to make the test scripts portable:
a. ${workspace_loc:/myproject/src/sub.c}
b. $workspace_loc:/myproject/src/sub.c

c. $(project_loc)/src/sub.c
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Note: When the Path environment variable is configured and the test script run, the build automatically
creates the three following environment variables:
o 'workspace_loc' corresponding to the workspace location
o 'project_loc' corresponding to the project location

o 'tstscript_loc' corresponding to the test script location

Testing with Python, Perl, Windows or Linux scripts

In HCL OneTest™ Embedded for Eclipse IDE, you can import and execute PTU and OTD test scripts but also other
scripts such as Batch (Windows only), Shell (Linux only), Perl or Python.

Before you begin

To be able to run Python (.py files) scripts, you must install the PyDev plugin in Eclipse and configure Python

Interpreter preferences. You can download the plug-in from this page https://www.python.org/downloads/.
About this task

This task applies to users who want to test with .bat files (Windows only), .pl files (Perl), .py files (Python), and .sh
(Shell for Linux only). You must import the script files in a project to execute them.

1. To import a test script file, proceed as follows: select File > Import and choose General > File System to
select the files. You can import these files in any folder at any file structure level.

2. To configure Python, Perl, Windows or Linux script files, see Configuring Python, Perl, Windows or Linux
scripts on page 238.

3. To execute the test script file, use one of the following methods:

a. To execute a test in a standalone mode in HCL OneTest™ Embedded for Eclipse IDE, right-click the

script file and choose Run as > Script test file.

b. Alternatively, select Run Configurations. In the dialog that opens, under Script test file, select a script
file. Right-click and select New to create a new launch configuration. Then proceed as follows:
= Set a name to your launch configuration.
= In the Testing Script tab, select your test script file in Select Application panel.
= Select your configuration in the Configurations panel and click Run. The reports are available
into the Test Result folder.

c. To execute test scripts from a Test Suite in HCL OneTest™ Embedded for Eclipse IDE, see Running a
test suite on page 233.
Result
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A test report and runtime analysis reports are generated. The reports are available into the Test Result

folder. From these files, you can open the appropriate HTML reports.

o Tip: The default execution timeout is set to 20 seconds but some scripts can take more time
to execute. You can modify the script execution timeout from Window > Preferences > >

installation settings > installation settings.

4. To open the reports, select the report file corresponding to your last execution, right-click and select Open
With > Test Report.

Configuring Python, Perl, Windows or Linux scripts

To run Python, Perl, Windows or Linux scripts in a standalone mode, you must configure your scripts by using the java
runtime that is delivered with HCL OneTest™ Embedded.

A java runtime named Scri pt Report . j ar is availableinthel i b/ j ava folder when you install HCL OneTest™
Embedded. It is used by default to ensure that test script results are displayed directly in your test suite, and in your
workspace after a manual refresh when the script is executed in a standalone mode. You must use some of the
runtime commands in your .py, .pl, .sh or .bat files to customize your reports.

Note: Using runtime commands in scripts requires advanced user level.

initreport

initreport <logfile>
This command is used in a script when all result files are created by the script.
It initializes necessary resources needed to create a log file.
This log file will contain the list of all intermediate files that are needed to create a result file.
<logfile> parameter is the name of this log file.
By convention, the extension is .xtp.
This log file will be generated if this command is used in a script that is executed in a standalone mode.

If this command used in a script that is executed from a test suite, the name of the test suite is taken into account,

and the parameter is ignored.
addreport
addreport <logfile> -path=<ressource path> [-kind=<ressource kind>]

<ressource path> : Resource to be added to the report. The resource path can be a relative path that points to the

script location, or an absolute path.
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<ressource kind>: Kind of resource (optional)
This command registers a resource to be added to a logfile.
If you add a folder as a resource, this folder will be the used as relative resource path.

For very advanced users: If you have a resource with an unusual extension, you can enter your own <resource kind>
option.

The following table gives the list of file extensions that are recognized in HCL OneTest™ Embedded for Eclipse IDE
and the corresponding <ressource kind> options that must be entered in the script file.

File extension <resource kind> option Resource added to the log file

.ccf CCF ccf file

.crc CRC crc file for MISRA report

.crc.json CRJ crj file

.crx.html CRX MISRA code review report in html for-
mat

.dep DCP dcp file

DCJ dcj file

.dcp.json

.dex.html DCX dcx file in html format for data cou-
pling report

<executable without any extension> | EXE

.exe EXE exe file

fdc FDC fdc file for coverage report

<folder> DIR new reference for further relative
path

.html HTM .html user file in html format

Jlog LOG log file

.met MET met file for metrics report

OBJ object file

.0

.obj

.req REQ req file
.rio RIO rio file
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File extension <resource kind> option Resource added to the log file
.tx RTX rtx file for charts report
Adf TDF tdf file for trace report
.tgj.json TGJ tgj file
tgx.html TGX tgx file for control coupling report in
html format
tio TIO tio file
Apf TPF tpf file for memory profiling report
Aqf TQF tqf file
Aqgf.html TQX tgx file for performance profiling re-

port in html format

.tqf.json TQJ tqj file
tsf TSF tsf file for trace
tzf TZF tzf file
TZJ tzj file
tzf.json
TZX tzx file for stack profiling report
Azx.html
.xob XOB xob file
xrd XRD xrd file for test report
Xtp XTP xtp file
genresult

genresult <logfile> [-path=<path>] [-name=<basename>]
<logfile> : Log file containing reports
<path> : Location where the result is generated (optional, the default value is <logfile folder>).
This command generates a result file from a logfile.
By default, it is the same location as the log file, with the same base name.
You can change this default behavior with optional parameters.

This command is supposed to be the last one, any resource added after this one will be ignored.
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getconfig

getconfig <key> [<env key> <default value>]
Note: This command should be used by very advanced users only.

This command returns a key from the config file if it is executed from a test suite.

The command returns "<not found>" if the key is not found or executed in a standalone mode.
If the key is "<not found>", it returns an environment variable <env key>.

If the environment variable <env key> is not found, the command returns the <default value>.

This command is used to retrieve preferences from HCL OneTest™ Embedded for Eclipse IDE, when you call your
script from a test suite.

If it is executed in a standalone mode, you can enter an environment variable as optional parameter or a default value

if there is no environment variable.
For example, you can retrieve “ conf r ul e” file when you use Code Rule Checker.

You can retrieve the multiple keys that are existing in a generated file named “ envTest RTcc. pl ” that is located in
the % ome%folder.

You can find examples in the Exanpl esEcl i pse folder under the product installation files. The folder contains a
set of sources and three scripts (perl, bat and python). Theses scripts perform Code Rule Checker on sources and
produce reports. They all use relative locations for sources and results so that they can be executed in a standalone
mode or from a test suite, by using a the runtime commands.

Stubbing functions

Stubbing overview

Stubs are simulations of actual functions, which can be used to isolate the function under test and to check that calls
to the stubbed function are correctly formulated.

Stub simulation is based on the idea that certain functions are simulated and are replaced with stubs generated in the
test harness. Stubs provide the same interface as the simulated functions, but the body of the functions is replaced
with a basic behavior. From the point of view of other functions in the test harness, the stub looks identical to the
actual function that it simulates.

Stubs can be used in the following roles:

- Retrieving and storing input values to stubbed functions from a function under test.

« Assigning output values from the stubbed functions to a function under test.

Stubs are described with the following elements:
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- A variable array for the input parameters of the stub.
- A variable array for the output parameters of the stub.
A body declaration for the stub behavior.

To create a stub, the source code of the stubbed function must be included in the project. HCL OneTest™ Embedded
analysis the prototype of the stubbed function to generate a stub with the same interfaces. Once the stub is created,
you use the stub editor to define the stub checks, which verify that each parameter in the call to the stubbed function

matches an expected expression.

Stub checks are based on the sequential number of the call, which typically reflects the iteration of the calling
function in the test case. The sequential call number is expressed as a range. For example a stub check for a
parameter a can be set to match an expected expression x for the first 10 calls received by the stub (range 0 to 10),

an expression y for the 11th to 20th calls (range 10 to 20), and an expression z for any following calls (range Others).

Stub expected value expressions

The expected expressions are used to specify a test criteria by comparison with the value of a call parameter received
by a stub. The test receives a passed verdict when the actual obtained value matches the expected value expression.

The expected expressions for a stub can be among any of the following values:

» Numeric (integer or floating-point), character, or character string literal values. Strings can be delimited by
single or double quotes.

« Native constants, which can be numeric, characters, or character strings.

« Ranges with lower and upper values and inclusive or exclusive bounds.

- Global variables that are declared by the program under test.

« A null pointer or a non-null pointer.

« Arrays and structures, any of the above-mentioned expressions between braces ('{}").

« C functions or expressions with one or more of the above elements combined using any operators and
casting, with all required levels of parentheses. The + operator allows to concatenate character string
variables.

« No Check, which specifies that no check is performed on that variable.

- Same As Init, which specifies that the expected variable equals the initialization expression.

« Data sets that are synchronized with a multiple initialization expression.

The data type of the variable defines the acceptable values for the expected value.
Numeric values can be associated with a comparison operator in the stub editor.

Stub return value

Return values are used for parameters and functions if a return value is defined in the signature of stubbed function.

A special line named return in the parameter table is added to define the value for the return value of the function.
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A return value can be defined for ouput parameters or input/output parameters. Change this setting in the Mode

column. The return value is a C native expression as numeric, character, or string...

The function's return value can be replaced by a special user source code. In this case, write the appropriate C source
code and add the return statement so that the function returns a value to the calling expression. To activate this
feature, select the return line and click the Use source code rather than return type tool button. The user source code
panel is activated and the C source code can be added.

Stub memory usage

For each STUB, the test harness allocates memory for the following tasks:

- Storing the expected expression of the input parameters during the test.
« Storing the obtained value of the input parameters during the test when an error is detected.
« Storing the values assigned to output parameters before the test.

A stub can be called several times during the execution of a test. The test harness allocates memory for expected

and returned values in accordance to the maximum number of calls to the stub in the test harness.

You can reduce the stub memory allocation value to a lower value in the configuration settings when running tests on

a target platform that is short on memory resources.

Creating stubs from the project explorer

You can create a stub from the project by simply selecting a source file or a function. Each stub simulates and

replaces a particular function.

To create a stub from the project explorer:

1. In the project explorer, right-click the project, source file, or a function, and click New > Stub Behavior.
If you select a function, skip to step 3.
Result
The Create Test Case wizard opens.
2. On the Stubbed function page, enter the function name that you want to test in the Filter field. You can choose
the functions displayed into the list.
3. On the Stub Behavior page, type a name for the stub behavior, an optional Description, and click Next.
The description contains information that can be viewed and edited in the test editor.

4. On the Stub Location page, select a folder and a type a file name for the stub and click Finish.

Results
The stub is generated in the project explorer and the stub editor opens. See Editing stubs on page 244 for
information about the stub editor. To use the stub in a test, you must add it to a test case, and add the function in the

stubbed function list of the test harness.
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Editing stubs

The stub editor enables you to visually describe the stub behavior and to define input and output parameters for the

stub.
About this task

The test case editor is made of three panes:

- The Stub Behaviors list displays one or several behaviors for the stub function. You can add new behaviors or
duplicate existing behaviors.

« The Calling Function pane displays the names of components that call the stubbed function.

« The Details pane contains the input and output values for the selected behavior.

» The User source code pane contains the user code added to compute a return value for the stub.

0 Tip: You can find where the edited file is located by clicking on the title of editor or on the header and
selecting Navigate > Show In > Project Explorer . The explorer selects the current stub and expands

automatically all parent nodes.

The main objective of editing a test case is to define the checks for each stub's call in the tested code.

1. In the project explorer, open a stub.
2. In the Stub Behaviors list, select the default behavior or create new one.
3. In the Details section, select a check block.
The Checked Variables table displays the variables and structures contained in the function under test.
4. For each variable or structure, specify an expected value and a return code.

These values can be simple values, multiple values (ranges, series) or C structures.

a. In the Stub call definition table, select a variable Expected Value cell that you want to set and click the
menu button = to specify an expected value or range.

See Variable initial expressions on page 214 for more information.

b. To edit single values, multiple values, or series, type the values in the quick edition area line above the
table. To specify structure values, edit the individual fields of the structure.
The quick editor area adapts to the selected data type or entry mode.

c. In the Stub call definition table, select a variable return cell that you want to set and click the menu
button = to specify a return value. This value can be a C native expression. If you want to replace a

single value by a section of source code, click on the \-T’I button. The User source code is activated and
you can enter your special source code for the stub. Don't forget the return statement to return a value

for the calling expression.

5. When you have finished editing the test case, click Save and close the stub editor.
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Application monitoring

With HCL OneTest™ Embedded for Eclipse IDE you can monitor the global variables of cyclic executive applications.

The monitoring feature is available from HCL OneTest™ Embedded for Eclipse IDE 8.3.1. It applies to cyclic executive
applications for software integration testing. A cyclic application is a long running program. It contains global
variables that read input data and set output data. With HCL OneTest™ Embedded for Eclipse IDE monitoring feature,

you can examine the global variables usage while your application is running.

Monitoring cyclic executive applications is an alternative to unit testing and software integration testing where only
one file of the application is tested (unit testing) or a collection of files is tested (software integration testing), the
other files are stubbed. With HCL OneTest™ Embedded for Eclipse IDE monitoring feature, you can test all the files
of your application. You can manually modify the input global variables in the monitoring view and select the output
variables that HCL OneTest™ Embedded for Eclipse IDE displays in a graph so that you can observe the behavior of
the application when the input values change.

To be able to monitor your application with HCL OneTest™ Embedded for Eclipse IDE, you must complete
prerequisites tasks. See Prerequisites to monitoring applications on page 245.
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Prerequisites to monitoring applications

Before you can monitor a cyclic executive application, you must import your project to HCL OneTest™ Embedded for

Eclipse IDE, configure HCL OneTest™ Embedded for Eclipse IDE and your application, and build your project.

To monitor an application, you must first complete the following tasks:

- Create or import a project with a source file in C language. A sample monitoring project is delivered with

HCL OneTest™ Embedded for Eclipse IDE. You can import it to get started with the monitoring feature. See

Importing a monitoring project example on page 246.
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- Enable monitoring in your application. You must enter a dedicated pragma command in one function of your
application to enable HCL OneTest™ Embedded for Eclipse IDE to access the global variables. See Enabling
monitoring in your application on page 246.

« Configure the build and the monitoring settings in HCL OneTest™ Embedded for Eclipse IDE. See Configuring
the build and monitoring settings on page 246. If you want to use the command line interface to activate the
monitoring feature in HCL OneTest™ Embedded for Eclipse IDE, see C and C++ Instrumentor on page 1110.

« Run the application. See the note in Configuring the build and monitoring settings on page 246.

The monitoring procedure is described in Monitoring a cyclic executive application on page 248.

Importing a monitoring project example

A sample project is provided with HCL OneTest™ Embedded to help you get started with monitoring.

. In the Project Explorer view of the C/C++ perspective, right-click and select Import.

. In the wizard that opens, select Projects from Folder or Archive and click Next.

. Click Archive, browse to the HCL OneTest™ Embedded installation directory.

. Inthe Exanpl esEcl i pse folder, select the engi neSi nmul at or. zi p file and click Open.
. Select the engi neSi nul at or. zi p_expanded\ engi neSi nul at or folder.

. Click Finish.

o g b~ WON =

Enabling monitoring in your application

You must enter a dedicated pragma command in a function of your application that is cyclically called to enable the

monitoring requests between HCL OneTest™ Embedded for Eclipse IDE and the target application.
About this task

In the identified cyclic function of your application, enter the following line at the appropriate location:
#pragma attol mnt_insert mnt_exec_request();

This function can have the following characteristics:

« Called in a timer interrupt
+ Located in the main loop of your application

- Any regularly called function tin your application

The call frequency of this function becomes the basis frequency used to refresh the cyclic data in the monitor view.

Configuring the build and monitoring settings

To monitor your cyclic executive application from HCL OneTest™ Embedded, you must enable the compilation and
monitoring build settings and configure some parameters related to the communication and libraries that are used to
monitor your application.

About this task
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1. Right-click in your project node.

2. Click Properties.

3. Select C/C++ Build > Settings in the Properties dialog box.

4. Click the Build TDP tab, click Target Deployment Port > Linker Options and set the appropriate library in
Libraries to enable compilation with a socket library. The default library isws2_32. | i b for Visual compiler or
-1 wsock32 for GNU compiler. This option must be set for a socket communication mode only, see step8.

5. From the Build Settings tab, click Settings > General > Selective instrumentation.

6. In Build options, click Application profiling > ... and select Application profiling in the Build Options dialog
box.

7. From the Build Settings tab, click Settings > Application profiling > Monitoring and set Activate to yes. You
can keep the default settings for the other parameters.

8. Select the Communication type used to allow communication between HCL OneTest™ Embedded and the
target application. SOCKET is the default communication mode. To use a customized communication mode,
select USER.

9. Select Yes in Cyclic read allowed to allow cyclic read of the global variables in your application.

Note: You have to allocate memory to your application to complete cyclic read. If you can't allocate

memory to your application, you must select No.

10. Select the Default Frequency of the streaming process if you enabled a cyclic read. The default scale factor is
set to 10. This is a multiplying factor that applies to the cyclic read frequency that is set in the function code
with the pragma. This multiplying factor can also be changed in the monitoring view.

11. Select Read only mode in Bitfields support if your application use bit fields. Select NONE if your application
doesn't use bit fields in order to reduce memory consumption used by the runtime.

12. Select the bit format in Bitfields Order: Little endian or Big endian order if you enabled Bitfields support.

13. Click Apply.

Result

The monitoring feature is enabled and the settings are configured. You can start building your application.

What to do next
The next step is to build your project and then start your application.

Building a project for monitoring

After you configure HCL OneTest™ Embedded for Eclipse IDE and your application, you must build your project to
instrument the source code of the application with the new configuration settings.

In the Project explorer view, right click your project folder and select Build Project.

Note: You can alternatively instrument the source code of the application with the attolc4 instrumentor

command-line tool. For more details, see Instrumenting and Compiling the Source Code on page 1005.

Result
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When you build your project, two files are created: an executable file (.exe file) with an embedded runtime and a . rmt

file that contains the communication parameters and the description of all the global variables of your project.

What to do next
You must run the application.

Note:

- If you run your application from the command tool, click Properties > Resources contextual menu to
find the location of the execution file.
« To run your application from the Project Explorer view, right-click the execution file and select Run as

> Instrumented Application.

Monitoring a cyclic executive application

With HCL OneTest™ Embedded for Eclipse IDE, you can monitor a cyclic executive application that is running on a

target computer and connected to HCL OneTest™ Embedded for Eclipse IDE.
Before you begin

Before you can monitor, you must complete the following tasks:

« Create or import a project that contains the source code file of an application written in C language. You
can optionally use the sample project that is delivered with HCL OneTest™ Embedded for Eclipse IDE to get
started with the monitoring feature. For more information, see Importing HCL OneTest Embedded examples
on page 65.

« Enable monitoring in your application. See Enabling monitoring in your application on page 246.

- Enable the monitoring feature and configured the build settings. See Configuring the build and monitoring
settings on page 246.

« Build your project. For more information, see Building a project for monitoring on page 247.

« Start your application.

About this task

To monitor an application, follow these steps:

1. Open the C/C++ perspective.
2. In the Project explorer view, right-click your project file and select Open Monitoring to open the Monitoring

view.

Note: In the Monitoring view, you can view all the global variables of your application that are not
arrays. It is directly connected to the application that is running in background.

3. Select the variable values that must be monitored in your application:
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o In the Read value column, select the variables that must be read by the application and click Read.

Clicking the Read button displays the variable value in the Read Value column. You can change this

value.

> In the Cyclic value, select the variables that must be read cyclically in the application and click Stream.
You can change the read process frequency in the Streaming list. This is a multiplier factor that

applies to the cyclic read frequency.

Note: The Cyclic value column is displayed only if you set the Cyclic read allowed option to
yes in the variable monitoring build settings. If the cyclic read is not allowed, the Stream is

disabled. For more details, see Configuring the build and monitoring settings on page 246

o In the Write value column, enter new values and select the variables that the application must read and
click Write.

Clicking Write displays the variable value in the Read Value column.

Note:

= Some write values can't be modified if you enabled the Bit Fields. In this case, the
values are presented in gray.

= A control check applies to the write values. The column cell turns red if you enter a
value with an invalid format, it turns yellow if the length of the value exceeds the size
that is defined for the type of value.

Result
A graph view is displayed when you click Stream so that you can examine the variable values usage in real-
time in your application. You can work with the different menus that are available in the toolbar of the Graph
view to change the graph format. In the Outline view, you can select the variables that are displayed in the
graph, you can also change the color of the curves in the graph.

. Click Stop streaming to stop the monitoring process.
Result
When you stop the monitoring process, the graph is saved in a .rtx file in your project.

. Click Add/Remove and in the Add/Remove dialog box that opens, select the variable values to add or remove

from the monitoring view.

Note: The default values that are displayed in the Monitoring view are the global variables. You might
want to remove the values that are not used or add values of an array to monitor.

. In the Add/Remove dialog box, click New Element and enter the element number of the array in the New
Element dialog box. Then click OK to add it to the Monitoring view.
Result
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The variable is added to the Variable column of the Monitoring view and is labeled with the following name:
<arraynanme>[ <i ndex>] .

7. If your application is rebuilt and the list of global variables changed, the variables in the Monitoring view might
be inaccurate, so click Reload to update the Monitoring view.
All the initial selections are lost, you must select the variables and enter their values again.

8. Click the . r t x file to open it in the graph editor or right-click the file and select Open with > Text editor to see
all the variable values that were read by the application or written during the monitoring process.

Note:

> The variable values that are not checked are identified by NaN (Not a Number) in the report
because they are not requested during the monitoring process. You can monitor the following
data types: numeric, integer, or float data for the basic data, and array, structure, and union
data types for the collection of data elements. However, the output format of the data is
always numeric.

o The report gives the time when the variable values were read or written in the application.

> You can extract these values for testing or replay needs. You just need to remove the line that

are prefixed with the hash sign (#) and exported a file in the . csv format.

1 Tasks B Console @ Emor Log =6 Progress 4 Search =l Monitoring 21 [ Coverage Analyzis (preview) % Target Deployment Port =
Global Variables from engineSimulator

Variable Data Type Read Value Cycle Value Write Value @ Connected (7778)
gear int 0O =] e —
internalState int O 1 -
rpm float O ] 1.080000E +03 Streaming 10x
speed float O / 1.08D000E +01 Read
speedAdapter int O o
userAction int [z =2 2 Stop Streaming
1 Write
Reload
e E~t 4
Streaming [ TIME 1]
EMGINE.C:gear (7
1,000 EMGINE.CinternalState
W ENGINE.Cigear [+#] ENGINE.C:rpm
B ENGINE.CiinternalState EMGINE.C:speed [1
W ENGINE.C:rpm EMGINE.CspeedAdapter

B ENGINE.Cspeed |+] EMGIMNE.Cuseriction [1]

[ ENGIME.C:speedAdapter
10,000 20,000 B ENGINE.C:userAction

Time (ms)

Graph Data

Results
All the completed actions and the updated values in the Monitoring view are automatically saved inthe . rt x file.
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Testing with Studio

HCL OneTest™ Embedded Studio overview

HCL OneTest™ Embedded Studio is the classic user interface that supports C, C++, Ada test and analysis tools.

The HCL OneTest™ Embedded Studio test environment is not compatible with the HCL OneTest™ Embedded for
Eclipse IDE environment that was introduced in version 8.0 of the product. The documentation in this section is

intended for:

« Users who want to use existing projects with test scripts created in versions 7.5 and earlier of HCL OneTest™
Embedded Studio.
« Users who are testing programs written in Ada.

If you are creating new test projects in C, use HCL OneTest™ Embedded for Eclipse IDE. The Eclipse workbench
provides many benefits, including visual test design, a more accessible user interface, and a higher level of
compatibility with other software development environments.

Analyzing static source code

The static analysis feature set of HCL OneTest™ Embedded allows you to analyze your source code to measure
complexity and compliance to standards. Each feature analyzes the source code without compiling and running it.

To learn about See

How to perform static analysis on your source code Static analysis overview
on page 251

How to evaluate the complexity of your source code Static metrics overview
on page 252

Verifying compliance with industry-wide coding stan- Code review overview

dards on page 260

Checking with static analysis

The static analysis features of HCL OneTest™ Embedded allow you to measure the complexity of your source code

and to check the adherence to coding guidelines.

These tools are able analyze the source code providing without compiling or running the application.

- Static metrics provide statistic indicators of code complexity.

» Code review performs in-depth verification of the source code against a set of rules that implement best

practices, coding guidelines, and standards.
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These static analysis features can be used together with any of the automated testing features and runtime analysis

features.
Here is a basic rundown of the main steps to using the runtime analysis feature set.

To use the static analysis features:

1. From the Start page, set up a new project. This can be done automatically with the New Project Wizard.

2. Follow the Activity Wizard to add your application source files to the workspace.

3. Select the source files under analysis in the wizard to create the application node.

4. Select the runtime analysis tools to be applied to the application in the Build options.

5. Use the Project Explorer to set up the test campaign and add any additional runtime analysis or test nodes.
6. Run the application node to build and execute the instrumented application.

7. View and analyze the generated analysis and profiling reports.

The runtime analysis options can be run within a test by simply adding the runtime analysis setting to an existing test

node.
Runtime or static analysis tools do not run on System Testing nodes.
Related Topics

Static analysis overview on page 251 | Code review overview on page 260

Static metrics

About Static Metrics
Static Metrics for C, C++ and Ada

Statistical measurement of source code properties is an extremely important matter when you are planning multiple
tests or for project management purposes. HCL OneTest™ Embedded provides a Metrics Viewer, which displays

detailed source code complexity data and statistics for your C, C++ and Ada source code.
Static Metrics supports the following languages:

» Ada: Ada 83 and Ada 95

+ C: C89 and C99

» C++:ISO/IEC 14882:1998
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How the static metrics tool works

Metrics are updated each time a file is modified. Static metrics can be computed each time a node is built, but can

also be calculated without executing the application.

The metrics are stored in .met metrics files alongside the actual source files.

To learn about See
Opening a Metrics Report Viewing Static Metrics on
page 253

V(g) or cyclomatic complexity met-  V(g) or Cyclomatic Number

rics on page 259

Halstead metrics Halstead Metrics on
page 258

Customizing metrics reports Metrics Viewer Prefer-

ences on page 1052

Related Topics

Runtime Analysis on page 335 | About Code Coverage on page 72

Viewing Static Metrics
Viewing static metrics
Static Metrics for C, C++ and Ada

Use the Metrics Viewer to view static testability measurements of the source files of your project. Source code
metrics are created each time a source file is added to the project.

To compute static metrics without executing the application:

1. In the Project Browser, select a node.

2. From the Build menu, select Options or click the Build Options = button in the toolbar.
3. Clear all build options. Select only Source compilation and Static metrics.

4. Click the Build [ toolbar button.

To open the Metrics Viewer:

1. Right-click a node in the Asset Browser of the Project Explorer.
2. From the pop-up menu, select View Metrics.

To manually open a report file:
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1. From the File menu, select Open... or click the Open & icon in the main toolbar.
2. In the Type box of the File Selector, select the .met Metrics File file type.

3. Locate and select the metrics files that you want to open.

4. Click OK.

Report Explorer

The Report Explorer displays the scope of the selected nodes, or selected .met metrics files. Select a node to switch
the Metrics Window scope to that of the selected node.

Metrics Window

Depending on the language of the analyzed source code, different pages are available:

 Root Page - File View: contains generic data for the entire scope
- Root Page - Object View: contains object related generic data for C++ only

- Component View: displays detailed component-related metrics for each file, class, method, function, unit,
procedure, etc...

The metrics window offer hyperlinks to the actual source code. Click the name of a source component to open the
Text Editor on page 725 at the corresponding line.

Related Topics

Root Level File View on page 255 | Root Level Object View on page 257 | Static Metrics on page 254 | Exporting
reports on page 737

Static metrics

Static Metrics for C, C++ and Ada
The Source Code Parsers provide static metrics for the analyzed C and C++ source code.
File Level Metrics

The scope of the metrics report depends on the selection made in the Report Explorer on page 1059 window. This

can be a file, one or several classes or any other set of source code components.

- Comment only lines: the number of comment lines that do not contain any source code
« Comments: the total number of comment lines

» Empty lines: the number of lines with no content

« Source only lines: the number of lines of code that do not contain any comments

- Source and comment lines: the number of lines containing both source code and comments
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« Lines: the number of lines in the source file
- Comment rate: percentage of comment lines against the total number of lines

» Source lines: total number of lines of source code

File, Class or Package, and Root Level Metrics

These numbers are the sum of metrics measured for all the components of a given file, class or package.

- Total statements: total number of statement in child nodes

« Maximum statements: the maximum number of statements

« Maximum level: the maximum nesting level

» Maximum V/(g): the highest encountered cyclomatic number

« Mean V(g): the average cyclomatic number

« Standard deviation from V(g): deviation from the average V(g)

 Sum of V(g): total V(g) for the scope.

Root level file view

Static Metrics for C, C++, Ada
At the top of the Root page, the Metrics Viewer displays a graph based on Halstead data.

On the Root page, the scope of the Metrics Viewer is the entire set of nodes below the Root node.

Halstead Graph
Halstead Metnc - Vocabulary

8 VerifyListener.c
B AssertionFailedErmrore
OCheck o
O Protectable o
O Stubinfoc
B Stublistenerc
H B StubSequence.c
= | |:| [ [ B [ OTeste
16 17 37 17 62 19 94 19 221 g2 @TestCasec

iK

The following display modes are available for the Halstead graph:
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 VocabularySize

* Volume

« Difficulty

- Testing Effort

« Testing Errors

« Testing Time
See the Halstead Metrics on page 258 section for more information.
Metrics Summary

The scope of the metrics report depends on the selection made in the Report Explorer window. This can be a file, one

or several classes or any other set of source code components.

Below the Halstead graph, the Root page displays a metrics summary table, which lists for for the source code
component of the selected scope:

- V(g): provides a complexity estimate of the source code component

« Statements: shows the number of statements within the component

« Nested Levels: shows the highest nesting level reached in the component

 Ext Comp Calls: measures the number of calls to methods defined outside of the component class (C++)

« Ext Var Use: measures the number of uses of attributes defined outside of the component class (C++)
To select the File View:

1. Select File View in the View box of the Report Explorer.

2. Select the Root node in the Report Explorer to open the Root page.

Note With C and Ada source code, File View is the only available view for the Root page.

To change the Halstead Graph on the Root page:

1. From the Metrics menu, select Halstead Graph for Root Page.

2. Select another metric to display.

Related Topics

Root Level Object View on page 257 | Static Metrics on page 254 | Viewing Static Metrics on page 253
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Object view

Static Metrics for C, C++ and Ada

Root Level Summary

At the top of the Root page, the Metrics Viewer displays a graph based on the sum ofdata.

On the Root page, the scope of the Metrics Viewer is the entire set of nodes below the Root node.

Sum of Statements J Sum of Mested Leve
B AssertionFalledErmor

i B Check
o Ew O Stublnfo

O StubSequence

] @ TestZaseFnm

o W TestFailure

g o W TestResult

L Inan O TestStub

B Testsube

Sum of Staternents B TestSuitePrim
@ Test=vnchroStub

Sum of Mested Lewve

File View is the only available view with C or Ada source code. When viewing metrics for C++, an Object View is also

available.

Two modes are available for the data graph:

« Vocabulary
* Size
* Volume
« Difficulty
« Testing Effort
« Testing Errors
« Testing Time
See the Halstead Metrics on page 258 section for more information.

Metrics Summary

Below the Halstead graph, the Root page displays a metrics summary table, which lists for each source code

component:
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- V(g): provides a complexity estimate of the source code component

- Statements: shows the total number of statements within the object

- Nested Levels: shows the highest statement nesting level reached in the object

« Ext Comp Calls: measures the number of calls to components defined outside of the object

- Ext Var Use: measures the number of uses of variables defined outside of the object
Note The result of the metrics for a given object is equal to the sum of the metrics for the methods it contains.
To select the Object View:

1. Select the Root node in the Report Explorer to open the Root page.

2. Select Object View in the View box of the Report Explorer.
To switch the object graph mode:

1. From the Metrics menu, select Object Graph for Root Page.

2. Select ExtVarUse by ExtCompCall or Nested Level by Statement.

Related Topics

Root Level File View on page 255 | Static Metrics on page 254 | Viewing Static Metrics on page 253

Halstead Metrics

Static Metrics for C, C++, Ada

Halstead complexity measurement was developed to measure a program module's complexity directly from source
code, with emphasis on computational complexity. The measures were developed by the late Maurice Halstead as a

means of determining a quantitative measure of complexity directly from the operators and operands in the module.
Halstead provides various indicators of the module's complexity
Halstead metrics allow you to evaluate the testing time of any C/C++ source code. These only make sense at the

source file level and vary with the following parameters:

Parame-  Meaning

ter
n1 Number of distinct operators
n2 Number of distinct operands
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N1 Number of operator in-
stances
N2 Number of operand instances

When a source file node is selected in the Metrics Viewer, the following results are displayed in the Metrics report:

Metric Meaning Formula
n Vocabulary n7+n2
N Size N2+N2
\ Volume N*log2n

D Difficulty n1/2*N2/n2
E Effort V*D
B Errors Vv /3000

T Testing E/k
time

In the above formulae, k is the stroud number, which has an arbitrary default value of 18. With experience, you can
adjust the stroud number to adapt the calculation of the estimated testing time (T) to your own testing conditions:

team background, criticity level, and so on.
When the Root node is selected, the Metrics Viewer displays the total testing time for all loaded source files.
Related Topics

Viewing Static Metrics on page 253 | V(g) or Cyclomatic Number on page 259

V(g) or Cyclomatic Number
Static Metrics for C, C++ and Ada

The V(g) or cyclomatic number is a measure of the complexity of a function which is correlated with difficulty in

testing. The standard value is between 1 and 10.

A value of 1 means the code has no branching.

A function's cyclomatic complexity should not exceed 10.

The Metrics Viewer presents V(g) of a function in the Metrics tab when the corresponding tree node is selected.

When the type of the selected node is a source file or a class, the sum of the V(g) of the contained function, the mean,

the maximum and the standard deviation are calculated.
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At the Root level, the same statistical treatment is provided for every function in any source file.
Related Topics

Viewing Static Metrics on page 253 | Halstead Metrics on page 258

Code review

Code review overview

Code Review for C

Automated source code review is a method of analyzing code against a set of predefined rules to ensure that the
source adheres to guidelines and standards that are part of any efficient quality control strategy. HCL OneTest™
Embedded provides an automated code review tool, which reports on adherence to guidelines for your C source code.

Among other guidelines, the code review tool implements rules from the MISRA-C:2004 standard, which are
Guidelines for the use of the C language in critical systems.

Code Review supports C89 and C99.

When an application or test node is built, the source code is analyzed by the code review tool. The tool checks the
source file against the predefined rules and produces a .crc report file that can be viewed and controlled from the HCL
OneTest™ Embedded graphical user interface (GUI).

Code review can be performed each time a node is built, but can also be calculated without executing the application.

The default code review report is generated in an HTML format. You can customize the report template that is
available in HCL OneTest™ Embedded.

To learn about See

The list of rules used by HCL OneTest™ Embedded  Code review MISRA 2004 rules on page 114
code review Code review MISRA 2012 rules on page 145
Setting up the rules to used for reviewing code Configuring code review rules on page 322

Performing a code review Running a code review on page 326

Running all of the MISRA rules from an application ~ Running complete verification of MISRA rules from an applica-
node tion node on page 328

For advanced users, executing the code review from Executing the code review from a script on page 327
the CLI

Viewing and understanding the results of a code re- Viewing code review results on page 328

view



Customizing the code review report

Customizing the code review report

Interpreting code review reports

Locally disabling a rule
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Customizing the code review report on page 176

Customizing the code review report on page 176

Understanding code review reports on page 329

Code review deviation on page 114

Code review MISRA 2004 rules

The code review tool covers rules from the lists the rules that produced and error or a warning. Each rule can be

individually disabled or assigned a Warning or Error severity by using the Rule configuration window. Some rules also

have parameters that can be changed. Among other guidelines, the code review tool implements most rules from the

MISRA-C:2004 standard, "Guidelines for the use of the C language in critical systems". These rules are referenced

with an M prefix. In addition to the industry standard rules, HCL OneTest™ Embedded provides some additional coding

guidelines, which are referenced with an E prefix.

Code Review for C - MISRA 2004 rules

Table 6. MISRA 2004 rules

Code review MISRA-C:
Code review message Description
reference 2004 reference

Code compli-

ance

M1.1 Rule 1.1 ANSI C error: <error> All code shall conform to 1ISO 9899:1990
Required

M1.1w Rule 1.1 ANSI C warning: <warning>
Required

Language exten-

. Required
sions
M2.2 Rule 2.2 Source code shall only use /* ... | Source code shall only use /* ... */ style
*/ style comments comments

Required

M2.3 Rule 2.3 The character sequence /* shall | The character sequence /* shall not be

not be used within a comment

used within a comment

Required
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Table 6. MISRA 2004 rules

(continued)

Code review MISRA-C:
Code review message Description
reference 2004 reference
E2.3.1 The character sequence // should not be
used within a 'C-style' comment
Advisory
E2.3.2 Line-splicing shall not be used in // com-
ments
Advisory
E2.6 A function should not contain unused label
declarations
Advisory
E2.7 There should be no unused para- | Advisory
meters in functions
E2.8 Macro %name% is never used
Advisory
E2.9 Type %name% is never used
Advisory
E2.10 Tag %name% is never used
Advisory
E2.50 Functions should have less than
Advi
'"100' lines. Note The number of visory
lines can be specified.
E2.51 Functions should have less than
Advisor
"15' V(g) complexity. Note: The y
complexity limit of lines can be
specified.
E2.52 Functions should have less than
‘%param%' lines, outside empty
lines (current value: %name%).
E2.53 Functions should have less than
'‘%param%' lines, outside empty
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Code review MISRA-C: . L.
Code review message Description
reference 2004 reference

lines or comment lines (current
value : %name%).

E2.54 Functions should have less than |Lines are not counted in the following cas-
‘%param%' lines, outside empty | es:
lines, comment lines or bracket
lines (current value : %name%). « If they contain spaces (including \t,

\r, \n),

« If they contain only brackets (there
might be several brackets on same
line),

« If they contain comments only, or
if they contain brackets and com-
ments only.

E2.55 Compilation units should define
Optional
have less than '‘%param%' func- P
tions (current value : %name%). | compilation unit max number of functions.
Default parameter value: 10.
E2.56 Optional
Compilation units should have
19 o' :
less than ‘%param%’ functions Compilation unit max number of variables.
(current value: %name%).
Default parameter value: 10.
E2.57 Compilation unit should have
. o s Optional
less than '%param%' lines (cur-
rent value: %name%). Compilation unit max number of lines.
Default parameter value : 200.
E2.58 Compilation unit should have
o o 1 Optional
less than '%param%' lines, not
counting empty lines (current val- | Compilation unit max number of lines.
ue : %name%).
Default parameter value : 200.
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Table 6. MISRA 2004 rules

(continued)

'%param%' parameters (current

value: %name%).

Code review MISRA-C: . L.
Code review message Description
reference 2004 reference
E2.59 Compilation unit should have
. . Optional
less than '%param%' lines, not
counting empty lines or com- Compilation unit max number of lines.
ments (current value: %name%).
Empty lines or comments (current value:
%name%) are not counted.
Default parameter value : 200.
E2.60 Compilation units should have
. - Optional
less than '%param%' lines, not
counting empty lines, com- Compilation unit max number of lines.
ments or brackets (current value:
%name%) are not counted. Empty lines, comments or brackets (current
value : %name%) are not counted.
Default parameter value : 200.
E2.61 Functions should have less than

Documentation

264

M3.4 Rule 3.4 All uses of the #pragma direc-
Requi
tive shall be documented and ex- equired
plained.
Character sets
M4.1.1 Rule 4.1 Only escape sequences that are | Only escape sequences that are defined in
defined in the ISO C standard the ISO C standard shall be used
shall be used
Required
M4.1.2 Rule 4.1 Only ISO C escape sequences are | Only ISO C escape sequences are al-
allowed(\v) lowed(\v)
Required
M4.2 Rule 4.2 Trigraphs shall not be used Trigraphs shall not be used
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Code review

reference

MISRA-C:

2004 reference

Code review message

Description

Required

Identifiers

M5.1

Rule 5.1

Identifiers %name% and %name
% are identical in the first <value>
characters. The number of char-
acters can be specified.

Identifiers (internal and external) shall not
rely on the significance of more than 31
characters

Required

E5.1.1

Identifiers %name% and %name%
are ambiguous because of pos-
sible character confusion. Note
that you can change parameters

for ambiguous characters.

Advisory

E5.1.2

Possible typing mistakes be-
tween the variables %name% or
%name% because of repeating
character.

Advisory

E5.1.3

Identifiers %name% and %name%
are identical in the first %param%
characters ignoring case

Advisory

E5.1.4

Macros %name% and %name%
are identical in the first %param%

characters

Advisory

E5.1.5

Macro %name% and identifier
%name% are identical in the first

%param% characters

Advisory

E5.1.6

Macros %name% and %name%
are identical in the first %param%

characters ignoring case

Advisory

E5.1.7

Macro %name% and identifier
%name% are identical in the first
%param% characters ignoring

case

Advisory
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Table 6. MISRA 2004 rules

(continued)

Code review MISRA-C: . L.
Code review message Description
reference 2004 reference

M5.2 Rule 5.2 Identifier %name% in an inner Identifiers in an inner scope shall not use

scope hides the same identifier | the same name as an identifier in an outer
in an outer scope : %location% scope, and therefore hide that identifier
Required

ES5.3 The tag name %name% should

Advisor
not be reused. Name already y
found in %location%

M5.3.1 Rule 5.3 The typedef name %name% should not be
reused except for its tag. Name already
found in %location%

Required

M5.3.2 Rule 5.3 The typedef name '%name%' should not be
reused even for its tag. Name already found
in %location%

Required
M5.4 Rule 5.4 A struct and union cannot use A tag name shall be a unique identifier
the same tag name
Required
M5.5 Rule 5.5 The static object or function No object or function identifier with static
%name% should not be reused. | storage duration should be reused
Static object or function already
Advisor
found in %location%. y
M5.6 Rule 5.6 No identifier in one name space should
Avoid using the same identifier . . e
have the same spelling as an identifier in
%name% in two different name . .
another name space, with the exception of
spaces. Identifier already found .
structure and union member names
in %location%
Advisory

M5.7 Rule 5.7 The identifier %name% should

Advisor
not be reused. Identifier already y
found in %location%.
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Code review MISRA-C:
Code review message Description
reference 2004 reference

Types

M6.1.1 Rule 6.1 The C language plain char type [ The C language plain char type should only
should only be used for character | be used for character values.
values.

Required

M6.1.2 Rule 6.1 Case char value is applicable on-

. . .| Required
ly if the switch statement value is
plain character variable

M6.1.3 Rule 6.1 Avoid using comparison opera- | Required
tors on plain char.

M6.2 Rule 6.2 The C language signed char or The C language signed char or unsigned
unsigned char types should only | char types should only be used for numeric
be used for numeric values. values.

Required

M6.3 Rule 6.3 The C language numeric type typedefs that indicate size and signedness
%name% should not be used di- | should be used in place of the basic types
rectly but instead used to define

Advisory
typedef.

E6.3 The implicit 'int' type should not | Required
be used.

M6.4.1 Rule 6.4 Bit fields should only be of type | Required
‘unsigned int' or 'signed int'".

M6.4.2 Rule 6.4 Bit fields should not be of type Required
‘enum'’

M6.4.3 Rule 6.4 Bit fields should only be of explic- | Required
itly signed or unsigned type

M6.4.4 Rule 6.4 Bit fields should not be of type Required
'bool' under c99

M6.4.5 Rule 6.4 Bit fields should not be of type Required
'boolean’ outside c99
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Table 6. MISRA 2004 rules

(continued)

%name% should be declared be-

fore calling the function

Code review MISRA-C:
Code review message Description
reference 2004 reference
M6.5 Rule 6.5 Bit fields of type 'signed int' must | Required
be at least 2 bits long.
Constants
M7.1 Rule 7.1 Octal constants and escape se- | Octal constants (other than zero) and octal
quences should not be used. escape sequences shall not be used
Required
E7.1 Octal and hexadecimal escape
. Required
sequences shall be terminated
E7.2 The lowercase character 'l' shall
Requi
not be used in a literal suffix equired
E7.3 A string literal shall not be as-
. . Required
signed to an object unless the
object's type is pointer to a con-
st-qualified char
Declarations
and definitions
M8.1.1 Rule 8.1 A prototype for the function Functions shall have prototype declarations
%name% should be declared be- | and the prototype shall be visible at both
fore defining the function. the function definition and call
Required
E8.1.1 A prototype for the global object |Required
%name% should be declared be-
fore defining the object
M8.1.2 Rule 8.1 A prototype for the function Functions shall have prototype declarations
%name% should be declared be- |and the prototype shall be visible at both
fore calling the function. the function definition and call
Required
M8.1.3 Rule 8.1 A prototype for the function
Required
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Code review MISRA-C:
Code review message Description
reference 2004 reference
M8.2.1 Rule 8.2 The type of %name% should be [ Whenever an object or function is declared
explicitly stated. or defined, its type shall be explicitly stated
Required
M8.2.2 Rule 8.2 The type of parameter %name% _
should be explicitly stated Required
M8.3 Rule 8.3 Parameters and return types For each function parameter the type giv-
should use the same type names | en in the declaration and definition shall be
in the declaration and in the defi- |identical, and the return types shall also be
nition, even if basic types are the |identical
same.
Required
E8.3 Parameters and return types Required
should use compatible type in
the declaration and in the defini-
tion
M8.4 Rule 8.4 If objects or functions are de- Required
clared multiple times their types
should be compatible.
M8.5.1 Rule 8.5 The body of function %name% Required
should not be located in a header
file.
E.8.50 Use the const qualification for Required
variable %name% which is point-
er and which is not used to
change the pointed object
E.8.51 The object %name% is never ref- | Required
erenced
M8.5.2 Rule 8.5 The memory storage (definition) | Objects shall be defined at block scope if
for the variable %name% should [they are only accessed from within a single
not be in a header file. function.
Required
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M8.6 Rule 8.6 Functions should not be declared

Required
at block scope.

M8.7 Rule 8.7 Global objects should not be de- | Objects shall be defined at block scope if
clared if they are only used from | they are only accessed from within a single
within a single function. function

Required

M8.8.2 Rule 8.8 Static function %name% should J

Require
only be declared in a single file. au
Redundant declaration found at:
%location%

M8.8.3 Rule 8.8 Static object %name% should on-

. . Required
ly be declared in a single file. Re- q
dundant declaration found at:
%location%
M8.8.4 Rule 8.8 Identifiers %name% that declare
. . . Required
objects or functions with external
linkage shall be declared once in
one and only one file
M8.8.5 Rule 8.8 Identifiers %name% that declare
. . . Required
objects or functions with external
linkage shall be unique

M8.9.1 Rule 8.9 The global object or function An identifier with external linkage shall
%name% should have exactly one | have exactly one external definition
external definition. Redundant
definition found in %location%

M8.9.2 Rule 8.9 The global object or function Required
%name% should have exactly one
external definition. No definition
found.

M8.10.1 Rule 8.10 Global object %name% that are | All declarations and definitions of objects
only used within the same file or functions at file scope shall have internal
should be declared using the sta- | linkage unless external linkage is required.
tic storage-class specifier.
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Required
M8.10.2 Rule 8.10 Global function %name% that are | All declarations and definitions of objects
only used within the same file or functions at file scope shall have internal
should be declared using the sta- | linkage unless external linkage is required
tic storage-class specifier.
Required
M8.11 Rule 8.11 Global objects or functions that | The static storage class specifier shall be
are only used within the same file | used in definitions and declarations of ob-
should be declared with using jects and functions that have internal link-
the static storage-class specifier. | age
Required
M8.12 Rule 8.12 When a global array variable can | Required
be used from multiple files, its
size should be defined at initial-
ization time.
E.8.14 Inline function %name% should | Required
be static
Initialization The restrict type qualifier shall Required
not be used
M9.1 Rule 9.1 Variables with automatic storage | Required
duration should be initialized be-
fore being used.
M9.2 Rule 9.2 Nested braces should be used to | Required
initialize nested multi-dimension
arrays and nested structures.
E9.2 Arrays shall not be partially ini- Required
tialized
M9.3 Rule 9.3 Either all members or only the In an enumerator list, the “=" construct shall
first member of an enumerator not be used to explicitly initialize members
list should be initialized. other than the first, unless all items are ex-
plicitly initialized
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Required
M9.3 Rule 9.3 Either all members or only the Required
first member of an enumerator
list should be initialized
E9.3 Rule E9.3 Enumeration member %name% | Required
have a not unique implicitly spec-
ified value
E9.4 The global variable %name% is Required
not initialized
Arithmetic type

conversions

E10.1 Constraint violation : can't use Required
floating type as operand of '[], %,

'
<<, >> ~ & "

M10.1.1 Rule 10.1 Implicit conversion of a complex | The value of an expression of integer type
integer expression to a smaller | shall not be implicitly converted to a differ-

sized integer is not allowed. ent underlying type if:

- a) itis not a conversion to a wider
integer type of the same signed-
ness, or

« b) the expression is complex, or

« c) the expression is not constant
and is a function argument, or

« d) the expression is not constant

and is a return expression.

Required

M10.1.2 Rule 10.1 Implicit conversion of an integer | Required
expression to a different signed-

ness is not allowed.
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M10.2 Rule 10.2 Conversion of a complex floating | The value of an expression of floating type
expression is not allowed. Only | shall not be implicitly converted to a differ-
constant expressions can be im- | ent type if:
plicitly converted and only to a
wider floating type of the same - a) it is not a conversion to a wider
signedness. floating type, or
« b) the expression is complex, or
« c) the expression is a function argu-
ment, or
« d) the expression is a return expres-
sion.
Required
E10.2 Operand should be boolean. Required
M10.3 Rule 10.3 Type cast of complex integer The value of a complex expression of inte-
expressions is only allowed in- ger type may only be cast to a type that is
to a narrower type of the same narrower and of the same signedness as
signedness. the underlying type of the expression
Required
E10.3 Can't use a boolean as a numeric | Required
value
M10.4 Rule 10.4 Type cast of complex floating The value of a complex expression of float-
expressions is only allowed in- ing type may only be cast to a narrower
to a narrower type of the same floating type
signedness.
Required
E10.4 Can't use a char as a numeric val- | Required
ue
M10.5 Rule 10.5 When using operator '~' or '<<' on | Required
‘unsigned char' or 'unsigned int',
you should always cast returned
value

273



HCL® OneTest™ Embedded

Table 6. MISRA 2004 rules

(continued)

Code review
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Code review message

Description

E10.5

Rule E10.5

Can't use a not anonymous enum

as a numeric value

Required

M10.6

Rule 10.6

Definitions of unsigned type con-

stants should use the 'U' suffix.

A “U" suffix shall be applied to all constants
of unsigned type

Required

E10.6

Shift and bitwise operations
should be performed on un-

signed value

Required

E10.7

Right hand operand of shift oper-
ation should be an unsigned val-

ue

Required

E10.8

Unary minus operation should
not be performed on unsigned

value

Required

E10.9

Expressions of essentially char-
acter type shall not be used inap-
propriately in addition and sub-
traction operations

Required

E10.10

The value of an expression shall
not be assigned to an object with

a narrower essential type

Required

E10.11

The value of an expression shall
not be assigned to an object with

a different essential type catego-

ry

Required

E10.12

Both operands of an operator in
which the usual arithmetic con-
versions are performed shall
have the same essential type cat-
egory

Required
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E10.13

The value of an expression
should not be cast to an inappro-
priate essential type

Required

E10.14

The value of a composite expres-
sion shall not be assigned to an

object with wider essential type

Required

E10.15

If a composite expression is
used as one operand of an opera-
tion in which the usual arithmetic
conversions are performed then
the other operand shall not have

wider essential type

Required

E10.16

The value of a composite expres-
sion shall not be cast to a differ-
ent essential type category or a
wider essential type

Required

Pointer type

conversions

M11.1 Rule 11.1 A function pointer should not Conversions shall not be performed be-
be converted to another type of | tween a pointer to a function and any type
pointer. other than an integral type

Required

E11.1 Conversions shall not be per- Required
formed between a pointer to an
incomplete type and any other
type

M11.2 Rule 11.2 An object pointer should not be [ Conversions shall not be performed be-

converted to another type of

pointer.

tween a pointer to object and any type oth-
er than an integral type, another pointer to

object type or a pointer to void

Required
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E11.2 A conversion should not be per- | Required
formed from pointer to void into
pointer to object

M11.3 Rule 11.3 Casting a pointer type to an inte- | A cast should not be performed between a
ger type should not occur. pointer type and an integral type

Advisory

E11.3 E11.3 A cast shall not be performed Required
between pointer to void and an
arithmetic type

E11.4 A cast shall not be performed Required
between pointer to object and a
non-integer arithmetic type

M11.4.1 Rule 11.4 Casting an object pointer type A cast should not be performed between a
to a different object pointer type | pointer to object type and a different point-
should not occur. er to object type

Advisory

M11.4.2 Rule 11.4 Casting an object pointer type Advisory
to a different object pointer type
should not occur, especially
when object sizes are not the
same.

M11.5 Rule 11.5 Casting of pointers to a type that | A cast shall not be performed that removes
removes any const or volatile any const or volatile qualification from the
qualification on the pointed ob- | type addressed by a pointer.
ject should not occur.

Required

Expressions

M12.1 Rule 12.1 Implicit operator precedence Limited dependence should be placed on
may cause ambiguity. Use paren- | C's operator precedence rules in expres-
thesis to clarify this expression. |sions

Advisory
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E12.11 Implicit bitwise operator prece- | Advisory
dence may cause ambiguity. Use
parenthesis to clarify this expres-
sion.
M12.3 Rule 12.3 The sizeof operator should not Required
be used on expressions that con-
tain side effects.
M12.4.1 Rule 12.4 An expression that contains a The right-hand operand of a logical && or ||
side effect should not be used in | operator shall not contain side effects
the right-hand operand of a logi- o
cal && or || operator. Require
M12.4.2 Rule 12.4 The function in the right-hand
operand of a logical && or || oper-
ator might cause side effects.
M12.5 Rule 12.5 Parenthesis should be used Required
around expressions that are
operands of a logical && or |[|.
E12.51 Ternary expression ?: should not | Advisory
be used.
E12.54 Expressions should not cause a | Advisory
side effect assignment.
M12.6 Rule 12.6 Only Boolean operands should be | The operands of logical operators (&&, ||
used with logical operators ( &&, |and!) should be effectively Boolean. Ex-
[l and !). pressions that are effectively Boolean
should not be used as operands to opera-
tors other than (&&, || and !)
Advisory
E12.61 The operator on a Boolean ex- Advisory
pression should be a logical op-
erator ( &amp;&amp;, || or !).
M12.7 Rule 12.7 Bitwise operators should only Bitwise operators shall not be applied to
use unsigned operands. operands whose underlying type is signed
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Required
M12.8 Rule 12.8 The right-hand operand of a shift | The right-hand operand of a shift operator
operator should not be too big or | shall lie between zero and one less than the
negative. width in bits of the underlying type of the
left-hand operand
Required
M12.9 Rule 12.9 Only use unary minus operators | The unary minus operator shall not be ap-
with signed expressions. plied to an expression whose underlying
type is unsigned
Required
M12.10 Rule 12.10 Do not use the comma operator | Required
M12.12 Rule12.12
Advisory
Parenthesis should be used around expres-
sion that is operand of 'sizeof' operator.
M12.13 Rule 12.13 The increment (++) or the decre- | Advisory
ment (-) operators should not be
used with other operators in an
expression.
Control state-
ment expres-
sions
E13.1 The result of an assignment op- | Required
erator should not be used in an
expression
M13.1.1 Rule 13.1 Boolean expressions should not | Assignment operators shall not be used in
contain assignment operators. expressions that yield a Boolean value
Required
M13.1.2 Rule 13.1 Boolean expressions should not | Required
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Code review message Description
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M13.2 Rule 13.2 Non-Boolean values that are test- | Tests of a value against zero should be
ed against zero should have an made explicit, unless the operand is effec-
explicit test tively Boolean
Advisory
M13.3 Rule 13.3 The equal or not equal opera- Floating-point expressions shall not be test-
tor should not be used in float- ed for equality or inequality
ing-point expressions.
Required
M13.4 Rule 13.4 Floating-point variables should Required
not be used to control a for state-
ment.
M13.5.1 Rule 13.5 Only loop counter should be ini-
L o The three expressions of a statement shall
tialized in a loop initialization
be concerned with loop control only.
part.
Required
M13.5.2 Rule 13.5 Required
In the 'update part' of a 'for state-
ment', only 'loop counter' should
be updated
M13.5.3 Rule 13.5 There should be one and only Required
one loop counter for loop state-
ment.
M13.6 Rule 13.6 Loop counter of a 'for statement' | Required
should not be modified within the
body of the loop.
M13.7 Rule 13.7 Invariant Boolean expressions Boolean operations whose results are in-
should not be used. variant shall not be permitted
Required
Control flow
M14.1 Rule 14.1 Unreachable code. Required
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M14.2 Rule 14.2 A non-null statement should ei- | Required
ther have a side effect or change
the control flow.

M14.3 Rule 14.3 A null statement in original Before preprocessing, a null statement
source code should be on a sep- | shall only occur on a line by itself; it may be
arate line and the semicolon followed by a comment provided that the
should be followed by at least first character following the null statement
one white space and then a com- | is a white-space character
ment.

Required

M14.4 Rule 14.4 Do not use the goto statement. Required

E14.41 The goto statement shall jump to | Required
a label declared later in the same
function

E14.4.2 Any label referenced by a goto Required
statement shall be declared in
the same block, or in any block
enclosing the goto statement

E14.4.3 There should be no more than Required
one break or goto statement
used to terminate any iteration
statement

M14.5 Rule 14.5 Do not use the continue state- Required
ment.

M14.6 Rule 14.6 Only one break statement should | For any iteration statement there shall be
be used within a loop. at most one break statement used for loop

termination
Required

M14.7.1 Rule 14.7 Only one exit point should be de- | A function shall have a single point of exit

fined in a function. at the end of the function
Required
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M14.7.2 Rule 14.7 The return keyword should not be | Required
used in a conditional block.

M14.8.1 Rule 14.8 The switch statement should be | The statement forming the body of a
followed by a compound state- switch, while, do ... while or for statement
ment {}. shall be a compound statement

M14.8.2 Rule 14.8 The while statement should be | Required
followed by a compound state-
ment {}.

M14.8.3 Rule 14.8 The do..while statement should
contain a compound statement
{.

M14.8.4 Rule 14.8 The for statement should be fol-
lowed by a compound statement
{.

M14.9.1 Rule 14.9 The if (expression) construct An if (expression) construct shall be fol-
should be followed by a com- lowed by a compound statement. The else
pound statement {}. keyword shall be followed by either a com-

d stat t ther if stat t

M14.9.2 Rule 14.9 The else keyword should be fol- pound statement, oranother it statemen
lowed by either a compound Required
statement or another if state-
ment.

M14.9.3 Rule 14.9 The else keyword should be fol-
lowed by a compound statement

M14.10 Rule 14.10 Allif ... else if sequences should | Allif ... else if constructs shall be terminat-
have an else block. ed with an else clause

Required

Switch state-

ments

M15.0 Rule 15.0 A switch block should start with [ The MISRA C switch syntax shall be used

Required
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M15.1 Rule 15.1 A case or default statements A switch label shall only be used when the
should only be used directly most closely-enclosing compound state-
within the compound block of a [ ment is the body of a switch statement
switch statement.

Required

E15.10 The switch expression should Required
not have side effects.

M15.2 Rule 15.2 The break statement should only | An unconditional break statement shall ter-
be used to terminate every non- | minate every non-empty switch clause
empty switch block.

Required

M15.3.1 Rule 15.3 The switch statement should Required
have a default clause.

M15.3.2 Rule 15.3 The default clause should be the
last clause of the switch state-
ment.

M15.4.1 Rule 15.4 A Boolean should not be used as | A switch expression shall not represent a
a switch expression. value that is effectively Boolean

Required

M15.4.2 Rule 15.4 A constant should not be used as | Required
a switch expression.

M15.5 Rule 15.5 At least one case should be de- [ Every switch statement shall have at least
fined in the switch. one case clause

Required

Functions

M16.1 Rule 16.1 The function %name% should not [ Functions shall not be defined with a vari-
have a variable number of argu- | able number of arguments
ments.

Required
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Rule M16.1.2 Rule 16.1 The library functions 'va_list, va_- | Required
arg, va_start, va_end, va_copy'
should not be used

M16.2.1 Rule 16.2 Recursive functions are not al- Functions shall not call themselves, either
lowed. The function %name% is | directly or indirectly Functions shall not call
directly recursive. themselves, either directly or indirectly

M16.2.2 Rule 16.2 Recursive functions are not al- Required
lowed. The function %name% is
recursive when calling %name% .

M16.3 Rule 16.3 The function prototype should Identifiers shall be given for all of the para-
name all its parameters. meters in a function prototype declaration

Required

M16.4 Rule 16.4 The identifiers used in the proto- | Required
type and definition should be the
same.

M16.5 Rule 16.5 Functions with no parameters Required
should use the void type.

E16.50 The function %name% is never Required
referenced.

M16.6 Rule 16.6 The number of arguments used | Required
in the call does not match the
number declared in the proto-
type.

M16.7 Rule 16.7 Use the const qualification for A pointer parameter in a function prototype
parameter %name% which is should be declared as pointer to const if
pointer and which is not used to | the pointer is not used to modify the ad-
change the pointed object. dressed object

Required

M16.8 Rule 16.8 The return should always be de- [ All exit paths from a function with non-
fined with an expression for non- | void return type shall have an explicit return
void functions. statement with an expression
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Required
M16.9 Rule 16.9 Function identifiers should al- A function identifier shall only be used with
ways use a parenthesis or a pre- | either a preceding &, or with a parenthe-
ceding &. sized parameter list, which may be empty
Required
M16.10 Rule 16.10 When a function returns a value, | If a function returns error information, then
this value should be used. that error information shall be tested
Required
Pointers and ar-
rays
M17.4 Rule 17.4 Pointer arithmetic except array | Array indexing shall be the only allowed
indexing should not be used. form of pointer arithmetic
Required
M17.5 Rule 17.5 A declaration should not use Advisory
more than two levels of pointer
indirection.
Structures and
unions
M18.1 Rule 18.1 Structure or union types should | Required
be finalized before the end of the
compilation units.
E18.1 Flexible arrays members shall Required
not be declared
18.2 Variable-length array types shall | Required
not be used
E18.3 The declaration of an array para- | Required
meter shall not contain the static
keyword between the [|
M18.4 Rule 18.4 Do not use unions. Required
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Preprocessing
directives
M19.1 Rule 19.1 Only preprocessor directives or | #include statements in a file should only be
comments may occur before the | preceded by other preprocessor directives
#include statements. or comments
Advisory
M19.2 Rule 19.2 Do not use non-standard charac- | Advisory
ters in included file names.
M19.3 Rule 19.3 Filenames with the #include di- | Required
rective should always use the
<filename> or "filename" syntax.
M19.4 Rule 19.4 A C macro should only be ex- Required
panded to a constant, a braced
initializer, a parenthesised ex-
pression, a storage class key-
word, a type qualifier, or a do-
while-zero block.
M19.5 Rule 19.5 Macro definitions or #undef Required
should not be located within a
block.
M19.6 Rule 19.6 Do not use the #undef directive. | Required
M19.7 Rule 19.7 Function should be used instead | Advisory
of macros when possible.
M19.8 Rule 19.8 Missing argument when calling [ A function-like macro shall not be invoked
the macro. without all of its arguments.
Required
M19.9 Rule 19.9 The preprocessing directive Arguments to a function-like macro shall
%name% should not be used as | not contain tokens that look like prepro-
argument to the macro. cessing directives
Required
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M19.10 Rule 19.10 The parameter %name% in the In the definition of a function-like macro
macro should be enclosed in each instance of a parameter shall be en-
parentheses except when it is closed in parentheses unless it is used as
used as the operand of # or ##. |the operand of # or ##

Required

M19.11 Rule 19.11 Undefined macro identifier in the | All macro identifiers in preprocessor direc-

preprocessor directive. tives shall be defined before use, except in
#ifdef and #ifndef preprocessor directives
and the defined() operator
Required

M19.12 Rule 19.12 The # or ## preprocessor opera- | There shall be at most one occurrence of
tor should not be used more than | the # or # preprocessor operators in a sin-
once. gle macro definition

Required

M19.13 Rule 19.13 The # and ## preprocessor oper- | Advisory
ator should be avoided.

M19.14 Rule 19.14 Only use the 'defined’ preproces- | The defined preprocessor operator shall
sor operator with a single identifi- | only be used in one of the two standard
er. forms

Required

M19.15 Rule 19.15 Header file contents should be Precautions shall be taken in order to pre-
protected against multiple inclu- | vent the contents of a header file being in-
sions cluded twice

Required

M19.16 Rule 19.16 Possible bad syntax in prepro- Preprocessing directives shall be syntac-

cessing directive. tically meaningful even when excluded by
the preprocessor
Required




Table 6. MISRA 2004 rules

(continued)

Chapter 5. Test Execution Specialist Guide

Code review MISRA-C:
Code review message Description
reference 2004 reference
M19.17 Rule 19.17 A #if, #ifdef, #else, #elif or #endif | All #else, #elif and #endif preprocessor di-
preprocessor directive has been | rectives shall reside in the same file as the
found without its matching direc- | #if or #ifdef directive to which they are re-
tive in the same file. lated
Required
E19.18 The controlling expression of a Required
#if or #elif preprocessing direc-
tive shall evaluate to 0 or 1
E19.19 A macro parameter immediately | Required
following a # operator shall not
immediately be followed by a ##
operator
E19.20 Macro parameter %name% used | Required
as an operand to the # and ##
operators shall not be used else-
where in this macro
Standard li-
braries
M20.1 Rule 20.1 %name% should not be defined, | Reserved identifiers, macros and functions
redefined or undefined. in the standard library, shall not be defined,
redefined or undefined
Required
E20.1 A macro shall not be defined with | Required
the same name as a keyword:
%name%
M20.2.1 #define and #undef shall not be | Required
used on a reserved identifier or
reserved macro name: ldentifier
%name% already found in %name
%
M20.2.2 Rule 20.2 #define and #undef shall not be | Required
used on identifier beginning with
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Code review MISRA-C: . L.
reference 2004 reference Code review message Description
an underscore or on 'defined' key-
word: %name%

M20.2.3 Rule 20.2 Declared identifier should not be | Required
areserved identifier or reserved
macro name: Identifier %name%
already found in %name%

M20.2.4 Rule 20.2 Declared identifier should not be- | Required
gin with an underscore or be 'de-
fined' keyword: %name%

M20.4 Rule 20.4 This precludes the use of the functions cal-
Dynamic heap memory allocation loc, malloc, realloc free and strdup. There
shall not be used. is a whole range of unspecified, undefined

and implementation-defined behaviour as-
sociated with dynamic memory allocation,
as well as a number of other potential pit-
falls. Dynamic heap memory allocation may
lead to memory leaks, data inconsistency,
memory exhaustion, non-deterministic.
Note that some implementations may use
dynamic heap memory allocation to imple-
ment other functions (for example func-
tions in the library string.h). If this is the
case then these functions shall also be
avoided.

Required

M20.5 Rule 20.5
The error indicator errno shall not | errno is a facility of C, which in theory
be used. should be useful, but which in practice is

poorly defined by the standard. A non zero
value may or may not indicate that a prob-
lem has occurred; as a result it shall not be
used. Even for those functions for which
the behaviour of errno is well defined, it is
preferable to check the values of inputs be-
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fore calling the function rather than rely on
using errno to trap errors (see Rule 16.10).
Required
M20.6 Rule 20.6 The macro offsetof, in library
Use of this macro can lead to undefined be-
<stddef.h>, shall not be used.
haviour when the types of the operands are
incompatible or when bit fields are used.
Required
M20.7 Rule 20.7 The setjmp macro and the
. . etjmp and longjmp allow the normal func-
longjmp function shall not be
used tion call mechanisms to be bypassed, and
' shall not be used.
Remark : sigsetjmp and siglongjmp (Gnu Li-
brary) are also detected
Required
E20.7 The standard header file <setjm- | Required
p.h> shall not be used
M20.8 Rule 20.8
The signal handling facilities of | Signal handling contains implementa-
<signal.h> shall not be used. tion-defined and undefined behavior.
Required
M20.9 Rule 20.9
The input/output library <stdio.h> [ This includes file and 1/0 functions fgetpos,
shall not be used in production fopen, ftell, gets, perror, remove, rename,
code. and ungetc.
Streams and file 1/0 have a large number
of unspecified, undefined and implemen-
tation-defined behaviours associated with
them. It is assumed within this document
that they will not normally be needed in pro-
duction code in embedded systems.
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Code review MISRA-C:
Code review message Description
reference 2004 reference
If any of the features of stdio.h need to be
used in production code, then the issues
associated with the feature need to be un-
derstood.
Required
M20.10 Rule 20.10
The library functions atof, atoi These functions have undefined behavior
and atol from library <stdlib.h> associated with them when the string can-
shall not be used. not be converted.
Required
M20.11 Rule 20.11
The library functions abort, exit, | These functions will not normally be re-
getenv and system from library | quired in an embedded system, which does
<stdlib.h> shall not be used. not normally need to communicate with an
environment
Then, it is essential to check on the imple-
mentation-defined behavior of the function
in the environment.
Required
E20.11 The library macro or function Required
'bsearch, gsort' should not be
used
M20.12 Rule 20.12

Includes time, strftime. This library is asso-
ciated with clock times. Various aspects
are implementation dependent or unspeci-
fied, such as the format of times. If any of
the facilities of time.h are used, then the ex-
act implementation for the compiler being
used must be determined, and a deviation
being raised.

Required




Table 6. MISRA 2004 rules

(continued)

Chapter 5. Test Execution Specialist Guide

Code review MISRA-C:
Code review message Description
reference 2004 reference

E20.12 The input/output library Required
<wchar.h> shall not be used in
production code

E20.13 The standard header file <tg- Required
math.h> shall not be used

E20.14 The library macro or function Required
‘feclearexcept, fegetexceptflag,
feraiseexcept, fesetexceptflag,
fetestexcept, FE_LINEXACT, FE_-
DIVBYZERO, FE_UNDERFLOW,
FE_OVERFLOW, FE_INVALID, FE_-
ALL_EXCEPT should not be used

Rule U99.1 Warning You can customize this rule in the confrule

Rule U99.2 Error file

Rule U99.3 Warning

Rule U99.4 Error

Rule U99.5 Warning

Rule U99.6 Error

Rule U99.7 Warning

Rule U99.8 Error

Rule U99.9 Warning

Rule U99.10 Error

Note: Applies to HCL OneTest™ Embedded Studio only:

The code review references in bold in this table are disabled when they are run from the code review link

checker in test mode. To verify these rules, you must run the code review from the application node in HCL
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9@ OneTest™ Embedded Studio. For more information, see Running complete verification of MISRA rules from an

application node on page 328.

Code review MISRA 2012 rules

The code review tool covers rules from the lists the rules that produced and error or a warning. Each rule can be
individually disabled or assigned a Warning or Error severity by using the Rule configuration window. Some rules also
have parameters that can be changed. Among other guidelines, the code review tool implements most rules from the
MISRA-C:2012 standard, "Guidelines for the use of the C language in critical systems". These rules are referenced
with an M prefix. In addition to the industry standard rules, HCL OneTest™ Embedded provides some additional coding

guidelines, which are referenced with an E prefix.

Code Review - MISRA 2012 rules

D is set for Decidable, U for Undecidable.

Code review L
Type D/U Description Level
reference

M1.1 Error D ANSI C error: %name Required
%

M1.1TW Error D ANSI C warning: Required

%name%

M1.2 Error U Use of #pragma Advisory
%name% should al-
ways be encapsulat-

ed and documented

E1.1 Error D Function max number Required

of line
E1.2 Error D Function max V(g) Required

E1.3 Functions should
have less than
‘%param%' lines, out-
side empty lines (cur-

rent value: %name%).

E1.4 Functions should
have less than
‘%param%' lines, out-
side empty lines or

comment lines (cur-

rent value : %name%).
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Code review o
Type D/U Description Level
reference

Functions should
have less than
‘%param%' lines, out-
side empty lines,
comment lines or
bracket lines (current

value : %name%).

Lines are not counted
in the following cas-

es:

- If they contain
spaces (in-
cluding \t, \r,
\n),

If they contain

only brackets
(there might
be several
brackets on

same line),

If they contain
comments on-
ly, or if they
contain brack-
ets and com-

ments only.

Optional

Compilation units
should define less
than '%param%' func-
tions (current value:

%name%).

Default parameter

value: 10.
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Code review

reference

E1.7

E1.8

E1.9

E1.10

Type

D/U

Description

Optional

Compilation units
should define less
than '%param%' vari-
ables (current value:

%name%).

Default parameter

value: 10.

Optional

Compilation units
should have less than
'‘%param%' lines (cur-

rent value: %name%).

Default parameter
value : 200.

Optional

Compilation unit
should have less
than '%param%' lines,
not counting empty
lines (current value :

%name%).

Empty lines (current
value : %name%) are

not counted.

Default parameter
value : 200.

Optional

Compilation unit
should have less than

‘%param%' lines not

Level
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Code review o
Type D/U Description Level
reference

counting empty lines
or comments (current

value : %name%).

Empty lines or com-
ments (current val-
ue : %name%) are not

counted.

Default parameter
value : 200.

E1.11
Optional

Compilation unit
should have less than
‘%param%' lines not
counting empty lines,
comments or brack-
ets (current value:

%name%).

Empty lines, com-
ments or brack-
ets (current value :
%name%) are not

counted.

Default parameter
value : 200.

E1.12 Functions should
have less than
‘%param%' parame-
ters (current value :

%name%).

M2.1 Error U a project shall not Required
contain unreachable

code
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Code review
reference
M2.2.1 Error
M2.2.2 Error
M2.2.3 Error
M2.3 Warning
M2.4 Warning
M2.5 Warning
M2.6 Warning
M2.7 Warning
M3.1.1 Error
M3.1.2 Error
M3.2 Error
E3.1 Error

296

Type

D/U

Description

A non-null statement
should either have a
side effect or change

the control flow

The function %name

% is never referenced

The object %name%

is never referenced

Type %name% is nev-

er used

Tag %name% is never

used

Macro %name% is

never used

A function should not
contain unused label

declarations

There should be no
unused parameters in

functions

The character se-
quence /* should not
be used within a com-

ment

The character se-
quence // should not
be used within a 'C-

style' comment

Line-splicing shall not
be used in // com-

ments

A null statement in
original source code
should be on a sep-

arate line and the

Level

Required

Required

Required

Advisory

Advisory

Advisory

Advisory

Advisory

Required

Required

Required

Required
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Code review

reference

M4.1

M4.2

E4.1

E.4.2

M5.1.1

M5.1.2

M5.2

M5.3

Error

Warning

Error

Error

Error

Error

Error

Error

Type

D/U

Description

semicolon should be
followed by at least
one white space and

then a comment

Octal and hexadec-
imal escape se-
quences shall be ter-

minated

Trigraphs should not
be used

Only ISO C escape se-

quences are allowed

Only ISO C escape
sequences are al-
lowed(\v)

External identifiers
shall be distinct in the

first 31 characters

External identifiers
shall be distinct in the
first 6 characters ig-

noring case

Identifiers %name

% declared in the
same scope and
name space shall

be distinct. Identifier
identical in the first
%param% characters
already found in %lo-

cation%

Identifier %name%
declared in an inner
scope shall not hide
an identifier declared

in an outer scope.

Level

Required

Advisory

Advisory

Advisory

Required

Required

Required

Required
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Code review
Type
reference
M5.4.1 Error
M5.4.2 Error
M5.5.1 Error
M5.5.2 Error
M5.6 Error
M5.7.1 Error

298

D/U

Description

Identifier identical
in the first %param
% characters already

found in %location%

Macros %name% and
%name% are identical
in the first %param%
characters

Macros %name% and
%name% are identical
in the first %param%
characters ignoring

case.

Macro %name% and
identifier %name%
are identical in the
first %param% char-

acters.

Macro %name% and
identifier %name%
are identical in the
first %param% char-

acters ignoring case.

Macro %name% and
identifier %name%
are identical in the
first %name% %param
% characters ignor-
ing case. The type-
def name %name%
should not be reused
except for its tag.
Name already found

in %location%

The tag name %name
% should not be

reused

Level

Required

Required

Required

Required

Required

Required
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Code review

reference

M5.7.2

M5.8

M5.9

ES.1

E5.2

E5.3

ES5.4

E5.5

Error

Error

Error

Error

Error

Warning

Error

Error

Type

D/U

Description

A struct and union
cannot use the same

tag name

Identifiers that define
objects or functions
with external linkage

shall be unique

Identifiers that define
objects or functions
with internal linkage
should be unique

External identifiers
shall not be ambigu-
ous because of pos-
sible character confu-

sion.

External identifiers
shall not be ambigu-
ous because of char-

acter repetition

The identifier<name>
should not be reused.
Identifier already

found in %location%

Identifier %name% in
an inner scope hides
the same identifier in
an outer scope : %lo-

cation%

The typedef name
%name% should not
be reused even for
its tag. Name already

found in %location%

Level

Required

Required

Advisory

Advisory

Advisory

Advisory

Advisory

Advisory
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Code review

reference

M6.1.1

M6.1.2

M6.1.3

M6.1.4

M6.1.5

M6.2

E6.1

E6.2

M7.1

M7.2

M7.3

Error

Error

Error

Error

Error

Error

Warning

Warning

Error

Error

Error

Type

D/U

Description

Bit fields should only
be of type 'unsigned

int' or 'signed int'

Bit fields should not

be of type 'enum'’

Bit fields should only
be of explicitly signed

or unsigned type

Bit fields should not

be of type 'bool' under

c99

Bit fields should not
be of type 'boolean’

outside c99

Single-bit fields shall
not be of a signed

type

The C language nu-
meric type %name%
should not be used
directly but instead
used to define type-
def

The implicit 'int' type
should not be used
Octal constans shall
not be used

A"u" or "U" suffix

shall be applied to all

integer constants that

are represented in an

unsigned type"

The lowercase char-

acted |" shall not be

used in a literal suffix"

Level

Required

Required

Required

Required

Required

Required

Required

Required

Required

Required

Required
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Code review

reference

M7.4

M8.1

M8.2.1

M8.2.2

M8.2.3

M8.3.1

M8.3.2

M8.4.1

M8.4.2

Error

Error

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description

A string litteral shall
not be assigned to an
object unless the ob-
ject's type is pointer
to a const-qualified

char

Types shall be explic-
itly specified

The function proto-
type should name all

its parameters

Functions with no pa-
rameters should use
the void type

The type of parame-
ter %name% should

be explicitly stated

Parameters and re-
turn types should use
compatible type in
the declaration and in

the definition

The identifiers used
in the prototype and
definition should be

the same

A prototype for

the global function
%name% should be
declared before defin-

ing the function

A prototype for the
global object %name
% should be declared
before defining the

object

Level

Required

Required

Required

Required

Required

Required

Required

Required

Required
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Code review
Type
reference
M8.4.3 Error
M8.5 Error
M8.6 Error
M8.7.1 Warning
M8.7.12 Warning
M8.8 Error
M8.9 Warning

302

D/U

Description

If objects or functions
are declared multi-
ple times their types

should be compatible

Identifiers %name%
that declare objects
or functions with ex-
ternal linkage shall be
declared once in one

and only one file

Identifiers %name%
that declare objects
or functions with ex-
ternal linkage shall be
unique

Global object %name
% that are only used
within the same file
should be declared
using the static stor-
age-class specifier.

Global function
%name% that are on-
ly used within the
same file should be
declared using the
static storage-class

specifier.

The static storage
class specifier shall
be used in all declara-
tions of objects and
functions that have

internal linkage

An object should
be defined at block

scope if its identifier

Level

Required

Required

Required

Advisory

Advisory

Required

Advisory
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Code review

reference

M8.10

M8.11

M8.14

E.8.1

E.8.2

E.8.3

E.8.4

E.8.5

Type

Error

Warning

Error

Error

Error

Error

Error

Error

D/U

Description

only appears in a sin-
gle function

Inline function
%name% should be

static

When an array with
external linkage is de-
clared, its size should

be explicitly specified

The restrict type qual-
ifier shall not be used

Parameters and re-

turn types should use
exactly the same type
names in the declara-
tion and in the defini-

tion

A prototype for

the static function
%name% should be
declared before defin-

ing the function

Static function
%name% should only
be declared in a sin-
gle file. Redundant
declaration found at:

%name%

Static object %name
% should only be de-
clared in a single file.
Redundant declara-

tion found at: %loca-

tion%

Either all members or

only the first member

Level

Required

Advisory

Required

Required

Required

Required

Required

Required
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Code review
Type D/U
reference
E.8.6 Error D
E.8.7 Error D
E.8.8 Error D
E.8.9 Error D
E.8.10 Error D
E.8.11 Error D
M9.2 Error D

304

Description

of an enumerator list
should be initialized

The body of function
%name% should not
be located in a header
file

The memory stor-
age (definition) for
the variable %name
% should not be in a

header file

Functions should not
be declared at block

scope

The global object or
function '%name%'
should have exactly
one external defini-
tion. Redundant defi-
nition found in %loca-

tion%

The global object or
function %name%
%name% should have
exactly one external
definition. No defini-

tion found

Use the const quali-
fication for variable
%name% which is
pointer and which is
not used to change

the pointed object

The initializer for an
aggregate or union
shall be enclosed in

braces

Level

Required

Required

Required

Required

Required

Required

Required

Exception not cov-

ered
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Code review

reference

M9.3

E9.1

E9.2

M10.1.1

M10.1.2

M10.1.3

M10.1.4

M10.1.5

M10.1.6

M10.1.7

M10.1.8

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description

Arrays shall not be

partially initialized

Variables with au-

tomatic storage du-
ration should be ini-
tialized before being

used

The global variable
%name% is not initial-

ized

Constraint violation :
can't use floating type
as operand of "[], %,
&lt;&lt;, >>, ~, &amp;, |,

Al

Operand should be

boolean

Can't use a boolean

as a numeric value

Can'tuseacharasa

numeric value

Can't use a not anony-
mous enum as a nu-

meric value

Shift and bitwise op-
erations should be
performed on un-

signed value

Right hand operand
of shift operation
should be performed

on unsigned value

Unary minus oper-

ation should not be

Level

Required

Exception not cov-

ered

Required

Required

Required

Required

Required

Required

Required

Required

Required

Required
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Code review
Type D/U
reference
M10.2 Error D
M10.3.1 Error D
M10.3.2 Error D
M10.4 Error D
M10.5 Warning D
M10.6 Error D
M10.7 Error D

306

Description

performed on un-
signed value

Expressions of essen-
tially character type
shall not be used in-
appropriately in addi-
tion and subtraction
operations

The value of an ex-
pression shall not be
assigned to an object
with a narrower es-

sential type

The value of an ex-
pression shall not be
assigned to an object
with a different es-

sential type category

Both operands of an
operator in which

the usual arithmetic
conversions are per-
formed shall have the
same essential type

category

The value of an ex-
pression should not
be cast to an inappro-

priate essential type

The value of a com-
posite expression
shall not be assigned
to an object with
wider essential type

If a composite ex-
pression is used as

one operand of an

Level

Required

Required

Required

Required

Advisory

Required

Required
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Code review

reference

M10.8

E10.1

M11.1

M11.2

M11.3.1

M11.3.2

Error

Error

Error

Error

Error

Error

Type

D/U

Description

operation in which

the usual arithmetic
conversions are per-
formed then the oth-
er operand shall not
have wider essential

type

The value of a com-
posite expression
shall not be cast to
a different essential
type category or a

wider essential type

When using operator
'~' or '&amp;lt;&am-
p;lt;' on 'unsigned
char' or 'unsigned int',
you should always

cast returned value

A function pointer
should not be con-
verted to another type

of pointer

Conversions shall

not be performed be-
tween a pointer to an
incomplete type and

any other type

Casting an object
pointer type to a dif-
ferent object pointer
type should not occur

Casting an object
pointer type to a dif-
ferent object pointer
type should not oc-

cur, especially when

Level

Required

Required

Required

Required

Required

Required
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Code review o
Type D/U Description Level
reference

object sizes are not
the same

M11.3.3 Error An object pointer Required
should not be con-
verted to another type

of pointer

M11.4 Warning Casting a pointer type Advisory
to an integer type

should not occur

M11.5 Warning A conversion should  Advisory
not be performed
from pointer to void

into pointer to object

M11.6 Error A cast shall not be Required
performed between
pointer to void and
and an arithmetic
type

M11.7 Error A cast shall not be Required
performed between
pointer to object and
a non-integer arith-

metic type

M11.8 Error Casting of pointers to Required
a type that removes
any const or volatile
qualification on the
pointed object should

not occur

M12.1.1 warning Implicit operator Advisory
precedence may
cause ambiguity. Use
parenthesis to clarify

this expression

M12.1.2 warning Implicit bitwise oper-  Advisory

ator precedence may
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Code review

reference

M12.1.3

M12.1.4

M12.3

E12.1

E12.2

E12.3

E12.4

M13.3

warning

warning

warning

warning

warning

error

error

Warning

Description Level

cause ambiguity. Use
parenthesis to clarify

this expression

Parenthesis should  Advisory
be used around ex-

pressions that are

operands of a logi-

cal &amp;amp;&am-

p;amp; or ||

Parenthesis should  Advisory
be used around

expression that is

operand of 'sizeof' op-

erator.

The comma operator  Advisory
should not be used.

The operator on a Advisory
Boolean expression

should be a logical

operator ( &amp;&am-

p; llor!)

Ternary expression '?:' Advisory

should not be used

Expressions should  Advisory
not cause a side ef-
fect assignment

The equal or not Advisory
equal operator should
not be used in float-

ing-point expressions

a full expression con- Advisory
taining an increment

(++) or decrement

(-) operator should

have no other poten-

tial side effects oth-
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Code review

reference

M13.4.1

M13.4.2

M13.6

E13.1

E13.2

E13.3

M14.1.1

310

Type D/U

Warning

Warning

Error

Error

Error

Error

Error

Description

er than that caused
by the increment or

decrement operator

Boolean expressions
should not contain
assignment opera-

tors.

The result of an as-
signment operator
should not be used in

an expression

The operand of the
sizeof operator shall
not contain any ex-
pression which has
potential side effects

Boolean expressions
should not contain

side effect operators

An expression that
contains a side ef-
fect should not be
used in the right-hand
operand of a logical
&amp;&amp; or || op-

erator

The function in the

right-hand operand of
a logical && or || oper-
ator might cause side

effects

Floating-point vari-
ables should not be
used to control a for

statement

Level

Advisory

Advisory

Required

Required

Required

Required

Required




Chapter 5. Test Execution Specialist Guide

Code review

reference

M14.2.1

M14.2.2

M14.2.3

M14.2.4

M14.3.1

M14.4

M15.1

M15.2

M15.3

Error

Error

Error

Error

Error

Error

Warning

Error

Error

Type

D/U

Description

Only loop counter
should be initialized
in a for loop initializa-

tion part

In the 'update part' of
a 'for statement’, only
'loop counter' should

be updated

There should be one
and only one loop
counter for loop

statement

Loop counter of a 'for
statement' should not
be modified within

the body of the loop

Invariant Boolean ex-
pressions should not
be used

Non-Boolean val-
ues that are tested
against zero should

have an explicit test

The goto statement

should not be used

The goto statement
shall jump to a label
declared later in the

same function

Any label referenced
by a goto statement
shall be declared in
the same block, or in
any block enclosing
the goto statement

Level

Required

Required

Required

Required

Required

Required

Advisory

Required

Required
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Code review

reference

M15.4

M15.5

M15.6.1

M15.6.1

M15.6.2

M15.6.3

M15.6.4

M15.6.5

M15.6.6

Type

Warning

Warning

Error

Error

Error

Error

Error

Error

Error

D/U

Description

There should be no
more than one break
or goto statement
used to terminate any

iteration statement

A function should
have a single point of

exit at the end

The switch statement
should be followed
by a compound state-
ment

The switch statement
should be followed
by a compound state-

ment

The while statement
should be followed
by a compound state-
ment

The do..while state-
ment should contain
a compound state-

ment

The for statement
should be followed
by a compound state-
ment

The if (expression)
construct should be
followed by a com-

pound statement

The else keyword
should be followed
by either a compound

Level

Advisory

Advisory

Required

Required

Required

Required

Required

Required

Required
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Code review

reference

M15.7

E15.1

E15.2

E15.3

E15.4

M16.1

M16.2

M16.3

M16.4

M16.5

Error

Error

Error

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description

statement or another
'if' statement.

All if ... else con-
structs shall be ter-
minated with an else

statement

Do not use the contin-

ue statement

Only one break state-
ment should be used

within a loop

The return keyword
should not be used in
a conditional block

The else keyword
should be followed
by a compound state-

ment.

All switch state-
ment should be well

formed

A switch label shall
only be used when
the most closely-en-
closing copound
statement is the body

of a switch statement

An unconditional
break statement
shall terminate every

switch-clause

Every switch state-
ment shall have a de-
fault label

A default label appear

as either the first or

Level

Required

Required

Required

Required

Required

Required

Required

Required

Required

Required
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Code review

reference

M16.6

M16.7

E16.1

E16.2

E16.3

M17.1.1

M17.1.2

M17.2.1

M17.2.2

Error

Error

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description

the last switch label
of a switch statement

Every switch state-
ment shall have at
least two switch-

clauses

A switch expression
shall not have essen-

tially Boolean type

Case char value is
applicable only if the
switch statement val-
ue is plain character

variable

A constant should not
be used as a switch

expression

The switch expres-
sion should not have
side effects

The function '%name
%' should not have a
variable number of ar-

guments

The va_list, va_arg,
va_start, va_end and
va_copy functions of
&lt;stdarg.h> shall not

be used

Recursive functions
are not allowed. The
function '%»name%' is

directly recursive

Recursive functions
are not allowed. The

function '%name%' is

Level

Required

Required

Required

Required

Required

Required

Required

Required

Required
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Code review

reference

M17.3

M17.4

M17.6

M17.7

E17.1

E17.2

E17.3

M18.4

Error

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description

recursive when call-

ing '%name%'

A function shall not
be declared implicitly

All exit paths from

a function with non-
void return type shall
have an explicit return
statement with an ex-
pression

The declaration of an
array parameter shall
not contain the static
keyword between the

I

The value returned by
function having non-
void return type shall

be used

The number of argu-
ments used in the call
does not match the
number declared in
the prototype

Use the const quali-
fication for parame-
ter '%name%' which
is pointer and which
is not used to change
the pointed object

Function identifiers
should always use a
parenthesis or a pre-

ceding &amp;

The +, -, += and -= op-

erators should not be

Level

Required

Required

Advisory

Required

Advisory

Advisory

Advisory

Advisory
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Code review

reference

M18.5

M18.7

M18.8

M19.2

E19.1

M20.1

M20.2

M20.3

M20.4
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Type

Error

Error

Error

Warning

Error

Warning

Error

Error

Error

D/U

Description

applied to an expres-
sion of pointer type

Declarations should
contain no more than
two levels of pointer

nesting

Flexible arrays mem-
bers shall not be de-

clared

Variable-length ar-
ray types shall not be
used

The union keyword
should not be used

Structure or union
types '%name%’
should be finalized
before the end of the
compilation units

#include directive
should only preceded
by preprocessor di-

rectives or comments

The', or \ character
and the /* or // char-
acter sequences shall
not occur in a header

file name"

The #include direc-
tive shall be followed
by either a &lt;file-
name> or a filename”"

sequence”

A macro shall not
be defined with the

Level

Advisory

Required

Required

Advisory

Advisory

Advisory

Required

Required

Required
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Code review

reference

M20.5

M20.6

M20.7

M20.8

M20.9

M20.10

M20.11

Type D/U

Warning

Error

Error

Error

Error

Warning

Error

Description

same name as a key-

word %name%

#undef should not be
used

Token that look like a
preprocessing direc-
tive should not occur
withing a macro argu-
ment

Expressions resulting
from the expansion
of macro parameters
shall be enclosed in

parenthesis

The controlling ex-
pression of a #if or
#elif preprocessing
directive shall evalu-

atetoOor1

All identifiers used

in the controlling ex-
pression of #if or
#elif preprocessing
directives shall be
#define'd before eval-

uation

The # and ## pre-
processor operators
should not be used

A macro parameter
immediately following
a # operator shall not
immediately be fol-
lowed by a ## opera-
tor

Level

Advisory

Required

Required

Required

Required

Advisory

Required
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Code review
reference
M20.12 Error
M20.13 Error
M20.14 Error
E20.1 Error
E20.2 Error
E20.3 Error
E20.4 Error
E20.5 Error

318

Type

Error

D/U

Description

A macro parameter
used as an operand
to the # and ## op-

erators shall only be
used as an operand

to these operators

A line whose first to-
ken is # shall be a
valid preprocessing
directive

All #else, #elif and
#endif preprocessor
directives shall reside
in the same file as
the #if, #ifdef or #ifn-
def directive to which

they are related

Header file contents
should be protected
against multiple inclu-

sions

The # or ## pre-
processor operator
should not be used

more than once

Missing argument
when calling the

macro

Only use the 'defined’
preprocessor opera-
tor with a single iden-
tifier

Macro definitions or
'#undef' should not

be located within a
block

Level

Required

Required

Required

Required

Required

Required

Required

Required
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Code review

reference

E20.6

M21.1.1

M21.1.2

M21.2.1

M21.2.2

M21.3

Type D/U

Error

Error

Error

Error

Error

Error

Description Level

A C macro should on- Required
ly be expanded to a

constant, a braced

initialiser, a paren-

thesised expression,

a storage class key-

word, a type qualifi-

er, or a do-while-zero

block

#define and #undef =~ Required
shall not be used

on areserved iden-

tifier or reserved

macro name: lden-

tifier %name% al-

ready found in &lt;

%libname%>

#define and #undef =~ Required
shall not be used on

identifier beginning

with an underscore or

on 'defined' keyword

%name%

Declared identifier Required
should not be a re-

served identifier or re-

served macro name:

Identifier %name% al-

ready found in <%lib-

name%>

Declared identifier Required
should not begin with

an underscore or be

'defined' keyword

%name%

The memory allo- Required
cation and deallo-
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Code review

reference

M21.4

M21.5

M21.6.1

M21.6.2

M21.7

M21.8

M21.9

M21.10

320

Error

Error

Error

Error

Error

Error

Error

Error

Type

D/U

Description

cation functions of
&lt;stdlib.h> shall not

be used

The standard header
file &lt;setjmp.h> shall

not be used

The standard header
file &lt;signal.h> shall
not be used

The input/output li-
brary &lt;stdio.h>
shall not be used in

production code

The input/output li-
brary &lt;wchar.h>
shall not be used in

production code

The library macro
or functions atof,
atoi, atol and atoll of
&lt;stdlib.h> shall not

be used

The library macro or
functions abort, exit,
getenv and system of
&lt;stdlib.h> shall not

be used

The library macro or
functions bsearch
and gsort of
&lt;stdlib.h> shall not
be used

The standard library
time and date func-
tions shall not be

used

Level

Required

Required

Required

Required

Required

Required

Required

Required
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Code review

reference

M21.11

M21.12

E21.1

E21.2

E21.3

Rule U99.1
Rule U99.2
Rule U99.3
Rule U99.4
Rule U99.5
Rule U99.6
Rule U99.7
Rule U99.8
Rule U99.9

Rule U99.10

Type D/U

Error

Warning

Error

Error

Error

Warning
Error
Warning
Error
Warning
Error
Warning
Error
Warning

Error

Description Level

The standard head-
er file &lt;tgmath.h>

Required

shall not be used

The library macro or  Advisory
function 'feclearex-
cept, fegetexceptflag,
feraiseexcept, fese-
texceptflag, fetestex-
cept, FE_LINEXACT,
FE_DIVBYZERO, FE_-
UNDERFLOW, FE_-
OVERFLOW, FE_IN-
VALID or FE_ALL_EX-
CEPT' should not be

used.

The variable 'errno’ Required

should not be used

The macro 'offsetof’  Required

should not be used

The library macro Required
or function 'setjm-
p,longjmp,sigsetjm-
p,siglongjmp' should

not be used

You can customize
this rule in the con-

frule file
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Configuring code review rules
Code Review for C

The code review tool uses a set of predefined rules. You can select the default rule configuration file for the code
review tool. MISRA 2004 and MISRA 2012 from HCL OneTest™ Embedded Studio V8.2.0 are the default installed rule

configuration files. You can either disable or set the severity level to Warning or Error.

By default all rules are enabled and produce either an error or a warning in the code review report. You can save

multiple customized rule policies.

The default rule policy files are located in the <installation directory> /plugins/Common/lib/confrule.xml file for MISRA
2004 and in <installation directory> /plugins/Common/lib/confrule_2012.xml for MISRA 2012.

Note All new projects use the default rule configuration file that you have selected in the configuration settings. Do
not modify the default rule configuration files. The only change that can be done in the default rule configuration files

is to change or disable the severity level of the rule from the settings.

To select the configuration file and disable or set the severity level of code review rules:

1. Select a node in the Project Explorer view and click the Settings button.
2. In the Configuration Settings list, select Code Review.

In Default configuration, select the MISRA rules to apply to your project: MISRA 2004 or MISRA 2012.
3. To modify the default set of rules, in Rule configuration, click ...and select the rule file that you want to
configure.

4. In Rule configuration click Edit @ This opens the Rule Configuration window where rules are grouped into

categories.
Note: You can filter the rules by labels from the Find field. Search is not case sensitive. When a rule is

selected, its description is displayed on the right panel with the parameter description and value if they

are defined in the selected rule.
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&3 Rule configuration ? X
NMUE CT.JIUmary A .
Rule E1.4 (Ermor Namme:

Rule E1.5 (Emor) Rule E1.12

Rule E1.6 (Eror)

Rule E1.7 (Emor)

Rule E1.8 (Emor) Description:

Rule E1.5 (Emor) Functions should have less than “.param’

Rule E1.10 (Eor) parameters (cument value : “name®).
Rule E1.11 (Emor)

over
Rule E1.12 (Emon) everty

£} 2- Unused code () Disabled () Waming (@ Emor
Rule M2.1 (Emor)
Rule M2.2.1 (Emor) Parameter:
Rule M2.2.2 (Emor) Function number of parameters
Rule M2.2.3 (Waming) 5
Bida M7 T Mlsrmina) o
< > [[] Show only the first occumence
Find: Find next
Save & Close Cancel Save As...

5. Select the severity level:
- Disabled: The selected rule is ignored. The list of disabled rules is displayed at the end of the report.

- Warning: When any non-compliance instance is found, a warning is displayed in the code review

report.

» Error: When any non-compliance instance is found, an error is displayed in the code review report.

Note: Multiple user-custom rules (from Rule U99.1 to Rule U99.10) can be defined for MISRA 2004 and
MISRA 2012 with their own severity level.

6. Select Show only the first occurrence to only show the first occurrence of a non-compliance in a file.

7. Select Save and Close to save the current configuration or Save As to create a new rule configuration file.

If your application is multi-threaded, you can provide the list of entry points to avoid that the rules about 'non-used

functions' are raised.

To configure the Multi_thread option, follow these steps:

323



HCL® OneTest™ Embedded

1. Click Configuration Properties > Runtime Analysis > Multi-threads.
2. In the right pane, click ... in the value field of the Entry points option to open the editor.
3. In the editor, enter the list of entry points for each thread and click OK

The Entry point option applies to rule E16.50 (MISRA_2004) and M2.2.2 (MISRA 2012).
Related Topics

Code review overview on page 260 | Code review settings on page 1043 | Code review MISRA 2004 rules on
page 114 | Understanding code review reports on page 329

Using a customized naming script file

In HCL OneTest™ Embedded Studio, you can edit and customize a Perl Naming script file to check your own naming
rules (code custom naming rules U99.1). You must set the path to this customized naming script file in the code
review settings to check your naming rules.

About this task

1. From the Project Window view, select the project node.

T Settings...

o @Testing_f:

oL double—
[+ Results

double ptu

@
° @ SOUMCE .C
o B #float
- Results
v‘ o float ptu
# K R,

2. Right-click and select Settings
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View Report

> Build Ctrl+B
. Rebuild Ctrl+R
| €3 Clean

= é’ Execute Testing_C
#‘ Debug Testing_C

2 :
Settings...
o
s = AddChitd ¥
®
: Source Control W

g Project Bn Properties

3. In the window that opens, select Code Review, click in the Value column of the Naming script file option, and

select the sample file that you installed: Example “NamingRules1.pl”.

o ]
ZyConfiguration propestie: | Name Vaiue
5gbud Rude carfiguraion cdefault>
n.-ld: options Addtional included system drectones
Lirkeer Review included system files Na
Exeeutian Include fies
Target Deployment Pol | mamiees 5 a
{41 [C1General .
5 (23 Furtime anclysa Naming scripl file C:\Program Files\HCL\HCLOne Test \Embedded\lib\scripts\Naming Rules 1 pl

&L Companent testing for

81 (ZComnponent testing for

& (C)System testing
Extemal command

4. Apply and close the window.

What to do next
You must enable the code review feature before running a build.
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Code review deviations

In some cases, it can be useful to temporarily ignore a rule non-compliance on a short portion of source code, while

documenting the reason why you are allowing this deviation.

About this task
You can justify why you are allowing the deviation in a text. The text is added to the non-compliance in the
source code. You can declare a deviation in the source code, for a specified number of lines and for the first or all

occurrences of the error, by adding pragma lines to your source code.

1. Open the source file in the Text editor and find the lines of code that you want the rule to ignore.
2. Before the section of code for which compliance to the rule should be ignored, add one of the following lines:

> To justify non-compliance of a rule to the following pragma statement in the first occurrence:
#pragma attol crc_justify (<rule>[,<lines>],"<text>")

» To justify non-compliance of a rule to the following pragma statement in all occurrences:
#pragma attol crc_justify_all (<rule>,<lines>,"<text>")

> To justify the first occurrence of non-compliance of a rule in all the files of the current project,

including in traps located before the pragma statement:

#pragma attol crc_justify_everywhere (<rule>,"<text>")

For all the pragma statements: <rule>
o <rul e> is the name of the code review rule (for example: 'Rule M8.5").
o <lines> is the number of lines.

o <t ext > is the reason why the rule is ignored.

The recommended usage for crc_j usti fy_everywhere is to create a specific source file containing only the list

of pragma statements and add this file to the project.

Running a code review
Code Review for C

You can use the code review tool on any test or application node or a single source file. The code review tool is run on

the source code whenever you build the file.

To enable the code review tool on a source file, test or an application node, follow these steps:

1. In Project Explorer, select the node that you want to review, right-click and select Build > Build options.
Alternatively, click the Settings button and in the Configuration Settings wizard, select Configuration
Properties > Build > Build Options > .

2. In the Build Options value field, click ...

3. In the Build Options wizard, select Code Review.
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To perform a code review without compiling and executing the application, follow these steps:

1. In the Project Browser tab of the Project Window view, select the node that you want to check.

2. Select Build > Options in the toolbar menu or click the Settings button and select Build > Build options.
3. Clear all build options and build steps (in the left) except Code Review.
4. Click the Build [# toolbar button.

Note: If your confrule.xml file is out-of-date, it is automatically upgraded during the build process. The
original configuration rule file is renamed and the .BAK extension is added. See the Messages tab in
the Output Window, where you can find the file path.

5. Double-click the results in the Project Browser to open the report. If the report is already open, close the report
and reopen it again.

Related Topics

Working with projects on page 706 | Building and running a node on page 730

Executing the code review from a script

You can execute the build from HCL OneTest™ Embedded Studio graphical interface or for advanced users, from the
command line interface.
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Note: The following procedure is for advanced-users.

« When crccc has been used, use crcld as follows:
crcld -xref="<model_file>.pl" "<crccc_result_file>.xob" -RULE="<confrule file>.xml" -TEST
« <model_file>.pl file will be generated, it contains data needed to perform custom namecheck rule.

« A file named <model_file>.R99.1.xob will be generated, it will be used on a final step when executing crcld.

« Use this xob file for the next call of crcld:

crcld -crc="<crc_file_name>.crc" "<all other xob file name>.xob" "<model_file>.R99.1.xo0b"
-RULE="<confrule_file>.xml" -TEST

Running complete verification of MISRA rules from an application node

To get a complete verification of MISRA rules, you must run the code review from an application node.
About this task

When running a code review from the code review link checker in test mode from HCL OneTest™ Embedded Studio,
the option -TEST' is set by default on all test nodes and, as a consequence some rules are filtered out. To see the list
of the rules that are filtered out, see the C Code Revi ew Li nker - crcl d page in the Studio Reference category
of the help, under 'Runti ne Anal ysis command |ine interface reference page.

To enable these rules, you must run a full check of MISRA rules from an application node in HCL OneTest™
Embedded Studio.

Create a project if not already done.

. Create a project.
. Create an 'application’ node.
. Add all your sources under this node.

. Select the application node, right-click and select Settings > Build > Build options.

a A W N =

. In the right panel, deselect all options except the Code Review option.

Edit conpi l er / user i ncl ude directories to point to your header files.
. Click Apply and then OK.
7. To run the build, select the application node, right-click and select Build.

o)}

8. To see the report, select the application node, right-click and select Open Report > Code Review.

Viewing code review results

Code Review for C

The GUI displays code review results in the Report Viewer.
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Reloading a Report

If you open the report in the report viewer and the report has been updated in the meantime, you can use the Reload

command to refresh the display:

To reload a report:
1. From the View Toolbar, click the Reload button.

Exporting a Report to HTML
Code review results can be exported to an HTML file.

To export results to an HTML file:

1. From the File menu, select Export and Export Project Report in HTML files format.
2. In the HTML Export Configuration window, select Code Review.
3. Specify an output directory and click Export.

Related Topics

Understanding code review reports on page 329 | Code review MISRA 2004 rules on page 114

Understanding code review reports

Code Review for C
The Code Review report lists the rules that produced and error or a warning.

Report explorer

The Report Explorer window displays a list of rules that were broken for each source file and function. You can use
there elements in this view to navigate through the report.

Report summary

At the top of the Code Review report a summary provides information about the general configuration, the date and

the number of analyzed files.
It also lists the number of errors and warnings that were encountered.

Code review details

The code review report lists the rules for which errors or warnings were detected. It also provides information about

the location of the error. You can click the title to go directly to the corresponding line in the source code.

Related Topics
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Using the code review viewer on page 328 | Viewing reports on page 736 | Understanding reports on page 738 |
Code review MISRA 2004 rules on page 114

Customizing the code review report

The default code review report is generated in an HTML format from a template named misrareport.template as that
you can modify to customize the code review reports.

The code review HTML reports are generated from a template named misrareport.template that you can find in the
following folder as a text file:

* On Windows: <instal l ati on_directory>\lib\reports

«OnUnix:<installation_directory>/lib/reports
The template file uses the following JavaScript libraries:

» Bootstrap

» JQuery

» Font Awesome
* VisdS

* Chart

These libraries are not provided. An internet connection is required to open the report. If you don't have any internet
connection, download the libraries (.css and .js files), copy them in the folder in which the report is saved, and modify

the template file as follows:

Replace the following block of lines:

<link rel="stylesheet" href="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/css/bootstrap.min.css"
integrity="sha384-MCw98/SFNGE8fJIT3GXWEONgsV7Zt27NXFoaoApmYm81iuXoPkFOJwI8ERdknLPMO"
crossorigin="anonymous">

<link rel="stylesheet" href="https://use.fontawesome.com/releases/v5.5.0/css/all.css"
integrity="sha384-B4dIYHKNBt8Bc1l2p+WXckhzcICoOwtJAoU8YZTY5qEOId1GSseTk6S+L3B1XeVIU"
crossorigin="anonymous">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.min.css">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/Chart.js/2.8.0/Chart.min.css">

<script src="https://code.jquery.com/jquery-3.3.1.slim.min.js"
integrity="sha384-q81i/X+965Dz00rT7abK41IStQIAqVgRVzpbzo5smXKp4YfRvH+8abtTE1Pi6jizo"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/popper.js/1.14.3/umd/popper.min.js"
integrity="sha384-ZMP7rVo3mIykV+2+9J3UJ46jBkOWLaUAdNn689aCwoqbBJiSnjAK/18WvCWPIPmM49"
crossorigin="anonymous"></script>

<script src="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/js/bootstrap.min.js"
integrity="sha384-ChfqqxuZUCnJSK3+MXmPNIyE6ZbWh2IMqE241rYiqIxyMiZ60W/ImZQ5stwEULTY"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.js"></script>
<script src="https://cdnjs.cloudflare.com/ajax/libs/Chart.js/2.8.0/Chart.min.js"></script>

With the following one:
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<link rel="stylesheet" href="./bootstrap.min.css>
<link rel="stylesheet" href="./all.css">

<link rel="stylesheet" href="./vis.min.css">
<link rel="stylesheet" href="./Chart.min.css">

<script src="./jquery-3.3.1.slim.min.js"></script>
<script src="./popper.min.js"></script>

<script src="./bootstrap.min.js"></script>

<script src="./vis.js"></script>

<script src="./Chart.min.js"></script>

The following sections give the list of elements that you can use in the raw data and the JavaScript functions to

customize your report file.

Data format

The misrareport.template template consists of two sections:

« The HTML section that is common to all reports,
« A JavaScript section that sets tables depending on two variables that are initialized dynamically when the

report is created:

var data = {{json}}; // the raw data, 1in json format
var d = new Date({{date}}) // the generation date

Raw data contains the following information at the top level:

- output is the name of the json file that contains the raw data

« title is the nternal title of the report (displayed in the “crc” file format)

« configurationTitle is the title of the used configuration file

« systemLevel is the C level norm used. The possible values are "C90", "C90 and Normative Addentum 1", "C99
or"C11"

- configuration is the configuration file used to generate this report

- date is the generation date of raw data

- nbAnalyzedFiles is the number of analyzed files

nbFileskO is the number of files containing errors

.

nbFilesOK is the number of files without errors

« nbError is the total number of all errors in all analyzed files

- nbWarning is the total number of all warnings in all analyzed files

- files is the array of file element (each one represents a physical file) or array of deactivated element
- statistics is the array of rule statistics element

Example:
{

"output": "../build/fullreport_1l.crc.json",

"title": "HCL OneTest (TM) Embedded MISRA C:2012 Report using C90",
"configurationTitle": "MISRA C:2012",

"systemLevel": "C90",
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0 "configuration": "C:\\Program
J
Files\\HCL\\HCLOneTest\\Embedded/plugins/Common/1lib/confrule_2012.xml",

"date": "Mon Oct 19 15:52:07 2020",
"nbAnalyzedFiles": 5,
"nbFilesk0": 4,
"nbFilesOK": 1,
"nbError": 49,
"nbWarning": 68,
"files": [

])

"statistics": [

]

}

Each file elementfile element represents an analyzed source file. It contains the following information at the top level:

- source is the physical location of source file

- fileDate is the date of last editing of this source

« nbErrorOrWarning is the total of error or warning in this file

« content is an array of rule element (if the rule is directly raised at file level) or function element. It is always

available but it can be empty (file with no function and with no error or warning)

Each function element represents a function. It contains the following information at the top level:
- function is the name of the function
- kind is the analysis result of this function. The possible values are 'Failed' or 'Passed'
- content is an array of rule element (rules that are raised inside this function). It is always available
but it can be empty (function with no error or no warning)

Examples:

file element

{

"source": "C:\\workspace\\project\\src\\core.h",
"fileDate": "Mon Sep 07 10:31:50 2020",
"nbErrorOrWarning": 25,

"content": [

]

}

function element:

{

"function": "win",
"kind": "Failed",
"content": [

]

}

Each rule element represents a triggered rule, justified or not. It contains the following information at the top level:
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- rule is the name of the rule, corresponding to its label defined in the configuration file

- group is the family of this rule, it corresponds to the label of the rule’s group that is defined in the configuration
file

« kind is the severity of the rule. The possible values are ‘error', 'warning' or 'info, depending on the error level in
the configuration file and on the possible justification (the justified rules have an 'info' type value)

« line is the line of the current file where the rule was triggered

« column is the column of the current file where the rule was triggered

« text is the rule description. It is related to the rule text in configuration file

- justification is the justification text for the rule. This field is optional, and is present only if the rule is justified

Example:
{

"rule": "M21.6.1",
"group": "21- Standard libraries",

"kind": "info",

"line": 21,

"column": 10,

"text": "The 1input/output library <stdio.h> shall not be used in production code.",
"justification": "This rule does not apply to the following line"

3

Each deactivated element represents a group of rules that is deactivated for a specific reason. It contains the

following information at the top level:

- deactivated_rules_by_user is used for all the rules that are deactivated when it is used in the configuration file
with the error set to level 0. This field is optional, it can be empty, or you can enter an array of deactivated rule

element

Example:
{

"deactivated_rules_by_user": [
]
}

- deactivated_rules_by_test_option is used for all the rules that are deactivated by using the “test” option. This
field is optional, it can be empty, or you can enter an array of deactivated rule element

Example:
{

"deactivated_rules_test_option": [
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]
4

Each deactivated rule element represents a deactivated rule for any reason. It contains the following information at

the top level:

« rule is the name of the rule, it corresponds to the rule label that is defined in the configuration file
- text is the rule description, it corresponds to the rule text in configuration file

Example:
{

"rule": "E15.3",
"text": "The return keyword should not be used in a conditional block."

}

Each rule statistics element represents global statistics for the rule raised during test. It contains the following

information at the top level:

- ruleStatistics is the array of the statistic rule element

Example:
{

"rulesStatistics": [
]
}

Each statistic rule element contains a rule that was raised one or several times. It contains the following information

at the top level:

« rule is the name of the rule. It corresponds to the rule label that is defined in the configuration file
« kind is the severity of the rule. The possible values are 'error' or 'warning' that correspond to the error level in
the configuration file

» occurences is the number of times that the rule was raised

Example:
{

"rule": "M17.7",
"kind": "error",
"text": "When a function returns a value, this value should be used.",
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0 "occurences": 4
J
}

Javascript functions
You can find in the misrareport.template template a set of JavaScript functions.

Some of the helper functions simplify access to “raw data”:

- isFct(element) checks whether an element is a function or not

« isFile(element) checks whether an element is a file or not

- isFilelnError(element) checks whether an element is a file that contains an error or a warning
- isFctPassed(element) checks whether an element is a passed function or not

- isFctFailed(element) checks whether an element is a failed function or not

« isRuleError(element) checks whether a rule level is error or not

« isRuleWarning(element) checks whether a rule level is warning or not

- isRulelnfo(element) checks whether a rule level is an information or not

- isRuleJustified(element) checks whether a rule is justified or not

Other functions are used to display each section of the report:

- emptyLine() displays an empty line (helper function)

- startFile(element) is called at start of a file element.

« endFile() is called at end of a file element.

- startFileRules() is called at the beginning of a group of rules that is relative to a file. Used to display array
headers

- endFileRules() is called at end of a group of rules relative to a file.

« startFileFunctions() is called at the beginning of a function

- rule(element) is called to display details of a raised rule.
The last section is a set of functions that is used to display summaries:

- displayDeactivatedbytest(elem) displays all deactivated rules by using the "-test' option
- displayDeactivatedbyuser(elem) displays all deactivated rules that are used in the configuration file

- displayrulesstatistics(elem) displays statistics for all rules that are raised during the test

The main algorithm dispatches the function calls by parsing the raw data.

Analyzing running applications

The runtime analysis feature set of HCL OneTest™ Embedded allows you to closely monitor the behavior of your
application for debugging and validation purposes. Each feature instruments the source code providing real-time
analysis of the application while it is running, either on a native or embedded target platform.
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To learn about See

How to perform runtime analysis on your source code Using Runtime Analysis Fea-
tures on page 336

Detecting memory leaks in C and C++ source code About Memory Profiling on
page 393

Measuring software performance with Performance Profiling About Performance Profiling
on page 414

Performing code and test coverage with Code Coverage About Code Coverage on
page 72

Obtaining real-time UML sequence diagram traces from your software with Runtime About Runtime Tracing on

Tracing page 424

Runtime analysis overview

The runtime analysis tools of HCL OneTest™ Embedded allow you to closely monitor the behavior of your application

for debugging and validation purposes.

These features use source code insertion to instrument the source code providing real-time analysis of the

application while it is running, either on a native or embedded target platform.

« Memory Profiling on page 393 analyzes memory usage and detects memory leaks.

« Performance Profiling on page 414 provides metrics on execution time for each procedure/function/
method of the application. For C language, it also provides an estimation of Worst Case Estimation Time.

« Code Coverage on page 72 performs code coverage analysis.

- Control Coupling on page 182 provides coverage information on Control Coupling that represent the

interactions between modules (C language only).

« Data Coupling on page 192 provides coverage information on def/use pairs identified in the application(C

language only).

» Worst Stack Size on page 199 computes an estimation of the maximum of the application stack size (C

language only).
« Runtime Tracing on page 424 draws a real-time UML Sequence Diagram of your application.

» Contract Check on page 545 (for C++ only) verifies behavioral assertions during execution of the code and

produces a Contract Check sequence diagram. on page 557

Each of these runtime analysis tools can be used together with any of the automated testing features providing, for

example, test coverage information.
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Note SCI instrumentation of the source code generates a certain amount of overhead, which can impact application

size and performance. See Source code instrumentation overview on page 16 for more information.
Here is a basic rundown of the main steps to using the runtime analysis feature set.

To use the runtime analysis tools:

1. From the Start page, set up a new project. This can be done automatically with the New Project Wizard on
page 696.

. Follow the Activity Wizard on page 695 to add your application source files to the workspace.

. Select the source files under analysis in the wizard to create the application node.

. Select the runtime analysis tools to be applied to the application in the Build options.

a A WON

. Use the Project Explorer on page 1056 to set up the test campaign and add any additional runtime analysis or
test nodes.

(o)}

. Run the application node on page 730 to build and execute the instrumented application.

7. View and analyze the generated analysis and profiling reports on page 715.

The runtime analysis tools can be run within a test by simply adding the runtime analysis setting to an existing test
node.

The runtime analysis tools for C and C++ can also be used in an Eclipse development environment. Runtime or static
analysis tools do not run on System Testing nodes.

Related Topics

Reducing Instrumentation Overhead on page 72
About Memory Profiling on page 393

About Performance Profiling on page 414
About Code Coverage on page 72

About Runtime Tracing on page 424

Profiling shared libraries
Runtime Analysis

In order to perform runtime analysis on a shared library, you must create an application node containing both a small
program that uses the library, and a reference link to the library.

After the execution of the application node, the runtime analysis results are located in the application node.

To profile a shared library:
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1. Add the library to your project as described in Using library nodes on page 718.
2. Create an empty application node:
o Right-click a group or project node and select Add Child and Application from the popup menu.
> Enter the name of the application node
3. Inside the application node, create a source file containing a short program that uses the shared library.
4. Link the application node to the shared library:

o Right-click the application or test node that will use the shared library and select Add Child and
Reference from the popup menu.

> Select the library node and click OK.

5. Select the application node, click the Settings button, and set the Build options to include the runtime analysis
tools that you want to use.

6. Build and execute the application node.

Example

An example demonstrating how to use Runtime Analysis tools on shared libraries is provided in the Shared Library

example project. See Example projects on page 709 for more information.
Related Topics

Using library nodes on page 718 | Testing shared libraries on page 480 | Selecting Build Options for a Node on
page 731

Code coverage

Code coverage overview

Source code coverage consists of identifying which portions of a program are executed or not during a given test
case. Source code coverage is recognized as one of the most effective ways of assessing the efficiency of the test

cases applied to a software application.

The code coverage tool can provide the coverage information for the following source code elements:

« Statement blocks, decisions, and loops.

« Function or procedure calls.

« Basic conditions, modified conditions/decisions (MC/DC), multiple condition, and forced condition.
* Procedure entries and exits.

» Terminal or potentially terminal statements

» Statements that are considered non-coverable in C.

338



Chapter 5. Test Execution Specialist Guide

See Coverage levels on page 73 for more details about each coverage level.

Information modes

The information mode is the method used to code the trace output. This has a direct impact of the size of the trace
file as well as on CPU overhead. You can change the information mode in the coverage type settings. See Changing

code coverage settings on page 81.

There are three information modes:

« Default mode: Each branch generates one byte of memory. This offers the best compromise between code
size and speed overhead.

- Compact mode: This is functionally equivalent to Pass mode, except that each branch needs only one bit of
storage instead of one byte. This implies a smaller requirement for data storage in memory, but produces a
noticeable increase in code size (shift/bits masks) and execution time.

- Hit Count mode: In this mode, instead of storing a Boolean value indicating coverage of the branch, a specific
count is maintained of the number of times each branch is executed. This information is displayed in the code
coverage report.

Count totals are given for each branch, for all trace files transferred to the report generator as parameters. In the code
coverage report, branches that have never been executed are highlighted with an asterisk "*'. The maximum count in
the report generator depends on the amount of memory available on the computer running the tests. If this maximum
count is reached, the report signals it with a Maximum reached message.

Note: The last bracket (}) in a function after a return statement is always displayed in red in the coverage
report, even if the function reports 100% coverage.

On-the-fly display

By default, code coverage generates a report when the execution ends. The on-the-fly mode generates code coverage
results dynamically during the execution. This is useful for applications that never exit or to interact with the
execution during the analysis, for example if you want to stop the code coverage when you reach a specified coverage
rate threshold.

Information Modes

Code Coverage for Ada, C and C++

The Information Mode is the method used by Code Coverage to code the trace output. This has a direct impact of the

size of the trace file as well as on CPU overhead.

You can change the information mode used by Code Coverage in the Coverage Type settings. There are three

information modes:
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« Default mode
« Compact mode

« Hit Count mode

Default Mode

When using Default or Pass mode, each branch generates one byte of memory. This offers the best compromise

between code size and speed overhead.

Compact Mode

The Compact mode is functionally equivalent to Pass mode, except that each branch needs only one bit of storage
instead of one byte. This implies a smaller requirement for data storage in memory, but produces a noticeable
increase in code size (shift/bits masks) and execution time.

Hit Count Mode

In Hit Count mode, instead of storing a Boolean value indicating coverage of the branch, a specific count is
maintained of the number of times each branch is executed. This information is displayed in the Code Coverage

report.
Count totals are given for each branch, for all trace files transferred to the report generator as parameters.
In the Code Coverage report, branches that have never been executed are highlighted with asterisk *' characters.

The maximum count in the report generator depends on the machine on which tests are executed. If this maximum
count is reached, the report signals it with a Maximum reached message.

Related Topics

About Code Coverage on page 72 | Selecting Coverage Type on page 340 | Estimating Instrumentation Overhead

on page 69 | Reducing Instrumentation Overhead on page 72

Coverage types

Code Coverage for Ada, C and C++

The Code Coverage feature provides the capability of reporting of various source code units and branches, depending

on the coverage type selected.

By default, Code Coverage implements full coverage analysis, meaning that all coverage types are instrumented by
source code insertion (SCI). However, in some cases, you might want to reduce the scope of the Code Coverage
report, such as to reduce the overhead generated by SCI for example.
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When referring to the Code Coverage feature, a branch denotes a generic unit of enumeration. For each branch, you

specify the coverage type. Code Coverage instruments each branch when you compile the source under test.

Coverage Levels

The following table provides details of each coverage type as used in each language supported by the product

Coverage Level

Block coverage

Call coverage

Condition coverage

ATC coverage

Function, unit or method cover-

age

Link files

Templates

Additional statements

To select a coverage level:

Languages

Con

page 355

Con

page 359

Con

page 360

Con

page 365

Con

page 367

Ada on
page 342

Ada on
page 345

Ada on
page 346

Ada on
page 346

Ada on
page 350

Ada on
page 352

Ada on
page 354

C++on

page 368

C++on

page 373

C++on

page 371

C++on

page 378

C++on

page 379

1. Right-click the application or test node concerned by the Code Coverage report.

2. From the pop-up menu, select Settings.

3. In the Configuration list, expand Code Coverage and select Instrumentation Control.

4. Select or clear the coverage levels as required.

5. Click OK.

Related Topics
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Source code instrumentation overview on page 16 | Generating SCI Dumps on page 1086 | Reducing Instrumentation

Overhead on page 72

Ada coverage

Block coverage
Code Coverage for Ada

When analyzing Ada source code, Code Coverage can provide the following block coverage types:

« Statement blocks
» Statement and decision blocks
« Statement, decision, and loop blocks

« Asynchronous transfer of control (ATC) blocks

Statement blocks (or simple blocks)

Simple blocks are the main blocks within units as well as blocks introduced by decisions, such as:

- then and else (elsif) of an if

« loop...end loop blocks of a for...while

- exit when...end loop or exit when blocks at the end of an instruction sequence

« when blocks of a case

« when blocks of exception processing blocks

« do...end block of the accept instruction

« or and else blocks of the select instruction

« begin...exception blocks of the declare block that contain an exceptions processing block.
« select...then abort blocks of an ATC statement

« sequence blocks: instructions found after a potentially terminal statement on page 354.

A simple block constitutes one branch. Each unit contains at least one simple block corresponding to its body, except
packages that do not contain an initialization block.

Decision coverage (implicit blocks)

An if statement without an else statement introduces an implicit block.
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-- Function power_10
---block=decision or -block=implicit
function power_10 ( value, max : in integer) return integer is
ret,i:integer;

begin

if (value == 0) then

return O;

-- implicit else block

end if ;

foriin0..9

loop

if ((max /10) < ret) then

ret :=ret*10;
else

ret := max;
end if ;

end loop ;
return ret;
end;

An implicit block constitutes one branch.
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Implicit blocks refer to simple blocks to describe possible decisions. The Code Coverage report presents the sum of

these decisions as an absolute value and a ratio.

Loop coverage (logical blocks)

A for or while loop constitutes three branches:
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» The simple block contained in the loop is never executed: the exit condition is true immediately
« The simple block is run only once: the exit condition is false, and then true on the next iteration

- The simple block run at least twice: the exit condition is false at least twice, then finally true)
A loop...end loop block requires only two branches because the exit condition, if it exists, is tested within the loop:

- The simple block is played only once: the exit condition is true on the first iteration, if the condition exists

- The simple block is played at least twice: the exit condition false at least once and then finally true, if the
condition exists

In the following example, you need to execute the function try_five_times() several times for 100 % coverage of the

three logical blocks induced by this while loop.
-- Function try_five_times

function try_five_times return integer is
result,i:integer:=0;

begin

--try is any function

while (i< 5) and then (result <= 0) loop
result :=try;

i := integer'succ(i);

end loop ;

return result;

end ; - 3 logical blocks

Logical blocks are attached to the loop introduction keyword.

Asynchronous transfer of control (ATC) blocks

This coverage type is specific to the Ada 95 asynchronous transfer of control (ATC) block statement (see your Ada
documentation).

The ATC block contains tree branches:
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- Control immediately transferred: The sequence of control never passes through the block then abort /end

select, but is immediately transferred to the block select/then abort.

- Control transferred: The sequence of control starts at the block then abort/end select, but never reaches the
end of this block. Because of trigger event appearance, the sequence is transferred to the block select/then
abort.

- Control never transferred: Because the trigger event never appears, the sequence of control starts and
reaches the end of the block then abort/end select, and was never transferred to the block select/then abort.

In the following example, you need to execute the compute_done function several times to obtain full coverage of the

three ATC blocks induced by the select statement:
function compute_done return boolean is
result : boolean := true ;

begin

- if computing is not done before 10s ...
select

delay 10.0;

result := false;

then abort

compute;

end select;

return result;

end ; - 3 logical blocks

Code Coverage blocks are attached to the Select keyword of the ATC statement.
Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Call coverage
Code Coverage for Ada
When analyzing Ada source code, Code Coverage can provide coverage of function, procedure, or entry calls.

Code Coverage defines as many branches as it encounters function, procedure, or entry calls.
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This type of coverage ensures that all the call interfaces can be shown to have been exercised for each Ada unit

(procedure, function, or entry). This is sometimes a pass/fail criterion in the software integration test phase.
Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Condition Coverage
Code Coverage for Ada
Basic Conditions

Basic conditions are operands of logical operators (standard or derived, but not overloaded) or, xor, and, not, or else,
or and then, wherever they appear in ADA units. They are also the conditions of if, while, exit when, when of entry
body, and when of select statement, even if these conditions do not contain logical operators. For each of these basic
conditions, two branches are defined: the sub-condition is true and the sub-condition is false.

A basic condition is also defined for each when of a case statement, even each sub-expression of a compound when,
that is when A | B: two branches.

-- power_of_10 function -- -cond

Function power_of_10( value, max : in integer )
is

result : integer ;

Begin

if value = 0 then

return O;

end if ;

result := value ;

foriin 0..9 loop

if (max > 0) and then (( max / value ) < result ) then
result := result * value;

else

result := max ;

end if ;
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end loop;

return result ;

end ; - there are 3 basic conditions (and 6 branches).

- Near_Color function

Function Near_Color ( color : in ColorType ) return ColorType
is

Begin

case color is

when WHITE | LIGHT_GRAY => return WHITE ;

when RED | LIGHT_RED .. PURPLE => return RED ;

end case;

End ; - there are 4 basics conditions (and 4 branches).

Two branches are enumerated for each boolean basic condition, and one per case basic condition.
Forced Conditions

A forced condition is a multiple condition in which any occurrence of the or else operator is replaced with the or
operator, and the and then operator is replaced with the and operator. This modification forces the evaluation of the
second member of these operators. You can use this coverage type after modified conditions have been reached to
ensure that all the contained basic conditions have been evaluated. With this coverage type, you can be sure that only

the considered basic condition value changes between both condition vectors.
-- Original source : - -cond=forceevaluation

if (aand then b)) or else ¢ then

- Modified source :

if (aand b ) or c then

Note This replacement modifies the code semantics. You need to verify that using this coverage type does not modify

the behavior of the software.
Example
procedure P ( A :intAccess) is

begin
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if A /= NULL and then A.value > 0 -- the evaluation of A.value will raise an
-- exception when using forced conditions

-- if the A pointer is nul

then

A.value := A.value - 1;

end if;

end P;

Modified Conditions

A modified condition is defined for each basic condition enclosed in a composition of logical operators (standard or
derived, but not overloaded). It aims to prove that this condition affects the result of the enclosing composition. To do
that, find a subset of values affected by the other conditions, for example, if the value of this condition changes, the

result of the entire expression changes.

Because compound conditions list all possible cases, you must find the two cases that can result in changes to the

entire expression. The modified condition is covered only if the two compound conditions are covered.
-- State_Control state - -cond=modified

Function State_Condtol return integer

is

Begin

if ((flag_running and then ( process_count>10))
or else flag_stopped )

then

return VALID_STATE;

else

return INVALID_STATE ;

end if ;

End;

-- There are 3 basic conditions, 5 compound conditions
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- and 3 modified conditions :

--flag_running : TTX=T and FXF=F

-- process_count > 10 : TTX=T and TFF=F

- flag_stopped : TFT=T and TFF=F, or FXT=T and FXF=F

- 4 test cases are enough to cover all the modified conditions :

- TTX=T

- FXF=F

- TFF=F

- FTF=F or FXT=T

Note You can associate a modified condition with more than one case, as shown in this example for flag_stopped.

In this example, the modified condition is covered if the two compound conditions of at least one of these cases are

covered.
Code Coverage calculates cases for each modified condition.

The same number of modified conditions as boolean basic conditions appear in a composition of logical operators
(standard or derived, but not overloaded).

Multiple Conditions

A multiple condition is one of all the available cases of logical operators (standard or derived, but not overloaded)
wherever it appears in an ADA unit. Multiple conditions are defined by the concurrent values of the enclosed basic

boolean conditions.

A multiple condition is noted with a set of T, F, or X letters, which means that the corresponding basic condition
evaluates to true or false, or it was not evaluated, respectively. Such a set of letters is called a condition vector. The
right operand of or else or and then logical operators is not evaluated if the evaluation of the left operand determines
the result of the entire expression.

-- State_Control Function -- -cond=compound
Function State_Control return integer

is

Begin

if ((flag_running and then ( process_count>10))

or else flag_stopped
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then

return VALID_STATE ;

else

return INVALIDE_STATE ;

end if ;

End;

- There are 3 basic conditions

--and 5 compound conditions :
~TTX=T<=>((TandthenT)orelseX)=T
- TFT=T

- TFF=F

- FXT=T

- FXF=F

Code Coverage calculates the computation of every available case for each composition.

The number of enumerated branches is the number of distinct available cases for each composition of logical
operators (standard or derived, but not overloaded).

Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Unit coverage

Code Coverage for Ada

Unit Entries

Unit entries determine which units are executed and/or evaluated.
- Function factorial

- -proc

function factorial (a: in integer ) return integer is

begin
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if (a>0)then

return a * factorial (a-1);
else

return 1;

end if;

end factorial ;
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One branch is defined for each defined and instrumented unit. In the case of a package, the unit entry only exists if the

package body contains the begin/end instruction block.

For Protected units, no unit entry is defined because this kind of unit does not have any statements blocks.

Unit Exits and Returns

These are the standard exit (if it is coverable), each return instruction (from a procedure or function), and each

exception-processing block in the unit.

-- Function factorial

- -proc=ret

function factorial (a: in integer ) return integer is
begin

if (a>0) then

return a * factorial (a-1);

else

return 1;

end if ;

end factorial ; -- the standard exit is not coverable
-- Procedure divide

procedure divide (a,b : in integer; ¢ : out integer ) is
begin

if (b==0)then

text_io.put_line("Division by zero");
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raise CONSTRAINT_ERROR,;

end if ;

if (b==1)then

c:=a;

return;

end if ;

c:=a/b

exception

when PROGRAM_ERROR => null ;

end divide ;

For Protected units, no exit is defined because this kind of unit does not have any statements blocks.

In general, at least two branches per unit are defined; however, in some cases the coding may be such that:

« There are no unit entries or exits (a package without an instruction block (begin/end), protected units case).

« There is only a unit entry (an infinite loop in which the exit from the task cannot be covered and therefore the

exit from the unit is not defined).

The entry is always numbered if it exists. The exit is also numbered if it is coverable. If it is not coverable, it is
preceded by a terminal instruction containing return or raise instructions; otherwise, it is preceded by an infinite loop.

A raise is considered to be terminal for a unit if no processing block for this exception was found in the unit.
Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Link files

Code Coverage for Ada

Link files are the library management system used for Ada Coverage. These libraries contain the entire Ada
compilation units contained by compiler sources, the predefined Ada environment and the source files of your
projects. You must use link files when using Code Coverage in Ada for the Ada Coverage analyzer to correctly analyze
your source code.

You can include a link file within another link file, which is an easy way to manage your source code.
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Link File Syntax

Link files have a line-by-line syntax. Comments start with a double hyphen (--), and end at the end of the line. Lines

can be empty.

There are two types of configuration lines:
« Link file inclusion: The link filename can be relative to the link file that contains this line or absolute.
<link filename> LINK

« Compilation unit description: The source filename is the file containing the described compilation unit
(absolute or relative to the link filename). The full unit name is the Ada full unit name (beware of separated

units, or child units).

<source filename> <full unit name> <type> [ada83]

The <type> is one of the following flags:

. > SPEC for specification
- BODY for a body

> PROC for procedure or function

Use the optional ada83 flag if the source file cannot be compiled in Ada 95 mode, and must be analyzed in Ada 83

mode.

Generating a Link File

The link file can be generated either manually or automatically with the Ada Link File Generator (attolalk) tool. See the

Studio Reference section of the help for more information about command line tools.

Sending the Link File to the Instrumentor

The loading order of link files is important. If the same unit name is found twice or more in one (or more) loaded link

files, the Instrumentor issues a warning and uses the last encountered unit.
Included link files are analyzed when the file including the link file is loaded.

In Ada, Code Coverage loads the link files in the following order:

- By default, either adalib83.alk or adalib95.alk is loaded. These files are part of the Target Deployment Port.

« If you use the -STDLINK command line option, the specified standard link file is loaded first. See the Studio

Reference section of the help for more information
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« The link file specified by the ATTOLCOV_ADALINK environment variable is loaded.

« The link files specified by the -Link option is loaded.
Now, you can start analyzing the file instrument.

Loading A Permanent Link File

You can ask Code Coverage to load the link file at each execution. To do that, set the environment variable
ATTOLCOV_ADALINK with the link filename separated by ':' on a UNIX system, or ;' in Windows. For example:

ATTOLCOV_ADALINK="compiler.alk/projects/myproject/myproject.alk"

A Link file specified on the command line is loaded after the link file specified by this environment variable.
Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Additional Statements
Code Coverage for Ada
Terminal Statements

An Ada statement is terminal if it transfers control of the program anywhere other than to a sequence (return, goto,

raise, exit).

By extension, a decision statement (if, case) is also terminal if all its branches are terminal (i.e., if, then and else
blocks and non-empty when blocks contain a terminal instruction). An if statement without an else statement is never
terminal, since one of the blocks is empty and therefore transfers control in sequence.

Potentially Terminal Statements

An Ada statement is potentially terminal if it contains a decision choice that transfers control of the program

anywhere other than after it (return, goto, raise, exit ).

Non-coverable Statements

An Ada statement is detected as being not coverable if it is not a goto label and if it is in a terminal statement
sequence. Statements that are not coverable are detected by the feature during the instrumentation. A warning is
generated to signal each one, which specifies its location source file and line. This is the only action Code Coverage

takes for statements that cannot be covered.

Note Ada units whose purpose is to terminate execution unconditionally are not evaluated. This means that Code

Coverage does not check that procedures or functions terminate or return.

354



Chapter 5. Test Execution Specialist Guide

Similarly, exit conditions for loops are not analyzed statistically to determine whether the loop is infinite. As a result, a
for, while or loop/exit when loop is always considered non-terminal (i.e., able to transfer control in its sequence). This
is not applicable to loop/end loop loops without an exit statement (with or without condition), which are terminal.

Related Topics

Selecting coverage types on page 340 | Code Coverage on page 1027

C coverage

Block coverage
Code Coverage for C

When running the Code Coverage feature on C source code, HCL OneTest™ Embedded can provide the following

coverage types for code blocks:

« Statement Blocks
» Statement Blocks and Decisions

- Statement Blocks, Decisions, and Loops

Statement Blocks (or Simple Blocks)

Simple blocks are the C function main blocks, blocks introduced by decision instructions:

« THEN and ELSE FOR IF

* FOR, WHILE and DO ... WHILE blocks

- non-empty blocks introduced by switch case or default statements

- true and false outcomes of ternary expressions (<expr> ? <expr> : <expr>)

« blocks following a potentially terminal statement.
/* Power_of_10 Function */ /* -block */

int power_of_10 ( int value, int max )

{

int retval = value, i;

if (value == 0) return 0; /* potentially terminal statement */
for (i=0;i<10;i++) /* start of a sequence block */

{
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retval = (max/ 10) < retval ? retval * 10 : max;
}

return retval;

} /* The power_of_10 function has 6 blocks */
/* Near_color function */

ColorType near_color ( ColorType color)

{

switch ( color)

{

case WHITE :

case LIGHT_GRAY :

return WHITE;

case RED :

case PINK:

case BURGUNDY :

return RED;

/*etc...*/

}

} /* The near_color function has at least 3 simple blocks */

Each simple block is a branch. Every C function contains at least one simple block corresponding to its main body.
Decisions (Implicit Blocks)

Implicit blocks are introduced by an IF statement without an ELSE or a SWITCH statement without a DEFAULT.

/* Power_of_10 function */

/* -block=decision */

int power_of_10 (int value, int max )

{
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int retval = value, i;

if (value == 0) return 0; else ;
for (i =0;i <10;i++)

{

retval = (max/ 10) < retval ? retval * 10 : max;
}

return retval;

}

/* Near_color function */
ColorType near_color ( ColorType color)
{

switch ( color)

{

case WHITE :

case LIGHT_GRAY :

return WHITE;

case RED:

case PINK:

case BURGUNDY :

return RED;

/* etc ... with no default */
default :;

}

}

Each implicit block represents a branch.
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Because the sum of all possible decision paths includes implicit blocks as well as statement blocks, reports
provide the total number of simple and implicit blocks as a figure and as a percentage. Code Coverage places this
information in the Decisions report.

Loops (Logical Blocks)

A typical FOR or WHILE loop can reach three different conditions:

- The statement block contained within the loop is executed zero times, therefore the output condition is True

from the start
» The statement block is executed exactly once, the output condition is False, then True the next time

« The statement block is executed at least twice. (The output condition is False at least twice, and becomes
True at the end)

In a DO...WHILE loop, because the output condition is tested after the block has been executed, two further branches
are created:

- The statement block is executed exactly once. The output is condition True the first time.

« The statement block is executed at least twice. (The output condition is False at least once, then true at the
end)

In this example, the function try_five_times () must run several times to completely cover the three logical blocks
included in the WHILE loop:

/* Try_five_times function */

/* -block=logical */

int try_five_times (void )

{

int result,i =0;

/*try ()is afunction whose return value depends

on the availability of a system resource, for example */
while ( ( (result = try ())!=0 )&&

(++i <5));

return result;

} /* 3 logical blocks */
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Related Topics

Selecting Coverage Types on page 340 | About Code Coverage on page 72 | Code Coverage settings on
page 1027

Call coverage

Code Coverage for C

When analyzing C source code, Code Coverage can provide coverage of function or procedure calls.
Code Coverage defines as many branches as it encounters function calls.

Procedure calls are made during program execution.

This type of coverage ensures that all the call interfaces can be shown to have been exercised for each C function.

This may be a pass or failure criterion in software integration test phases.

You can use the -EXCALL option to select C functions whose calls you do not want to instrument, such as C library

functions for example.

Example

/* Evaluate function */

/*-call */

int evaluate ( NodeTypeP node )

{

if (node == (NodeTypeP)0 ) return 0;
switch ( node->Type )

{

int tmp;

case NUMBER :

return node->Value;

case IDENTIFIER :

return current value ( node->Name );

case ASSIGN :
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set ( node->Child->Name,

tmp = evaluate ( node->Child->Sibling ) );
return tmp;

case ADD:

return evaluate ( node->Child ) +

evaluate ( node->Child->Sibling );

case SUBTRACT :

return evaluate ( node->Child ) -

evaluate ( node->Child->Sibling );

case MULTIPLY :

return evaluate ( node->Child ) *

evaluate ( node->Child->Sibling );

case DIVIDE :

tmp = evaluate ( node->Child->Sibling );

if (tmp == 0) fatal error ( "Division by zero");
else return evaluate ( node->Child ) / tmp;

}

} /* There are twelve calls in the evaluate function */

Related Topics

C Block Coverage on page 355 | C Condition Coverage on page 360 | C Function Coverage on page 365 | C
Additional Statements on page 367 | Code Coverage settings on page 1027

Condition coverage
Code Coverage for C

When analyzing C source code, HCL OneTest™ Embedded can provide coverage for:

« Basic condition coverage

+ Modified condition/decisioncoverage(MC/DC)
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» Multiple condition coverage

« Forced condition coverage

Basic Conditions

Conditions are operands of either || or && operators wherever they appear in the body of a C function. They are also
if and ternary expressions, tests for for, while, and do/while statements even if these expressions do not contain || or

&& operators. Two branches are involved in each condition: the sub-condition can be true or false.

Basic conditions enable different cases or a default (which could be implicit) in a switch. These are distinguished
even when they invoke the same simple block. One basic condition is associated with every case and default, whether

implicit or not.

In the following example, there are 4*2 basic conditions:
/* Power_of_10 function */

/*-cond */

int power_of_10 ( int value, int max )

{

int result = value, i;

if (value == 0) return 0;
for(i=0;i<10;i++)

{

result = max > 0 && ( max / value ) < result ?
result * value :

max;

return result ;

In the following example, there are 5 basic conditions:
/* Near_color function */

ColorType near_color ( ColorType color)
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{

switch (color)

{

case WHITE :

case LIGHT_GRAY :
return WHITE;

case RED:

case PINK:

case BURGUNDY :
return RED;

/*etc...*/

}

}

Two branches are enumerated for each condition, and one per case or default.
Modified Conditions

A modified condition (MC) is defined for each basic condition enclosed in a composition of || or && operators, proving
that the condition affects the result of the enclosing composition. For example, in a subset of values affected by the

other conditions, if the value of this condition changes, the result of the entire expression changes.

Because compound conditions list all possible cases, you must find the two cases that can result in changes to the

entire expression. The modified condition is covered only if the two compound conditions are covered.

In this following example, there are 6 basic conditions (FALSE and TRUE of each), 5 compound conditions, and 3

modified conditions :

/* state_control function */
int state_control ( void )

{

if (((flag & 0x01) &&
(iinstances_number >10)) ||

(flag & 0x04))
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return VALID_STATE;
else
return INVALID_STATE;

}

The conditions can be described as True (T), False (F), or Not evaluated (X), as in the following example:

- flag & 0x01 : TTX=T and FXF=F
» nb_instances > 10 : TTX=T and TFF=F

- flag & 0x04 : TFT=T and TFF=F, or FXT=T and FXF=F
Therefore the 4 following test cases are enough to cover all those modified conditions :

« TTX=T
- FXF=F
- TFF=F
- TFT=T or FXT=T

Note You can associate a modified condition with more than one case, as shown in this example for flag & 0x04. In
the example, the modified condition is covered if the two compound conditions of at least one of these cases are

covered.
Code Coverage calculates matching cases for each modified condition.

The number of modified conditions matches the number of Boolean basic conditions in a composition of || and &&

operators.

Multiple Conditions

A multiple (or compound) condition is one of all the available cases for the || and && logical operator's composition,
whenever it appears in a C function. It is defined by the simultaneous values of the enclosed Boolean basic

conditions.

Remember that the right operand of a || or && logical operator is not evaluated if the evaluation of the left operand

determines the result of the entire expression.
In the following example, there are 3 basic conditions and 5 compound conditions:
/* state_control function */

/* -cond=compound */
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int state_control ( void )
{
if (((flag & 0x01) &&
(iinstances_number >10)) ||
(flag & 0x04))
return VALID_STATE;
else
return INVALID_STATE;
}
The conditions can be described as True (T), False (F), or Not evaluated (X), as in the following example:
« TTX=T<=>((T&&T)|IX)=T
« TFT=T
- TFF=F
« FXT=T
- FXF=F
Code Coverage calculates every available case for each composition.

The number of enumerated branches is the number of distinct available cases for each composition of || or &&

operators.

Forced Conditions

Forced conditions are multiple conditions in which the Instrumentor replaces any occurrence of the || and &&
operators in the code, with | and & binary operators. You can use this coverage type, after evaluating all modified
conditions, to be sure that every basic condition has been evaluated. With this forced condition coverage, you can

ensure that only the basic condition has changed between two tests.
/* User source code */ /* -cond=forceevaluation */

if ((a&&b)lc)..

/* Replaced with the Code Coverage feature with : */
if((a&b)lc)..

/* Note : Operands evaluation results are enforced to one if different from 0 */
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Note This replacement modifies the code semantics. Before running the test, you need to verify that this coverage
type does not modify the behavior of the software.

int f (MyStruct *A)

{

if (A && A->value > 0) /* the evaluation of A->value will cause a program error using
forced conditions if A pointer

is null */

{

A->value -=1;

}

}

Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Function coverage
Code Coverage for C

When analyzing C source code, HCL OneTest™ Embedded can provide the following function coverage:

» Procedure Entries

» Procedure Entries and Exits

Procedure Entries

Inputs identify the C functions that are executed.
/* Factorial function */

/* -proc */

int factorial (inta)

{

if (a>0) return a * factorial (a-1);
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elsereturn 1;

One branch is defined per C function.

Procedure Entries and Exits (Returns and Terminal Statements)

These include the standard output (if coverable), and all return instructions, exits, and other terminal instructions that

are instrumented, as well as the input.
/* Factorial function */

/* -proc=ret */

int factorial (inta)

{

if (a>0) return a * factorial (a-1);
elsereturn 1;

} /* standard output cannot be covered */
/* Divide function */

void divide (int a, int b, int *c )

{

if (b==0)

{

fprintf ( stderr, "Division by zero\n");
exit (1);

|3

return;

|5
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*c=a/b;

At least two branches are defined per C function.

The input is always enumerated, as is the output if it can be covered. If it cannot, it is preceded by a terminal
instruction involving returns or an exit.

In addition to the terminal instructions provided in the standard definition file, you can define other terminal

instructions using the pragma attol exit_instr.

Note: The last bracket }' in a function after a return statement is always displayed in red in the coverage

report, even if the function reports 100% coverage.

Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Additional statements
Code Coverage for C
Terminal Statements

A C statement is terminal if it transfers program control out of sequence (RETURN, GOTO, BREAK, CONTINUE), or
stops the execution (EXIT).

By extension, a decision statement (IF or SWITCH) is terminal if all branches are terminal; that is if the non-empty
THEN ... ELSE, CASE, and DEFAULT blocks all contain terminal statements. An IF statement without an ELSE and a
SWITCH statement without a DEFAULT are never terminal, because their empty blocks necessarily continue program

control in sequence.

Potentially Terminal Statements

The following decision statements are potentially terminal if they contain at least one statement that transfers
program control out of their sequence (RETURN, GOTO, BREAK, CONTINUE), or that terminates the execution (EXIT):

« IF without an ELSE
« SWITCH
* FOR

* WHILE or DO ... WHILE
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Non-coverable Statements in C

Some C statements are considered non-coverable if they follow a terminal instruction, a CONTINUE, or a BREAK,
and are not a GOTO label. Code Coverage detects non-coverable statements during instrumentation and produces a

warning message that specifies the source file and line location of each non-coverable statement.

Note User functions whose purpose is to terminate execution unconditionally are not evaluated. Furthermore, Code
Coverage does not statically analyze exit conditions for loops to check whether they are infinite. As a result, FOR ...
WHILE and DO ... WHILE loops are always assumed to be non-terminal, able to resume program control in sequence.

Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

C++ coverage
Block coverage

Code Coverage for C++
When analyzing C++ source code, Code Coverage can provide the following block coverage types:
« Statement Blocks
« Statement Blocks and Decisions
- Statement Blocks, Decisions, and Loops
Statement Blocks
Statement blocks are the C++ function or method main blocks, blocks introduced by decision instructions:
» THEN and ELSE FOR IF, WHILE and DO ... WHILE blocks
« non-empty blocks introduced by SWITCH CASE or DEFAULT statements
- true and false outcomes of ternary expressions (<expr> ? <expr> : <expr>)
» TRY blocks and any associated catch handler

« blocks following a potentially terminal statement.

int main () /*-BLOCK */
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{

func ("Hello");

}

else

{

throw UnLucky ();

}

}

catch ( Overflow & 0) {
cout << 0.String << '\n}

}
catch (UnLucky & u) {

throw u;

} /* potentially terminal statement */

return 0; /* sequence block */

}
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Each simple block is a branch. Every C++ function and method contains at least one simple block corresponding to its

main body.

Decisions (Implicit Blocks)

Implicit blocks are introduced by IF statements without an ELSE statement, and a SWITCH statements without a

DEFAULT statement.

/* Power_of_10 function */
/* -BLOCK=DECISION or -BLOCK=IMPLICIT */

int power_of_10 (int value, int max )

{

int retval = value, i;

if (value == 0) return 0; else ;
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for (i=0;i<10;i++)

{

retval = (max/ 10) < retval ? retval * 10 : max;
}

return retval;

}

/* Near_color function */
ColorType near_color ( ColorType color)
{

switch ( color)

{

case WHITE :

case LIGHT_GRAY :

return WHITE;

case RED:

case PINK:

case BURGUNDY :

return RED;

/* etc ... with no default */
default :;

}

}

Each implicit block represents a branch.

Since the sum of all possible decision paths includes implicit blocks as well as simple blocks, reports provide the
total number of simple and implicit blocks as a figure and a percentage after the term decisions.

Loops (Logical Blocks)

Three branches are created in a for or while loop:
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« The first branch is the simple block contained within the loop, and that is executed zero times (the entry
condition is false from the start).

« The second branch is the simple block executed exactly once (entry condition true, then false the next time).

« The third branch is the simple block executed at least twice (entry condition true at least twice, and false at
the end).

Two branches are created in a DO/WHILE loop, as the output condition is tested after the block has been executed:

« The first branch is the simple block executed exactly once (output condition true the first time).

- The second branch is the simple block executed at least twice (output condition false at least once, then true
at the end).

/* myClass::tryFiveTimes method */ /* -BLOCK=LOGICAL */
int myClass::tryFiveTimes ()

{

int result, i = 0;

/* letsgo () is a function whose return value depends

on the availability of a system resource, for example */
while (( (result =letsgo ())!=0) &&

(++i<5));

return result;

} /* 3 logical blocks */

You need to execute the method tryFiveTimes () several times to completely cover the three logical blocks included
in the while loop.

Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Method coverage

Code Coverage for C++

Inputs to Procedures

Inputs identify the C++ methods executed.
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/* Vector::getCoord() method */ /* -PROC

*/

int Vector::getCoord (int index )

{

if (index >= 0 && index < size ) return Values[index];
else return -1;

}

One branch per C++ method is defined.

Procedure Inputs, Outputs and Returns, and Terminal Instructions
These include the standard output (if coverable), all return instructions, and calls to exit(), abort(), or
terminate(), as well as the input.

/* Vector::getCoord() method */ /* -PROC=RET */

int Vector::getCoord ( int index )

{

if (index >= 0 && index < size ) return Values[index];

else return -1;

}

/* Divide function */

void divide (iint a, int b, int *c)

{

if (b==0)

{

fprintf ( stderr, "Division by zero\n");

exit (1);

2

if (b ==1)
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*C =a;
return;
h

*c =a/b;

At least two branches per C++ method are defined. The input is always enumerated, as is the output if it can
be covered. If it cannot, it is preceded by a terminal instruction involving returns or by a call to exit(), abort(), or
terminate().

Potentially Terminal Statements

The following decision statements are potentially terminal if they contain at least one statement that transfers
program control out of its sequence (RETURN, THROW, GOTO, BREAK, CONTINUE) or that terminates the execution
(EXIT).

« IF without an ELSE

* SWITCH, FOR

* WHILE or DO... WHILE

Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Condition coverage

Code Coverage for C++

When analyzing C++ source code, HCL OneTest™ Embedded can provide the following condition coverage:

« Basic Coverage

« Forced Coverage

Basic Conditions

Conditions are operands of either || or && operators wherever they appear in the body of a C++ function. They are also

if and ternary expressions, tests for for, while, and do/while statements even if these expressions do not contain || or
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&& operators. Two branches are involved in each condition: the sub-condition being true and the sub-condition being
false.

Basic conditions also enable different case or default (which could be implicit) in a switch to be distinguished even

when they invoke the same simple block. A basic condition is associated with every case and default (written or not).
There are 4*2 basic conditions in the following example:
/* Power_of_10 function */

/*-cond */

int power_of_10 (int value, int max )

{

int result = value, i;

if (value == 0) return 0;

for (i=0;i<10;i++)

{

result = max > 0 && ( max / value ) < result ?

result * value :

max;

}

return result ;

There are at least 5 basic conditions in this example:
/* Near_color function */

ColorType near_color ( ColorType color)

{

switch ( color)

{

case WHITE :

case LIGHT_GRAY :
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return WHITE;

case RED:

case PINK:

case BURGUNDY :

return RED;

/*etc...*/

}

}

Two branches are enumerated for each condition, and one per case or default.
Forced Conditions

Forced conditions are multiple conditions in which any occurrence of the | | and && operators has been replaced in
the code with | and & binary operators. Such a replacement done by the Instrumentor enforces the evaluation of the
right operands. You can use this coverage type after modified conditions have been reached to be sure that every
basic condition has been evaluated. With this coverage type, you can be sure that only the considered basic condition

changed between the two tests.

/* User source code */ /* -cond=forceevaluation */

if((a&&b)llc)..

/* Replaced with the Code Coverage feature with : */

if((a&b)|c)...

/* Note : Operands evaluation results are enforced to one if different from 0 */

Note This replacement modifies the code semantics. You need to verify that using this coverage type does not modify
the behavior of the software.

int f ( MyStruct *A)

{

if (A && A->value > 0) /* the evaluation of A->value will cause a program error using
forced conditions if A pointer

is null */
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{

A->value -=1;

}

}

Modified Conditions

A modified condition is defined for each basic condition enclosed in a composition of | | or && operators. It aims
to prove that this condition affects the result of the enclosing composition. To do that, find a subset of values
affected by the other conditions, for example, if the value of this condition changes, the result of the entire expression

changes.

Because compound conditions list all possible cases, you must find the two cases that can result in changes to the

entire expression. The modified condition is covered only if the two compound conditions are covered.
/* state_control function */

int state_control ( void )

{

if (((flag & 0x01) &&

(iinstances_number >10)) ||

(flag & 0x04))

return VALID_STATE;

else

return INVALID_STATE;

}

In this example, there are 6 basic conditions (FALSE and TRUE of each), 5 compound conditions, and 3 modified

conditions :

« flag & 0x01 : TTX=T and FXF=F
» nb_instances > 10 : TTX=T and TFF=F

- flag & 0x04 : TFT=T and TFF=F, or FXT=T and FXF=F

Therefore the 4 following test cases are enough to cover all those modified conditions :
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« TTX=T
- FXF=F
- TFF=F

« TFT=T or FXT=T

Note You can associate a modified condition with more than one case, as shown in this example for flag & 0x04. In
this example, the modified condition is covered if the two compound conditions of at least one of these cases are

covered.
Code Coverage calculates matching cases for each modified condition.

The same number of modified conditions as Boolean basic conditions appears in a composition of | | and &&

operators.

Multiple Conditions

A multiple (or compound) condition is one of all the available cases for the || and && logical operator's composition,
whenever it appears in a C++ class. It is defined by the simultaneous values of the enclosed Boolean basic

conditions.

A multiple condition is noted with a set of T, F, or X letters. These mean that the corresponding basic condition
evaluated to true, false, or was not evaluated, respectively. Remember that the right operand of a || or && logical

operator is not evaluated if the evaluation of the left operand determines the result of the entire expression.
/* state_control function */

/* -cond=compound */

int state_control ( void )

{

if (((flag & 0x01) &&

(iinstances_number >10)) ||

(flag & 0x04))

return VALID_STATE;

else

return INVALID_STATE;
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In this example, there are 3 basic conditions and 5 compound conditions :
cTTX=T<=>((T&&T)IIX)=T
« TFT=T
» TFF=F
« FXT=T
* FXF=F
Code Coverage calculates every available case for each composition.

The number of enumerated branches is the number of distinct available cases for each composition of || or &&

operators.
Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Template instrumentation
Code Coverage for C++

Code Coverage performs the instrumentation of templates, functions, and methods of template classes, considering
that all instances share their branches. The number of branches computed by the feature is independent of the
number of instances for this template. All instances will cover the same once-defined branches in the template code.

Files containing template definitions implicitly included by the compiler (no specific compilation command is required
for such source files) are also instrumented by the Code Coverage feature and present in the instrumented files where
they are needed.

For some compilers, you must specifically take care of certain templates (for example, static or external linkage). You
must verify if your Code Coverage Runtime installation contains a file named templates.txt and, if it does, read that

file carefully.

- To instrument an application based upon Rogue Wave libraries , you must use the
-DRW_COMPILE_INSTANTIATE compilation flag that suppresses the implicit include mechanism in the header

files. (Corresponding source files are so included by pre-processing.)

« To instrument an application based upon ObjectSpace C++ Component Series , you must use the
-DOS_NO_AUTO_INSTANTIATE compilation flag that suppresses the implicit include mechanism in the header

files. (Corresponding source files are so included by pre-processing.)

» Any method (even unused ones) of an instantiated template class is analyzed and instrumented by the

Instrumentor. Some compilers do not try to analyze such unused methods. It is possible that some of these
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methods are not fully compliant with C++ standards. For example, a template class with a formal class
template argument named T can contain a compare method that uses the == operator of the T class. If the C
class used for T at instantiation time does not define an == operator, and if the compare method is never used,
compilation succeeds but instrumentation fails. In such a situation, you can declare an == operator for the C

class or use the -instantiationmode=used Instrumentor option.

Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Additional Statements
Code Coverage for C++
Non-coverable Statements

A C++ statement is non-coverable if the statement can never possibly be executed. Code Coverage detects non-
coverable statements during instrumentation and produces a warning message that specifies the source file and line
location of each non-coverable statement.

Related Topics

Selecting coverage types on page 340 | Code Coverage settings on page 1027

Using the Code Coverage Viewer to view reports
Code Coverage for Ada, C and C++

The Code Coverage Viewer allows you to view code coverage reports generated by the Code Coverage feature. Select

a tab at the top of the Code Coverage Viewer window to select the type of report:

« A Source Report on page 381, showing the source code under analysis, highlighted with the actual coverage

information.

A Rates Report on page 384, providing detailed coverage rates for each activated coverage type.

You can use the Report Explorer to navigate through the report. Click a source code component in the Report Explorer

to go to the corresponding line in the Report Viewer.

You can jump directly to the next or previous Failed test in the report by using the Next Failed Test or Previous Failed

Test buttons from the Code Coverage toolbar.

You can jump directly to the next or previous Uncovered line in the Source report by using the Next Uncovered Line or

Previous Uncovered Line buttons in the Code Coverage feature bar.
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When viewing a Source coverage report, the Code Coverage Viewer provides several additional viewing features for

refined code coverage analysis.

To open a Code Coverage report, follow these steps:

1. Right-click a previously executed test or application node
2. If a Code Coverage report was generated during execution of the node, select View Report and then Code

Coverage.

Coverage types

Depending on the language selected, the Code Coverage feature offers (see Coverage Types on page 340 for more

information):

« Function or Method code coverage: select between function Entries, Entries and exits, or None.
« Call code coverage: select Yes or No to toggle call coverage for Ada and C.
« Block code coverage: select the desired block coverage method.

 Condition code coverage: select condition coverage for Ada and C.

Please refer to the related topics for details on using each coverage type with each language.

Any of the Code Coverage types selected for instrumentation can be filtered out in the Code Coverage report stage if

necessary.

To filter coverage types from the report, proceed as follows:

1. From the Code Coverage menu, select Code Coverage Type.
2. Toggle each coverage type in the menu.

For example, to filter out multiple conditions (MC) from the report, select Code Coverage > Code Coverage Type, and

clear Multiple conditions.

Alternatively, you can filter out coverage types from the Code Coverage toolbar by toggling the Code Coverage type

filter buttons.

Test by test analysis mode

The t est by test analysis mode allows you to refine the coverage analysis by individually selecting the various tests
that were generated during executions of the test or application node. In Test-by-Test mode, a Tests node is available

in the Report Explorer.
When test by test analysis is disabled, the Code Coverage Viewer displays all traces as one global test.

To toggle Test-by-Test mode, follow these steps:
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1. In the Code Coverage Viewer window, select the Source tab.

2. From the Code Coverage menu, select Test-by-Test.
To select the Tests to display in Test-by-Test mode, follow these steps:

1. Expand the Tests node at the top of the Report Explorer.
2. Select one or several tests. The Code Coverage Viewer provides code coverage information for the selected

tests.

Reloading a report

If a Code Coverage report has been updated since the moment you have opened it in the Code Coverage Viewer, you

can use the Reload command to refresh the display:

To reload a report, select Reload from the Code Coverage menu, select Reload.

Resetting a report

When you run a test or application node several times, the Code Coverage results are appended to the existing report.

The Reset command clears previous Code Coverage results and starts a new report.

To reset a report, select Reset from the Code Coverage menu.

Related information

Code Coverage viewer preferences on page 1049
Coverage types on page 340

Exporting reports to HTML on page 737

Coverage source report

Code Coverage applies to Ada, C and C++ languages.

You can use the standards keys (arrow keys, home, end, etc.) to move about and to select the source code. The Code
Coverage source report displays covered and uncovered lines of code colors. You can change these colors in the

Code Coverage report preferences.

Note: In C source files, the last bracket }' in a function after a return statement is always displayed as uncovered in

the coverage report, even if the function reports 100% coverage.

Code colors

The covered and uncovered lines are displayed with the following colors by default:

» Green for covered lines of code.

» Red for uncovered lines of code.
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382

- Orange for partially covered lines of code.

- Blue for justified lines of code.

« Blue with the + icon for justified lines of code, which means that they should not be justified.

» Red with - icon for unreachable code.

int count(int x)

e |

)

eturn % -1:

| W0

{pragma attel cnv._junt'if"_\-r (0, block, , "block not reachable™)

t

int main (void)

return 0;

puts ("1 basic boolocan conditions:
4 -
fpragma atteol cq ‘cond not reachable"}
tpragma attol o e : not reachabls")
. o | False
L1l L= 1
#pragma attol cov_Jjustify (block, "block not reachable")
int. b = a+l;

lpragma attel cov justify (return, "return not reachable™)

i

return 1;

tpragma allel cov juslily (2, cond,"al 2:Llrue","cond nol reachable")

fpragma attcel o

int b =
return
int o

ov_justify (0,mede, "TF:TT:FX", "mede not reachable™)

b l '

count (b) :

=

For uncovered line of codes that are justified, click on the blue attributes value to see more details about the

justification text.
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You can change the default colors in the code coverage report preferences. In the main menu toolbar, click
Edit > Preferences > Code Coverage Viewer > Styles, you can modify the text color for the covered lines,
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covered lines with justify, justified lines, partially covered lines, and uncovered lines.

Hypertext Links

The Source report provides hypertext navigation throughout the source code:

« Click a plain underlined function call to jump to the definition of the function.

« Click a dashed underlined text to view additional coverage information in a pop-up window.

- Right-click any line of code and select Edit Source to open the source file in the Text Editor at the selected line

of code.

Macro Expansion

Certain macro-calls are preceded with a magnifying glass icon.

Click the magnifying glass icon to expand the macro in a pop-up window with the usual Code Coverage color codes.

Hit Count

The Hit Count tool-tip is a special capability that displays the number of times that a selected branch was covered.
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Hit Count is only available when Test-by-Test analysis is disabled and when the Hit Count option has been enabled for

the selected Configuration on page 690.

To activate the Hit Count tool-tip:

1. In the Code Coverage Viewer window, select the Source tab.
2. From the Code Coverage menu select Hit. The mouse cursor changes shape.

3. In the Code Coverage Viewer window, click a portion of covered source code to display the Hit Count tool-tip.

Cross Reference
The Cross Reference tool-tip displays the name of tests that executed a selected branch.
Cross Reference is only available in Test-by-Test mode.

To activate the Cross Reference tool-tip:

1. In the Code Coverage Viewer window, select the Source tab.
2. From the Code Coverage menu select Cross Reference. The mouse cursor changes shape.

3. In the Code Coverage Viewer window, click a portion of covered source code to display the Cross Reference
tooltip.

Comment

You can add a short comment to the generated Code Coverage report by using the Comment option in the Misc.
Options Settings for Code Coverage. This can be useful to distinguish different reports generated with different

Configurations.

Comments are displayed as a magnifying glass symbol at the top of the source code report. Click the magnifying

glass icon to display the comment.
Related Topics

About the code coverage viewer on page 72 | Coverage rates report on page 384

Coverage rates report

Code Coverage for Ada, C and C++
From the Code Coverage Viewer window, select the Rates tab to view the coverage rate report.

To view the coverage rate and type for a particular source code component, select the component in the Report

Explorer. Select the Root node to view coverage rates for all current files.
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To change the displayed format between absolute values, percentages, or both, click on the Display line located just
above the table.

To sort the table by one of the values, click the column title.

Code Coverage rates are updated dynamically as you navigate through the Report Explorer and as you select various

coverage types.

Related Topics

About the Code Coverage Viewer on page 72 | Source Report on page 381
Bitwise MC/DC coverage

Put your short description here; used for first paragraph and abstract.

Type your text here.

« an interesting point
- another interesting point

Subheading

Here's a little section in a concept.
Exemple

Example

Here's a little example section in a concept.

On-the-fly code coverage

Code Coverage for C and C++

By default code coverage generates a report when the execution ends. The On-the-fly mode generates code coverage
results dynamically during the execution. This is useful for applications that never exit or to interact with the
execution during the analysis, for example if you want to stop the code coverage when you reach at a given coverage
rate threshold.

To enable the On-the-fly mode in Code Coverage:

1. In the Project Explorer, click the Settings “==1 button.
2. Select a node in the Project Explorer pane.

3. In the Configuration Settings list, expand Runtime Analysis and select Coverage > Advanced Options > On-

the-fly frequency dump.
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4. Specify the number of function calls after which the coverage results are updated during execution. 0 means

that there is no on-the-fly updating and that results are only generated at the end of the execution.

5. When you have finished, click OK to validate the changes.

Related Topics

Code Coverage settings on page 1027

Code Coverage Dump Driver
Code Coverage for C and C++

In C and C++, you can dump coverage trace data without using standard 1/0 functions by using the Code Coverage

Dump Driver API contained in the atcapi.h file, which is part of the Target Deployment Port

To customize the Code Coverage Dump Driver, open the Target Deployment Port directory and edit the atcapi.h.

Follow the instructions and comments included in the source code.
Related Topics

Generating SCI Dumps on page 1086

Cleaning code coverage report files
Code Coverage for C and C++

Code Coverage produces reports on each execution of the application under test. After many executions, the .tio
coverage report files can become quite large and take up a lot of disk space.

You can use the -CLEAN option with the attolcov command to remove unused and obsolete traces and to regain
some space without losing your execution history.

You can use the -MERGETESTS command line option to merge all the specified .tio coverage report files together.
To clean the .tio coverage report files, run the following command line:
attolcov <oldfiles.tio> -clean=<newfile.tio> -mergetests

where <oldfiles.tio> is a list of old .tio coverage report files and <newfile.tio> is the new .tio coverage report file.

Related Topics

About code coverage on page 72 | File types on page 1067

Justification of non-covered lines of code
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You can enter justification statements in uncovered branches of a program so that they are considered as exceptions
to the coverage rules. Thus, you identify in the source code the branches that are not covered and explain why they
are not covered. The justification text must be declared in the attol cov_justify pragma line of the uncovered branch
with one or multiple attributes.

Note: This feature applies to C and C++ programming languages only.

SYNTAX:

The justification pragma syntax is the following one:

#pragma attol cov_justify (<lineOffset>, <type>, <what>, <justification text> ) [ (w.) [ (w.) w..]1]
#pragma attol cov_justify is the pragma, and <lineOffset>, <type>, <what>, and <justification text> are the attributes.
Multiple statements can be specified in the same pragma line, with four attributes for each.

Each justification statement in a pragma line can cover only one branch of the code starting from a specified line of

the source code.
Double-quotes can be added if the attribute includes commas.

The attributes are the following ones:

- <type> attribute:

This attribute is mandatory. It is used to determine what kind of code must be covered and how it must be

covered.

You can use the following <type>values:

o proc: to justify that a function or a method is not covered.

o return: to justify that a return statement is not covered.

> branch or block: to justify that a block of code is not covered.

- implicit: to justify that an implicit else statement is not covered.

- logical, or for, or while: to justify that a loop is not covered (the loop number is given in the <what>
attribute).

o case: to justify that a case statement in a switch is not covered.

> call: to justify that a function call or method call is not covered.

- cond: to justify that a simple condition is not covered (the value true or false of the condition is given
in the <what> attribute).

> medc: to justify that a MC/DC is not covered (the description of the MD/DC is given in the <what>
attribute).

- <lineOffset> attribute:

This attribute is optional.
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<lineOffset> attribute represents the number of lines between the pragma and the branch that must be
justified. The value can be '+ if the branch is located after the pragma, or -'if the branch is located before the
pragma.

If the <lineOffset> attribute is omitted <lineOffset> is considered as "0". It means that the justification applies
to the closest type of branch (attribute <type>) from the pragma. If there are multiple branches at a same
distance of the pragma, <lineOffset> helps distinguish between branches which branch should be justified.

The <lineOffset> attribute specifies the line where the branch or condition to justify starts, it is relative to the
pragma line (+/-), allowing to write this pragma line anywhere in the source file.

Note: For the <block> value, the target block of lines is the block where the pragma is declared.

- <what> attribute:

The <what> values are used to help specify some of the branches to be justified. It depends on the attribute

<type> values being used:

> For block or branch <type>: The value is a string that describes the logical position of the block in the
function, like ‘/then/else/seq'.

> For logical, for and while <type>: The value is a list of ‘0’ (the loop is not executed), ‘1’ (the loop is
executed only once) or 2+ (the loop is executed more that once) separated by *;, each of them could
be prefixed with the block description string.

> For cond <type>: The value is <expression>:<value>, <value> is true or false and <expression>.

> For medc <type>: The value is a list of impossible combinations of the conditions separated by ',
each value of the conditions are set with ‘T’ for true, ‘F’ for false, or ‘X’ if the condition is not evaluated.
For example, if the MC/DC consists of 3 conditions, the <what> value could be the following one:
“TEX;FXX".

- <justification text> is the reason why this part of code can't be covered by a test.

<justification> is mandatory. It is presented as a free text in the coverage report that justifies a uncovered
branch. It explains why it is not covered.

Example:

#pragma attol cov_justify (call, ”my justification”) (block, ”myjustification”) (cond, ”:true”,
”my justification”) (for, ”0;1” ,”my justification”)

The following table lists the parameters that can be entered in the “<lineOffset>" and <what> attributes depending on
the parameters indicated in the <type> attribute.

<type> attribute <lineOffset> attribute <what> attribute

proc For the <type>=proc, the pragma line

declared above or inside the body, or
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<type> attribute <lineOffset> attribute <what> attribute
just after the end of the body justifies
the function/procedure entry.
return For <type>=return, the pragma line,
must be just before or just after the
return line.
branch/block For <type>=branch or block. It starts
The “branch to cover" attribute is
on the first { of that block or on the
. . used for a branch=<type> The branch
line of the unique statement.
string format is a list of :
/then/ el se/ seq OF /
It is used to indicate which branch
to cover when there are multiple
branches on the same line.
It can be empty is there are no ambi-
guity with the line number.
implicit For <type>=implicit, the pragma line

must be just before the decision, or

at the else place.

The “branch to cover" attribute is
used for <type>= <branch>.

The branch string format is a list of: /

then/ el se/ seq Or /

It is used to indicate which branch
to cover when there are multiple

branches on the same line.

It can be empty is there are no ambi-

guity with the line number.

logical/for/do/while

For <type>=logical/for/while, the
pragma line must be just before the

‘for' or ‘while’, or ‘do’ keyword.

This attribute is used for <type>=log-
ical, the branch string format looks
like ‘branch depth/instruction type/

value’ with :
instruction type is:
/for OF /whileoOr/do

The valueis /o or /1 or/2+to specify

which part must be covered and jus-
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<type> attribute

<lineOffset> attribute

<what> attribute

tified. It is mandatory and can speci-
fy multiple parts if separated by ; e.g.
“90: /1"

Branch depth is a suite of strings like
/then /else /for /while etc. clari-
fying the code depth of the branch

where the loop has been found.

e.g. “I el se/then/for/whilel/ 1" or

”

“I'while/1” or “/1

must be just before or just after the

condition line.

case For <type>=case, the pragma line
Used for <type>=case, the string de-
must be just before or just after the yp g
. tails the case expression (between
case line.
‘case’ and the ") to cover into the
A case is both a block and a condi- switch block.
tion. If you enter a justification for a
- . .| It can be empty is there are no ambi-
case <type>, it is the condition that is
uity with the line number.
justified. You need to declare another gurty
pragma to justify the corresponding
block.
call For <type>=call, the pragma line
. . Used for type=call, the string details
must be just before or just after the yP g
. the called method name to cover.
call line,
It can be empty is there are no ambi-
guity with the line number.
cond For <type>=cond, the pragma line

“condition expression:value” is used
for “<type>"=cond.The string indi-
cates the condition expression to
cover into the decision with the value
to cover, true or false. The “condition
expression” can be empty if there is
no ambiguity with the line number
but the value must always be spec-
ified after a colon at the end of the
string.

Example: “var>5: fal se” or “: true”.
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<type> attribute

<lineOffset> attribute

<what> attribute

Multiple values can be justified, sepa-

rated by ;" such as “true ; :false”

mcdc

For <type>=mcdc, the pragma line
must be just before or after the first
condition line, or just before or after

the last condition line.

“combinations” is used for type=
mcdc. It is a series of patterns sepa-

rated by a semi-colon ";". It cannot be

empty.

Once the source code is built, you can see the results of the non-coverage justification statements in the Code

Coverage report, on the Source page.

For more information about the code coverage reports, see About coverage reports on page 961.

Code coverage for assembler source files

With HCL OneTest™ Embedded Studio, you can collect coverage metrics for assembler source files. Coverage

information is displayed in the coverage report.

Note:

This feature supports only ARM in 32 bits mode. It is an extension of the C language mode.

You must have configured HCL OneTest™ Embedded Studio to recognize the .asm file extension used for

assembler files. For more details, see Using assembler source files on page 716.

Coverage Assembler language for ARM processor is fully compatible with C/C++ and Ada code coverage.

Assembler source files are taken into account in the build as C/C++ source files. Optionally, C/C++ source

files could be instrumented at the assembler level and not at the C/C++ level. To launch code coverage

for assembiler files from a command, see Command line to launch code coverage for assembler files on

page 1107.

The supported coverage levels are:

 Functions

» Functions and exits
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o « Statement blocks
« Calls
CONFIGURATION

Code coverage for assembler source files requires the use of an appropriate TDP. You can use the
cl i nCr ossRaspi Renot e. xdp and cwi nCr ossRaspi Renot e. xdp that are delivered, for example.

There two use case scenarios:

« For a project that uses both C and assembler source files, you only have to add the assembler .asm source
files to the list of sources to be compiled. The .asm files are then instrumented, built, and linked with the other
C sources to produce an executable file.

« For C code source files that are instrumented in assembler mode, the C source files are converted into
assembler files by using the gcc -S command. Then, they are instrumented in assembler mode, they are

converted into assembly language, and linked.
To implement this use case scenario, you must set the INSTR_C_AS_ASM=1 environment variable.

To add this environment variable in Studio, proceed as follows:
o Click Settings in the Project window.
o Select Build options > Environment.
o Click the Value field on the Environment variable line, and click ....
o Click the Add icon, give a name to the variable, and enter INSTR_C_AS_ASM=1 in Value.
> Apply and close the window.
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See the following example:

g ReadMe.txt Configuration Settings ? X
Configuration: Visual v Configuration Manager ...
=3 Configuration propertie: | Name Value
=14 Build ) Target Deployment Port aunable display value>
Md aplions List tested files versions No
Compiler
Linker Environment variables =INSTR_C_AS_ASM=1 Mg
Execution
Target Deployment Po
+-(_)General

+-(_J Runtime analysis
Bxdemal command
Static metrics
Code Review

ok Cancel By Help

Note: In some case, when the assembler code increased due to the code coverage level, it might be
necessary to re-organize the assembler code (Example: you can move data pools), or to decrease the level of
code coverage (Example: you can delete code coverage for some functions calls in libraries).

Memory profiling for C and C++

About Memory Profiling for C and C++

Memory Profiling for C and C++

Run-time memory errors and leaks are among the most difficult errors to locate and the most important to correct.
The symptoms of incorrect memory use are unpredictable and typically appear far from the cause of the error. The
errors often remain undetected until triggered by a random event, so that a program can seem to work correctly when

in fact it's only working by accident.

That's where the Memory Profiling feature can help you.
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- You associate Memory Profiling with an existing test node or application code.
« You compile and run your application.

« The application with the Memory Profiling feature, then directs output to the Memory Profiling Viewer, which
provides a detailed report of memory issues.

Memory Profiling uses Source Code Insertion Technology for C and C++.

Because of the different technologies involved, Memory Profiling for Java on page 409 is covered in a separate

section.

Memory Profiling for C and C++ supports the following languages:

« C: ANSI 89, ANSI 99, or K&R C

» C++:ISO/IEC 14882:1998

How Memory Profiling for C and C++ Works

When an application node is executed, the source code is instrumented by the C or C++ Instrumentor (attolcpp or
attolcc1). The resulting source code is then executed and the Memory Profiling feature outputs a static .tsf file for
each instrumented source file and a dynamic .tpf file.

These files can be viewed and controlled from the HCL OneTest™ Embedded GUI. Both the .tsf and .tpf files need to
be opened simultaneously to view the report.

Of course, these steps are mostly transparent to the user when the test or application node is executed in the HCL
OneTest™ Embedded GUI or Eclipse (for C and C++).

To learn about See

Performing Memory Profiling on C and C++ source Using Runtime Analysis Features on

code page 336

How Memory Profiling for C and C++ works Memory Profiling User in C and C++
on page 402

Source Code Insertion technology Source code instrumentation overview
on page 16

JVMPI technology for Java memory analysis JVMPI Technology on page 412

Understanding Memory Profiling Reports Memory Profiling Results on
page 395

Using the Memory Profiler Viewer Using the Memory Profiling Viewer on
page 407
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Customizing the Memory Profiling Viewer Memory Profiling Viewer Preferences
on page 1054

Related Topics

Memory Profiling Settings on page 1030 | Runtime Analysis on page 335 | Memory Profiling for Java on
page 409

Memory Profiling Results for C and C++
Memory Profiling for C and C++

After execution of an instrumented application, the Memory Profiling report provides a summary diagram and a

detailed report for both byte and memory block usage.

A memory block is a number of bytes allocated with a single malloc instruction. The number of bytes contained in
each block is the actual amount of memory allocated by the corresponding allocation instruction.

Summary diagrams
The summary diagrams give you a quick overview of memory usage in blocks and bytes.

Blocks Summary Bytes Summary

£ 2

§ @ Allocated -E' @ Allacated
B Unfread B Unfreed
O Maximum O Mazxirmuwm

0 160

Where:

« Allocated is the total memory allocated during the execution of the application
« Unfreed is the memory that remains allocated after the application was terminated

» Maximum is the highest memory usage encountered during execution
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Detailed Report

The detailed section of the report lists memory usage events, including the following errors and warnings:

 Error messages on page 396

» Warning messages on page 399

Related Topics

Using the Memory Profiling Viewer on page 407 | Memory Profiling Settings on page 1030

Memory Profiling Error Messages

Memory Profiling Error Messages
Memory Profiling for C and C++

Error messages indicate invalid program behavior. These are serious issues you should address before you check in
code.

List of Memory Profiling Error Messages
« Free on page 396 ing Freed Memory (FFM) on page 397
* Freeing Unallocated Memory (FUM) on page 397
* Freeing Invalid Memory (FIM) on page 397
- Late Detect Array Bounds Write (ABWL) on page 397
» Late Detect Free Memory Write (FMWL) on page 398
» Memory Allocation Failure (MAF) on page 399

« Core Dump (COR) on page 399

Related Topics

Memory Profiling Results on page 395 | Memory Profiling Settings on page 1030 | Warning Messages on
page 399

Freeing Freed Memory (FFM)
Memory Profiling for C and C++

An FFM message indicates that the program is trying to free memory that has previously been freed.
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This message can occur when one function frees the memory, but a data structure retains a pointer to that memory

and later a different function tries to free the same memory. This message can also occur if the heap is corrupted.

Memory Profiling maintains a free queue, whose role is to actually delay memory free calls in order to compare with
upcoming free calls. The length of the delay depends on the Free queue length and Free queue threshold Memory
Profiling Settings. A large deferred free queue length and threshold increases the chances of catching FFM errors
long after the block has been freed. A smaller deferred free queue length and threshold limits the amount of memory

on the deferred free queue, taking up less memory at run time but providing a lower level of error detection.
Related Topics

Error Messages on page 396 | Memory Profiling Results on page 395 | Memory Profiling Settings on page 1030

Freeing Unallocated Memory (FUM)
Memory Profiling for C and C++
An FUM message indicates that the program is trying to free unallocated memory.

This message can occur when the memory is not yours to free. In addition, trying to free the following types of
memory causes a FUM error:

« Memory on the stack

« Program code and data sections

Related Topics

Error Messages on page 396 | Memory Profiling Results on page 395 | Memory Profiling Settings on page 1030

Freeing Invalid Memory (FIM)

Memory Profiling for C and C++

An FIM message indicates that the program is trying to free allocated memory with the wrong instruction.

This message can occur when the memory free instruction mismatches the memory allocation instruction.

For example, a FIM occurs when memory is freed with a free instruction when it was allocated with a new instruction.
Related Topics

Error Messages on page 396 | Memory Profiling Results on page 395 | Memory Profiling Settings on page 1030

Late Detect Array Bounds Write (ABWL)

Memory Profiling for C and C++
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An ABWL message indicates that the program wrote a value before the beginning or after the end of an allocated

block of memory.

Memory Profiling checks for ABWL errors whenever free() or dump() routines are called, or whenever the free queue is

actually flushed.

This message can occur when you:

- Make an array too small. For example, you fail to account for the terminating NULL in a string.
« Forget to multiply by sizeof(type) when you allocate an array of objects.

« Use an array index that is too large or is negative.

« Fail to NULL terminate a string.

« Are off by one when you copy elements up or down an array.

Memory Profiling actually allocates a larger block by adding a Red Zone at the beginning and end of each allocated

block of memory in the program. Memory Profiling monitors these Red Zones to detect ABWL errors.

Increasing the size of the Red Zone helps HCL OneTest™ Embedded catch bounds errors before or beyond the block

at the expense of increased memory usage. You can change the Red Zone size in the Memory Profiling Settings.
The ABWL error does not apply to local arrays allocated on the stack.

Note Unlike PurifyPlus, the ABWL error in the HCL OneTest™ Embedded Memory Profiling tool only applies to heap
memory zones and not to global or local tables.

Related Topics

Error Messages on page 396 | Memory Profiling Results on page 395 | Memory Profiling Settings on page 1030

Late Detect Free Memory Write (FMWL)

Memory Profiling for C and C++
An FMWL message indicates that the program wrote to memory that was freed.

This message can occur when you:

+ Have a dangling pointer to a block of memory that has already been freed (caused by retaining the pointer too

long or freeing the memory too soon)
« Index far off the end of a valid block

« Use a completely random pointer which happens to fall within a freed block of memory
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Memory Profiling maintains a free queue, whose role is to actually delay memory free calls in order to compare with
upcoming free calls. The length of the delay depends on the Free queue length and Free queue threshold Memory
Profiling Settings. A large deferred free queue length and threshold increases the chances of catching FMWL errors. A
smaller deferred free queue length and threshold limits the amount of memory on the deferred free queue, taking up

less memory at run time but providing a lower level of error detection.
Related Topics

Error Messages on page 396 | Memory Profiling Results on page 395 | Memory Profiling Settings on page 1030

Memory Allocation Failure (MAF)
Memory Profiling for C and C++

An MAF message indicates that a memory allocation call failed. This message typically indicates that the program
ran out of paging file space for a heap to grow. This message can also occur when a non-spreadable heap is
saturated.

After Memory Profiling displays the MAF message, a memory allocation call returns NULL in the normal manner.
Ideally, programs should handle allocation failures.

Related Topics

Error Messages on page 396 | Memory Profiling Results on page 395 | Memory Profiling Settings on page 1030

Core Dump (COR)
Memory Profiling for C and C++

A COR message indicates that the program generated a UNIX core dump. This message can only occur when the

program is running on a UNIX target platform.
Related Topics

Error Messages on page 396 | Memory Profiling Results on page 395 | Memory Profiling Settings on page 1030

Memory Profiling Warning Messages

Memory Profiling Warning Messages
Memory Profiling for C and C++

Warning messages indicate a situation in which the program might not fail immediately, but might later fail
sporadically, often without any apparent reason and with unexpected results. Warning messages often pinpoint
serious issues you should investigate before you check in code.
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List of Memory Profiling Warning Messages

» Memory in Use (MIU) on page 400

» Memory Leak (MLK) on page 400

- Potential Memory Leak (MPK) on page 401
« File in Use (FIU) on page 401

« Signal Handled (SIG) on page 402

Related Topics

Memory Profiling Results on page 395 | Memory Profiling Settings on page 1030 | Error Messages on page 396

Memory in Use (MIU)
Memory Profiling for C and C++
An MIU message indicates heap allocations to which the program has a pointer.

Note At exit, small amounts of memory in use in programs that run for a short time are not significant. However, you

should fix large amounts of memory in use in long running programs to avoid out-of-memory problems.

Memory Profiling generates a list of memory blocks in use when you activate the MIU Memory In Use option in the

Memory Profiling Settings.
Related Topics

Memory Profiling Results on page 395 | Warning Messages on page 399 | Memory Profiling Settings on
page 1030

Memory Leak (MLK)
Memory Profiling for C and C++

An MLK message describes leaked heap memory. There are no pointers to this block, or to anywhere within this
block.

Memory Profiling generates a list of leaked memory blocks when you activate the MLK Memory Leak option in the
Memory Profiling Settings.

This message can occur when you allocate memory locally in some function and exit the function without first freeing
the memory. This message can also occur when the last pointer referencing a block of memory is cleared, changed,

or goes out of scope. If the section of the program where the memory is allocated and leaked is executed repeatedly,
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you might eventually run out of swap space, causing slow downs and crashes. This is a serious problem for long-

running, interactive programs.

To track memory leaks, examine the allocation location call stack where the memory was allocated and determine
where it should have been freed.

You can ignore memory leaks that do not have a call stack, for memory allocations that occur before the application
starts by changing the configuration Runtime Analysis > Memory Profiling > Instrumentation control > Only show
memory leaks with call stack.

Related Topics

Memory Profiling Results on page 395 | Warning Messages on page 399 | Memory Profiling Settings on
page 1030

Memory Potential Leak (MPK)
Memory Profiling for C and C++

An MPK message describes heap memory that might have been leaked. There are no pointers to the start of the
block, but there appear to be pointers pointing somewhere within the block. In order to free this memory, the program
must subtract an offset from the pointer to the interior of the block. In general, you should consider a potential leak to
be an actual leak until you can prove that it is not by identifying the code that performs this subtraction.

Memory in use can appear as an MPK if the pointer returned by some allocation function is offset. This message
can also occur when you reference a substring within a large string. Another example occurs when a pointer to a C++
object is cast to the second or later base class of a multiple-inherited object and it is offset past the other base class
objects.

Alternatively, leaked memory might appear as an MPK if some non-pointer integer within the program space, when

interpreted as a pointer, points within an otherwise leaked block of memory. However, this condition is rare.
Inspection of the code should easily differentiate between different causes of MPK messages.

Memory Profiling generates a list of potentially leaked memory blocks when you activate the MPK Memory Potential
Leak option in the Memory Profiling Settings.

Related Topics

Memory Profiling Results on page 395 | Warning Messages on page 399 | Memory Profiling Settings on
page 1030

File in Use (FIU)

Memory Profiling for C and C++
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An FIU message indicates a file that was opened, but never closed. An FIU message can indicate that the program
has a resource leak.

Memory Profiling generates a list of files in use when you activate the FIU Files In Use option in the Memory Profiling

Settings.
Related Topics

Memory Profiling Results on page 395 | Warning Messages on page 399 | Memory Profiling Settings on
page 1030

Signal Handled (SIG)
Memory Profiling for C and C++
A SIG message indicates that a system signal has been received.

Memory Profiling generates a list of received signals when you activate the SIG Signal Handled option in the Memory

Profiling Settings.
Related Topics

Memory Profiling Results on page 395 | Warning Messages on page 399 | Memory Profiling Settings on
page 1030

Memory Profiling User Heap in C and C++
Memory Profiling for C and C++

When using Memory Profiling on embedded or real-time target platforms, you might encounter one of the following
situations:

« Situation 1: There are no provisions for malloc, calloc, realloc or free statements on the target platform.

Your application uses custom heap management routines that may use a user API. Such routines could, for example,

be based on a static buffer that performs allocation and free actions.

In this case, you need to customize the memory heap parameters RTRT_DO_MALLOC and RTRT_DO_FREE in the TDP
to use the custom malloc and free functions.

In this case, you can access the custom API functions.

- Situation 2: There are partial implementations of malloc, calloc, realloc or free on the target, but other

functions provide methods of allocating or freeing heap memory.
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In this case, you do not have access to any custom API. This requires customization of the Target Deployment
Port. Please refer to the Target Deployment Guide provided with the Opening the Target Deployment Port Editor on
page 40.

In both of the above situations, Memory Profiling can use the heap management routines to detect memory leaks,
array bounds and other memory-related defects.

Note Application pointers and block sizes can be modified by Memory Profiling in order to detect ABWL errors (Late
Detect Array Bounds Write). Actual-pointer and actual-size refer to the memory data handled by Memory Profiling,
whereas user pointer and user-size refer to the memory handled natively by the application-under-analysis. This
distinction is important for the Memory Profiling ABWL and Red zone settings.

Target Deployment Port API

The Target Deployment Port library provides the following API for Memory Profiling:

void * _PurifyLTHeapAction ( _PurifyLT_API_ACTION, void *, RTRT_U_INT32, RTRT_U_INT8 );

In the function _PurifyLTHeapAction the first parameter is the type of action that will be or has been performed on the
memory block pointed by the second parameter. The following actions can be used:

typedef enum {

_PurifyLT_API_ALLOC,

_PurifyLT_API_BEFORE_REALLOC,

_PurifyLT_API_FREE

} _PurifyLT_API_ACTION;

The third parameter is the size of the block. The fourth parameter is either of the following constants:

#define _PurifyLT_NO_DELAYED_FREE 0

#define _PurifyLT_DELAYED_FREE 1

If an allocation or free has a size of 0 this fourth parameter indicates a delayed free in order to detect FWML
(Late Detect Free Memory Write) and FFM (Freeing Freed Memory) errors. See the section on Memory Profiling
Configuration Settings for Detect FFM, Detect FMWL, Free Queue Length and Free Queue Size.

A freed delay can only be performed if the block can be freed with RTRT_DO_FREE (situation 1) or ANSI free (situation
2). For example, if a function requires more parameters than the pointer to de-allocate, then the FMWL and FFM
error detection cannot be supported and FFM errors will be indicated by an FUM (Freeing Unallocated Memory) error

instead.
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The following function returns the size of an allocated block, or 0 if the block was not declared to Memory Profiling.

This allows you to implement a library function similar to the msize from Microsoft Visual 6.0.
RTRT_SIZE_T _PurifyLTHeapPtrSize ( void *);
The following function returns the actual-size of a memory block, depending on the size requested. Call this function

before the actual allocation to find out the quantity of memory that is available for the block and the contiguous red
zones that are to be monitored by Memory Profiling.

RTRT_SIZE_T _PurifyLTHeapActualSize ( RTRT_SIZE_T);
Examples

In the following examples, my_malloc, my_realloc, my_free and my_msize demonstrate the four supported memory

heap behaviors.

The following routine declares an allocation:

void *my_malloc ( int partld, size_t size)

{

void *ret;

size_t actual_size = _PurifyLTHeapActualSize(size);

/* Here is any user code making ret a pointer to a heap or

simulated heap memory block of actual_size bytes */

/* After comes Memory Profiling action */
return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0 );
/* The user-pointer is returned */

}

In situation 2, where you have access to a custom memory heap AP, replace the "..." with the actual malloc API

function.

For a my_calloc(size_t nelem, size_t elsize) , pass on nelem*elsize as the third parameter of the _PurifyLTHeapAction
function. In this case, you might need to replace this operation with a function that takes into account the alignments
of elements.

To declare a reallocation, two operations are required:

void *my_realloc (int partld, void * ptr, size_t size )
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{

void *ret;

size_t actual_size = _PurifyLTHeapActualSize(size);

/* Before comes first Memory Profiling action */

ret = _PurifyLTHeapAction ( _PurifyLT_API_BEFORE_REALLOC, ptr, size, 0);
/* ret now contains the actual-pointer */

/* Here is any user code making ret a reallocated pointer to a heap or

simulated heap memory block of actual_size bytes */

/* After comes second Memory Profiling action */
return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0);
/* The user-pointer is returned */

}

To free memory without using the delay:

void my_free (iint partld, void * ptr)

{

/* Memory Profiling action comes first */

void *ret = _PurifyLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, 0 );
/* Any code insuring actual deallocation of ret */

}

To free memory using a delay:

void my_free ( int partld, void * ptr)

{

/* Memory Profiling action comes first */

void *ret = _PurifyLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, 1);

/* Nothing to do here */

Chapter 5. Test Execution Specialist Guide
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To obtain the user size of a block:
size_t my_msize ( int partld, void * ptr)
{

return _PurifyLTHeapP1rSize ( ptr);

}

Use the following macros to save customization time when dealing with functions that have the same prototypes as
the standard ANSI functions:

#define _PurifyLT_MALLOC_LIKE(func) \

void *RTRT_CONCAT_MACRO(usr_,func) ( RTRT_SIZE_T size ) \

{\

void *ret; \

ret = func (_PurifyLTHeapActualSize ( size ) ); \

return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0); \

}

#define _PurifyLT_CALLOC_LIKE(func) \

void *RTRT_CONCAT_MACRO(usr_,func) ( RTRT_SIZE_T nelem, RTRT_SIZE_T elsize ) \
{\

void *ret; \

ret = func ( _PurifyLTHeapActualSize ( nelem * elsize ) ); \

return _PurifyL.THeapAction ( _PurifyLT_API_ALLOC, ret, nelem * elsize, 0 ); \
}

#define _PurifyLT_REALLOC_LIKE(func,delayed_free) \

void *RTRT_CONCAT_MACRO(usr_,func) ( void *ptr, RTRT_SIZE_T size ) \
{\

void *ret; \
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ret = func ( _PurifyLTHeapAction ( _PurifyLT_API_BEFORE_REALLOC, \
ptr, size, delayed_free ), \

_PurifyLTHeapActualSize ( size ) ); \

return _PurifyLTHeapAction ( _PurifyLT_API_ALLOC, ret, size, 0 ); \

}

#define _PurifyLT_FREE_LIKE(func,delayed_free) \

void RTRT_CONCAT_MACRO(usr_,func) ( void *ptr) \

{\

if (delayed_free )\

{\

_PurifyLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, delayed_free ); \

N

else \

{\

func ( _PurifyLTHeapAction ( _PurifyLT_API_FREE, ptr, 0, delayed_free ) ); \
N

}

Related Topics

Chapter 5. Test Execution Specialist Guide

About Memory Profiling for C and C++ on page 393 | Error Messages on page 396 | Opening the Target

Deployment Port Editor on page 40

Using the Memory Profiling Viewer

Memory Profiling for C and C++

Memory Profiling results for C and C++ are displayed in the Memory Profiling Viewer.

Error and Warning Filter

The Memory Profiling Viewer for C and C++ allows you to filter out any particular type of Error on page 396 or

Warning on page 399 message from the report.
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To filter out error or warning messages:

1. Select an active Memory Profiling Viewer window.
2. From the Memory Profiling menu, select Errors and Warnings.

3. Select or clear the type of message that you want to show or hide.

For example, you can disable MLK (Memory Leak) with empty stack trace to hide from the report memory allocations
that occurred before the application started.

Reloading a Report

If a Memory Profiling report has been updated since the moment you have opened it in the Memory Profiling Viewer,

you can use the Reload command to refresh the display:

To reload a report:
1. From the View Toolbar, click the Reload button.

Resetting a Report

When you run a test or application node several times, the Memory Profiling results are appended to the existing

report. The Reset command clears previous Memory Profiling results and starts a new report.

To reset a report:
1. From the View Toolbar, click the Reset button.

Related Topics

Memory Profiling results on page 395 | Opening a report on page 715 | Report Explorer on page 1059 | Using the

report viewer on page 737 | Exporting reports on page 737

Checking for ABWL and FMWL errors

By default, Memory Profiling checks for ABWL and FMWL errors whenever the routines are called, or whenever the

free queue is actually flushed.

In some cases, it might be desirable to manually specify when to check for ABWL and FMWL errors, and on which

functions.

By using the ABWL and FMWL check frequency setting you can order a check on:

« Each time the memory is dumped (by default).
» Each time a manual check macro is encountered in the code.

» Each function return.
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The checks can be performed either on all memory blocks or only a selection of memory blocks.

Specifying a manual check

To indicate where you want an ABWL or FMWL check to occur in your source code, you insert an _ATP_CHECK()
macro at the corresponding location. The syntax for the macro is:

#pragma attol insert _ATP_CHECK(@RELFLINE)

Each time this macro is encountered during execution, Memory Profiling checks for ABWL and FMWL errors on the
specified blocks. The @RELFLINE parameter allows navigation from the Memory Profiling report to the corresponding

line in the source code.

Selecting blocks to check

To create a selection of blocks that you specifically want to verify, you create a list in your source code using the
_ATP_TRACK() macro variable. The syntax for this macro is:

#pragma attol insert _ATP_TRACK(<pointer>)
Example

A sample demonstrating how to use this feature is provided in the ABWL Check Frequency example project. See

Example projects on page 709 for more information.
Related Topics

Memory Profiling Settings on page 1030 | Late Detect Free Memory Write (FMWL) on page 398 | Late Detect Array
Bounds Write (ABWL) on page 397

Memory Profiling for Java

Run-time memory problems are among the most difficult errors to locate and the most important to correct. The
symptoms of incorrect memory use are unpredictable and typically appear far from the cause of the error. The issue
often remain undetected until triggered by a random event, so that a program can seem to work correctly when in fact
it's only working by accident.

That's where the Memory Profiling feature can help you get ahead.
« You associate Memory Profiling with an existing test node or Application code.
« You compile and run your application.

« The application with the Memory Profiling feature, then directs output to the Memory Profiling Viewer, which
provides a detailed report of memory issues.

The Java version of Memory Profiling differs from other programming languages, among other aspects, by the way

memory is managed by the Java Virtual Machine (JVM). The technique used is the JVMPI Agent technology for Java.
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Memory Profiling for Java supports JDK 1.3.x and JDK 1.4.x
« C++: ISO/IEC 14882:1998

How Memory Profiling for Java Works

When an application node is executed, the source code is executed. The Memory Profiling for Java feature uses the
JVMPI mechanism to monitor the application. JVMPI outputs a dynamic .jpt file.

The .jpt file is split into a .tpf file and a .txf file, which can be viewed and controlled from the HCL OneTest™
Embedded GUI. Both the .tpf and .txf files need to be opened simultaneously to view the report.

Of course, these steps are mostly transparent to the user when the test or application node is executed in the HCL
OneTest™ Embedded GUI.

To learn about See
Performing Memory Profiling on C, C++ and Java source Using Runtime Analysis Features on
code page 336
JVMPI technology for Java memory analysis JVMPI Technology on page 412
Understanding Memory Profiling Reports Memory Profiling Results for Java on
page 410
Viewing the Memory Profiling reports for Java Using the Report Viewer on
page 737
Customizing the Memory Profiling Viewer Memory Profiling Viewer Prefer-

ences on page 1054

Related Topics

Memory Profiling Settings on page 1030 | JVMPI Technology on page 412 | About Memory Profiling for C and C++
on page 393

Memory Profiling Results for Java
Memory Profiling for Java

After execution of an instrumented application, the Memory Profiling report displays:

« In the Report Explorer window: a list of available snapshots

« In the Memory Profiling window: the contents of the selected Memory Profiling snapshot
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Report Explorer

The Report Explorer window displays a Test for each execution of the application node or for a test node when using

Component Testing for Java. Inside each test, a Snapshot report is created for each Memory Profiling snapshot.

Method Snapshots

The Memory Profiling report displays snapshot data for each method that has performed an allocation. If the Java
CLASSPATH is correctly set, you can click blue method names to open the corresponding source code in the Text
Editor. System methods are displayed in black and cannot be clicked.

Method data is reset after each snapshot.

For each method, the report lists:

« Method:The method name. Blue method names are hyperlinks to the source code under analysis
- Allocated Objects: The number of objects allocated since the previous snapshot

- Allocated Bytes: The total number of bytes used by the objects allocated by the method since the previous

snapshot

« Local + D Allocated Objects: The number of objects allocated by the method since the previous snapshot as

well as any descendants called by the method

- Local + D Allocated Bytes: The total number of bytes used by the objects allocated by the method since the
previous snapshot and its descendants

Referenced Objects

If you selected the With objects filter option in the JVMPI Settings dialog box, the report can display, for each method,
a list of objects created by the method and object-related data.

From the Memory Profiling menu, select Hide/Show Referenced Objects.

For each object, the report lists:

- Reference Object Class:The name of the object class. Blue class names are hyperlinks to the source code
under analysis.

- Referenced Objects: The number of objects that exist at the moment the snapshot was taken

- Referenced Bytes: The total number of bytes used by the referenced objects

Differential Reports

The Memory Profile report can display differential data between two snapshots within the same Test. This allows you
to compare the referenced objects. There are two diff modes:
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- Automatic differential report with the previous snapshot

« User differential report
Differential reports add the following columns to the current Memory Profiling snapshot report:

- Referenced Objects Diff AUTO: Shows the difference in the number of referenced objects for the same
method in the current snapshot as compared to the previous snapshot

- Referenced Bytes Diff AUTO : Shows the difference in the memory used by the referenced objects for the
same method in the current snapshot as compared to the previous snapshot

- Referenced Objects Diff USER: Shows the difference in the number of referenced objects for the same
method in the current snapshot as compared to the user-selected snapshot

- Referenced Bytes Diff USER: Shows the difference in the memory used by the referenced objects for the
same method in the current snapshot as compared to the user-selected snapshot

To add or remove data to the report:

1. From the Memory Profiling menu, select Hide/Show Data.
2. Toggle the data that you want to hide or display

To sort the report:

1. In the Memory Profiling window, click a column label to sort the table on that value.
To obtain a differential report:

1. From the Memory Profiling menu, select Diff with Previous Referenced Objects.
To obtain a user differential report:

1. In the Report Explorer, select the current snapshot

2. Right-click another snapshot in the same Test node and select Diff Report.

Related Topics

Using the Memory Profiling Viewer on page 407 | Memory Profiling Settings on page 1030

JVMPI Technology

Memory Profiling for Java

Memory Profiling for Java uses a special dynamic library, known as the Memory Profiling Agent, to provide advanced

reports on Java Virtual Machine (JVM) memory usage.
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Garbage Collection

JVMs implement a heap that stores all objects created by the Java code. Memory for new objects is dynamically
allocated on the heap. The JVM automatically frees objects that are no longer referenced by the program, preventing

many potential memory issues that exist in other languages. This process is called garbage collection.

In addition to freeing unreferenced objects, a garbage collector may also reduce heap fragmentation, which occurs
through the course of normal program execution. On a virtual memory system, the extra paging required to service an
ever growing heap can degrade the performance of the executing program.

JVMPI Agent

Because of the memory handling features included in the JVM, Memory Profiling for Java is quite different from the
feature provided for other languages. Instead of Source Code Insertion technology, the Java implementation uses a
JVM Profiler Interface (JVMPI) Agent whose task is to monitor JVM memory usage and to provide a memory dump

upon request.

The JVMPI Agent analyzes the following internal events of the JVM:

» Method entries and exits

 Object and primitive type allocations

The JVMPI Agent is a dynamic library —DLL or lib.so depending on the platform used— that is loaded as an option on

the command line that launches the Java program.

During execution, when the agent receives a snapshot trigger request, it can either an instantaneous JVMPI dump of

the JVM memory, or wait for the next garbage collection to be performed.

Note Information provided by the instantaneous dump includes actual memory use as well as intermediate and
unreferenced objects that are normally freed by the garbage collection. In some cases, such information may be

difficult to interpret correctly.

The actual trigger event can be implemented with any of the following methods:

- A specified method entry or exit used in the Java code
- A message sent from the Snapshot button or menu item in the graphical user interface

- Every garbage collection

The JVMPI Agent requires that the Java code is compiled in debug mode, and cannot be used with Java in just-in-
time (JIT) mode.

Related Topics

Source code instrumentation overview on page 16 | About Memory Profiling on page 393 | Memory Profiling for

Java on page 409
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Performance profiling

Performance Profiling
Performance Profiling applies to C and C++

The Performance Profiling feature puts successful performance engineering within your grasp. It provides complete,
accurate performance data in an understandable and usable format so that you can see exactly where your code is
least efficient. Using Performance Profiling, you can make virtually any program run faster. And you can measure the

results.

Performance Profiling measures performance for every component in C and C++ source code, in real-time, and on
both native or embedded target platforms. Performance Profiling instruments the C and C++ source code of your
application. To test an application with the performance profiling feature: .

- Associate Performance Profiling with an existingtest orapplication code.

« Build and execute your code in HCL OneTest™ Embedded.

« The application under test is instrumented with the Performance Profiling feature and provides a detailed
report with metrics on execution time for each procedure/function/method of the application. For C language,

it also provides an estimation of Worst Case Estimation Time.
Performance Profiling supports the following languages:

« C: ANSI 89, ANSI 99, or K&R C
« C++:ISO/IEC 14882:1998
Related Topics

Source code instrumentation overview on page 16

Performance profiling settings

You can configure the performance profiling settings before running your application in HCL OneTest™ Embedded for
Studio.

Configuration Settings

All the following options must be set from the Configuration Settings window. To open this window:

« In the Project Window, right-click on the project and select Settings.
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Enable the Performance Profiling

« In the Configuration Settings window, in the left panel, click Configuration properties > Build >
Build options.

« In the right pane, click the Value field in Build options and click ... to open the Build options
window.

- In the Build options list, click Performance Profiling to enable the feature.

Generate a trace file

- In the Configuration Settings window, in the left panel, click Configuration properties > Runtime
analysis > Performance Profiling.

« In the right panel, click in the value field of the Trace file name (.tqf) line option, and click .... In
the editor window that opens, specify a filename for the generated .tqf trace file for performance

profiling.

To get an evaluation of the Worst Case Execution Time in the report, you must set the WCET option.

Select the Worst Case Execution Time and/or the maximum execution time for each function and descendants:

« In the Configuration Settings window, in the left panel, click Configuration properties > Runtime
analysis > Performance Profiling.
« In the right pane, click Compute F max and F+D max time and select a value depending on the
execution time that you want to be calculated for your project:
> No: Does not calculate the maximum execution time for each function and descendants.
> Yes: Calculate the maximum execution time for each function and its descendants.
> Yes + WCET: Calculate the maximum execution time for each function and descendants,
and the Worst Case Execution Time. With this option selected, the report indicates the

number of time a function is called.

To get the performance profiling per entry point, you must enter the list of entry point threads of your application.
Entry points

To get the performance profiling per entry point, you must enter the list of entry points for each thread of

your application.

« In the Configuration Settings window, in the left panel, click Configuration properties > Runtime
analysis > General> Multi-thread options.
« Click in the value field and click ... to open the editor and enter the list of entry points for each

thread of your application. Use commas to separate the thread names.

Then, run the application and see the Performance report.
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Performance Profiling Results

The Performance Profiling report provides function profiling data for your program and its components so that you
can see exactly where your program spends most of its time. When the configuration settings are set and the test
application is run, you can see the Performance Profiling report.

The default Performance report is in HTML format. It is generated from a template named wcetreport.template
provided as text file that you can modify to customize the report. It uses four online JavaScript libraries:

» Bootstrap,

« JQuery,

* Font Awesome,
* VisJS.

These libraries are not provided. You need an internet connectivity when you open the report. If not, download the

libraries (.css and .js files), copy them in the same folder than your report, and modify the template file as follows:

Replace the following lines:

<link rel="stylesheet" href="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/css/bootstrap.min.css"
integrity="sha384-MCw98/SFnNGE8fJIT3GXWEONgsV7Zt27NXFoaoApmYm81iuXoPkFOJwI8ERdAknLPMO"
crossorigin="anonymous">

<link rel="stylesheet" href="https://use.fontawesome.com/releases/v5.5.0/css/all.css"
integrity="sha384-B4dIYHKNBt8Bc12p+WXckhzcICoOwtJAoU8YZTY5qEOId1GSseTk6S+L3B1XeVIU"
crossorigin="anonymous">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.min.css">

<script src="https://code.jquery.com/jquery-3.3.1.slim.min.js"
integrity="sha384-q81i/X+965Dz00rT7abK41JIStQIAqVgRVzpbzo5smXKp4YfRvH+8abtTE1Pi6jizo"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/popper.js/1.14.3/umd/popper.min.js"
integrity="sha384-ZMP7rVo3mIykV+2+9J3UJ46jBkOWLaUAdn689aCwoqbBJIiSnjAK/18WvCWPIPmM49"
crossorigin="anonymous"></script>

<script src="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/js/bootstrap.min.js"
integrity="sha384-ChfqqxuZUCnJISK3+MXmPNIyE6ZbWh2IMqE241rYiqJIxyMiZ60W/ImZQ5stwEULTY"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.js"></script>

With the following ones:

<link rel="stylesheet" href="./bootstrap.min.css>
<link rel="stylesheet" href="./all.css">
<link rel="stylesheet" href="./vis.min.css">

<script src="./jquery-3.3.1.slim.min.js"></script>
<script src="./popper.min.js"></script>
<script src="./bootstrap.min.js"></script>

<script src="./vis.js"></script

The Performance profiling report is made of Summary, Functions and the Call Graph parts.
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SUMMARY
Summary table

The Summary table displays the total number of functions and the number of functions that have

never been executed and for which we have no data. If the instrumentation has been done with the
WCET option (Worst Case Execution Time), then the table contains the list of the entry points with an
evaluation of the WCET for each of them. This information can be empty (and the cell is red) if the
WCET could not be computed. This can occur when one of the called functions in the call graph starting

with this entry point has never been executed.

The WCET is given for each entry point if you have entered the list of entry point of your application in

the Settings. For more details, see Performance profiling settings on page 95.

Summary

# Functions and Entry Points
# Functions 29

# Never called Functions

main

ompute uationOflme I main obliquityCorrected main recherche_elevation Max [l recherche elevation X

iy -

% Function Time Average Function Time

Function time graphs

The Summary is followed by two graphs that provide a high level view of the largest time consumers

detected by Performance Profiling in your application.

* % Function Time: It gives the five top functions with the greatest percentage of Function Time.
- Average Function Time: It gives the five top functions with the greatest Average Function Time.

FUNCTIONS

The Functions section of the report displays a table with the instrumented functions, procedures or methods

(collectively referred to as functions) found in the application with the following information:

« Functions: Name of the function (in red if the function has never been executed).

If you have selected the WCET option, the chevron in front of the name allows the user to see how many times

this function calls other functions. This can help to understand how the WCET is calculated.

417



HCL® OneTest™ Embedded

- EP: Indicate if this function is an entry point or not. You can provide the list of the entry points, or, if not, they
are deduced from the call graph (all the functions that are never called).

« # Calls: Number of times the function is called. If this value is 0, there is no more information for this function
in the table because it has never been executed.

- Function Time: Total time spent for executing the function, excluding its descendants.

« Function + Descendants Time: Total time spent for executing the function, including its descendants.

* % Function Time: Percentage of time spent in this function against the total execution time.

» % Function + Descendants Time: Percentage of time spent for executing the function and its descendants
against the total execution time.

- Average Function Time: Average time spent for executing this function, excluding its descendants.

« Max Function Time: Only if you set the option Compute F max and F + D max. Indicates the maximum time
spent in a call while executing this function, excluding its descendants.

» Max Function + Descendants Time: Only if you set the option Compute F max and F + D max time, see
Performance profiling settings on page 95. This is the maximum time spent in a call while executing this
function, including its descendants.

« WCET: Only if you set the option WCET, see Performance profiling settings on page 95. It gives an
evaluation of the Worst Case Execution Time. This information can be empty if the WCET could not be

calculated during the execution. It is the case when one of the function and its descendants has never been

executed. Click the chevron icon to deploy the list of functions that are not called.

Functions
% Max
Function % Function  Average Max Function
Function  + Desc. Function  + Desc. Function  Function  + Desc.
Functions Time Time Time Time Time Time “ Time
> main v o 13310us 153967us  8.64% 100% 13310us 13310us 153967us
write_st_elevation_time 1 445us 445us 0.29% 0.29% 445us 445us 445us 445us
Call Graph

The Call Graph part displays all the functions in an interactive call graph that can be moved from left to right or from
top to bottom. If the option WCET has been set, a tooltip on each function (node of the graph) gives the WCET. For

more information, see Performance profiling settings on page 95.

Customize the Performance Report

You can customize a Performance report.

The Performance report is based on a template called wcetreport.template that you can find in the following folder:

* In Windows:

<installation_directory>\|IBM TestReal Tine\lib\reports
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« In Unix:

<installation_directory>/1BM TestReal Time/lib/reports

Raw data

This template is made of three sections:

« The HTML section that is the common part of all reports,
« A JavaScript section that sets the tables and call graph depending of 2 variables dynamically initialized while

the report is creating:
var data = {{json}}; // the raw data

var d = new Date({{date}}) // the date of the generation
Raw data is composed of three sections at the top level:

« The list of the modules, each of them has the following information:
- Name is the short name of the C file,
> Fullname is the name and path of the C file,
o uuid is a unique identifier of the module,
- unknown is set to true is the module is not part of the information you provided (there is only one
unknown module that gathers all the function calls that are not in the known modules),

- functions is the list of the unique identifiers of functions of the module.

Modules are listed as hashmap with the uuid, as follows:

"modules™; {
"f5b5579edeaca82df478a6780c0c4c92™: {
"name”: "USAGE.C",

"fullname™ "..."
"yuid": "f5b5579%edeacal2df478a6780c0c4c92",
"unknown™

]

"functions™ [
"ba9eb05ad703046fed306b4271b7ead7"

]
..

« The list of functions including following information:
- name is the name of the C function,
o line is the first line of the function in the module,
o id is the number used in .tsf file to identify this function,
- stacksize is the stack size computed during the execution if this option has been set (otherwise -1),
- uuid is a unique identifier of the function,
> module is a unique identifier of the module in which the function is declared,

o calls is the list of the calls in this function. Each of them have the following information:
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= calling_uuid is the unique identifier of the calling function,
= called_uuid is the unique identifier of the called function,
= line is the line number of the call in the module,
= col is the column number of the call in the module,
= same_module is set to true id the called function is in the same module that the calling
function.
- level is a number that represent the level of the function in the call graph, starting to 0.
- calledby is the list of unique identifiers of functions that call this one.
- maxLocal is the maximum time spent in the function, excluding its descendants.
- maxTotal is the maximum time spent in the function, including its descendants.
- sumLocal is the time spent in the function, excluding its descendants.
- sumTotal is the time spent in the function, excluding its descendants.
> weet is the Worst Case Execution Time of the function (this value is negative if it has not been
calculated).
« Functions are listed as hashmap with the uuid, as following:

"functions”; {
"bafebl5ad703046fed306b4 27 1bTead?™: {
"name": “wiile usage”,
"lina™; 9,
“id™: 1,
“slacksize” -1,
"yuid": “bafeb(bad703046fed306b427 1bTeadT",
"module”: fSbhh T Sedeacal2di47BaG7 80cOc4ci2”,
"calls™; [

{
"caling_uykl™ "bafeb05ad703046fed 3060427 1h eadr”,
“called_uuid™: “Fbicdb43b5b44e 12051030 G2720eba",
“hine": 10,
"col™ 2,

) "same. medule™

.
“lewel™ 1,

“calledby” [
"3bEb2065IcIbT Ofcid01baT97abae 1"

I,

"maxl.ocal™ 27,
“maxlotal’ 28,
“sumlocal™ 3190,
"sumlotal: 3853,
"averagelocal’: 0,
“woat™ 60

« The final section contains the following information:
- entrypoints is the list of entry points of the application; each of them contains:
= name is the name of the entry points.
= module is the uuid of the module where is the entry point.
= wcet is the Worst Case Execution Time of the entry points (this value is negative if it has not

been calculated).
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- timeunit is the unit of time used in the report (us is for micro-second, ms for millisecond, s for
second).

o level is the setting for performance (0 when there is no "compute F max + D max time", 1 when this
option is not set to yes, 2 when it is set to yes + WCET).

An example of this section:
"entrypoints™: [
{

"name"; "main",
"module™: "57f1afe89e0ar4b/86aab/5cd448db9b",
"weet™ -10

¥

tim it" "us",
"level": 2

]

Performance Profiling SCI Dump Driver
Performance Profiling for C and C++

In C and C++, you can dump profiling trace data without using standard I/0 functions by using the Performance

Profiling Dump Driver API contained in the atgapi.h file, which is part of the Target Deployment Port

To customize the Performance Profiling Dump Driver, open the Target Deployment Port directory and edit the

atqapi.h. Follow the instructions and comments included in the source code.
Related Topics

Generating SCI Dumps on page 1086

Using the Performance Profiling Viewer
Performance Profiling for C and C++
The product GUI displays Performance Profiling results in the Performance Profiling Viewer.

Reloading a Report

If a Performance Profiling report has been updated since the moment you have opened it in the Performance Profiling
Viewer, you can use the Reload command to refresh the display:

« Click the Reload button to reload a report From the View Toolbar.
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Resetting a Report

When you run a test or application node several times, the Performance Profiling results are appended to the existing

report. The Reset command clears previous Performance Profiling results and starts a new report.
« Click the Reset button from the View Toolbar to reset a report.

Exporting a Report to HTML

Performance Profiling results can be exported to an HTML file.

« Select Export from the File menu to export results.

Related Topics

Performance Profiling Results on page 96 |Applying Performance Profile Filters on page 422 | Opening a Report
on page 715 | Report Explorer on page 1059

Applying Performance Profile Filters
Performance Profiling for C and C++

Filters allow you to streamline a performance profile report by filtering out specific events. Use the Filter List dialog
box to specify how events are to be detected and filtered.

The export and import facilities are useful if you want to share and re-use filters between Projects and users.

To access the Filter List:

1. From the Performance Profile Viewer menu, select Filters or click the Filter button in the Perfomance Profile

Viewer toolbar.
To create a new filter:

1. Click the New button

2. Create the new filter with the Event Editor on page 436.
To modify an existing filter:

1. Select the filter that you want to change.
2. Click the Edit button.

3. Modify the filter with the Event Editor.

To import one or several filters:
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1. Click the Import button.
2. Locate and select the .xIf file(s) that you want to import.

3. Click OK.
To export a filter event:

1. Select the filter that you want to export.
2. Click the Export button.
3. Select the location and name of the exported .xIf file.

4. Click OK.

Related Topics

Editing Performance Profile Filters on page 423 | Performance Profiling Results on page 96 | Using the

Performance Profiling Viewer on page 421

Editing Performance Profile Filters

Performance Profiling for C and C++

Use the Filter Editor to create or modify filters that allow you to hide or show routines in the performance profile
report, based on specified filter criteria.

By default, routines that match the filter criteria are hidden in the report. Use the Invert filter option to invert this

behaviour: only routines that match the filter criteria are displayed.

Routine filters can be defined with one or more of the following criteria:

- Name: Specifies the name of a routine as the filter criteria.

« Calls > and Calls <: The number times the function was called is greater or lower than the specified value.
« F Time > and F Time <: Function time greater or lower than the specified value.

« F+D Time > and F+D Time <: Function and descendant time greater or lower than the specified value.

- F Time (%) > and F Time (%) <: Function time, expressed in percentage, greater or lower than the specified

value.

 F+D Time (%) > and F+D Time (%) <: Function and descendant time, expressed in percentage, greater or lower
than the specified value.

- Average > and Average <: The average time spent executing the function greater or lower than the specified

value.
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To define a routine filter:

1. In the Name box, specify a name for the filter.
2. Click More or Fewer to add or remove a criteria.
3. From the drop-down criteria box, select a criteria for the filter, and an argument.

Arguments must reflect an exact match for the criteria. Pay particular attention when referring to labels that

appear in the sequence diagram since they may be truncated.
You can use wildcards (*) or regular expressions by selecting the corresponding option.
4. Add or remove a criteria by clicking the More or Fewer buttons.

5. Click Ok.

Related Topics

Applying Performance Profile Filters on page 422 | Performance Profiling Results on page 96 | Using the

Performance Profiling Viewer on page 421

Runtime tracing

Runtime Tracing
Runtime Tracing for C, C++

Runtime Tracing is a feature for monitoring real-time dynamic interaction analysis of your C, C++ source code.
Runtime Tracing uses exclusive Source Code Insertion (SCI) instrumentation technology to generate trace data, which
is turned into UML sequence diagrams within the HCL OneTest™ Embedded GUI.

In HCL OneTest™ Embedded, Runtime Tracing can run either as a standalone product, or in conjunction with a
Component Testing or System Testing test node.

* You associate Performance Profiling with an existing test or application code.
« You build and execute your code in HCL OneTest™ Embedded.

« The application under test, instrumented with the Runtime Tracing feature, then directs output to the UML/SD
Viewer on page 431, which a provides a real-time UML Sequence Diagram of your application's behavior.

Runtime Tracing supports the following languages:

+ C: ANSI 89, ANSI 99, or K&R C

» C++:ISO/IEC 14882:1998
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How Runtime Tracing Works

When an application node is executed, the source code is instrumented by the C, C++ Instrumentor (attolcc1, attolccp
or attolcc4). The resulting source code is then executed and the Runtime Tracing feature outputs a static .tsf file for

each instrumented source file as well as a dynamic .tdf file.

These files can be viewed and controlled from the HCL OneTest™ Embedded GUI. Both the .tsf and .tdf files need to
be opened simultaneously to view the report.

Of course, these steps are mostly transparent to the user when the test or application node is executed in the HCL
OneTest™ Embedded GUI or Eclipse (for C and C++).

UML sequence diagram overview

Runtime Tracing for C, C++./span>

The lifeline of an object is represented in the UML/SD Viewer as shown below.
The instance creation box displays the name of the instance.

Example

Below is an example of object lifelines generated by Runtime Tracing from a C++ application.

x

g nt main [int, char ™)

h abji-Expand

I
g vald test_baffer (Expar I
|
1

H " Exaand:selinpd fU"i

consl char ™ Expand FJ-}tEI;'l-,‘:IrTyp:Nﬂ.ml?: 0

| b

int Expand :gei@lockLength 0 |

In this C++ example:

425



HCL® OneTest™ Embedded

« Functions and static methods are attached to the World instance.
« Objects are labelled with obj <number> : <classname>

« The black cross represents the destruction of the instance.

« Constructors are displayed as green arrow actions.

« Destructors are the blue arrows.

» Return messages are dotted red lines.

« Other functions and methods are black.

» Themain() is a function of the World instance called by the same World instance.

You can perform the following tasks from the sequence diagram:

426

- To jump to the corresponding portion of source code, double-click an element of the object lifeline to open the

Text Editor at the corresponding line in the source code

« To jump to the beginning or to the end of an instance:
o Right-click an element of the object lifeline to jump to the beginning or to the end of an instance.

> Select Go to Head or Go to Destruction in the pop-up menu.

« To filter an instance out of the UML sequence diagram:
o Right-click an element of the object lifeline.

o Select Filter instance in the pop-up menu.

Related information

UML Sequence Diagrams on page 426

Model Elements and Relationships in Sequence Diagrams on page 440

UML Sequence Diagrams

A sequence diagram is a Unified Modeling Language (UML) diagram that provides a view of the chronological
sequence of messages between instances (objects or classifier roles) that work together in an interaction or
interaction instance. A sequence diagram consists of a group of instances (represented by lifelines) and the
messages that they exchange during the interaction. You line up instances participating in the interaction in any order
from left to right, and then you position the messages that they exchange in sequential order from top to bottom.

Activations sometimes appear on the lifelines.

A sequence diagram belongs to an interaction in a collaboration or an interaction instance in a collaboration instance.
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Related information

Model Elements and Relationships in Sequence Diagrams on page 440

Viewing UML sequence diagrams on page 431

Tracing a test node

Runtime Tracing for C and C++

When Runtime Tracing is activated with a Component Testing or System Testing test node, monitoring a UML
sequence diagram of the execution from Runtime Tracing is a matter of including Runtime Tracing in the Build

options of an existing test node.

If however you are using Runtime Tracing on its own, you need to create an application node in the Project Explorer,

and associate it with the source files that you want to monitor.

To enable the runtime tracing option:

1. From the Build toolbar, click the Options button.
2. In the options list, select Runtime Tracing.

3. Click anywhere outside the options list to close it.

Next time you run a Make command on the selected test node, a Runtime Tracing UML sequence diagram will be
produced simultaneously with the standard test output.

To view runtime tracing output:

1. Runtime Tracing output is displayed, with the UML/SD Viewer, in the same UML sequence diagram as the

standard test's graphical output.

Related Topics

C and Ada Component Testing UML Sequence Diagrams on page 541 | C++ Component Testing UML Sequence
Diagrams on page 556| System Testing UML Sequence Diagrams on page 673

Step-by-step tracing
Runtime Tracing for C and C++

When tracing large applications, it may be useful to slow down the display of the UML sequence diagram. You can do

this by using the Step-by-Step mode.

To activate Step-by-Step mode:
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1. From the UML/SD Viewer menu, select Display Mode and Step-by-Step.
To select the type of graphical element to skip over:

1. In the UML/SD Viewer toolbar, click the » button.

2. Select the graphical elements that will stop the Step command. Clear the elements that are to be ignored.
To step to the next selected element:

1. Click the Step button in the UML/SD Viewer toolbar or press F10.
To skip to the end of execution:

1. Click the Continue button in the UML/SD Viewer toolbar. This will immediately display the rest of the UML
sequence diagram.

To restart the Step-by-Step display:
1. Click the Restart button in the UML/SD toolbar.
To de-activate Step-by-Step mode
1. From the UML/SD Viewer menu, select Display Mode and All.

Related Topics

UML/SD Viewer Preferences on page 1052 | Runtime Tracing Control Settings on page 1032 | UML/SD Viewer
Toolbar on page 1063

Using sequence diagram triggers
Runtime Tracing for C and C++

Sequence Diagram triggers allow you to predefine automatic start and stop parameters for the UML/SD Viewer. The

trigger capability is useful if you only want to trace a specific portion of an instrumented application.
Triggers can be inactive, time-dependent, or event-dependent.

To access the Trigger dialog box:
1. From the UML/SD Viewer menu, select Triggers or click the Trigger button in the UML/SD Viewer toolbar.

Start and End of Runtime Tracing:

The Runtime Tracing start is defined on the Start tab:
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« At the beginning: Runtime Tracing starts when the application starts.
« On time: Runtime Tracing starts after a specified number of microseconds.

- On event: Runtime Tracing starts when a specified event is detected. One or several events must be specified
with the Event Editor.

The Runtime Tracing end is defined on the Stop tab:
- Never: Runtime Tracing ends when the application exits.

- On time: Runtime Tracing ends after a specified number of seconds.

- On event: Runtime Tracing ends when a specified event is detected. One or several events must be specified
with the Event Editor.

To create a new trigger event:

1. Click the New button

2. Create the new trigger event with the Event Editor.
To modify an existing trigger event:

1. Select the trigger event that you want to change.
2. Click the Edit button.

3. Modify the trigger event with the Event Editor.

To import one or several trigger events:

The import facility is useful if you want to reuse trigger events created in another Project.

1. Click the Import button.
2. Locate and select the file(s) that you want to import.

3. Click OK.

To export a trigger event:

The export facility allows you to transfer trigger events.

1. Select the trigger event that you want to export.

2. Click the Export button.
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3. Select the location and name of the exported .tft file.

4. Click OK.

Related Topics

Editing Trigger or Filter Events on page 436 | Applying Filters on page 430

Applying Sequence Diagram Filters

Runtime Tracing for C, C++.

Filters allow you to streamline a sequence diagram by filtering out specific event types. Use the Viewer's Filter List

dialog box to specify how events are to be detected and filtered.
The export and import facilities are useful if you want to share and re-use filters between Projects and users.

To access the Filter List:
1. From the UML/SD Viewer menu, select Filters or click the Filter button in the UML/SD Viewer toolbar.
To create a new filter:

1. Click the New button

2. Create the new filter with the Event Editor on page 436.
To modify an existing filter:

1. Select the filter that you want to change.
2. Click the Edit button.

3. Modify the filter with the Event Editor.
To import one or several filters:

1. Click the Import button.
2. Locate and select the .tft file(s) that you want to import.

3. Click OK.
To export a filter event:

1. Select the filter that you want to export.

2. Click the Export button.
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3. Select the location and name of the exported .tft file.

4. Click OK.

Related Topics

Editing Trigger or Filter Events on page 436

Adding UML notes to source code

Runtime Tracing for C and C++

You can manually add your own notes inside your source code in order to make them display in the UML sequence
diagram when runtime tracing is enabled. To do this, you must insert the following line, called an instrumentation

pragma, in your C or C++ source code:

#pragma attol att_insert_ ATT_USER_NOTE("Text")

This can be done automatically with the text editor.

To manually set the syntax coloring mode:

1. Ina C or C++ source file, place your cursor at the line where you want a UML note to be displayed in the UML

sequence diagram.
2. In the toolbar, click Add Note . This inserts the instrumentation pragma line in the source code:

3. Replace "Text" with a meaningful string that will be displayed in the note.

Related Topics

Runtime tracing on page 424 | Editing code and test scripts on page 725 | UML sequence diagrams on

page 426 | Notes on page 682 | Instrumentation pragmas on page 1081

Viewing UML sequence diagrams
Runtime Tracing for C and C++
The UML/SD Viewer renders sequence diagram reports as specified by the UML standard.

UML sequence diagram can be produced directly via the execution of the SCl-instruction application when using the

Runtime Tracing feature.

The UML/SD Viewer can also display UML sequence diagram results for Component and System Testing features.

To learn about See
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The meaning of UML sequence diagrams produced by the Runtime Runtime Tracing sequence diagram represen-

Tracing feature tations

The meaning of UML sequence diagrams produced by the Compo- Component Testing for C and Ada sequence

nent Testing for C and Ada feature diagram representations on page 541

The meaning of UML sequence diagrams produced by the Compo- Component Testing for C++ sequence diagram

nent Testing for C++ feature representations

The meaning of UML sequence diagrams produced by the System  System Testing sequence diagram representa-

Testing for C feature tions on page 673

Moving around in a UML sequence diagram Navigating through UML/SD Viewer reports
Filtering out specific events from the UML sequence diagram Applying filters

Setting start and stop triggers on specific events in the UML se- Sequence diagram triggers

quence diagram

How to find particular items within a UML sequence diagram Finding a text string in a UML Sequence Dia-
gram

Using the zoom setting Setting a zoom level

Customizing the UML/SD Viewer UML/SD Viewer preferences

Related Topics
UML Sequence Diagrams on page 426

About Runtime Tracing on page 424

Navigating through UML Sequence Diagrams

Runtime Tracing for C and C++

There are several ways of moving around the UML sequence diagrams displayed by the UML/SD Viewer:

- Navigation Panel: Click and drag the Navigation button in the lower right corner of the UML/SD Viewer

window to scroll through a miniature navigation pane representing the entire UML sequence diagram.

- Free scroll: Press the Control key and the left mouse button simultaneously. This displays a compass icon,

allowing you to scroll the UML sequence diagram in all direction by the moving the mouse.

» Report Explorer: The Report Explorer is automatically activated when the UML/SD Viewer is activated. The
Report Explorer offers a hierarchical view of instances. Click an item in the Report Explorer to locate and
select the corresponding UML representation in the main UML/SD Viewer window.

Some elements in the sequence diagram provide links to the corresponding line in the source code. For example, if

you click a message in a sequence diagram, the text editor opens the corresponding source file in the text editor.
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Note If the source file is already open, it is not brought forward.
Related Topics

Report Explorer on page 1059 | Finding Text in a UML Sequence Diagram on page 439 | Applying Filters on
page 430 | Sequence Diagram Triggers on page 428 | UML/SD Viewer Preferences on page 1052 | UML/SD
Viewer Toolbar on page 1063

Time Stamping
Runtime Tracing for C and C++

The UML/SD Viewer displays time stamping information on the left of the UML sequence diagram. Time stamps are

based on the execution time of the application on the target.
You can change the display format of time stamp information in the UML/SD Viewer Preferences.

The following time format codes are available:

« %n - nanoseconds

« %U - microseconds
* %m - milliseconds

* %S - seconds

* %M - minutes

* %H - hours

These codes are replaced by the actual number. For example, if the time elapsed is 12ms, then the format %mms
would result in the printed value 12ms. If the number 0 follows the % symbol but precedes the format code, then 0
values are printed to the viewer - otherwise, 0 values are not printed. For example, if the time elapsed is 10ns, and the
selected format code is %0mms %nns, then the time stamp would read Oms 10ns .

Note To change the format code you must press the Enter key immediately after selecting/entering the new code.
Simply pressing the OK button on the Preferences window will not update the time stamp format code.

Related Topics

UML/SD Viewer Preferences on page 1052 | About the UML/SD Viewer on page 431

Coverage Bar
Runtime Tracing for C and C++

In C and C++, the coverage bar provides an estimation of code coverage.
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Note The coverage bar is unrelated to the Code Coverage feature. For detailed code coverage reports, use the

dedicated Code Coverage feature.

When using the Runtime Tracing feature, the UML/SD Viewer can display an extra column on the left of the UML/SD
Viewer window to indicate code coverage simultaneously with UML sequence diagram messages.

The UML/SD Viewer code coverage bar is merely an indication of the ratio of encountered versus declared function or

method entries and potential exceptions since the beginning of the sequence diagram.

If new declarations occur during the execution the graph is recalculated, therefore the coverage bar always displays a

increasing coverage rate.

To hide the coverage bar:

1. Right-click inside the UML/SD Viewer window.

2. From the pop-up menu, select Hide Coverage.
To show the coverage bar:

1. Right-click inside the UML/SD Viewer window.

2. From the pop-up menu, select Show Coverage.

Related Topics

About Code Coverage on page 72 | Memory Usage Bar on page 434 | Time Stamping on page 433 | UML/SD
Viewer Preferences on page 1052 | Memory Profiling Settings on page 1030

Memory Usage Bar

Runtime Tracing for C and C++.

When using the Runtime Tracing feature on a Java application, the UML/SD Viewer can display an extra bar on the left

of the UML/SD Viewer window to indicate total memory usage for each sequence diagram message event.

The memory usage bar indicates how much memory has been allocated by the application and is still in use or not

garbage collected.

In parallel to the UML sequence diagram, the graph bar represents the allocated memory against the highest amount

of memory allocated during the execution of the application.

This ratio is calculated by subtracting the amount of free memory from the total amount of memory used by the
application. The total amount of memory is subject to change during the execution and therefore the graph is

recalculated whenever the largest amount of allocated memory increases.

A tooltip displays the actual memory usage in bytes.
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To activate or disable coverage tracing with a Java application:

1. Before building the node-under-analysis, open the Memory Profiling settings box.
2. Set Coverage Tracing to Yes or No to respectively activate or disable coverage tracing for the selected node.

3. Click OK to override the default settings of the node
To hide the memory usage bar:

1. Right-click inside the UML/SD Viewer window.

2. From the pop-up menu, select Hide Memory Usage.
To show the memory usage bar:

1. Right-click inside the UML/SD Viewer window.

2. From the pop-up menu, select Show Memory Usage.

Related Topics

Thread Bar on page 435 | Time Stamping on page 433 | UML/SD Viewer Preferences on page 1052 | Memory
Profiling Settings on page 1030

Thread Bar

Runtime Tracing for C and C++

When using the Runtime Tracing feature on C and C++ code, the UML/SD Viewer can display an extra column on the

left of its window to indicate the active thread during each UML sequence diagram event.
Each thread is displayed as a different colored zone. A tooltip displays the name of the thread.
Click the thread bar to open the Thread Properties window.

To hide the thread bar:

1. Right-click inside the UML/SD Viewer window.

2. From the pop-up menu, select Hide Thread Bar.
To show the thread bar:

1. Right-click inside the UML/SD Viewer window.

2. From the pop-up menu, select Show Thread Bar.
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Related Topics

Thread Properties on page 436 | Memory Usage Bar on page 434 | Time Stamping on page 433 | UML/SD

Viewer Preferences on page 1052

Thread properties
Runtime Tracing for C and C++

The Thread Properties window displays a list of all threads that are created during execution of the application.
Threads are listed with the following properties:

« Colour tab: As displayed in the Thread Bar.

« Thread ID: A sequential number corresponding to the order in which each thread was created.
» Name: The name of the thread.

« State: Either Sleeping or Running state.

« Priority: The current priority of the thread.

« Since: The timestamp of the moment the thread entered the current state.
Click the title of each column to sort the list by the corresponding property

Thread Properties Filter
By default, the Thread Properties window displays the entire list of thread states during execution of the program.

To switch the Thread Properties Filter:

1. Click Filter to display reduce the display to the list of threads created by the application.

2. Click Unfilter to return the full list of thread states.

Related Topics

Thread Bar on page 435

Filtering sequence diagram events
Runtime Tracing for C and C++

Use the Event Editor to create or modify event triggers or filters for UML sequence diagrams:
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- Filters: Specified events are hidden or shown in the UML sequence diagram.

- Start triggers: The UML/SD Viewer starts displaying the sequence diagram when a specified event is

encountered. If no event matches the output of the application, the diagram will appear blank.

- Stop triggers: The UML/SD Viewer stops displaying the sequence diagram when a specified event is
encountered.

Events can be related to messages, instances, notes, synchronizations, actions or loops.

To define an event or filter:

1. Specify a name for the event.

2. Select the type of UML element you want to define for the event and select Activate. Several types of elements
can be activated for a single filter or trigger event.

3. Click More or Fewer to add or remove line to the event criteria.
4. From the drop-down criteria box, select a criteria for the filter, and an argument.

5. Arguments must reflect an exact match for the criteria. Pay particular attention when referring to labels that

appear in the sequence diagram since they may be truncated.

6. You can use wildcards (*) or regular expressions by selecting the corresponding option.

7. Click the "‘H button to enable or disable case sensitivity in the criteria.
8. You can add or remove a criteria by clicking the More or Fewer buttons.

9. Click Ok.

Message Criteria

- Name: Specifies a message name as the filter criteria.

- Internal message: Considers all messages other than constructor calls coming from any internal source, as

opposed to those messages coming from the World instance.

« From Instance: Considers all messages other than constructor calls prior to the first message sent from the

specified object

« To Instance: Considers out all messages other than constructor calls if any message is sent to the specified

object
« From World: Considers all messages received from the World instance

« To World: Considers all messages sent to the World instance
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Instance Criteria

- Name: Specifies an instance name as the filter criteria

« Instance child of: Specifies a child instance of the specified class.
Note Criteria

« All: Considers all notes

- Name: Specifies a note name

- All message notes: Considers any note attached to a message

« All instance notes: Considers any note attached to an instance

« Instance child of: Specifies a note attached to an instance of the specified class
- Note on message named: Considers a note attached to a specified message

- With style named: Considers a note with the specified style attributes
Synchronization Criteria

« All: Considers all synchronization events

» Name: Specifies a synchronization name
Action Criteria

« All: Considers all actions

- Name: Specifies an action name

- From Instance: Considers an action performed by the specified object

» From World: Considers all actions performed by the World instance

« Instance child of: Specifies an action performed by an instance of the specified class

« With style named: Considers an action with the specified style attributes
Loop Criteria

« All: Considers all loops

« Name: Specifies a loop name
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Boolean Operators

« All Except expresses a NOT operation on the criteria
« Match All performs an AND operation on the series of criteria

« Match Any performs an OR operation on the series of criteria

Related Topics

Applying Filters on page 430 | Sequence Diagram Triggers on page 428 | Understanding UML Sequence Diagrams
on page 425

Finding text in a sequence diagram
Runtime Tracing for C and C++

The UML/SD Viewer has an extensive search facility that allows users to locate specific UML sequence diagram

elements by searching for a text string.

To search for a text string inside the UML/SD Viewer:

1. Click inside a UML/SD Viewer window to activate it.

2. From the Edit menu, select Find menu item. The Find dialog box opens.
3. Type your search criteria in the Find dialog box.

4. Click the Find Next button.

5. If a string corresponding to the search criteria is found in the UML/SD Viewer, the string is highlighted and the
following message is displayed: Runtime Tracing has finished searching the document.

6. Click OK.
Search Options
» Forward and Backward specifies the direction of the search.

 The Search into option allows you to specify type of object in which you expect to find the search string.

« The Find dialog box accepts either UNIX regular expressions or DOS-like wildcards ('?' or *'). Select either

wildcard or reg. exp. in the Find dialog box to select the corresponding mode.

Related Topics

About the UML/SD Viewer on page 431 | Navigating through UML/SD Viewer reports on page 432
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Exporting a sequence diagram to a text file (.csv)

The UML/SD Viewer can generate sequence diagram results in a .csv text file. A .csv file is a text file presented as

a table. You can import these results into a text editor, a spreadsheet application or use them to operate a file diff

comparison for non-regression evaluation.

You can specify the format used to generate the .csv text file in the Data table preferences.

To generate a .csv text file from a sequence diagram:

. From the Runtime Trace menu, select Generate CSV.
. In the Generate CSV window, specify the name of the text file.

a A WO N =

and Down buttons to change the order.

o

. After running an application or test node with Runtime Tracing, open a sequence diagram.

. Select Generate columns header to insert a line with column titles at the top of the file.

. In the Columns list, select the sequence diagram elements that you want to export to the text file. Use the Up

. In the Additional Filters list, select any sequence diagram elements that you want to filter out of the report.

7. Click Preview to see how the table will appear in a spreadsheet application. The CSV Preview window is

limited to the first 100 lines. Click Close to exit the preview.
8. Click OK.

Related Topics

Data table preferences on page 1046 | Exporting reports to CSV | Exporting reports to HTML on page 737

Model Elements and Relationships in Sequence Diagrams

The UML sequence diagrams produced by the UML/SD Viewer illustrate program interactions with an emphasis on

the chronological order of messages.

To learn about

Notation used to show when an instance (object or classifier role) is active

Model elements that represent roles played by classifiers participating in a collaboration

Notation used to show that an instance has been destroyed

Notation used to show the existence of an instance during an interaction

Model elements that represent communication between classifier roles

See

Activations on

page 675

Classifier Roles

on page 676

Destruction
Markers on

page 678

Lifelines on

page 679

Messages on

page 681
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Model elements that represent instances of classifiers

Model elements that represent communication between objects

Non-standard model elements that represent thrown exceptions in C++

Model element that describes a role that a user plays when interacting with the system being

modeled

Non-standard model elements that represent a loop in the execution of a program

Non-standard model elements that are used to represent synchronization points when multiple

files are viewed together

Model elements that represent miscellaneous information such as comments or user-defined

messages

Related Topics

UML Sequence Diagrams on page 426

Advanced runtime tracing

Multi-thread support
Runtime Tracing for C, C++

Runtime Tracing can be configured for use in a multi-threaded environment such as Windows.

Objects on

page 683

Stimuli on

page 684

Exceptions on

page 678

Actors on

page 675

Loops on

page 680

Synchro-
nizations on

page 686

Notes on

page 682

Multi-thread mode protects Target Deployment Port global variables against concurrent access. This causes a

significant increase in Target Deployment Port size as well as an impact on performance. Therefore, select this option

only when necessary.

Multi thread settings:

These settings are ignored if you are not using a multi-threaded environment. To change these settings, use the Build

Settings > Target Deployment Port build dialog box.
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- Maximum number of threads: This value sets the size of the thread management table inside the Target
Deployment Port. Lower values save memory on the target platform. Higher values allow more simultaneous
threads.

- Record and display thread info: When selected, the UML Sequence Diagram displays a note each time a new
thread is created and each time a thread's schedule is changed.

To access the multi-thread build settings:

1. In the Project Explorer, click the Open Settings... button.

2. Select one or several nodes in the Configuration pane.

3. Select Build > Target Deployment Port build.

4. Set the Multi-threaded application and Maximum number of threads settings.
5. Select Runtime Analysis > Runtime Tracing > Runtime options.

6. Set Record and display thread info to Yes or No.

7. When you have finished, click OK to validate the changes.

Related Topics

Runtime Tracing Control Settings on page 1032 | Build settings on page 1019 | About Configuration Settings on
page 690

Partial trace flush
Runtime Tracing for C, C++

When using this mode, the Target Deployment Port only sends messages related to instance creation and destruction,
or user notes. All other events are ignored. This can be useful to reduce the output of trace.

When Partial Trace Flush mode is enabled, message dump can be toggled on and off during trace execution.
The Partial Trace Flush settings are located in the Runtime Tracing Settings.

To enable Partial Trace Flush from the Node Settings:

1. In the Project Explorer, click the Open Settings... button.

2. Select one or several nodes in the Configuration pane.

3. Select Runtime Analysis > Runtime Tracing > Runtime options.

4. Set the Partial Runtime Tracing flush setting to Yes or No to activate or disable the mode.

5. When you have finished, click OK to validate the changes.
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To toggle message dump from within the source code:
1. To do this, use the Runtime Tracing pragma user directives:

. o _ATT_START_DUMP
> _ATT_STOP_DUMP
o _ATT_TOGGLE_DUMP

o _ATT_DUMP_STACK

See the Reference Manual for more information about pragma directives.
To control message dump through a user signal (native UNIX only):
This capability is available only when using a native UNIX target platform.

Under UNIX, the kill command allows you to send a user signal to a process. Runtime Tracing can use this signal to

toggle message dump on and off.

1. In the Project Explorer, click the Open Settings... button.

2. Select one or several nodes in the Configuration pane.

3. Select the Runtime Analysis node and the Runtime Tracing node.

4. Select Runtime Tracing Control.

5. Set the Partial Runtime Tracing flush setting to Yes or No to activate or disable the mode.

6. When you have finished, click OK to validate the changes.

Note By default, the expected signal is SIGUSR1, but you can change this by setting the ATT_SIGNAL_DUMP
environment variable to the desired signal number. See the Reference Manual for more information about

environment variables.
Related Topics

Runtime Tracing Control Settings on page 1032

Trace item buffer

Runtime Tracing for C and C++

Buffering allows you to reduce formatting and 1/0 processing at time-critical steps by telling the Target Deployment

Port to only output trace information when its buffer is full or at user-controlled points.
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This can prove useful when using Runtime Tracing on real-time applications, as you can control buffer flush from
within the source-under-trace.

To activate or de-activate trace item buffering:

1. In the Project Explorer, click the Open Settings... button.

2. Select one or several nodes in the Configuration pane.

3. Select the Runtime Analysis node and the Runtime Tracing node.

4. Select Runtime Tracing Control.

5. Set the Buffer trace items setting to Yes or No to activate or disable the mode.
6. Set the size of the buffer in the Items buffer size box.

7. When you have finished, click OK to validate the changes.

A smaller buffer optimizes memory usage on the target platform, whereas a larger buffer improves performance of
the real-time trace. The default value is 64.

Flushing the Trace Buffer through a User Directive

It can be useful to flush the buffer before entering a time-critical part of the application-under-trace. You can do this
by adding the _ATT_FLUSH_ITEMS user directive to the source-under-trace.

Note See Runtime Tracing pragma directives in the Reference Manual to control Target Deployment Port buffering
from within the source code.

Splitting trace files

Runtime Tracing for C and C++a

During execution, Runtime Tracing generates a .tdf dynamic file. When a large application is instrumented, the size of
the .tdf file can impact performance of UML/SD Viewer.

Splitting trace files allows you to split the .tdf trace file into smaller files, resulting in faster display of the UML
Sequence Diagram and to optimize memory usage. However, split trace files cannot be used simultaneously with On-
the-Fly tracing.

When displaying split .tdf files, Runtime Tracing adds Synchronization elements to the UML sequence diagram to
ensure that all instance lifelines are synchronized.

To set Split Trace mode:
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1. In the Project Explorer, select the highest level node from which you want to activate split trace mode.
2. Click the Open Settings... button.

3. Select Runtime Analysis and the Runtime Tracing settings.

Select Trace Control.
Set the Size (Kb) of each split .tdf. The default size is 5000 Kb.

Specify a File Name Prefix for the split .tdf filenames. The prefix is followed by a 4-digit number that identifies each
file.

1. Click OK.

Note The total size of split .tdf files is slightly larger than the size of a single .tdf file, because each file contains

additional context information.

Trace Probes for C

Trace Probes for C

Trace Probes for C

The Trace Probes feature of HCL OneTest™ Embedded allows you to manually add special probe C macros at specific
points in the source code under test, in order to trace messages.

Upon execution of the instrumented binary, the probes record information on the exchange of specified messages,
including message content and a time stamp. Probe trace results can then be processed and displayed in the UML/
SD Viewer.

The use of C macros offers extreme flexibility. For example, when delivering the final application, you can leave the
macros in the final source and simply provide an empty definition.

Trace Probes supports ANSI 89, ANSI 99, or K&R C.

How Trace Probes work
The first step is to manually add specific macros to your C source code.

When the test or application node is executed, the Probe Processor produces an instrumented source file. which is
functionally identical to the original, but which generates extra message tracing results.

The resulting source code is then executed and the Trace Probe feature outputs a .rio output file for each probe

instance.
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A .tsf static trace file is generated during instrumentation, and the .rio output file is processed and transformed into a
.tdf file. These files can be viewed and controlled from the HCL OneTest™ Embedded GUI. Both the .tsf and .tdf files
need to be opened simultaneously to view the UML sequence diagram report.

Of course, these steps are mostly transparent to the user when the test or application node is executed in the HCL
OneTest™ Embedded GUI.
Related Topics

Probe Control Settings on page 1041 | Probe Output Modes on page 447 | Circular Trace Buffer on page 687 |
About the UML/SD Viewer on page 431

Using Probe Macros
Trace Probes for C

Before adding probe macros to your source code, add the following #include statement to each source file that is to

contain a probe:

#include "atlprobe.h"

The atl_start_trace() macro must be called before any probe activity can occur; for example, it can be placed at the
start of the application.

The atl_end_trace() macros must be called after all probe activity has ended; for example, when the application

terminates.

Other macros must be placed inside the source code, at locations that are relevant for the messages that you want to
trace.

The following probe macros are available:

« atl_dump_trace()
- atl_end_trace()

« atl_recv_trace()

- atl_select_trace()
« atl_send_trace()
- atl_start_trace()

- atl_format_trace()

Please refer to the section on Probe Macros in Reference for a complete definition of each probe macro.
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To activate the Trace Probe feature:

1. In the Project Browser, select the application or System Testing node on which you want to use the feature.
2. Click Settings and open the Probe control box.

3. Set Probe enable to Yes, select the correct output mode in Probe Settings and click OK.

4. Edit the source code under test to add the trace probe macros, including the #include line.

5. Set up your trace probes within your application source files.
To read the trace probe output:

1. From the File menu, select Open and File.

2. In the file selector, select Trace Files (*.tsf, *.tdf) and select the .tsf and .tdf files produced after the execution

of the application under test.

3. Click OK.

Trace Probe output modes

Trace Probes for C

By default, the message traces are written to the .rio output file. However, in some cases, this may not be practical,
therefore the Trace Probe feature can be configured to send trace information to a temporary buffer before writing to

afile.

To change the way traces are stored, specify the trace mode as specified in the Probe Control Settings:

- DEFAULT: In this mode, the message traces are written directly to the .rio output file.

- FIFO: Binary format traces are directed to a temporary first-in first-out memory buffer before writing to the
.rio file when the atl_dump_trace macro is encountered. This mode is intended for embedded or realtime
applications which may not be able to access a filesystem when running.

« FILE: Binary format traces are written to a low footprint temporary file before writing to the .rio file when
the atl_dump_trace macro is encountered. This mode is intended for embedded or realtime applications
which may not have enough memory or processing power to continuously write to the .rio file. In this case for

example, a second application could be set up to read the file and generate the .rio result file.
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« USER: Uses methods, described in a user-defined probecst.c file to direct traces to a user-defined format
before writing to the .rio file when the atl_dump_trace macro is encountered. See Customizing the USER
output mode on page 449 for more information.

» IGNORE: Use this setting to ignore trace probe macros on compilation. In this case, the binary is compiled
without instrumentation.

When FIFO, FILE or USER are selected, the traces must be flushed to the .rio file with a specific atl_dump_trace macro

placed in a source file.

Use the DEFAULT output mode whenever possible. In most other cases, the FIFO or FILE should be enough and can

be optimized using parameters provided in the Reference section.

Only use USER mode if none of the other settings are practical for your application. Using the USER output mode
requires that you rewrite your own probecst.c and probecst.h using the files provided with the product as a template.

See Customizing the USER output mode on page 449 for more information.

When using the USER mode, you must specify the location of the user-defined probecst.c and probecst.h files in the

USER custom files directory setting. See Probe control settings on page 1041 for details.
Related Topics

Trace Probes on page 445 | Circular Trace Buffer on page 687 | Probe Control Settings on page 1041 |
Customizing the USER output mode on page 449

Traces Probes and System Testing for C
Trace Probes for C
You can use Trace Probes to produce a System Testing .pts test script based on probe activity.

When a probed application is executed, the .rio result file is processed, which produces a .pts test script for System
Testing for C.

The Script generation flags setting allows you to specify the command line arguments that will be used to generate

the .pts test script. The available flags are:
-accuracy=<time>
-polling=<time>

These values express the desired accuracy and polling intervals to be used in the .pts test script, where <time> is

expressed in milliseconds (ms).

You can edit and reuse this script in later tests to replay the exact same data exchanges in a System Testing for C

test node.

Related Topics
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Trace Probes for C on page 445 | About System Testing for C on page 618 | Probe Control Settings on page 1041

Customizing the USER output mode

Trace Probes for C

The USER output mode for Trace Probes requires that you rewrite user-defined probecst.c and probecst.h based on
the files provided with the product.

Only use the USER mode if the DEFAULT, FIFO or FILE modes are not practical for your application.

To rewrite your own routines, make a copy of the probecst.c and probecst.h that are provided with the product and
use them as a template. These files are located in the following directory located in the installation directory of the

product:
/lib/probe/probecst/fifo

Note These are the files that are used for the FIFO output mode, therefore ensure that any changes that you make are
performed on copies of these files.

The implementation delivered in the FIFO mechanism is based on a circular buffer. The instrumented application
sends traces to the intermediate storage buffer, by using the atl_write_probe function. The traces can then be read by

the atl_read_probe function.
You can modify this file to adapt the probe mechanism to your application and platform.

For example, when using USER mode, the main probed application may store messages in binary format in a shared
memory or pipe, whereas a dedicated "dump application" can be written to read the shared memory or pipe and to

generate the .rio result file.

By using this method, the probed application can still run with minimal overhead while another process generates the

.rio result file either on the fly or after the execution of the probed application.

Whichever storage mechanism you use, it is important that the dump application runs within the same hardware

architecture as the main application to avoid misalignment or little-big endian problems.

When using the USER mode, you must specify the location of the user-defined probecst.c and probecst.h files in the

USER custom files directory setting. See Probe control settings on page 1041 for details.

The probecst.c file contains definitions for the Trace Probe macro functions. These are detailed below. For the usage
and syntax of the Trace Probe macros, please refer to the Reference section. For each function, the probecst.c file

contains comments that should help you to rewrite each of these functions.

The following functions must be executed during the execution of the probed application:

- atl_create_probe

- atl_end_probe
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« atl_write_key

« atl_write_probe

The following functions can be executed when the probed application ends or after the application has finished in a
dedicated dump application:

- atl_open_probe
« atl_close_probe

- atl_read_probe

atl_start_trace

The atl_start_trace function executes atl_create_probe. It must be called before any other macros, once for each
instance. Its role is to open, create and initialize the intermediate storage media used to keep messages in the

intermediate binary format.

atl_end_trace

The atl_start_trace function executes atl_end_probe. It must be called at the end of the application, once for each

instance. Its role is to close the intermediate storage media used to keep messages in the intermediate binary format.

atl_send_trace and atl_recv_trace

The atl_send_trace and atl_recv_trace functions execute atl_write_probe in order to dump the message to the
intermediate storage media.

It is important that the .rio result file retains the message sequence. Therefore, ensure that data is recorded in the
execution order.

atl_write_probe

The role of the atl_write_probe function is to record the following data:
- The complete message, the length of the message is provided to help.
* The date of the event.
« An internal code.

« The key format.

If your USER mechanism required the use of intermediate storage, the atl_dump_trace must be called after the
atl_end_trace macro.
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atl_dump_trace()

This macro can be either part of the probed application or part of a dedicated dump program that would be executed

after the main application, depending on what is practical in your application.

The atl_dump_trace() macro executes, for each instance,

- atl_open_probe,
- atl_read_probe for each recorded message, and

- atl_close_probe.

atl_open_probe

The role of the atl_open_probe function is to reopen the intermediate storage and point to the first recorded message.
atl_close_probe

The role of the atl_close_probe function is to close, destroy or free the memory of the intermediate storage.
atl_read_probe

The role of the atl_read_probe function is to retrieve the following data from the intermediate storage:

« The message as it was recorded during the execution.
- A timestamp of the message.
« An internal code.

* The key format of the message.

atl_select_trace

The role of the atl_select_trace function is to execute atl_write_key in the API. The code of this function must not be

customized. It must be copied from the original probecst.c without any change.
Related Topics

Trace Probes for C on page 445 | Trace Probe output modes on page 447 | Probe Control Settings on page 1041

Coupling Analysis

Coupling Analysis consists of Control Coupling and Data Coupling.
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Control Coupling

Control Coupling is defined as “the manner or degree by which one software component influences the execution
of another software component" in the Clarification of Structural Coverage Analyzes of Data Coupling and Control
Coupling document edited by the Certification Authorities Software Team (CAST). The purpose is 'to provide a
measurement and assurance of the correctness of these modules/components’ interactions and dependencies'.

Control Coupling is used to verify that all the interactions between modules have been covered by at least one test.

HCL OneTest™ Embedded introduces a new coverage level called “Control Coupling" for C language that consists in
verifying that all the interactions between modules have been covered by at least one test. This new coverage level is

implemented in HCL OneTest™ Embedded in two ways:

« Modules are compilation units, in this case:
> Control Couplings are calls between two functions that are in two different compilation units.
= Control Coupling is not a simple interaction. It is a control flow in the calling module that ends with an
interaction with another module.
> Groups of compilation units can be defined as a single module. This will increase the number of calls
between modules but also increase the number of control flows in the calling modules.
> The report contains a button to display:
= All the Control Couplings (default option).
= Only the shortest Control Couplings (only the last calls between modules are taken into
account)
= Only the longest Control Couplings (the sub-control flows are ignored)
» Modules are Functions, in this case:
> Control Couplings are considered as all the calls between two functions, in the same compilation unit
or not.

= Each Control Coupling is only a call, and not a control flow as previously defined.

So, to identify the Control Couplings, HCL OneTest™ Embedded analyzes all the external calls between modules
(definition of the modules could be different depending on the option) and statically identifies all the possible paths in
the calling module that end with each external call, excluding the one that starts with a static function (ex: a function

that can't be called from another module). This constitutes the set of Control Coupling of the application.

For each of them, HCL OneTest™ Embedded provides the following information:

« The calling modules.
 The complete control flow (example: the set of successive calls, the last one is the external call). If the option
"module as function" is set, each control flow has two functions only.
« In case of option module as "compilation unit":
o Is it the longest one that leads to this external call (it is not the longest when there is another Control
Coupling that includes the current one).
> |s it the shortest one that leads to this external call (it is not the shortest when there is another Control
Coupling that is included by the current one).
« It is covered or not.
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- The list of test cases that each Control Coupling covered.

« The list of requirements that are related to the test cases.

How Control Coupling Works

When an application node or a test is executed, the source code is instrumented by the Instrumentor (attolcc4 for
C language) that produces a static file with the extension .tsf containing information on the Control Couplings. The
resulting source code is then compiled, linked and executed and the Control Coupling feature outputs a dynamic file

with the extension .tgf.

These 2 types of files are the input of the report generator that produces a report in HTML format (and optionally
the raw data can be generated in a Json file). A template is provided for this generator. You can provide your own

template to modify the report.

If the Control Coupling feature is used with unit testing feature, the report generator can take the .tdc files as input
files. This allows to have also in the report the test cases that covered each Control Coupling and the associated
requirements declared in the .ptu file. If not, the test cases are identified by their execution date, and there is no

requirement.

Note:

To visualize your report in HCL OneTest™ Embedded for Eclipse IDE, if you are using the default browser
option, be sure that JavaScript is enabled. Otherwise, you can choose another browser that is compatible with
your version of JavaScript by changing it in Window > Preferences > General > Web Browser .

Set Control Coupling Options

You can set the options for Control Coupling to build your project in HCL OneTest™ Embedded Studio.
Execute a build with Control Coupling

« In HCL OneTest™ Embedded Studio, open the Settings of the project and click the Configuration Properties >
Build > Build options menu.

« In the right panel, click on the Build options and edit the options by clicking on the ... button.

« In the dialog window that shows up on the right, you can select the different tools that can be used for the

build. Select Ctrl Coupling analysis to enable the control coupling feature.

Control Coupling options

Options for Control Coupling can be updated in the following menu of the settings: Configuration Properties >

Runtime analysis > Control coupling

From this setting page, you can change the following choices:
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- Trace file name (.tgf): sets the name of the trace file dedicated to control coupling. By default, this name is
the base name of the test with the extension .tgf.
« Exclude libraries: Include or exclude the control couplings that end with a call to a function that is not part of
the application (sets the -noccext option of the report generator if it is set to yes).
- Report Template: changes the template of the report generator. By default, this template is ccreport.template.
» Modaule as: Select the choice that corresponds the best to your definition of a module. A module can be
defined as a function or a compilation unit. HCL OneTest™ Embedded offers two ways to interpret Control
Coupling, depending on how the "module" in CAST-19 is interpreted:
> Module as function: Each call between each function is considered as Control Coupling.
> Module as compilation unit: Only the calls between two functions in two different compilation units
are considered as Control Coupling. Moreover, the different called stacks in the calling module are
also considered as different Control Couplings. With the previous option set, the user can group two
or more compilation units in a single module (called component) in order to ignore the calls between

these compilation units.

Control Coupling Report

After you build a project with HCL OneTest™ Embedded, you can get a Control Coupling report with compilation unit
module or a Control Coupling report with function module, depending on the build settings.

The default Control Coupling report is in HTML format. It is generated from a template named ccreport.template (for
the module as compilation unit option ), or ccfreport.template (for the module as function option). The templates are
provided as text files that you can modify to customize the report. It uses four online JavaScript libraries:

» Bootstrap,

» JQuery,

* Font Awesome,
* VisJS.

These libraries are not provided. You must have an internet connection when you open the report. If not, download the

libraries (.css and .js files), copy them in the same folder than your report, and modify the template file as follows:

Replace the following lines with the lines from the second text block:

<link rel="stylesheet" href="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/css/bootstrap.min.css"
integrity="sha384-MCw98/SFnGE8fJIT3GXWEONgsV7Zt27NXFoaoApmYm81iuXoPkFOJwI8ERdAknLPMO"
crossorigin="anonymous">

<link rel="stylesheet" href="https://use.fontawesome.com/releases/v5.5.0/css/all.css"
integrity="sha384-B4dIYHKNBt8Bc12p+WXckhzcICoOwtJAoU8YZTY5qEOId1GSseTk6S+L3B1XeVIU"
crossorigin="anonymous">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.min.css">

<script src="https://code.jquery.com/jquery-3.3.1.slim.min.js"
integrity="sha384-q81i/X+965Dz00rT7abK41JIStQIAqVgRVzpbzo5smXKp4YfRvH+8abtTE1Pi6jizo"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/popper.js/1.14.3/umd/popper.min.js"
integrity="sha384-ZMP7rVo3mIykV+2+9J3UJ46jBkOWLaUAdn689aCwoqbBJIiSnjAK/18WvCWPIPmM49"
crossorigin="anonymous"></script>
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<script src="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/js/bootstrap.min.js"
integrity="sha384-ChfqqxuZUCnISK3+MXmPNIyYE6ZbWh2IMqE241rYiqIxyMiZ60W/ImZQ5stwEULTY"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.js"></script>

Replacement lines:

<link rel="stylesheet" href="./bootstrap.min.css>
<link rel="stylesheet" href="./all.css">
<link rel="stylesheet" href="./vis.min.css">

<script src="./jquery-3.3.1.slim.min.js"></script>
<script src="./popper.min.js"></script>

<script src="./bootstrap.min.js"></script>

<script src="./vis.js"></script

If you set a module as a compilation unit in the control coupling properties, you get a control coupling report with
compilation units in output of your project build. If you set a module as a function, you get a control coupling report
with function in output. For more details about the control coupling settings, see Set Control Coupling options on
page 183 for HCL OneTest™ Embedded for Eclipse IDE. In a report with function as module, the report shows all the

function calls (internal and external).
The Control Coupling report includes three parts.

Summary

In the Summary section, you find the number of Control Couplings for your application that are covered, given the

information that you provided and the percentage of Control Couplings that are covered.
A graph displays the total percentage of covered and non covered control couplings for the entire application.

The Summary table displays the following information:

« The percentage of Control Couplings of your application by module pairs that have not been covered,
depending on the information that you provided.

« The percentage of Control Couplings that are covered by module pairs.
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Filter Modules l m Show Hide Graphs Show Hide Requirements

Summary
# Control Coupling 98 (filtered W)
% Control Coupling covered 33%
Control Coupling covered
Details

The Details table lists all the Control Couplings and displays the following information for each of them:

« The calling compilation unit.

 The control flow, for example: the successive calls in the module that end with the external call in the called
module. Note that the called module is mentioned in the last function of the control flow. In case of option
"module as function®, this control flow contains only two functions.

- A check mark if it is a longest Control Flow but only if the "module as compilation unit" option is set.

- A check mark if it is a shortest Control Flow but only if the "module as compilation unit" option is set.

« The list of test cases that covered this control flow. If the Control Coupling feature is set with the unit testing
feature, the test cases are the one in the . pt u files named as <service>/<test>.

- The associated requirements. If the Control Coupling feature has been set with the unit testing feature, the
requirements are those that have been described in the . pt u files with the keyword REQUIREMENT for each
test cases that covered this Control Coupling.

« A check mark if the control coupling has been covered.

Call Graph

For each compilation unit, a partial call graph displays all the functions in an interactive call graph from left to right or

from top to bottom, depending on the selector button position on the top of the call graph.

You can select a control coupling in the table to highlight it in the call graph.
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At the end of the report, a complete call graph displays all the functions calls.

Filters

You can apply filters in the report by selecting different options at the top:

- If the option “module as compilation unit" option is set, you can choose first to display all Control Couplings,
the longest (only the Control Couplings that have the longest control flow in the calling module) or the
shortest (only the Control Couplings that have the shortest control flow in the calling module). The summary
tables and the details table are updated accordingly to your selection. This option applies to reports with
compilation unit as module only.

« You can select the calling modules and the called modules. It filters the Control Couplings depending on
their calling and called modules. The summary tables and the details table are updated accordingly to your
selection.

* You can choose to display all graphs or hide them in the report.

« You can show or hide the Requirements.

Customize Control Coupling Report

The Control Coupling report is created from a template called ccreport.template (if option “module as compilation
unit" is set), or ccfreport.template (if option “module as function” is set) that you can find in the folder <install>/lib/

reports.

This template is made of 2 parts:

e The HTML part that is the common part of all reports,
A JavaScript part that sets the tables and call graph depending of 2 variables initialized dynamically when the

report is creating:
var data = {{json}}; // the raw data

var d = new Date({{date}}) // the date of the generation
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Raw data

Raw data is composed of 4 sections at the top level:

« A summary of the Control Coupling metrics:
> nbecc is the number of Control Coupling found in the application,
> nbcovered is the number of Control Coupling found in the application that have been covered by at
least one test,
> nbccShortest and nbcoveredShortest are the same for the shortest Control Coupling,
- nbccLongest and nbcoveredLongest are the same for the longest Control Coupling,
- filtered is set to true if the report has been generated with a filter (shortest or longest),
- filtered_longest is set to true if the report has been generated with a filter longest (set only if filter is

true).

"filtered": ,
"filtered longest™: ,
"nbcc": 112,

"nbcovered”: 48,
"nbccshortest™: 32,
"nbcoveredshortest™: 25,

"nbcclongest™: 58,
"nbcoveredLongest": 23

« The list of the modules, each of them has the following information:
> Name is the short name of the C file,
> Fullname is the name and path of the C file,
o uuid is a unique identifier of the module,
- unknown is set to true is the module is not part of the information you provided (there is only one
unknown module that gathers all the call to functions that are not in the known modules),

- functions is the list of the unique identifiers of functions of the module.
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Modules are listed as hashmap with the uuid, as follows:

"modules": {
"f5bb57% deacald2dfd78a6780c0cdc92m: |
"name": "USAGE.C",
"uuid": "fOb5579%edeacal82df478a6780c0c4c92",
"unknown": ;

"functions": [
"ba9eb05ad703046fed306b4271b7cad/"

]
by

« The list of functions including following information:
> name is the name of the C function,
- line is the first line of the function in the module,
o id is the number used in .tsf file to identify this function,
- stacksize is the stack size computed during the execution if this option has been set (otherwise -1),
- uuid is a unique identifier of the function,
- module is a unique identifier of the module in which the function is declared,
o calls is the list of the calls in this function. Each of them have the following information:
= calling_uuid is the unique identifier of the calling function,
= called_uuid is the unique identifier of the called function,
= line is the line number of the call in the module,
= col is the column number of the call in the module,
= same_module is set to true id the called function is in the same module that the calling
function.
- level is a number that represent the level of the function in the call graph, starting to 0.
- calledby is the list of unique identifiers of functions that call this one.
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- Functions are listed as hashmap with the uuid, as following:

"functions": |
"bateb05ad703046fed206b4271b7ead": |

"name": "write usage",

"line™: 9,

Tlid'rl . l_,

"gtacksize": L,

"ouid": "bal9ehb05ad703046fed306b4271b72ad?",
"module": "fibELTVOedeacalfidlrd78ae780c0cdcB2",
"calls™: [

i
"calling uuid": "ba9eb05ad703046fed306b4271b7ead7",
"called uuid": "7bécdbd3bbbddelebl0f3056272%ba™,
"line™: 10,
"col": 2,
"same module":

}

1,

"level™: 1,

"calledby": [
"Ifh6bZ206509c8bT0fchd01ba797abacl "
1
b

- The list of the Control Couplings, each of them have the following information:
o calls is the list of successive calls that composed this control coupling, each of them have the
following information:
= calling_uuid is the unique identifier of the calling function.
= called_uuid is the unique identifier of the called function.
= isShortest is set to true if the control coupling is a shortest one.
= isLongest is set to true if the control coupling is a longest one
= line is the line number of the call in the module.
= col is the column number of the call in the module.
= same_module is set to true if the called function is in the same module that the calling
function.
- testcases is the list of test cases that covered the control coupling, each of them have the following
information:
= name is the name of the test case.
= requirements is the list of requirements that is covered by this test case.
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Control couplings are listed as an array, as follows:

"controlcouplings": [
1
"isLongest": '
"calls™: [

{
"calling uuid": "3fb6b20659c9b70fcéd01ba797abaclf",

"called uuid": "0ddedlfbch09e237ch0600£451d27d59",
"line™: 100,

"col™: 19,

"zame module":

}
1,

"teskcases": [

i
"name": "fct &8/1",
"requirements™: [

{
"name": "REQ PTU 123"

Data Coupling

Data Coupling is defined as “the manner or degree by which one software component influences the execution of
another software component” in the Clarification of Structural Coverage Analyzes of Data Coupling and Control
Coupling document edited by the Certification Authorities Software Team (CAST). The purpose is 'to provide a
measurement and assurance of the correctness of these modules/components’ interactions and dependencies'. Data
Coupling is used to verify that all the global variables of the application under test have been consumed in read (also

called use) and write (also called def) during the tests.

HCL OneTest™ Embedded introduces a new coverage level call “data coupling” for C language that consists to verify
that all the global variables of the application under test has been consumed in read (also called use) and write (also

called def) during the tests, as following:

« For each global variable, HCL OneTest™ Embedded identifies the def and use. Then it considers all the
possible def/use pair as a data coupling.

- To cover a Data Coupling, i.e. a def/use pair, this def and this use must be executed from at least one test.

HCL OneTest™ Embedded provides a new interactive HTML-based report for Data Coupling.
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To identify Data Coupling instances, HCL OneTest™ Embedded analyzes all the global variables of the application,
where they are read and written. For one global variable, each pair of write and read constitutes an instance of Data
Coupling.

For each data coupling, HCL OneTest™ Embedded provides the following information:

« The name of the global variable.

« The def position (file name, line, and column).

* The use position (file name, line, and column).

« The list of test cases that covered the Data Coupling.

« The list of requirements that are relative to these test cases.

How Data Coupling works

HCL OneTest™ Embedded identifies the position if the def/use using coverage information. When you select the Data

Coupling option, some coverage options are set automatically: blocks, calls and conditions.

Coverage files (.fdc and .tio) are the input of the report generator that produces a report in HTML format (and
optionally the raw data can be generated in a Json file). A template is provided for this generator. You can provide

your own template to modify the report.

If the Data Coupling feature is used with unit testing feature, the report generator could take as input the .tdc
files. This allows to have also in the report the test cases that covered each Control Coupling and the associated
requirements declared in the .ptu file. If not, the test cases are identified by its execution date, and there is no

requirement.

Set Data Coupling options

You can set the options for Data Coupling to run the build for your project in HCL OneTest™ Embedded Studio.
Execute a build with Data Coupling

« In HCL OneTest™ Embedded Studio, open the Settings of the project and click the Configuration Properties >
Build > Build options menu.

« In the right panel, click on the Build options and edit the options by clicking on the ... button.

- In the dialog window that shows up on the right, you can select the different tools that can be used for the

build. Select Data Coupling analysis to enable the Data Coupling feature.

Data Coupling options

Options for Data Coupling can be updated in the following menu of the settings: Configuration Properties > Runtime
analysis > Data Coupling

From this setting page, you can change the following choice:
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- Report Template: You can change the template of the report generator. By default, this template is

ccreport.template.

Data Coupling report

From HCL OneTest™ Embedded V8.2.0, you can get a HTML interactive Data Coupling report as a result to your
project build.

The default Data Coupling report is in HTML format. It is generated from a template named dcreport.template

provided as a text file that you can modify to customize the report. It uses four online JavaScript libraries:

» Bootstrap,

» JQuery,

* Font Awesome,
* VisJS.

These libraries are not provided. You need an Internet connection when you open the report. Otherwise, download the

libraries (.css and .js files), copy them in the same folder as your report's, and modify the template file as follows:

Replace:

<link rel="stylesheet" href="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/css/bootstrap.min.css"
integrity="sha384-MCw98/SFNGE8fJIT3GXWEONgsV7Zt27NXFoaoApmYm81iuXoPkFOJwI8ERdknLPMO"
crossorigin="anonymous">

<link rel="stylesheet" href="https://use.fontawesome.com/releases/v5.5.0/css/all.css"
integrity="sha384-B4dIYHKNBt8Bc1l2p+WXckhzcICoOwtJAoU8YZTY5qEOId1GSseTk6S+L3B1XeVIU"
crossorigin="anonymous">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.min.css">

<script src="https://code.jquery.com/jquery-3.3.1.slim.min.js"
integrity="sha384-q81i/X+965Dz00rT7abK413StQIAqVgRVzpbzo5smXKp4YfRvH+8abtTE1Pi6jizo"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/popper.js/1.14.3/umd/popper.min.js"
integrity="sha384-ZMP7rVo3mIykV+2+9J3UJ46jBkOWLaUAdn689aCwoqbBJIiSnjAK/18WvCWPIPmM49"
crossorigin="anonymous"></script>

<script src="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/js/bootstrap.min.js"
integrity="sha384-ChfqqxuZUCnISK3+MXmPNIyE6ZbWh2IMqE241rYiqIxyMiZ60W/ImZQ5stwEULTY"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.js"></script>

with

<link rel="stylesheet" href="./bootstrap.min.css>
<link rel="stylesheet" href="./all.css">
<link rel="stylesheet" href="./vis.min.css">

<script src="./jquery-3.3.1.slim.min.js"></script>
<script src="./popper.min.js"></script>

<script src="./bootstrap.min.js"></script>

<script src="./vis.js"></script

The Report is made of three parts.
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Summary

In the summary section, a table displays the following information:

» The number of global variables in your application.

« The number of Data Couplings in your application.

 The number and the list of global variables without Data Coupling. If you get this information,
it means that HCL OneTest™ Embedded has identified global variables that are read but never
written, or written but never read. This could be due to the fact that only a part of the application

is analyzed.
Two charts display the following information:

« The percentage of Data Coupling in a pie graph.
- A two-colored horizontal graph that provides a number of covered and uncovered Data

Couplings for each global variable.

Data Coupling covered 1 1 2 2 35 40

Details

A table lists all the Data Couplings and displays the following information for each of them:

« Variable: The name of the global variable.

« Def: The Def position of the column: file name [line] and (column).

« Use: The Use position of the column: file name [line] and (column).
« Test Cases: The list of cases that covered the Data Coupling.

- Requirements: The list of requirements relative to these test cases.

« Covered: This option is checked if the Data Coupling has been covered.

They are grouped by global variables.
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Details

Variable Def Use =T Requirements  Covered
Global Vanable "‘currentDate’

currentDate  main [MAIN.C] (33:2) main [MAIN.C] (118:T) = o name &1 [Thu Moy 14 14:08:14 2019) v
currentDate  main [MAIN.C] (33:2) main [MAIMN.C] (123:2) = Ia r};irrru' #7 [Thu Nov 14 140614 2019) v
currentDate DiffDays [DIFFDATES.C] (74:28) main [MAIN.C] (118:7)
currentDate  DiffDays [DIFFDATES.C] (74:28)  main [MAIN.C] (123:2)

Global Variable ‘updated’

This variable ‘'updated” is written but never read within the selected compilation units

Call graph

The call graph displays all the global variables with their interactions with one or more functions of the
application that read or/and write them.

« Incoming arrows are 'Def' (write).

« Outcoming arrows are 'Use' (read).

The arrows between them represent a 'Def’ or a 'Use' (depending of the sense of the arrow). It is green
if the corresponding 'Def' or 'Use’ has been covered. These arrows are not representing Data Coupling.
A Data Coupling instance is a couple of incoming and outcoming arrows that reach the same global

variables.

Filters

Buttons can be used to filter different sections of the report.

« Show/Hide Graph: It is used to show or hide the call graph at the end of the report.
- Show/Hide Requirements: It is used to show or hide the Requirements column in the Details
section of the report.

Customize Data Coupling Report

The Data Coupling report is based on a template called ccreport.template that you can find in the following folder:

Raw data

This template is made of 2 parts:
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» The HTML part that is the common part of all reports,
- A JavaScript part that sets the tables and call graph depending of 2 variables initialized dynamically when the

report is creating:
var data = {{json}}; // the raw data

var d = new Date({{datel}}) // the date of the generation
Raw data is composed of 4 sections at the top level:

« A summary of the Data Coupling metrics:
- nbGlobalVariables is the number of global variables found in the application.
> nbDefUses is the number of Def/Use pairs found in the application.
- nbDefUsesCovered Def/Use pairs found in the application that have been covered by at least one test.
- nbVariablesWithoutDefUse is the number of global variables that have no Def/Use pairs in the
application.
- variablesWithoutDefUse is the list of global variables that have no Def/Use pairs in the application.

"nbGlobalVariables™: 2,
"nbDeflses": 4,
"nbDeflUsesCovered”: 2,
‘nbVarablesWithoutDeflse™ 1,

"vanablesWithoutDeflse™ [
"updated"

]

« The list of the modules, each of them has the following information:
- Name is the short name of the C file,
o Fullname is the name and path of the C file,
o uuid is a unique identifier of the module,
> unknown is set to true is the module is not part of the information you provided (there is only one
unknown module that gathers all the call to functions that are not in the known modules),
> functions is the list of the unique identifiers of functions of the module.

Modules are listed as hashmap with the uuid, as follows:

"modules: {
"f5b5579edeacaB2df478a6780c0c4c92™: {
"name”: "USAGE.C",
“fullname™ "...",
"yuid": "f5b5579edeacal2df478a6780c0c4c92",
"unknown": \
"functions”™; [
"bafeb05ad703046fed306b427 1bTead7"

]
b
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« The list of functions including following information:
> name is the name of the C function,
- line is the first line of the function in the module,
o id is the number used in .tsf file to identify this function,
- stacksize is the stack size computed during the execution if this option has been set (otherwise -1),
- uuid is a unique identifier of the function,
- module is a unique identifier of the module in which the function is declared,
o calls is the list of the calls in this function. Each of them have the following information:
= calling_uuid is the unique identifier of the calling function,
= called_uuid is the unique identifier of the called function,
= line is the line number of the call in the module,
= col is the column number of the call in the module,
= same_module is set to true id the called function is in the same module that the calling
function.
- level is a number that represent the level of the function in the call graph, starting to 0.
- calledby is the list of unique identifiers of functions that call this one.
- Functions are listed as hashmap with the uuid, as following:

“functions™: {
"ba%ebl5adT03046fed306b42 T 1bVead ™ {

“name”: Wiile. usage”,

“line™; 9,

Sid™; 1,

“slacksize’ -1,

“yyid™ "bafeb0fad703046fad 3060427 1h7eadi",
“module™; THbHSTSedeacab2df478a6780c0c4e92",
“calls™ [

{
“calling_wuid": "ba%eb(5ad703046fed306b427 1bTead?™,
“called_uuid™ “ThEod643bob44e1e05T1INMB2T20aba”,
“lina™: 10,
“col™; 2,
"same._moduls™

1

1.

“level™: 1,
"calledby [
"IhEb20659cHh 7 Metad0Tbal 97 abae 1

1
L.

« The list of the control flows, each of them have the following information:
- stacksize is the size computed for this control flow. This value is -1 if the tool was unable to compute.
- calls is the list of successive calls that composed this Control Flow, each of them have the following
information:
= calling_uuid is the unique identifier of the calling function.
= called_uuid is the unique identifier of the called function.
= line is the line number of the call in the module.
= col is the column number of the call in the module.
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= same_module is set to true if the called function is in the same module that the calling
function.
= alternates is a list of line and column if the function is called several times in this function
o isRecursive is set to true if a recursive call has been found in this control flow.
= name is the name of the test case.
= missingFunctions is the list of functions (name and unique identifier) in the control flow for
which there is no stack size.

Control couplings are listed as an array, as follows:
“varnables" [

{
“name” "cumentiate”,
“line™ T,
"modulenuid”: "e602 18b87T 2e86cTd154al4e306e9160a",
“vanablename™ "cumeniDate”,
“linglocal™ -1,
"line™: 33,
"col™: 2
"function™ “main”,
"medulewusd™ "4306a1i82e1b1400a35d13acte2efce’™,
"tsdef” true,
"where™. "bloc”,
"“yaraiblelype™ "global”,
"covered. frue
).
I,
"uses”: |
{
“yanablename”: “cumeniate”,
"Iinglocal™ -1,
"line”: 118,
"eal™: 7,
"function”; "man”,
"moduleuud™ "4306a1f8221b1400a35d13acBe2efca™,
"tedef” false,
"where™ "oond”,
“varpbletype” "global”,
"covered™. frue
)
‘nbDefllses™ 4,
“testcases” |
|
[
{
“name”. ot 81",
"requirements”™; [

"name”; "REQ_PTLI 123"
}

Application Profiling

Application Profiling is gathering the main features that provide profiling information at the application level: the

Worst Stack Size feature and the Worst performance (coming soon) feature.
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Worst Stack Size

HCL OneTest™ Embedded introduces the Worst Stack Size feature to compute an estimation of the maximum stack

size of the application under test.

Overview

To implement this feature, HCL OneTest™ Embedded uses two mixed technologies:

- Static analysis that computes the call graph of the application (Example: all the calls between functions are
analyzed and computed as a graph),

« Dynamic analysis that provides the stack size of each functions when executing them.

This information is used to provide an estimation of the worst stack size. This estimation is accurate under the
following conditions:

« All the functions of the application should have been executed at least once in order to have the stack size for
each of them.

« Your application should not have recursive calls, because the number of loops in the recursive calls being
unpredictable, it is impossible to compute the stack size.

« If your application used libraries (Example: call functions for which we have not the source code), you should
provide an additional file that gives an estimation of the stack size for each of them. These estimations do not
need to be precise, but should be an upper bound of the exact stack size.

« If your compiler optimizes the Stack Size, you might have different Stack Sizes for the same function. In this
case, the Worst Stack Size is computed with the maximum value found in the different runs.

- If your application is multi-threaded, you can provide the list of entry points so that HCL OneTest™ Embedded
can calculate the worst total stack size and compare it to the maximum memory stack available on your
target to produce a pass/failed verdict.

For the Worst Stack, HCL OneTest™ Embedded provides a brand-new interactive HTML-based report. This report
identifies if one or more of these conditions are not met.

How Worst Stack Size Works

When an application node is executed, the source code is instrumented by the Instrumentor (attolcc4
for C language) that produces a static file with the .tsf extension that contains information on the
functions (this file is common with Control Coupling feature). The resulting source code is then
compiled, linked and executed and the Control Coupling feature outputs a dynamic file with the

extension .tzf.

These 2 types of files are used in input of the report generator that produces a report in HTML format
(and optionally the raw data can be generated in a Json file). A template is provided for this generator.
You can provide your own template to modify the report. An addition file could be provided to this report
generator in order to specify the stack size of the external functions.
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Note:

To visualize your report in Eclipse, if you are using the default browser option, be sure that JavaScript is enabled.
Otherwise, you can choose another browser that is compatible with your version of JavaScript by changing it in

Window> Preferences> General > Web Browser.

Set Worst Stack Size Options

Enable Worst Stack Size

« In HCL OneTest™ Embedded Studio, open the settings of the project and click Configuration Properties >
Build > Build options.

« Then, in the right panel, click on the value field of the Build options line and click the ... button to open the
Build options editor.

- Then, a dialog window shows you on the right the different tools that you can select during the build. Select
Application profiling to enable the Worst Stack Size feature.

Multi-thread option

The Multi-thread option for the Worst Stack Size feature can be configured in the following menu of the settings:

« Click Configuration Properties > Runtime analysis > Multi-Threads.
« In the right pane, click the ... in the value field of the Entry points option to open the Entry points editor.
« In the Entry points editor, enter the list of entry points for each thread and click OK.

Stack Size options

Options for the Worst Stack Size feature can be updated in the following menu of the settings: Configuration

Properties > Runtime analysis > Application Profiling > Stack size.

In the setting page, you can change the following options:

- Trace file name (.tzf): set the name of the trace file dedicated to worst stack size. By default this name is the
base name of the test with the extension .tzf.

- Report Template: change the template of the report generator. By default this template is wssreport.template.

« External functions stack size: this is a file that contains the stack size of the external functions (generally
functions that are in libraries and used by your application). The format of this file should be in Json, with the
extension .tzfe, as follows:

[

{"name":"printf", "stacksize":4},
{"name":"sin", "stacksize":4},
{"name":"cos", "stacksize":4},
{"name":"tan", "stacksize":4}
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« Maximum Size: Enter the maximum stack size in bytes that the application should not exceed.

- Security: Enter a percentage of available Stack Size for security.

If you provide the maximum Stack Size allowed and a percentage of available Stack Size for security, the

report displays the total Stack Size and verify if this size does not go over the available Stack Size.
Worst Stack Size Report

The default Worst Stack Size report is in HTML format. It is generated from a template named wssreport.template
provided as a text file that you can modify to customize the report. It uses four online JavaScript libraries:

» Bootstrap,

» JQuery,

» Font Awesome,
* VisJS.

These libraries are not provided. You need an Internet connection when you open the report. Otherwise, you need to
download the libraries (.css and .js files), copy them in the same folder as your report's, and modify the template file
as follows:

Replace:

<link rel="stylesheet" href="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/css/bootstrap.min.css"
integrity="sha384-MCw98/SFNGE8fJIT3GXWEONgsV7Zt27NXFoaoApmYm81iuXoPkFOJwI8ERdknLPMO"
crossorigin="anonymous">

<link rel="stylesheet" href="https://use.fontawesome.com/releases/v5.5.0/css/all.css"
integrity="sha384-B4dIYHKNBt8Bc12p+WXckhzcICoOwtJAoU8YZTY5qEOId1GSseTk6S+L3B1XeVIU"
crossorigin="anonymous">

<link rel="stylesheet" href="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.min.css">

<script src="https://code.jquery.com/jquery-3.3.1.slim.min.js"
integrity="sha384-q8i/X+965Dz00rT7abK41IStQIAqVgRVzpbzo5smXKp4YfRvH+8abtTE1Pi6jizo"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/popper.js/1.14.3/umd/popper.min.js"
integrity="sha384-ZMP7rVo3mIykV+2+9J3UJ46jBkOWLaUAdn689aCwoqbBJiSnjAK/18WvCWPIPmM49"
crossorigin="anonymous"></script>

<script src="https://stackpath.bootstrapcdn.com/bootstrap/4.1.3/js/bootstrap.min.js"
integrity="sha384-ChfqqxuZUCnJISK3+MXmPNIYE6ZbWh2IMqE241rYiqIxyMiZ60W/ImZQ5stwEULTY"
crossorigin="anonymous"></script>

<script src="https://cdnjs.cloudflare.com/ajax/libs/vis/4.21.0/vis.js"></script>

with

<link rel="stylesheet" href="./bootstrap.min.css>
<link rel="stylesheet" href="./all.css">
<link rel="stylesheet" href="./vis.min.css">

<script src="./jquery-3.3.1.slim.min.js"></script>
<script src="./popper.min.js"></script>

<script src="./bootstrap.min.js"></script>

<script src="./vis.js"></script

The Worst Stack Size report is made of three parts.
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Summary

472

Worst Stack Size per Entry Point table

Summary

Worst Stack Size per Entry Point 1616 bytes

# Control Flows 165 2

# Control Flows without Stack Size E
# Recursive Computed Control Flows 0 0

# Functions 37 3

The Summary section displays a table with the Worst Stack Size calculated by the tools, given the

information you provided in the build settings. This number is provided in bytes.

The Worst Stack Size is given per entry point and per thread if you have entered the list of entry point
threads of your application in the Build Settings. You can set the list of entry point threads of your
application in the Build Settings.

The table displays the following information:

» The number of control flows found in your application. A control flow is a set of successive calls
starting from an entry point (each function that is never called by another one is considered as

an entry point) to a function with no call or to an external function.

The number of control flows for which we have no estimation of the stack size. This happens
when one of the functions in this control flow has not been executed or if it is an external

function for which no estimation of the stack size is provided.

If this number if greater than 0, it is highlighted in red because there is no way to be sure that the

worst stack size is really the worst regarding the missing information.

The number of recursive control flows found in the application. If this number if greater than 0,
it is highlighted in red because there is no way to be sure that the worst stack size is really the

worst.

The number of functions in your application.
The number of functions without stack size estimation. These are the functions that have not

been executed or the external functions for which we have not provided an estimation of the
stack size. If this number if greater than 0, it is highlighted in red because we can't be sure that

the worst stack size is really the worst.
The information is given for each entry thread.

If you don't provide the list of entry points in the build settings, the information is displayed only

for the control flow and gives the Worst Stack Size.
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Total Stack Size vs. Maximum Stack Size graph

Total Stack Size vs. Maximum Stack Size

Total Worst Stack Size 1616 bytes
Maximum Stack Size 3000 bytes
% Stack Size for Security 30 %

Maximum Stack Size Allowed 2100 bytes

If you provide in the Settings the list of entry points, optionally you can provide the maximum Stack Size
allowed and a percentage of available Stack Size for security. In such case, the report displays the total

Stack Size and verifies if this size does not go over the available Stack Size.

The Maximum Stack Size and Percentage of available Stack Size for security options can be set in the
Build Settings.

In the report, you can compare the Stack Size or the sum of Stack Size with the maximum of Stack
Size allowed and the percentage of available Stack Size for security if both options are provided in the
settings.

In the toolbar that is under the graph, you can select the information to display or hide (all entry points, or for only one
thread) and the number of control flows in the table. You can also show or hide the graph in the report from a button.

Details

The Details table lists by default the 10 first control flows with the biggest Stack Size and displays for each of them

the following information:

« The control flow, for example, the successive functions starting from an entry point (any function that is never
called by another one is considered as an entry point) to a function with no call, or to an external function.
Each function is identified by its name, its module (example: C file) between brackets, and by the line and
column where this call to the next function calls appear in the code in parenthesis.

« The estimation of the Stack Size. The information is blank if the tool has not been able to calculate the Stack
Size for this control flow. In this case, the functions in the control flow that prevent us from computing the
Stack Size are highlighted in red.

A drop down menu at the top of the table allows you to choose 10, 20, 30, 50, 100 or all the control flows to display.

Functions

The Functions table lists all the functions of your application, including external functions. The following information
is provided for each function:
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» The module name (i.e. the C file) where the function is saved.,

» The function name. This name is in red if there is no stack information for this function,
« The number of functions called in the current one.

 The Stack Size of the function in bytes.

Call Graph

The Call Graph part displays all the functions as an interactive call graph from left to right or from the top to the

bottom, depending on the selector button position on the top of the call graph.

You can select a control flow in the table to highlight it in the call graph.
Customize the Worst Stack Size Report

The Worst Stack Size report is based on a template called wssreport.template that you can find in the folder

<install>/lib/reports.

This template is made of 2 parts:

« The HTML part that is the common to all reports,
A JavaScript part that sets the tables and call graph depending on 2 variables dynamically initialized when the

report is created:
o var data = {{json}}; // the raw data

o var d = new Date({{date}}); // the date of the generation

Raw data

Raw data is made of four sections at the top level:

« A summary of the Worst Stack Size metrics:

- worstStackSize is the worst stack size computed by the tools, depending on the information you
provided. This number is provided in bytes.

> nbFlows is the number of control flows found in your application. A control flow is a set of successive
calls starting from an entry point (each function that is never called by another one is considered as an
entry point) to a function without calls or to an external function.

> nbFlowsWithoutStack is the number of control flows for which there is no estimation of the stack
size. This happens when one of the functions in this control flow has not been executed, or if it is an
external function for which we have not provided an estimation of the stack size.

- nbRecursiveFlows is the number of recursive control flows found in the application.
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- nbFunctions is the number of functions in your application.

- nbFunctionsNoValue is the number of functions without stack size estimation. These are the

functions that have not been executed, or the external functions for which there is no estimation of the

stack size provided.

"worstStackSize™: 2139,
“nbFlows’: 167,
"neFlowsWithoutStack™ 70,
‘nbRecursiveFlows™ 0,
‘nbFunctions:” 40,
"nbEunctionsNoValue™ 10

The list of the modules, each of them has the following information:

* name is the short name of the C file,

« fullname is the name and path of the C file,

- uuid is a unique identifier of the module,

« unknown is set to true if the module is not part of the information you provided (there is only one unknown
module that gathers all the function calls that are not in the known modules),

« functions is the list of the unique identifiers of functions of the module.

Modules are listed as Hashmap with the uuid, as following:

"modules™: {
"f5b5579edeacaB82df478a6780c0c4c92"; {
"name”: "USAGE.C",

"fullname” "...",
"uyid": "fob5579edeaca82df478a6780c0c4c92",
"unknown": ,

“functions™: [
"ba9eb05ad703046fed306b4271b7ead7"

]
..

The list of functions, each of them have the following information:

» name is the name of the C function.

« line is the first line of the function in the module.

« id is the number used in .tsf file to identify this function.

- stacksize is the stack size computed during the execution if this option has been set (otherwise -1).
« uuid is a unique identifier of the function.

» module is a unique identifier of the module in which the function is declared.

- calls is the list of the calls in this function. Each of them have the following information:
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- calling_uuid is the unique identifier of the calling function.

- called_uuid is the unique identifier of the called function.

o line is the line number of the call in the module.

o col is the column number of the call in the module.

- same_module is set to true if the called function is in the same module that the calling function.
- level is a number that represents the level of the function in the call graph, starting from 0.

- calledby is the list of unique identifiers of functions that call the function.

Functions are listed as hashmap with the uuid, as following:

"functions”; {
"ba9eb05ad703046fed306b4271b7ead 7" {
"name”: "write. usage”,
"ling™ 9,
"id™ 1, _
“slacksize™ -1,
"yuid™: "bafeb05ad03046fed306b427 1b7eadi",
"module”; "f3bi57%edeacal2df478a6780c0c4c92”,
“calls™ |
{
“calling_uuid™ "ba%eb05ad703046fed306b427 1b7ead7",
"called, uuid”™: “7Th6cd643b5b44e1e0510f30f6272%eba”,
"line™; 10,
"E.Dl": ?I
"same.module”™
}
]?
“level™ 1,
“calledby™ |
"3b6b20659cb70fc6d(1bar97fabae 1"

]
he..

The list of the Control Flows, each of them have the following information:

- stacksize is the size of the stack computed for the control flow. This value is -1 if the tool was unable to
compute it.
« calls is the list of successive calls that composed this control flow, each of them is including the following
information:
- calling_uuid is the unique identifier of the calling function.
- called_uuid is the unique identifier of the called function.
o line is the line number of the call in the module.
o col is the column number of the call in the module.
- same_module is set to true id. The called function is in the same module that the calling function.
- alternates is a list of line & column in case of the calling function is called several times in this
function.
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« isRecursive is set to true if a recursive call has been found in this control flow.

- missingFunctions is the list of functions (name and unique identifier) in the control flow for which we have not

the stack size.

Control flows are listed as an array, as follows:

"%mupjjl,@m“: [

"isRecursive” false,
“slacksize™ 2139,
"calls™ [
{
"calling_uvid™ "3fb6b20659cb70fc6d01ba7o7abaelf”,

"called_uuid™ "0dd641fbc509e237cb0600f451d27d59",
"line™: 97

"col": 19,

“same_module™ false,

"a{lLem.ate;i‘: [

"line"; 100,
"col™ 19
}
]
b
]

"

ﬁ]?ﬁﬁiﬂﬂiUﬂﬂil.Q_ﬂﬁ"' I,
|

Testing software components

The test features provided with HCL OneTest™ Embedded allow you to submit your application to a robust test
campaign. Each feature uses a different approach to the software testing problem, from the use of test drivers
stimulating the code under test, to source code instrumentation testing internal behavior from inside the running
application.

« Component Testing for C and Ada performs black box or functional testing of software components
independently of other units in the same system.

- Component Testing for C++ uses object-oriented techniques to address embedded software testing.

- System Testing for C is dedicated to testing message-based applications.

These test features each use a dedicated scripting language for writing specialized test cases.HCL OneTest™

Embedded test features can also be used together with any of the runtime analysis tools.

To learn about See
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Black-box or functional testing of C software components independently of other units Component Testing for C

in the same system. and Ada on page 478

Using object-oriented techniques to test your C++ code Component Testing for C+
+ on page 543

Testing message-based applications written in C System Testing for C on

page 618

To use a component test feature:

Here is a rundown of the main steps to using the HCL OneTest™ Embedded test features:

1. Set up a new project in HCL OneTest™ Embedded. This can be done automatically with the New Project
Wizard on page 696.

2. Follow the Activity Wizard on page 695 to add your application source files to the workspace.

3. Select the source files under test with the Test Generation Wizard to create a test node. The Wizard guides
you through process of selecting the right test feature for your needs.

4. Develop the test cases by completing the automatically generated test scripts with the corresponding script
language and native code.

5. Use the Project Explorer on page 1056 to set up the test campaign and add any additional runtime analysis or
test nodes.
6. Run the test campaign on page 730 to builds and execute a test driver with the application under test.

7. View and analyze the generated test reports on page 715.

Related Topics

About Component Testing for C and Ada on page 478 | About Component Testing for C++ on page 543 | About
System Testing for C on page 618 | Using Runtime Analysis Features on page 336

Component Testing for C overview

Component Testing for C

The Component Testing for C feature of HCL® OneTest™ Embedded provides a unique, fully automated, and proven
solution for applications written in C, dramatically increasing test productivity.

Component Testing for C supports ANSI C89 and C99.

How Component Testing for C Works

When a test node is executed, the Test Script Compiler (attolpreproC) compiles both the test scripts and the source

under test. This preprocessing creates a .tdc file. The resulting source code generates a test driver.

If any Runtime Analysis tools are associated with the test node, then the source code is also instrumented with the

Instrumentor (attolcc1) tool.
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The test driver, TDP, stubs and dependency files all make up the test harness.

The test harness interacts with the source code under test and produces test results. Test execution creates a .rio
file.

The .tdc and .rio files are processed together the Component Testing Report Generator (attolpostpro). The output is
the .xrd report file, which can be viewed and controlled in the HCL® OneTest™ Embedded GUI.

Of course, these steps are mostly transparent to the user when the test node is executed in the HCL® OneTest™
Embedded GUI.

To learn about See

Writing test scripts for your software under test Writing a Test Script on page 481

The types of source files under test Integrated, Simulated and Additional Files
on page 479

Configuration Settings for Component Testing test Component Testing for C Settings on

nodes page 1034

Viewing Component Testing for C test results Viewing Reports on page 539

Upgrading from a pre-2002 version of HCL® OneTest™ Importing V2001 Component Testing
Embedded Files on page 537
Related Topics

Using Test Features on page 477 | Activity Wizards on page 695 | Manually Creating a Test or Application Node
on page 712 | About System Testing for C on page 618

Integrated, simulated and additional files
Component Testing for C

When creating a Component Testing test node for C and Ada, the Component Testing wizard offers the following
options for specifying dependencies of the source code under test:

« Integrated files
« Simulated files

» Additional files

Integrated Files

This option provides a list of source files whose components are integrated into the test program after linking.
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The Component Testing wizard analyzes integrated files to extract any global variables that are visible from outside.
For each global variable the Parser declares an external variable and creates a default test which is added to an
environment named after the file in the .ptu test script.

By default, any symbols and types that could be exported from the source file under test are declared again in the test
script.

Simulated Files
This option gives the Component Testing wizard a list of source files to simulate—or stub—upon execution of the test.

A stub is a dummy software component designed to replace a component that the code under test relies on, but
cannot use for practicality or availability reasons. A stub can simulate the response of the stubbed component.

The Component Testing parser analyzes the simulated files to extract the global variables and functions that are
visible from outside. For each file, a DEFINE STUB block, which contains the simulation of the file's external global

variables and functions, is generated in the .ptu test script.
By default, no simulation instructions are generated.

Additional Files

Additional files are merely dependency files that are added to the Component Testing test node, but ignored by the

source code parser. Additional files are compiled with the rest of the test node but are not instrumented.

For example, Microsoft Visual C resource files can be compiled inside a test node by specifying them as additional

files.
You can toggle a source file from under test to additional by using the Properties Window dialog box.
Related Topics

Component Testing Wizard on page 698

Testing shared libraries
Component Testing for C

In order to test a shared library, you must create a test node containing the .ptu component test script that uses the

library, and a reference link to the library.

After the execution of the test node, the runtime analysis and component test results are located in the application

node.

To test a shared library:
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1. Add the library to your project:
a. Right-click a group or project node and select Add Child and Library from the popup menu.
b. Enter the name of the Library node
c. Right-click the Library node and select Add Child and Files from the popup menu.
d. Select the source files of the shared library.

2. Run the Component Testing wizard as usual on the source file of your library. This creates a test node

containing the test scripts and the source file.
3. Delete the source file from the test node.
4. Create a reference to the shared library in the test node:

a. Right-click the application or test node that will use the shared library and select Add Child and
Reference from the popup menu.

b. Select the library node and click OK.

5. Build and execute the test node.

Example

An example demonstrating how to test shared libraries is provided in the Shared Library example project. See

Example projects on page 709 for more information.
Related Topics

Using shared libraries on page 718 | Profiling shared libraries on page 337

Writing a Test Script
Component Testing for C

When you first create Component Testing for C test node with the Component Testing Wizard, HCL OneTest™

Embedded produces a .ptu test script template based on the source under test.
To write the test script, you can use the Text Editor provided with HCL OneTest™ Embedded.

Component Testing for C uses the C Test Script Language. Full reference information for this language is provided in
the Reference section.

To learn about See
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Basic .ptu test script instructions Test Script Structure
on page 482

Initializing and testing variable val- Testing Variables on

ues page 485

Simulating stub functions Stub Simulation on
page 588

Catching exceptions Unexpected Excep-

tions on page 612

Other specific C testing notions Advanced C Testing on
page 531

Related Topics

Structure Statements on page 565 | About the Text Editor on page 725

Test Script Structure
Component Testing for C

The C Test Script Language allows you to structure tests to:

- Describe several test cases in a single test script,

- Select a subset of test cases according to different Target Deployment Port criteria.

Test script flenames must contain only plain alphanumerical characters.
A typical Component Testing .ptu test script looks like this:

HEADER add, 1, 1

<variable declarations for the test script>

BEGIN

SERVICE add

<local variable declarations for the service>

TEST 1

FAMILY nominal

ELEMENT

VAR variable1, INIT=0, EV=0
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VAR variable2, INIT=0, EV=0

#<call to the procedure under test>
END ELEMENT

END TEST

END SERVICE

All instructions in a test script have the following characteristics:

« All statements begin with a keyword.
- Statements are not case sensitive (except when C expressions are used).

- Statements start at the beginning of a line and end at the end of a line. You can, however, write an instruction
over several lines using the ampersand (&) continuation character at the beginning of additional lines. In this
case, the ampersand must be the very first character on that line; no spaces or tabs should precede it.

- Statements must be shorter than 2048 characters, although this limit may be lower on some platforms.

Structure statements

The following statements allow you to describe the structure of a test.

« HEADER: For documentation purposes, specifies the name and version number of the module being tested, as

well as the version number of the tested source file. This information is displayed in the test report.
» BEGIN: Marks the beginning of the generation of the actual test program.

« SERVICE: Contains the test cases related to a given service. A service usually refers to a procedure or
function. Each service has a unique name (in this case add). A SERVICE block terminates with the instruction
END SERVICE.

» TEST: Each test case has a number or identifier that is unique within the block SERVICE. The test case is
terminated by the instruction END TEST.

« FAMILY: Qualifies the test case to which it is attached. The qualification is free (in this case nominal). A list of

qualifications can be specified (for example: family, nominal, structure) in the Tester Configuration dialog box.

« ELEMENT: Describes a test phase in the current test case. The phase is terminated by the instruction END
ELEMENT. The different phases of the same test case cannot be dissociated after the tests are run, unlike the
test cases introduced by the instruction NEXT_TEST. However, the test phases introduced by the instruction
ELEMENT are included in the loops created by the instruction LOOP.

The three-level structure of the test scripts has been deliberately kept simple. This structure allows:
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« A clear and structured presentation of the test script and report

« Tests to be run selectively on the basis of the service name, the test number, or the test family.

In the test script, the testers can add an optional REQUIREMENT statement in order to linked the tests to one or

several requirements of the application under test.

The REQUIREMENT instruction appears within TEST blocks, where it defines the requirements for this test or within
SERVICE blocks where it defines the requirements for the tests including in this service or before the first SERVICE
block where it defines the requirements for the all the tests in the file.

Euclidian divisions in C
All Euclidian divisions performed by the Test Script Compiler round to the inferior integer.

Therefore, writing -a/b returns a different result than -(a/b), as in the following examples:

* -(9/2) returns -4

*-9/2 returns -5

Related Topics

Component Testing Tester Configuration on page 733

Using native C statements
Component Testing for C

In some cases, it can be necessary to include portions of native C code inside a .ptu test script. You can use the #, @,

and ! prefixes to do this.

Analyzed native code - #

When lines are prefixed with the # character, the Test Script Compiler analyzes the line and then copies the line into
the generated code. You can use the # prefix to declare test script variables and to include the files that declare the

functions under test.

Variable declarations must be placed outside of C test script blocks preferably at the beginning of scenarios and

procedures.

Ignored native code - @

When lines are prefixed with the @ character, the Test Script Compiler only copies the line into the test harness and
does not analyze the line. You can use the @ prefix to copy instructions into the test harness, when the test script
compiler would not understand these instructions. Assembly instructions are examples of these instructions.
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Parsed native code - !

When lines are prefixed with the ! character, the Test Script Compiler analyzes the lines, but does not copy the lines

into the test harness. You can use the ! prefix to declare variables and types that are built into the compiler.

Automatically updating a .ptu test script

Component Testing for C

Changes that are made during the development process can sometimes impact the test script, for example when new

functions are added after the test script was generated.

You can update a .ptu test script to automatically add new elements to SERVICES and INCLUDE blocks to reflect

changes that were made to the source code. An update does not remove or modify any existing statements.

For the update to work, you must not edit any generated comment lines that start with %c or %d in the test script. The
update command only works with .ptu test scripts that were generated by Test RealTime 7.0 or later, which contain

these %c and %d comment lines.

To update a .ptu test script

1. In the Project Explorer, right-click the .ptu test script that you want to update.
2. From the pop-up menu, select Update.

3. Edit the .ptu test script.

Related Topics

Writing a Test Script on page 481 | Stub Simulation on page 507

Testing variables
Component Testing for C

One of the main features of Component Testing for C is its ability to compare initial values, expected values and

actual values of variables during test execution. In the C Test Script Language, this is done with the VAR statement.

The VAR statement specifies both the test start-up procedure and the post-execution test for simple variables. This

instruction uses three parameters:

- Name of the variable under test: this can be a simple variable, an array element, or a field of a record. It is also
possible to test an entire array, part of an array or all the fields of a record.

- Initial value of the variable: identified by the keyword INIT.

- Expected value of the variable after the procedure has been executed: identified by the keyword EV.
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